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Reference Manual Overview
Background The Reference Manual provides:

o   A command reference that contains a description of and
      procedure for using each command available in Visible Advantage
      7, the Visible Admin Utility 7 (for system administrators), the
     Visible Utility, and the stand-alone edition which can run on a single
     workstation (as well as a client/server edition).
o   An appendix that contains reference information about functions
      and expressions, IDEF1X data map notation, and VSC file
      formats.

This introduction provides information about using the Reference Manual.
If you are looking for overview information about each working
area/window of Visible Advantage, see the User’s Guide.

In This This chapter contains the following topic.
Chapter

Topic                                                                           
Using This Manual
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Using This Manual

Overview  This section provides a brief overview of how to use the Reference
Manual, which contains the Command Reference and Appendices.

Command The purpose of the Reference Manual is to provide users with
Reference information on each command available within Visible Advantage
Purpose and Visible Advantage Admin Utility. Each command entry

in the Command Reference section contains the following information
about the command:
o   A description of the command
o   Usage tips, if applicable
o   Step-by-step procedure(s)
o   Illustration(s) of key dialog box(es) related to the command
o   A description of each field in the illustrated dialog boxes

Command The command reference is alphabetized by command name.
Reference If you do not find the command you are looking for within this
Organization section, use the index in the back of the manual, which

cross-references each command.
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ADD ACCESS MECHANISM

Adding Access Mechanisms
Description The Add Access Mechanism command, available from the

Design Map and Design Dictionary windows, allows you to add an access
mechanism to the encyclopedia for use within a database design.  An access
mechanism specifies the pattern(s) of access for a data structure.

Visible Advantage uses two categories of data access mechanism:  standard
access mechanisms and storage access mechanisms.

Usage Tips If you want to add a storage access mechanism, use the Add
Storage command on the Access menu.

Access mechanisms and storage access mechanisms are defined for each
data structure manager through the Visible Access Admin Utility
Table/Data Structure managers command.

When you add an access mechanism, you specify the data items accessed by
the data structure and the order of access (ascending, descending, first
in/first out, last in/first out, etc.).  Each data structure may have many access
mechanisms, but only one storage access mechanism.

You may add several types of access mechanisms through this command.
The types you can add depend on those defined for the current data
structure manager through the Visible Advantage Admin Utility Table/Data
Structure Managers command.

The Visible Advantage Admin Utility contains two new data access
methods not previous seen in Visible Advantage:  Primary Key Constraint
and Foreign Key Constraint.  These two access mechanisms can generate
SQL constraint clauses.  (See Data Structure Managers.)

Procedure å To add an access mechanism in the Design Map and Design
Dictionary windows:

1 Choose Add... from the Access menu.
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Result:  If more than one access mechanism has been defined
for the current database design’s data structure manager, the Add
Access Mechanism dialog box appears.

      Add Access Mechanism Dialog Box

If only one access mechanism has been defined for the current
database design’s data structure manager, the dialog box for adding
that access mechanism appears.

2  Note  Only mechanism types defined as access mechanisms will
appear in the Add Access Mechanism dialog box.

2 Select the type of access mechanism you want to add,, then
click on OK.

The dialog box includes the access mechanism types defined for
the current data structure manager.  Access mechanism types can
include hashing, index, set, primary key constraint, foreign key
constraint, etc.

Result:  The dialog box appears for the type of access mechanism
you selected.

3 Complete the dialog box, then click on OK.



5

Add Primary Key Constraint Access
Mechanism Dialog Box

Dialog Box
Illustration

               
                               Add Primary Key Constraint Access Mechanism Dialog Box

Dialog Box Use the information below to complete the Add Primary Key
Components Constraint Mechanism dialog box.

Component         Description                                                                 
Name Type the name of the primary key constraint

access mechanism into this field.  You may
type up to 51 alpha-numeric characters.  The
@ symbol and quotation marks (“) are not
allowed.

Data Items When using Design Dictionary, the data items
for the design object you selected before you chose
the Add Access Mechanism command appear
in this list.

Purpose Type a purpose for the primary key constraint
access mechanism  in this text box.
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Current View Use this button to add the primary key constraint
Only to the current view only.

All Design Use this button to add the primary key constraint
Object Views to all design object views.
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Add Foreign Key Constraint Access
Mechanism Dialog Box

Dialog Box
Illustration

Add Foreign Key Constraint Access Mechanism Dialog Box

Dialog Box Use the information below to complete the Add Foreign Key
Components Constraint Access Mechanism dialog box.

Component         Description                                                                 
Name Type the name of the foreign key constraint

access mechanism into this field.  You may
type up to 51 alpha-numeric characters.  The
@ symbol and quotation marks (“) are not
allowed.

Relationship Click on the drop-down arrow to select a
relationship.  The related data structure must
have a primary key constraint with the same
data items in the same order.

Data Items The data items for the relationship you selected appear in
this list.
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Purpose Type a purpose for the foreign key constraint
access mechanism  in this text box.

Current View Use this button to add the foreign key constraint
Only to the current view only.

All Design Use this button to add the foreign key constraint
Object Views to all design object views.
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Add Index Access Mechanism
Dialog Box

Dialog Box
Illustration

         Add Index Access Mechanism Dialog Box

Dialog Box Use the information below to complete the Add Index Access
Components Mechanism dialog box.

Component         Description                                                                 
Name Type the name of the index access mechanism in this

Field.  You may type up to 51 alpha-numeric
characters.  The @ symbol and quotation marks (“)
are not allowed.

Data Items The data items for the relationship you selected appear in
this list.  You may add or delete data items by clicking on
the Edit List button to display the Access Mechanism
Components dialog box.

Edit List Click here to display the Access Mechanism
Button Components dialog box to edit the data items list.

Unique Click here to make the index unique.
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Purpose Type a purpose for the index access mechanism  in
this text box.

Current View Use this button to add the index to the current view
Only only.

All Design Use this button to add the index to all design object
Object Views to all design object views.
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Access Mechanism
Components Dialog Box

Dialog Box
Illustration

      Access Mechanism Components Dialog Box

Dialog Box Use the information below to complete the Access Mechanism
Components Components dialog box.

Component         Description                                                                 
Selected The names of the selected components are listed in
Components this box.  You add components from the Candidates

List box.

Use this button to select components. Highlight the
components you wish to select and click this button.
The selected components will appear in the Selected

 Components list box.

Use this arrow to deselect components. Highlight the
components in the Selected Components list box,

   then click this button.  The selected components will
  then return to the Candidates list box.
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Use this button to select all components.  When you
click on this button, all components in the
Candidates list box will be moved to the Selected
Components list box.

Use this button to deselect all components.  When
you click on this button, all components in the
Selected Components list box will be returned to
the Candidates list box.

Ordered Click here to order the components.  Select the order
method from the drop down list.  The order method
appears in parentheses after the component name in
the Selected Components list box.
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ADD ASSOCIATION

Adding Associations

Description The Add Association command, available from both the Data Map
and Data Dictionary windows, allows you to add an association between
two entities in the current model view.

Usage Tips When you add an association, you define the following details:
o   The entities in the association
o   The nature and degree at each end of the association
o   The purpose of the association

You may define an association only between entities in the same
model view.  When you want to add an association between the
current entity and an entity in another model view, you must
first change to a model view that contains both entities to be
associated.

This command is available for multiple selected entities in both
the Data Map and Data Dictionary windows.  See the User’s
Guide for information on selecting multiple entities in those
windows.

Procedure å  To add an association for each selected entity in the
Data Map or Data Dictionary window:

1 Choose Add... from the Association menu.

Result:  The Add Association dialog box appears for the
first selected entity.

2 Complete the Add Association dialog box, then click on
OK.

Result:  The active window redisplays with the new
association.
or
If you selected more than one entity, the Add Association
dialog box reappears for the next selected entity.



14

Add Association Dialog Box

Dialog Box
Illustration

        Add Association Dialog Box

Dialog Box Use the information below to complete the Add Association dialog
Components box.

Components       Description                                                                 
Parent Entity The currently selected entity is displayed in this box.

If you want to define a different entity for the parent
side of the association, clear the Parent Entity box
and select one from this drop down list.

Child Entity Select an entity for the child end of the association
from this drop-down list.  The list includes all
entities in the current model view.

2  Note  You should select a parent and a child
entity before you select a type for the association.

Type Select an association type from this drop-down
list if the association you wish is different than the
type shown.  The association type defines the degree
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and nature combination at each entity end of the
association.

See the Data Modeling section in the User’s Guide
for a description of each nature and degree
combination.

Identifying Select this checkbox to have the primary keys
cascade from parent to child as primary keys.  If
unchecked, keys will cascade as foreign keys.

Categorizing Select this checkbox to indicate the entity on the
optional side of the association is the child in a
supertype (parent) to subtype (secondary)
association.  This distinguishes which entity is the
supertype for the secondary.

Min Type the minimum number of occurrences
with which the opposite entity is related.
You define this for the parent entity
in the Parent area and for the child entity
in the Child area.

Max Type the maximum number of occurrences
with which the opposite entity is related.
You define this for the parent entity in the
Parent area and for the child entity in the
Child area.

Allow Select this checkbox if the entity should be
Cascade deleted when the last occurrence of the entity
Delete on which it depends is deleted.  You define

this for the parent entity in the Parent area
and for the child entity in the Child area.

From Label Type the label assigned to the association from
Parent to Child.

To Label Type the label assigned to the association, Child to
Parent.
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Purpose Type a purpose for the association in this
scrolled text box.  The purpose of the
association explains its business significance
to the data model and the planning statements
that direct the project.

Status Select a status from the drop-down list.  You
may select Accepted, Proposed, or Presentation.
Only one Accepted status is allowed for an
association between two given entities.

Reverse If you want to reverse the association, click on
this button.  This reverses the parent and child
entities in the association, but retains the combination
of degree and nature at each entity end of the
association.

Use the Reverse button if you want to place the
child entity in the parent box and the parent entity in the
child box.

Keys Click on this button to display the Association
Keys dialog box.  Complete the dialog box and
click on OK.

Spell Click on this button to spell check the dialog box.

More This button is available when custom fields have
been defined using Table/Custom Fields in the
Admin Utility.
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Association Keys Dialog Box

Dialog Box
Illustration

                     

         Association Keys Dialog Box

Dialog Box Use the information below to complete the Association Keys dialog
Components box.

Component         Description                                                                 
Parent Keys/ This box displays a list of the parent and linked keys.
Linked Keys

Child This box displayed a list of the child candidate keys.
Candidate
Keys

Change Click on this command button to change the
highlighted child candidate key to a linked key.

Migrate Click on this command button to migrate the
highlighted key to the linked key.
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Remove Click on this command button to remove the linked
key from the highlighted parent key.

Show All Click on this command button to show all candidate
keys.
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ADD ATTRIBUTE

Overview

Description The Add Attribute command, available from both the Data Map and
Data Dictionary windows, allows you to add primary key, foreign key, and
non-key attributes and attribute groups to selected entities in the Data Map
or Data Dictionary window.

Usage Tips When you choose the Add Attribute command, you can add
successive attributes to selected entities through the Add Attribute dialog
box.  When you add attributes to an entity, the attributes and their details
are added to all other occurrences of the entity in the encyclopedia.

This command is available for multiple selected entities in both the Data
Map and Data Dictionary windows.  See the User’s Guide for information
on selecting multiple entities in those windows.

In This This chapter covers the following topics:
Chapter

Topic                                                                           
Adding Primary Keys
Adding Foreign Keys
Adding Non-Keys
Adding Primary Key Groups
Adding Foreign Key Groups
Adding Non-Key Groups
Add Attribute Dialog Box
Add Primary Key Attribute Dialog Box
Add Foreign Key Attribute Dialog Box
Add Non-Key Attribute Dialog Box
Add Primary Key Group Attribute Dialog Box
Add Foreign Key Group Attribute Dialog Box
Add Non-Key Group Attribute Dialog Box
Assemble Attribute Group Dialog Box
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Adding Primary Keys

Procedure å  To add a primary key to selected entities in the Data Map or
Data Dictionary window:

1 Choose Add... from the Attribute menu, then click on the
Primary Key button in the Add Attribute dialog box.

Result: The Add Primary Key Attribute dialog box appears.

2 Complete the Add Primary Key Attribute dialog box , then
click on OK.

3 If you selected multiple entities, the Add Attribute dialog box
appears for the next entity.  Click on the Primary Key button
and redo step 2 until you are finished adding attributes to all
selected entities.
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Adding Foreign Keys

Procedure å  To add a foreign key to selected entities in the Data Map or
Data Dictionary window:

1 Choose Add... from the Attribute menu, then
click on the Foreign Key button in the Add Attribute dialog box.

Result: The Add Foreign Key Attribute dialog box appears for the
first selected entity.

2 Complete the Add Foreign Key Attribute dialog box,
then click on OK.

3 If you selected more than one entity, the Add Attribute
dialog box appears.  Click on the Foreign Key button and
repeat step 2.

2  Note  Only one foreign key is allowed per selected
entity.
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Adding Non-Keys

Procedure å  To add a Non-Key Attribute to selected entities in the Data
Map or Data Dictionary window:

1 Choose Add... from the Attribute menu, then
click on the Non-Key button in the Add Attribute dialog box.

Result: The Add Non-Key Attribute dialog box appears.

2 Complete the Add Non-Key Attribute dialog box, then click
on OK.

3 If you selected multiple entities, the Add Attribute dialog box
appears for the next selected entity. (Repeat the above steps
until you are finished adding attributes to all selected
entities.)
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Adding Primary Key Groups

Procedure å  To add a Primary Key Group attribute to selected entities in
the Data Map or Data Dictionary window:

1 Choose Add... from the Attribute menu.

Result: The Add Attribute dialog box appears.

2 Select the Group checkbox, then click on the Primary Key
button.

Result: The Add Primary Key Group Attribute dialog box appears.

3 Complete the Add Primary Key Group dialog box,
then click on Group Members.

Result: The Assemble Attribute Group dialog box appears.

4 Complete the Assemble Attribute Group dialog box, then
click  on OK.

Result:  The Add Attribute dialog box reappears.

5 Click on OK.

6 If you selected multiple entities, the Add Attribute dialog box
appears for the next selected entity. (Repeat the above steps
until you are finished adding attributes to all selected
entities.)
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Adding Foreign Key Groups

Procedure å  To add a Foreign Key Group attribute to selected entities in
the Data Map or Data Dictionary window:

1 Choose Add... from the Attribute menu.

Result: The Add Attribute dialog box appears.

2 Select the Group checkbox, then click on the Foreign Key
button.

Result: The Add Foreign Key Group Attribute dialog box appears.

3 Complete the Add Foreign Key Group dialog box,
then click on Group Members.

Result: The Assemble Attribute Group dialog box appears.

4 Complete the Assemble Attribute Group dialog box, then
click on OK.

Result: The Add Attribute dialog box reappears.

5 If you selected multiple entities the Add Attribute dialog box
appears for the next selected entity. (Repeat the above steps
until you are finished adding attributes to all selected
entities.)
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Adding Non-Key Group

Procedure å  To add a non-key group attribute to selected entities in the
Data  Map or Data Dictionary window:

1 Choose Add... from the Attribute menu.

Result: The Add Attribute dialog box appears.

2 Select the Group checkbox, then click on the Non-Key
button.

Result: The Add Non-Key Group Attribute dialog box appears.

3 Complete the Add Non-Key Group dialog box  then click on
Group Members.

Result: The Assemble Attribute Group dialog box appears.

4 Complete the Assemble Attribute Group dialog box, then
click  on OK.

Result: The Add Attribute dialog box reappears after the last
associated entity.

5 If multiple entities are selected, the Add Attribute dialog box
appears for the next selected entity. (Repeat the above steps
until you are finished adding attributes to all selected
entities.)
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Add Attribute Dialog Box

Dialog Box
Illustration

       

         Add Attribute Dialog Box

Dialog Box Use the information below to complete the Add Attribute dialog
Components box.

Component         Description                                                                 
Entity The name of a selected entity in the Data Map

window or the current entity in the Data Dictionary
window.

When you select multiple entities in the Data Map
window, the entity name in this box changes to the next
selected entity after you finish adding an
attribute to the currently selected attribute.

Primary Key Click on this button to add a primary key to the
entity whose name appears in the Entity box.

Foreign Key Click on this button to add a foreign key to the entity
whose name appears in the Entity box.

Non-Key Click on this button to add a non-key attribute to the
entity whose name appears in the Entity box.
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Group Select this checkbox before clicking on one of the
Add Attribute buttons (Primary Key, Foreign Key, or
Non-Key) to define the new attribute as an attribute
group.

Close Click on this button when you are finished adding
attributes and want to return to the active Data Map or
Data Dictionary window.
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Add Primary Key Attribute Dialog Box

Dialog Box
Illustration

             Add Primary Key Attribute Dialog Box

Dialog Box Use the information below to complete the Add Primary Key
Components Attribute dialog box.

Component         Description                                                                 
Entity The name of the current entity is displayed.

Attribute Type the name of the new attribute in this box. An
attribute name can be from 2 to 51 alphanumeric
characters long, and may include spaces. This is a
required field.

Alias Type an alternate name for the attribute in this box,
if necessary. An alias is used to identify multiple
occurrences of the same attribute or an occurrence of a
foreign key in a specific entity.

If the attribute has already been added to another entity in
the current model view, you may type a new alias or
select one from the Alias drop-down list.
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This list includes all aliases defined for the attribute name
displayed in the Attribute box.

Purpose Type a purpose that explains the attribute's
significance to the data model and to the planning
statements that direct the data model.

2 Note  If you change this field for an attribute, the
change will appear in all other uses of the attribute.

Domain Select a domain set from this drop-down list. A
domain set determines the length, precision, range, and
accepted values the attribute's field will have in the
implemented information system.

This list includes predefined domain sets, as well as any
defined through the Domain Set command on the
Attribute menu.

2  Note  If you change this field for an attribute, the
change will appear in all other uses of the attribute.

Length Type a length for the attribute value.

Precision Type a precision for the attribute value.

Edit Domain Click this button to edit the domain set.  The Add
Domain Set dialog box is displayed.

System Select this checkbox if the value for the attribute in
Controlled the implemented system will be system controlled,

rather than user defined.

Model View Select each model view authority checkbox
Authority  (Read or Update) that applies to the new attribute.

An attribute's model view authority indicates the access
level given to the model view to which the attribute is
being added

This area will be dimmed if you are adding the attribute to
the entire encyclopedia.
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Spell Click this button to spell check the dialog box.

More This command button is available when custom
fields have been defined using Table/Custom Fields
in the Admin Utility.
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Add Foreign Key Attribute Dialog Box

Dialog Box
Illustration

          Add Foreign Key Attribute Dialog Box

Dialog Box Use the information below to complete the Add Foreign Key
Components Attribute dialog box.

Component         Description                                                                 
Entity The name of the current entity is displayed.

Attribute Type the name of the key, but the key name you type
must be used as a primary key in the current model
view.

Alias Type an alternate name for the attribute in this box,
if applicable. An alias is used to identify multiple
occurrences of the same attribute or an occurrence of a
foreign key in a single entity.

Purpose Type the purpose of the attribute.  The purpose of the
attribute explains its significance to the encyclopedia
and to the planning statements that direct the
encyclopedia.



32

2  Note  If you add a purpose, the new purpose will
appear in all other uses of the key.

Edit Rule Select an edit rule from this drop-down list. Edit
rules describe how the attribute relates to the entity.

Select this option...,          If you want to...
Add Now, Modify enter a value for the
Later attribute when an

occurrence of the entity is
added, and you want to be
able to change the value
after it has been entered.

Add Now, Cannot enter a value for the
Modify attribute when an

occurrence of the entity is
added, and you do not
want to be able to change
the value after it has been
entered.

Add Later, Modify enter a value for the
Later attribute after an

occurrence of the entity
has been added, and you
want to be able to change
the value after it has been
entered.

Add Later, Cannot enter a value for the
Modify attribute after an

occurrence of the entity
has been added, and you
do not want to be able to
change the value after it
has been entered.

Domain Select a domain set from this drop-down list. A
domain set determines the length, precision, range, and
accepted values the attribute's field will have in the
implemented information system.
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This list includes predefined domain sets, as well as any
defined through the Domain Set command on the
Attribute menu.

2 Note  If you change this field for an attribute,
the change will appear in all other uses of the
attribute.

Length Type a length for the attribute value.

Precision Type a precision for the attribute value.

Optional Select this checkbox if the attribute is optional for
the entity.

Unique Select this checkbox if each value for the attribute is
used in one and only one occurrence within the entity.

Edit Domain Click this button to edit the domain.  The Add
Domain Set dialog box is displayed.

Repeating Select this checkbox if the attribute occurs more than
once within the entity.

Min If the attribute is repeating, type a minimum number
of times it can occur within the entity in this box.

Max If the attribute is repeating, type a maximum number
of times it can occur within the entity in this box.

Model View Select each model view authority checkbox
Authority (Read or Update) that applies to the attribute.

An attribute's model view authority indicates the
modification or viewing authority given to the model
view to which the attribute is being added.

This area will be dimmed if you are adding the attribute to
the entire encyclopedia.

Spell Click this button to spell check the dialog box.
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More This command button is available when custom
fields have been defined using Table/Custom Fields
in the Admin Utility.
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Add Non-Key Attribute Dialog Box

Dialog Box
Illustration

Add Non-Key Attribute Dialog Box

Dialog Box Use the information below to complete the Add Non-Key
Components Attribute dialog box.

Component         Description                                                                 
Entity The name of the current selected entity is displayed.

Attribute Type the name of the attribute in this box. The name
of the attribute can be from 2 to 51 alphanumeric
characters long and may include spaces. This is a required
field.

Purpose Type a purpose for the attribute in this text box. The
purpose of the attribute should explain its significance to
the data model and to the planning statements that direct
the project.
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Derived If the value for the attribute depends on one or more
other attribute value(s) within the encyclopedia, select this
checkbox.

+  Example  The attribute “total quantity on hand”
is a derived attribute because its value depends on the
quantities on hand of a specific item at all locations. The
attribute “gender” is not a derived attribute because its
value does not depend on any other attribute.

Formula If you selected the Derived checkbox, type a
derivation formula in the Formula text box. See the
Appendix of this manual for information on valid syntax
for expressions.

The derivation formula you type can include any
functions or operators defined for the encyclopedia. You
define functions and operators through the Functions
command on the Attribute menu.

Edit Rule Select an edit rule from this drop-down list. Edit
rules describe how the attribute relates to the entity. The
table below describes each edit rule option.

Select this option...           If you want to...
Add Now, Modify enter a value for the
Later attribute when an

occurrence of the entity is
added, and you want to be
able to change the value
after it has been entered.

Add Now, Cannot enter a value for the
Modify attribute when an

occurrence of the entity is
added, and you do not
want to be able to change
the value after it has been
entered.

Add Later, Modify enter a value for the
Later attribute after an
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occurrence of the entity
has been added.

Add Later, Cannot enter a value for the
Modify attribute after an

occurrence of the entity
has been added.

Domain Select a domain set from this drop-down list. A
domain set determines the length, precision, range, and
accepted values the attribute's field will have in the
implemented information system.

This list includes predefined domain sets, as well as any
defined through the Domain Sets command on the
Attribute menu.

Length Type a length for the attribute value in this field.

Precision Type a precision for the attribute value in this field.

System Select this checkbox if the value for the attribute
Controlled in the implemented system will be system controlled,

rather than user defined.

Unique Select this checkbox if each value for the attribute is
used in one and only one occurrence within the entity.

Optional Select this checkbox if the attribute is optional for
the entity.

Edit Domain Click this button to edit the domain.  The Add
Domain Set dialog box is displayed.

Model View Select each authority checkbox (Read or Update)
Authority that applies to the attribute. An attribute's model

view authority indicates the modification or viewing
authority given to the model view to which the attribute is
being added.

This area will be dimmed if you are adding the attribute to
the entire encyclopedia.



38

Repeating Select this checkbox if the attribute can assume more
than one set of values for a single occurrence of the entity.

Min If you selected the Repeating checkbox, type a
minimum number of times the attribute can occur within
the entity in this box.

Max If you selected the Repeating checkbox, type a
maximum number of times the attribute can occur within
the entity in this box.

Spell Click this button to spell check the dialog box.

More This command button is available when custom
fields have been defined using Table/Custom Fields
in the Admin Utility.

.
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Add Primary Key Group
Attribute Dialog Box

Dialog Box
Illustration

                             

          Add Primary Key Group Attribute Dialog Box

Dialog Box Use the information below to complete the Add Primary Key Group
Components Attribute dialog box.

Component         Description                                                                 
Entity The name of the current entity is displayed.

Attribute Type the name of the new group attribute.
An attribute name can be from 2 to 51 alphanumeric
characters long, and may include spaces. This is a
required field.

Alias Type an alternate name for the attribute in this box,
if applicable. An alias is used to identify multiple
occurrences of the same attribute or an occurrence of a
foreign key in a single entity.

You may either type a new alias or select one from the
Alias drop-down list. This list includes all aliases defined
for the attribute name displayed in the Attribute box.
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Purpose Type a purpose for the key. The purpose of the
attribute explains its significance to the encyclopedia
and to the planning statements that direct the
encyclopedia.

Group Use this button to define the attributes within the
Members primary attribute group. When you click on this

button, the Assemble Attribute Group dialog box
appears.

Spell Click this button to spell check the dialog box.

More This command button is available if custom fields
have been defined using Table/Custom Fields in the
Admin Utility.
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Add Foreign Key Group
Attribute Dialog Box

Dialog Box
Illustration

                                 

          Add Foreign Key Group Attribute Dialog Box

Dialog Box Use the information below to complete the Add Foreign Key Group
Components Attribute dialog box.

Component         Description                                                                 
Entity The name of the current entity is displayed.

Attribute Type the name of the new group attribute in this box.
An attribute name can be from 2 to 51 alphanumeric
characters long, and may include spaces. This is a
required field.

Alias Type an alternate name for the attribute in this box,
if applicable. An alias is used to identify multiple
occurrences of the same attribute or an occurrence of a
foreign key in a single entity.

Purpose Type a  purpose for the attribute.  The purpose of the
attribute explains its significance to the encyclopedia
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and to the planning statements that direct the
encyclopedia.

Unique Select this checkbox if each value for the attribute is
used in one and only one occurrence within the entity.

Optional Select this checkbox if the attribute is optional for
the entity.

Repeating Select this checkbox if the attribute occurs more than
once within the entity.

Min If the attribute is repeating, type a minimum number
of times it can occur within the entity in this box.

Max If the attribute is repeating, type a maximum number
of times it can occur within the entity in this box.

Group Use this button to define the attributes in the foreign
Members key group. When you click on this button, the

Assemble Attribute Group dialog box appears.

Spell Click this button to spell check the dialog box.

More This command button is available when custom
fields have been defined using Table/Custom Fields
in the Admin Utility.
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Add Non-Key Group
Attribute Dialog Box

Dialog Box
Illustration

                                     

                    Add Non-Key Group Attribute Dialog Box

Dialog Box Use the information below to complete the Add Non-Key Group
Components Attribute dialog box.

Component         Description                                                                 
Entity The name of the current entity is displayed.

Attribute Type the name of the new group attribute in this box.
An attribute name can be from 2 to 51 alphanumeric
characters long, and may include spaces. This is a
required field.

Purpose Type a purpose for the attribute.  The purpose of the
attribute explains its significance to the encyclopedia
and to the planning statements that direct the
encyclopedia.

Unique Select this checkbox if each value for the attribute is
used in one and only one occurrence within the entity.
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Optional Select this checkbox if the attribute is optional for
the entity.

Repeating Select this checkbox if the attribute occurs more than
once within the entity, select this checkbox.

Min If the attribute is repeating, type a minimum number
of times it can occur within the entity in this box.

Max If the attribute is repeating, type a maximum number
of times it can occur within the entity in this box.

Group Use this button to define the attributes in the non-key
Members group. When you click on this button, the Assemble

Attribute Group dialog box appears.

Spell Click this button to spell check the dialog box.

More This command button is available when custom
fields have been defined using Table/Custom fields
in the Admin Utility.
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Assemble Attribute Group Dialog Box

Dialog Box
Illustration

                                 

                    Assemble Attribute Group Dialog Box

Dialog Box Use the information below to complete the Assemble Attribute
Components Group dialog box.

Component         Description                                                                 
Attr Name The name of the group attribute specified in the

applicable add attribute dialog box (primary, foreign, or
non-key) is displayed.

Members The attributes that comprise the group attribute. You
add attributes to and remove them from this box.

Attributes Select an attribute from this drop-down list to add to
the Members box. This list includes all attributes
(primary, foreign, and non-key) in the current model
view.

Add Click on this button to add the selected attribute to
the attribute group. The selected attribute will appear in
the Members box. Do this for each attribute you want to
add to the group.
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Remove To remove an attribute from the Members box,
highlight the name of the attribute you want to remove,
then click on the Remove button.
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ADD BUSINESS EVENT

Adding Business Events

Description The Add Business Event command allows you to add a business event
to the process model. Business events initiate business processes.

Usage Tips When you add a business event, you provide its title and purpose, as
well as the business process that the business event initiates. Business
events appear in the Process Hierarchy window.

Any planning statement added to the Planning Outline or Planning
Dictionary window and assigned the “business event” statement type is also
treated like a business event and will appear in the Process Hierarchy
window. When you add a business event as a planning statement in a
planning window, you must then use the Process Hierarchy window to
define the business process it initiates.

Procedure å  To add a business event to the process model:

1 Choose Add... from the Event menu.

Result: The Add Business Event dialog box will appear.

2 Complete the Add Business Event dialog box, then click on
OK.
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Add Business Event Dialog Box

Dialog Box
Illustration

        Add Business Event Dialog Box

Dialog Box Use the information below to complete the Add Business Event
Components dialog box.

Component         Description                                                                 
Name Type a name for the business event you are adding

into this box.

Process Choose from this drop-down list the business process
that the business event will invoke. The list includes all
business events added to the encyclopedia.

Purpose Type a purpose for this business event into this text
box. You may type up to 32,000 characters.

Spell Click this button to spell check the dialog box.

Current Click this button to add the business event to the
current view.
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All Views Click this button to add the business event to all
views.

Selected Click this button to add the business event to
Views selected views.  The Select Views button becomes

available.  Click the Select Views button to display
the Select Views dialog box.
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ADD CONDITION END

Adding Condition Ends

Description The Add Condition End command allows you to add a condition end
to a process. A condition end shows where two or more logic paths
converge after they have diverged from a condition.

A condition end is symbolized by a filled diamond.

Procedure å  To add a condition end:

1 Select one of the process steps whose logic paths you want to
converge.

2 Choose Add Condition End from the Control menu.

Result: A control flow leading from the selected process step to a
filled diamond appears. The filled diamond represents the
condition end.

3 You can now converge the logic paths of the other process
steps subject to conditions.

To do this, hold down the left mouse button and drag the mouse
cursor from one of the steps you want to converge into the
condition end (filled diamond) you just added. Repeat this for each
step you want to converge into the condition end.
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ADD CONTROL FLOW

Adding Control Flows

Description The Add Control Flow command lets you add a control flow from one
process step or control mechanism to another process step or control
mechanism (conditional, parallel, or stop). Control flows connect and
sequence all process steps within a process.

A control flow is displayed as a single-headed arrow originating from one
process step/control mechanism and arriving at another process step/control
mechanism. The head of the arrow points to the target step/control
mechanism.

Usage Tips You do not access the Add Control Flow from any Process Map menu;
instead, you use the mouse to add a control flow from one process step or
control mechanism to another.

Whenever a new step is added to the current process, Visible Advantage
will automatically depict the control flow originating from the selected step
or control mechanism to the new one. Add a control flow manually when a
specific direction of the flow is desired (looping, for example) or a new
connection between process steps or control mechanisms is sought.

Procedure å  To add a control flow:

1 Select the process step or control mechanism from which you
want the control flow to originate.

2 Hold down the left mouse button and drag the mouse cursor
from the selected process step or control mechanism to the
destination process step or control mechanism.

Result: The Add Control Flow dialog box appears.

3 Complete the Add Control Flow dialog box.

To define a condition for the control flow, click on the Define
button. The Control Flow Condition States dialog box appears.
Complete the dialog box, then click on OK to return to the Add
Control Flow dialog box.
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4 Click on OK in the Add Control Flow dialog box.
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Add Control Flow Dialog Box

Dialog Box
Illustration

    Add Control Flow Dialog Box

Dialog Box Use the information below to complete the Add Control Flow
Components dialog box.

Component         Description                                                                 
From Step The type of the step from which the flow is

originating is listed in this field.

To Step The type of the step the flow is targeting is listed in
this field.

Conditions The conditions set for the execution of the new flow
are listed here. Conditions determine under which
circumstances the target process step is executed. You
add conditions to this list through the Define button.

Define Use this button to define the conditions that apply to
the control flow. The Control Flow Condition States
dialog box appears when you click on this button.
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Purpose Type a purpose that explains the control flow's
significance to the process model into this box. You may
type up to 32,000 alphanumeric characters.

Spell Click this button to spell check the dialog box.
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Control Flow Condition States Dialog Box

Dialog Box
Illustration

      Control Flow Condition States Dialog Box

Dialog Box Use the information below to complete the Control Flow Condition
Components States dialog box.

Component         Description                                                                 
Candidates The names of the condition states that are possible

for this control flow are listed in this box.

Use this button to select condition state candidates.
Highlight condition states in the Candidates list
box, then click on this button. The selected candidates
will then appear in the Condition States list box.

 Use this button to deselect condition states. Highlight
 condition states in Condition States list box, then
click on this button. The selected condition states will
then return to the Candidates list box.

Use this button to select all condition states
candidates. When you click on this button, all
condition states in the Candidates list box will be
moved to the Condition States list box.
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Use this button to deselect all condition states.  When
you click on this button, all condition states in the

   Condition States list box will be returned to the
   Candidates list box.
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 ADD DATA ITEM

Adding Data Items

Description The Add Data Item command, available from the Design Map and
Design Dictionary windows, allows you to add a data item to the
currently displayed data structure.

Usage Tips As an alternative to adding data items with this command, you may
also add a data item to a data structure through the Copy From Data Model
command on the item menu.

When you add a data item, you define the following details:
o   Name
o   Meta ID
o   Alias
o   Role
o   Purpose
o   Type
o   Data type
o   Length and precision
o   Uniqueness
o   Optionality
o   Repeatability

Procedure å  To add a data item to the current database design:

1 Choose Add Data Item from the Property menu.

Result:  The Add Data Item dialog box appears.

2 Complete the Add Data Item dialog box, then click
on OK.
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Add Data Item Dialog Box

Dialog Box
Illustration

Add Data Item Dialog Box

Dialog Box Use the information below to complete the Add Data Item dialog
Component box.

Component         Description                                                                 
Name Type a name for the data item in this field, or select

one using the Existing button.

The name must begin with an alphabetic character
and can only include letters, numbers, underscores,
and spaces.

Existing Click this button to display the Locate Design Object
Property dialog box, then select the design object and 
property.



59

Meta Id Type the meta id  into this field.  Meta ids are used
as additional identifiers.

Alias If desired, type an alias into this field.  Data item
aliases are used as shorthand handles for quick
identification.

Primary Key Click on this checkbox to add the data item as a
primary key.

Foreign Key Click on this checkbox to add the data item as a
foreign key.

Edit Domain Click this button to edit the domain.  The Add
Domain Set dialog box is displayed.

Purpose Type a purpose for the data item into this text
box.

Type Select a type for the data item from this drop-down
list box.  The types available for a data item depend
on the data item types defined through the Visible
Advantage Admin Utility Table/Data Item Types
command.

Domain Select a domain for the data item from this drop-
down list box.

Length Type a length for the data item value in this field.

Precision Type a precision for the data item value in this field.

Unique Select this checkbox if each value for the data item is
used in only one occurrence within the data
structure.

Repeating Select this checkbox if the data item occurs more
than once within the data structure.

Current View Select this checkbox to display the data item in
Only the current view only.
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All Design Select this checkbox to display the data item in
Object Views all  design object views.

Display Click on this button to display the Display
Characteristics Characteristics dialog box.

Complete the Display Characteristics dialog
box and click on OK.

More Click this button to display the Optional Fields
dialog box.  This command button is available when
custom fields have been defined using Table/Custom
Fields in the Admin Utility.

Spell Click this button to spell check the dialog box.
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Display Characteristics
Dialog Box

Dialog Box
Illustration

                             

           Data Item Display Characteristics Dialog Box

Dialog Box Use the information below to complete the Data Item Display
Components Characteristics dialog box.

Component         Description                                                                 
Data Item Defaults
Heading Type the default heading for the data item.

Label Type the default label for the data item.

Display Mask Type the default automatic formatting.

This Data Item Use
Heading Type the data item heading for this use.

Label Type the data item label for this use.
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Display Mask Type the automatic formatting for this use.

Default Type the default for this use.
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ADD DATA STRUCTURE

Adding Data Structures

Description The Add Data Structure command, available from the Design
Map and Design Dictionary windows, allows you to add a data
structure to the current design object.

Usage Tips As an alternative to adding data structures with this command, you
may also add a data structure through the Copy From Data Model
command on the Design Object menu.

When you add a data structure, you define the following details:
o   Name
o   Meta Id
o   Purpose
o   Code
o   Type
o   Nature
o   Volume

If you want to add a data structure to the current design object that
has already been added to another design object, use the Copy From
Database Design command on the Design Object menu.

Procedure å To add a data structure to the current design object:

1 Choose Add... from the Design Object menu.

Result:  The Select Design Object Type dialog box appears.

2 Select data structure and click on OK.

3 Complete the Add Data Structure dialog box, then click
on OK.
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Add Data Structure Dialog Box

Dialog Box
Illustration

                               

         Add Data Structure Dialog Box

Dialog Box Use the information below to complete the Add Data Structure
Components dialog box.

Component         Description                                                                 
Name Type a name for the data structure into this field.

The name must begin with an alphabetic character
and can only include letters, numbers, underscores,
and spaces.

Meta Id Type a meta id for the data structure into this text
box.  The meta id is used to differentiate when two
or more data structures have the same name.

Purpose Type a purpose for the data structure into this text
box.

Code Type a code (also known as an alias) into this field.
You can use a code for a data structure as a short
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name for ease of use for developers, operators, and
users.

Type Select a type for the data structure from this drop-
down list.  The types available for a data structure
depend on the data structure manager for the current
design object.

You can edit the data structure types for each data
structure manager through the Visible Advantage
Table/Data Structure Manager command.

Dynamic Select this data structure nature if the data
structure’s data item values will be user defined.
This is the default nature value.

Static Select this data structure nature if the user will
select the data structure’s data item values from a
predefined set of values.

Use the Populate Table command on the Structure
menu to enter the predefined values for a static data
structure’s data items.

Volume Type into this field the expected maximum number
of times the data structure will appear in the
implemented system.

Spell Click this button to spell check the dialog box.

More This command button is available when custom
fields have been defined using Table/Custom Fields
in the Admin Utility.
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ADD DATA STRUCTURE
 MANAGER

Adding a Data Structure Manager

Description This command, available through the Visible Advantage Admin
Utility, allows the system administrator to add a data structure
manager to the implemented system.

Usage Tips Your Visible Advantage comes with predefined data structure
managers:  DB2, Microsoft SQL, Oracle v.7, SUPRA, SYBASE v.10,
Velocis SQL, WATCOM SQL.

Procedure å  To add a data structure manager:

1 Choose Table from the Visible Advantage Admin
Utility.

2 Choose Data Structure Managers from the cascading
Table menu.

Result:  The Data Structure Managers box appears.

Predefined Data Structure Managers are listed.

3 Click on the option Add.

Result:  The Add Data Structure Managers dialog box
appears.

4 Complete the dialog box, then click on OK.

(See Data Structure Managers for information on the
dialog box fields.)
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ADD DATA STRUCTURE
RELATIONSHIPS

Adding Data Structure Relationships

Description The Add Data Structure Relationship command allows you to add a
relationship between two data structures in the current database design from
the Design Dictionary and Design Map windows.

Procedure å  To add a relationship for the currently displayed
data structure:

1 Choose Add... from the Relationship menu.

Result:  The Relationship Reason dialog box is
displayed.

2 Select the relationship reason and click on OK.

Result:  The Add dialog box is displayed.

3 Complete the dialog box and click on OK.
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Add Calls Relationship Dialog Box

Dialog Box
Illustration

           

Add Calls Relationship Dialog Box

Dialog Box Use the information below to complete the Add Calls Relationship
Components dialog box.

Component         Description                                                                 
Parent Design Select a parent design object from the drop-down
Object list.

Child Design Select a child design object from the drop-down
Object list.

Purpose Type a purpose in the text box.

Reverse Click on this command button to reverse the
relationship.

More This command button is available when  custom
fields have been defined using Table/Custom
Fields in the Admin Utility.
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Add Contains Relationship Dialog Box

Dialog Box
Illustration

            

Add Contains Relationship Dialog Box

Dialog Box Use the information below to complete the Add Contains Relationship
Components dialog box.

Component         Description                                                                 
Parent Design Select a parent design object from the drop-down
Object list.

Child Design Select a child design object from the drop-down
Object list.

Type Select a type from the drop-down list.

Identifying Select this check box to have the primary keys
cascade from parent to child as primary keys.  If
unchecked, keys will cascade as foreign keys.
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Categorizing Select this check box to indicate the entity on the
optional side of the association is the child in a
supertype (parent) to subtype (secondary)
association.  This distinguishes which entity is the
supertype for the secondary.

Min Type a minimum number of occurrences of the
entity for each single occurrence of the associated
entity.

Max Type a maximum number of occurrences of the
entity for each single occurrence of the associated
entity.

Purpose Type a purpose in this text box.

Reverse Click on this command button to reverse the
relationship.

More This command button is available when custom
fields have been defined using Table/Custom Fields
in the Admin Utility.
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Add Data Dependency Dialog Box

Dialog Box
Illustration

       Add Data Dependency Relationship Dialog Box

Dialog Box Use the information below to complete the Add Data Dependency
Components Relationship dialog box.

Component         Description                                                                 
Parent Design Select a parent design object from the drop-down
Object list.

Child Design Select a child design object from the drop-down
Object list.

Type Select a type from the drop-down list.

Identifying Select this checkbox to have the primary keys
cascade from parent to child as primary keys.  If
unchecked, keys will cascade as foreign keys.
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Categorizing Select this checkbox to indicate the entity on the
optional side of the association is the child in a
supertype (parent) to subtype (secondary)
association.  This distinguishes which entity is the
supertype for the secondary.

Min Type a minimum number of occurrences of the
entity for each single occurrence of the associated
entity.

Max Type a maximum number of occurrences of the
entity for each single occurrence of the associated
entity.

Allow Cascade Select this checkbox if the design object should be
Delete deleted when the last occurrence of a design object

on which it depends is deleted.  You define this for
the parent design object in the Parent area and for
the child design object in the Child area.

From Label Type the name of the owning design object.

To Label Type the name of the owned  design object.

Purpose Type a purpose in this text box.

Reverse Click on this command button to reverse the
relationship.

Keys Click on this command button to display the
Relationship Keys dialog box.

Complete the Relationship Keys dialog box and
click on OK.

More This command button is available when custom
fields have been defined using Table/Custom Fields
in the Admin Utility.
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Relationship Keys Dialog Box

Dialog Box
Illustration

                  

       Relationship Keys Dialog Box

Dialog Box Use the information below to complete the Relationship Keys dialog
Components box.

Components       Description                                                                 
Relationship Existing relationship keys are displayed in this
Keys box.

Add Highlight a parent candidate key and then a child
candidate key.  Click on the this command button
to add the relationship to the relationship keys
box.

Change Highlight a relationship in the relationship keys
box and click on the this command button to
change the relationship
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Remove Highlight a relationship in the relationship keys box
and click on the this command button to remove
the relationship.

Parent Select a parent key from the candidate list.
Candidate
Keys

Child Select a child key from the candidate list.
Candidate
Keys
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Add Is Superclass of Dialog Box

Dialog Box
Illustration

              

        Add Is Superclass of Relationship Dialog Box

Dialog Box Use the information below to complete the Add Is Superclass of
Components Relationship dialog box.

Component         Description                                                                 
Parent Design Select a parent design object from the drop-down
Object list.

Child Design Select a child design object from the drop-down
Object list.

Purpose Type a purpose in this text box.

Reverse Click on this command button to reverse the
relationship.

More This command button is available when custom
fields have been defined using Table/Custom fields
in the Admin Utility.



76

ADD DESIGN OBJECT

Adding Design Objects

Description The Add Design Object command, available from the Design
Map and Design Dictionary windows, allows you to add  a design
object to the encyclopedia.

Procedure å  To add a design object to the encyclopedia:

1 Choose Add... from the Design Object menu.

Result:  The Select Design Object Type dialog box
appears.

2 Select any type except Data Structure and click on OK.

Result:  The Add Design Object dialog box appears.

3 Complete the dialog box, then click on OK.
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Add Design Object Dialog Box

Dialog Box
Illustration

                           

                      Add Design Object Dialog Box

Dialog Box Use the information below to complete the Add Design Object
Components dialog box.

Component         Description                                                                 
Name Type a name for the design object into this

field.  You may type up to 51 alphanumeric
characters.  The @ symbol and quotation
marks (“) are not allowed.

Meta Id Type an alternate name for the design object.

Purpose Type a purpose for the design object into this
text box.

More This command button is available when custom
fields have been defined using Table/Custom Fields
in the Admin Utility.
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ADD ENTITY

Adding Entities

Description The Add Entity command, available from both the Data Map and Data
Dictionary windows, allows you to add a new entity to the
encyclopedia.

Usage Tips You may define an entity's details when you add the entity, or you may
define them at a later time. Entity details include:
o   Purpose
o   Nature
o   Category
o   Model view authority

When you add an entity, you specify in which model views it should be
visible: current view only, all views, child views, or selected views.

If you want to add an entity to the current model view that has already been
added to another model view, use the Copy From Model View command on
the Entity menu.

Procedure å  To add an entity to the current model view:

1 Choose Add... from the Entity menu.

Result: The Add Entity dialog box appears.

2 Complete the Add Entity dialog box, then click on
OK.
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Add Entity Dialog Box

Dialog Box
Illustration

                                   

                                Add Entity Dialog Box

Dialog Box Use the information below to complete the Add Entity dialog box.
Components

Component         Description                                                                 
Name Type the name of the entity into this box. An entity

name can be from 2 to 31 alphanumeric characters long,
and may include spaces.

Purpose Type the purpose of the entity in this text box. The
purpose of the entity explains its significance to the data
model and to the planning statements upon which the data
model is based.

Spell Click this button to spell check the dialog box.
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Principal Select this entity category if the entity does not
require one of the special use categories described below.
Principal entities will frequently appear in several
functional areas. This is the default value for entity
category.

Secondary Select this entity category if the entity contains data
unique to a specific subset of occurrences of an entity.

Type Select this entity category if the entity contains data
that describe the valid subsets of a principal or secondary
entity. Each of these subsets may refer directly to a
secondary entity.

Structure Select this entity category if the entity contains data
that describe the relationship between different
occurrences of another entity.

Intersecting Select this entity category if the entity records
specific combinations of related occurrences of two or
more other entities. An intersecting entity usually results
from resolving a many-to-many association between two
other entities.

Role Select this entity category if the entity will allow for
an occurrence of a principal or secondary entity to be of
multiple categories. A role entity is a special use of an
intersecting entity.

Entity View Select each model view authority checkbox (Create,
Authority Read, Update, or Delete) that applies to the entity.

Dynamic Select this entity nature if the entity's attribute values
will be user-defined. This is the default entity nature
value.

Static Select this entity nature if the user will select the
entity's attribute values from a predefined set of values.
Use the Populate Static Table command on the Entity
menu to enter the predefined values for a static entity's
attributes.
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Current View Select this button to add the entity to the current
model view only.

All Views Select this button to add the entity to all views.

Selected Views Use this button to select the model views in which
the entity should be visible.  When you click on
this button, the Select Model Views dialog box
appears.

You select model views through this dialog box in
the same way that you select entities in the Data
Dictionary window.  See Select Entities in this
manual for information on this type of dialog box.

More This command button is available if custom fields
have been defined using Table/Custom fields in the
Admin Utility.
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ADD NOTE

Adding Notes

Description The Add Note command allows you to attach notes to specific
objects in the encyclopedia.

Usage Tips The Notes command is available from all windows from the
Main/Encyclopedia Management menu.  It is also available in most
windows from the menu for the window’s principal object.

+   Example  If you are using the Data Dictionary or Data Map
window, the Notes command is located on the Entity menu; if you are
using the Planning Outline or Planning Dictionary, the Notes
command is located on the Statement menu.

Procedure å To add a note:

1 Choose Notes from the Encyclopedia menu.

Result:  The Notes dialog box appears.

2 Click on the Compose button.

Result:  The Add Note dialog box appears.

3 Complete the Add Note dialog box and click on OK.
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Add Note Dialog Box

Dialog Box
Illustration

          Add Note Dialog Box

Dialog Box Use the information below to complete the Add Note dialog box.
Components

Component         Description                                                                 
Title Type the title of the note. The title defaults to the

capitalization standards defined through the Admin
Utility Preferences/Naming command.

You may type up to 51 alphanumeric characters.
The @ symbol and quotation marks (“) are not
allowed.

Text Type the text in the large text box.
The text can be up to 32,000 alphanumeric
characters long.

Selected Use this button to attach objects.  When you
Objects click on this button, the objects already attached

appear in the Attached text box.
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User Use this button to attach a user to the note.  When
you click on this button, the Select User dialog box
appears.

Select the user you wish to attach and click on
OK.  The user you selected appears in the Attached
text box on the Add Note dialog box.

View Use this button to attach a view to the note.  When
you click on this button, the Select View dialog box
appears.

You may select View or Entire Model.  If you select
View, select the view you wish to attach.  Select
Structured or Alphabetical.  Click on OK.

Statement Use this button to attach a planning statement to the
note.  When you click on this button, the Locate
Planning Statement dialog box appears.

Select a title from the drop-down list, or type a title.
Click on OK.

Entity Use this button to attach an entity to the note.
When you click on this button, the Locate Entity
dialog box appears.

Select an entity from the drop down box, or type an
entity name.  Click on OK.

Design Object Click on this button to attach a design object to
the note.  When you click on this button, the
Locate Design Object dialog box appears.

Select a design object from the drop down list or
type a design object name.  Click on OK.

Detach Click on this button to detach an attached object.
Highlight the object you wish to detach and click
on Detach.

Spell Click this button to spell check the dialog box.
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ADD PARALLEL
CONTROL

Adding Parallel Controls

Description The Add Parallel Control command allows you to add a parallel
control to a process. A parallel control shows where unconditional
branching in the logic path of a process diverges, converges, or both. The
parallel control is the tool that allows concurrent activity within a process.

A parallel control is represented by a filled circle.

Procedure å  To add a parallel control:

1 Select the step or control mechanism from which the parallel
control originates.

2 Choose Add Parallel from the Control menu.

Result: A control flow leading from the selected step or control
mechanism to a filled circle appears.

3 You can now add the steps that occur concurrently.

To do this, select the parallel control you just added, then add the
first concurrent step. Then, select the parallel control again and add
the next concurrent step. Repeat this until you have added all
concurrent steps.

To converge the logic path of the concurrent steps, select one of
the concurrent steps, then choose Add Parallel Control from the
Control menu. You must then add a control flow from each other
concurrent step into the parallel control you just added.
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ADD PROCESS

Overview

Description The Add Process command allows you to add a business or data access
process to the process model portion of the encyclopedia.

Usage Tips When you are working in the Process Hierarchy, you may only add
business processes to the process model— data access processes may not be
added.

When you are working in the Process Map window, the dialog box for
adding the type of process currently displayed in the window appears when
you choose the Add command on the Process menu. If you want to add a
different process type from the one displayed, you must first change to a
process of the type you want to add, and then use the Add Process
command.

+   Example  A data access process is displayed in the Process Map
window and  you want to add a business process. You change to a business
process through the Process/Change To command, then choose
Process/Add.

In This This chapter contains the following topics.
Chapter

Topic                                                                                         
Adding Business Processes
Adding Data Access Processes
Add Data Access Process Dialog Box
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Adding Business Processes

Description You use the Process/Add command to add business processes. A
business process is the type of process that responds— either directly or
indirectly— to a business event.

Usage Tips After you define a business processes as being invoked by a business
event, the business process will appear underneath the invoking event in the
Process Hierarchy window. You may also view a graphic picture of each
business process through the Process Map window.

Procedure å  To add a business process to the current model view from the
Process Map window:

1 Choose Add... from the Process menu.

Result: If a business process is displayed in the active Process Map
window, the Add Business Process dialog box appears.

If a data access process is displayed, the Add Data Access Process
dialog box appears. In this case, you must return to the Process
Map window and use the Change To command on the Process
menu to display a business process in the window.

2 Type a name and purpose for the new business process, then
click on OK.

å To add a business process to the current model view from the
 Process Hierarchy window:

1 Choose Add... from the Process menu.

Result: The Add Business Process dialog box appears.

2 Type a name and purpose for the new business process, then
click on OK.
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Adding Data Access Processes

Description You add data access processes through the Process/Add command in
the Process Map window. A data access process directly accesses an entity
in the data model.

Usage Tips You may add data access processes only through the Process Map
window. When you add a data access process, you define the type of access
operation it performs on the object entity (create, read, update, or delete), as
well as the entity it accesses. The accessed entity must be visible in the
current model view.

The name of each data access process is the concatenation of the type of
access and the name of the entity that is the object of the data access process
(Create EMPLOYEE, Delete ORDER, etc.).

In addition to adding data access processes with the Process/Add command
in the Process Map window, they can also be automatically generated as
they are needed when you add process steps to a business or data access
process. When the software detects that a data access process should be
generated while you add process steps, a message will appear asking if you
want the data access process to be generated.

After a data access process is added or generated, it will appear in the
Process Hierarchy window beneath the business process that invokes it.
You may also view a graphic picture of each data access process through
the Process Map window.

Procedure å  To add a data access process  from the Process Map window:

1 Choose Add... from the Process menu.

Result: If a data access process is displayed in the active Process
Map window, the Add Data Access Process dialog box appears.

If a business process is displayed, the Add Business Process dialog
box appears. In this case, you must return to the Process Map
window and use the Change To command on the Process menu to
display a data access process in the window.

The Add Data Access Process dialog box appears.
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2 Complete the Add Data Access Process dialog box, then click on
OK
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Add Data Access Process Dialog Box

Dialog Box
Illustration

Add Data Access Process Dialog Box

Dialog Box Use the information below to complete the Add Data Access Process
Components dialog box.

Component         Description                                                                 
Operation Select the operation (create, read, update, or delete)

the data access process will perform on the entity.

Entity Select the entity the data access process will access
from this drop-down list. The list contains all entities in
the current model view.

To change the model view, use the View/Change To
command.

Purpose Type a purpose for the data access process into this
text box. The purpose may contain up to 32,000
characters.

Spell Click this button to spell check the dialog box.
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More This button is available when custom fields have
been defined using Table/Custom Fields in the
Admin Utility.
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ADD PROCESS STEP

Overview

Description The Add Process Step command allows you to add one of the 15
step types to the current process. A process step is responsible for a single
activity within the process as a contributor to its entirety. A process step is
depicted as a round-cornered box.

Usage Tips When another object in the process is selected (a step, parallel control,
or condition end, or the start mechanism), the step you add will
automatically be inserted beneath it and a control flow will be drawn from
the selected object to the new step. When no object is selected, the new
process will be placed beneath the start mechanism at the top of the process.

When you add a process step, the list of step types you may add depends on
the type of process to which you are adding the step.

+  Example  Accept steps are used only in business processes, Evaluate
steps are used only in data access processes, and Examine steps are
used in both business processes and data access processes.

The table below indicates whether a step may be used by business processes
(BP), data access processes (DAP) or both.

Step Type                          Used by
Accept BP
Choose BP
Create DAP
Delete DAP
Do BP
Do Create Both
Do Delete Both
Do Read Both
Do Update Both
Evaluate BP
Examine Both
Next Both
Present BP
Read DAP
Update DAP
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In This This chapter contains the following topics.
Chapter

Topic                                                                                         
Adding Accept Steps
Adding Choose Steps
Adding Create Steps
Adding Delete Steps
Adding Do Steps
Adding Do Create Steps
Adding Do Delete Steps
Adding Do Read Steps
Adding Do Update Steps
Adding Evaluate Steps
Adding Examine Steps
Adding Next Steps
Adding Present Steps
Adding Read Steps
Adding Update Steps
Add Process Step Dialog Box
Add Accept Step Dialog Box
Add Choose Step Dialog Box
Add Create Step Dialog Box
Add Delete Step Dialog Box
Add Do Step Dialog Box
Add Do Create Step Dialog Box
Add Do Delete Step Dialog Box
Add Do Read Step Dialog Box
Add Do Update Step Dialog Box
Add Evaluate Step Dialog Box
Add Examine Step Dialog Box
Add Next Step Dialog Box
Add Present Step Dialog Box
Add Read Step Dialog Box
Add Update Step Dialog Box
Accept List Dialog Box
Initiation List Dialog Box
Present List Dialog Boxes
Return List Dialog Box
Modified Attribute Dialog Box
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Adding Accept Steps

Description The Accept step gathers data from outside the process for use inside
the process.

Usage Tips Accept steps are used only in business process.  The Accept step
requires an Accept list, which specifies the attributes or aliases that are
being used by the step. These attributes or aliases may come from different
entities in the data model.

Procedure å  To add an Accept step to a business process:

1 Select the step or control mechanism from which you want
the Accept step to originate.

2 Choose Add.... from the Step menu.

Result: The Add Process Step dialog box appears.

3 From the Step Type list box, select Accept. If Accept is not
listed, a data access process is displayed in the Process Map
Window. Accept steps are used only in business process.

4 Click on OK.

Result: The Add Accept Step dialog box appears.

5 In the Add Accept Step dialog box , define the attributes to
include on the step's Accept list. To do this, click on the
Define button.

Result: The Accept List dialog box appears.

6 Complete the Accept List dialog box, then click on OK to
return to the Add Accept step dialog box.

7 Click on OK in the Add Accept step dialog box.
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Adding Choose Steps

Description The Choose step selects a subset of occurrences from a set identified in
a Do Read step accomplished upline in a business process.

Usage Tips Accept steps are used only in business processes.

The Present list for a Choose step may contain attributes or variables from
more than one entity in the data model. The Accept list is always a subset of
the Present list.

Procedure å  To add a Choose step to a business process:

1 Select the step or control mechanism from which you want
the Choose step to originate.

2 Choose Add.... from the Step menu.

Result: The Add Process Step dialog box  appears.

3 From the Step Type list box, select Choose. If Choose is not
listed, a data access process is displayed in the Process Map
Window. Choose steps are used only in business process.

4 Click on OK.

Result: The Add Choose Step dialog box appears.

5 In the Add Choose Step dialog box, define the attributes to
include on the step's Present list. To do this, click on the
Define button next to the Present List box.

Result: The Present List dialog box appears.

6 Complete the Present List dialog box, then click on OK to
return to the Add Choose Step dialog box.

7 In the Add Choose Step dialog box, define the attributes to
include on the step's Accept list. To do this, click on the Define
button next to the Accept list box.
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Result: The Accept List dialog box appears.

8 Complete the Accept List dialog box, then click on OK to
return to the Add Choose Step dialog box.

9 Click on OK in the Add Choose Step dialog box.
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Adding Create Steps

Description The Create step adds one or more new occurrences of an entity.

Usage Tips Create steps are used only by data access processes.
The Create and Return lists for a Create step are inherited from the Do
Create step that initiates the Create step.

Procedure å  To add a Create step to a data access process:

1 Select the step or control mechanism from which you want
the Create step to originate.

2 Choose Add.... from the Step Menu.

Result: The Add Process Step dialog box appears.

3 From the Step Type list, select Create. If Create is not listed,
a business process is displayed in the Process Map window. Create
steps are used only in data access processes.

4 Click on OK.

Result: The Add Create Step dialog box appears.

5 In the Add Create Step dialog box, define the attributes to
include on the step's Create list. To do this, click on the
Define button next to the Create List box.

Result: The Create List dialog box appears.

6 Complete the Create List dialog box, then click on OK to
return to the Add Create Step dialog box.

7 In the Add Create Step dialog box, define the attributes to
include on the step's Return list. To do this, click on the Define
button next to the Return list box.

Result: The Return List dialog box appears.

8 Complete the Return List dialog box, then click on OK to
return to the Add Create Step dialog box.
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9 Click on OK in the Add Create Step dialog box.
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Adding Delete Steps

Description The Delete step removes one or more occurrences of an entity.

Usage Tips Delete steps are used only in data access processes.

Procedure å  To add a Delete step to a data access process:

1 Select the step or control mechanism from which you want
the Delete step to originate.

2 Choose Add.... from the Step menu.

Result: The Add Process Step dialog box appears.

3 From the Step Type list, select Delete. If Delete is not listed,
a business process is displayed in the Process Map Window.

Delete steps are used only in data access processes.

4 Click on OK.

Result: The Add Delete Step dialog box appears.

5 In the Add Delete Step dialog box, define the attributes to
include on the step's Delete list. To do this, click on the
Define button next to the Delete List box.

Result: The Delete List dialog box appears.

6 Complete the Delete List dialog box, then click on OK to
return to the Add Delete Step dialog box.

7 Click on OK in the Add Delete Step dialog box.
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Adding Do Steps

Description The Do step initiates another business process, providing the link that
allows reusability of business logic.

Usage Tips Do steps are used only in business processes.

The Initiate list contains none, some, or all of the attributes on the
Invocation list of the business process being invoked by the Do step.

The Return list contains none, some, or all of the attributes on the Return
list for the business process being invoked by the Do step.

Procedure å  To add a Do step to a business process:

1 Select the step or control mechanism from which you want
the Do step to originate.

2 Choose Add.... from the Step menu.

Result: The Add Process Step dialog box appears.

3 From the Step Type list, select Do. If Do is not listed, a data
access process is displayed in the Process Map window. Do steps
are used only in business processes.

4 Click on OK.

Result: The Add Do Step dialog box appears.

5 In the Add Do Step dialog box, define the attributes to include
on the step's Initiation list. To do this, click on the Define
button next to the Initiation List box.

Result: The Initiation List dialog box appears.

6 Complete the Initiation List dialog box, then click on OK to
return to the Add Do Step dialog box.

7 In the Add Do Step dialog box, define the attributes to
include on the step's Return list. To do this, click on the Define
button next to the Return List box.
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Result: The Return List dialog box appears.

8 Complete the Return List dialog box, then click on OK to
return to the Add Do Step dialog box.

9 Click on OK in the Add Do Step dialog box.
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Adding Do Create Steps

Description The Do Create step initiates a Create data access process, providing
the link that allows reusability of the creation logic for an entity.

Usage Tips Do Create steps are used in both business and data access processes.
A Do Create step may have an Initiation list that contains some of all of the
attributes on the Create list for the Create data access process that is
invoked by the Do Create step.

A Do Create step may also have a Return list, which contains some or all of
the attributes on the Return list of the Create data access process invoked by
the Do Create step.

Procedure å  To add a Do Create step to either a business process or a data
access process:

1 Select the step or control mechanism from which you want
the Do Create step to originate.

2 Choose Add... from the Step menu.

Result: The Add Step dialog box appears.

3 From the Step Type list, select Do Create, then click on
OK.

Result: The Do Create dialog box appears.

4 In the Add Do Create Step dialog box, define the attributes to
include on the step's Initiation list. To do this, click on the
Define button next to the Initiation List box.

Result: The Initiation List dialog box appears.

5 Complete the Initiation List dialog box, then click on OK to
return to the Add Do Create Step dialog box.

6 In the Add Do Create Step dialog box, define the attributes to
include on the step's Return list. To do this, click on the Define
button next to the Return List box.
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Result: The Return List dialog box appears.

7 Complete the Return List dialog box, then click on OK to
return to the Add Do Create Step dialog box.

8 Click on OK in the Add Do Create Step dialog box.
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Adding Do Delete Steps

Description The Do Delete step initiates a Delete data access process, providing
the link that allows reusability of the deletion integrity logic for a specific
entity.

Usage Tips Do Delete steps are used in both business processes and data access
processes.

The Initiation list for a Do Delete step controls which entity occurrences to
delete. It contains some, one, or all attributes from the object entity.

Procedure å  To add a Do Delete step to either a business process or a data
access process:

1 Select the step or control mechanism from which you want
the Do Delete step to originate.

2 Choose Add... from the Step menu.

Result: The Add Step dialog box appears.

3 From the Step Type list, select Do Delete, then click on
OK.

Result: The Do Delete dialog box appears.

4 In the Add Do Delete step dialog box, define the attributes to
include on the step's Initiation list. To do this, click on the
 Define button next to the Initiation List box.

Result: The Initiation List dialog box appears.

5 Complete the Initiation List dialog box, then click on OK to
return to the Add Do Read Step dialog box.

6 Click on OK in the Add Do Create Step dialog box.
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Adding Do Read Steps

Description The Do Read step initiates a Read data access process.

Usage Tips The Do Read steps are used in both business and data access processes.
The Qualifying list for a Do Read step controls which entity occurrence to
use for the Return list. You use an expression to specify a Qualifying list,
which identifies the occurrences from which you want to read data.
Specified attributes on the Qualifying list must be from the object entity
only.

The Return list contains attributes from the object entity that are required
for downline process steps.

Procedure å  To add a Do Read step to either a business process or a data
access process:

1 Select the step or control mechanism from which you the Do
Read step to originate.

2 Choose Add... from the step menu.

Result: The Add Process step dialog box appears.

3 From the Step Type list, select Do Read, then click on
OK.

Result: The Add Do Read step dialog box appears.

4 In the Add Do Read step dialog box, define the attributes in
the Return list. To do this, click on the Define button.

Result: The Return List dialog box appears.

5 Complete the Return List dialog box, then click on OK to
return to the Add Do Read Step dialog box.

6 Click on OK in the Add Do Read Step dialog box.



106

Adding Do Update Steps

Description The Do Update step initiates an Update access process, allowing the
reusability of the update integrity logic for a specific entity.

Usage Tips Do Update steps are used for both business and data access processes.
You may provide a Qualifying list for a Do Update Step, which identifies
the entity occurrences to which the updates apply. You use an expression to
specify a qualifying list. Specified attributes must be from the object entity
only.

The Initiation list for a Do Update step contains some or all of the attributes
on the Initiation list for the Update data access process initiated by the Do
Update step.

The Return list for a Do Update step contains some or all of the attributes
on the Return list for the Update data access process initiated by the Do
Update step.

Procedure å  To add a Do Update step to either a business process or a data
access process:

1 Select the step or control mechanism from which you want
the Do Update step to originate.

2 Choose Add.... from the Step menu.

Result: The Add Process Step dialog box appears.

3 From the Step Type list, select Do Update, then click on
OK.

Result: The Add Do Update Step dialog box appears.

4 Complete the Add Do Update Step dialog box.

To define the attributes on the Initiation list, click on the Define
button next to the Initiation List box.

Result: The Initiation List dialog box appears. Complete the dialog
box, then click on OK to return to the Add Do Update Step dialog
box.
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To define the attributes on the Return list, click on the Define
button next to the Return List box.

Result: The Return List dialog box appears. Complete the dialog
box, then click on OK to return to the Add Do Update Step dialog
box.

5 Click on OK in the Add Do Update Step dialog box.
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Adding Evaluate Steps

Description The Evaluate step uses an expression as the basis for selecting from
alternative actions.

Usage Tips Evaluate steps are used only for business processes.
The object of an Evaluate step is a logical expression. All components of
the expression must have read model view authority for the operational area
you are modeling.

Procedure å  To add an Evaluate step to business process:

1 Select the step or control mechanism from which you want
the Evaluate step to originate.

2 Choose Add.... from the Step menu.

Result: The Add Process Step dialog box appears.

3 From the Step Type list, select Evaluate, then click on
OK. If Evaluate is not listed, a data access process is displayed in
the Process Map window. Evaluate steps are used only for business
process.

Result: The Add Evaluate Step dialog box appears.

4 Complete the Add Evaluate Step dialog box then click on
OK.
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Adding Examine Steps

Description The Examine step uses the value of an attribute as the basis for
selecting from alternative actions.

Usage Tips Examine steps are used only for business processes.

Procedure å  To add an Examine step to a business process:

1 Select the step or control mechanism from which you want
the Examine step to originate.

2 Choose Add.... from the Step menu.

Result: The Add Process Step dialog box appears.

3 From the Step Type list box, select Examine, then click on
OK. If Examine is not listed, a data access process is displayed in
the Process Map window. Only business processes use Examine
steps.

Result: The Add Examine Step dialog box appears.

4 Complete the Add Examine Step dialog box, then click on
 OK.
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Adding Next Steps

Description The Next step designates instance-at-a-time logic.

Usage Tips Next Steps are used by both business and data access processes.

Procedure å To add a Next step to either a business process or a data access
process.

1 Select the step or control mechanism from which you want
the Next step to originate.

2 Choose Add.... from the Step menu.

Result: The Add Process Step dialog box appears.

3 From the Step Type list, select Next, then click on OK.

Result: The Add Next Step dialog box appears.

4 Complete the Add Next Step dialog box, then click on
OK.
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Adding Present Steps

Description The Present step provides data from within the process for use outside
of the process.

Usage Tips Present steps are only used for business processes.

The Present list may contain attributes or variables of more than one entity
in the data model.

Procedure å  To add a Present step to a business process:

1 Select the step or control mechanism from which you want
the Present step to originate.

2 Choose Add.... from the Step menu.

Result: The Add Process Step dialog box appears.

3 From the Step Type list, select Present, then click on OK. If
Present is not listed, a data access process is displayed in the
Process Map window. Only business processes use Present steps.

Result: The Add Present Step dialog box appears.

4 Complete the Add Present Step dialog box.

To define the attributes in the Present list, click on the Define
button.

Result: The Present List dialog box appears. Complete the dialog
box, then click on OK to return to the Add Present list dialog box.

5 Click on OK in the Add Present list dialog box.
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Adding Read Steps

Description The Read step retrieves data from one or more occurrences of an
entity.

Usage Tips The Return list for a Read step contains all Attributes for the entity
being read. Read steps are used only by data access processes.

Procedure å  To add a Read step to a data access process:

1 Select the step or control mechanism from which you want
the Read step to originate.

2 Choose Add.... from the Step menu.

Result: The Add Process Step dialog box appears.

3 From the Step Type list, select Read, then click on OK.

If Read is not listed, a business process is displayed in the Process
Map window. Only data access processes use Read steps.

Result: The Add Read Step dialog box appears.

4 In the Add Read Step dialog box, define the attributes for the
Return list. To do this, click on the Define button.

Result: The Return List dialog box appears.

5 Complete the Return List dialog box, then click on OK to
return to the Add Read Step dialog box.

6 Click on OK in the Add Read Step dialog box.
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Adding Update Steps

Description The Update step modifies the values of one or more existing
occurrence of an entity.

Usage Tips Update steps are used only in data access processes.

The attributes on the Update list are inherited from the Do Update step that
initiated the Update step.

Procedure å  To add an Update step to a data access process:

1 Select the step or control mechanism from which you want
the Update step to originate.

2 Choose Add.... from the Step menu.

Result: The Add Process Step dialog box appears.

3 From the Step Type drop-down list, select Update, then click
on OK. If Update is not listed, a business process is displayed in
the Process Map window. Update steps are used only in data
access steps.

Result: The Add Update Step dialog box appears.

4 Select from the Entity drop-down list the entity whose occurrences
you want to update.   Type a purpose in the Purpose text box.

5 Click on OK.

.
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Add Process Step Dialog Box

Dialog Box
Illustration

3
 Add Process Step Dialog Box

Dialog Box Use the information below to complete the Add Process Step
Components dialog box.

Component         Description                                                                 
Step Type Select a step type from this list box. Depending on

the kind of process you are building (business process or
data access process), only certain types of process steps
are listed in this list box.

Refer to the beginning of the Add Process Step section for
more information.

When you select a step type and click on OK, the dialog
box for the step type you selected will appear.
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Add Accept Step Dialog Box

Dialog Box
Illustration

Add Accept Step Dialog Box

Dialog Box Use the information below to complete the Add Accept Step
Components dialog box.

Component         Description                                                                 
Accept List This list box contains attributes that are gathered

from outside of the process for its internal use. You define
this list by clicking on the Define button.

Define Use this button to define the list of attributes for the
Accept list. The Accept List dialog box appears when you
click on this button.

Purpose Type a purpose for this step in this list box. You may
type up to 32,000 characters.

Spell Click this button to spell check the dialog box.
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Add Choose Step Dialog Box

Dialog Box
Illustration

Add Choose Step Dialog Box

Dialog Box Use the information below to complete the Add Choose Step dialog
Components box.

Component         Description                                                                 
Entity Select from this drop-down list the entity whose

occurrence(s) you want to choose.

This list includes all entities within the current model
view. To change the model view, use the Change To
command on the View menu.

Present List This list box contains the attributes to be included on
the Present list for the step. You define this list by
clicking on the Define button to the right of this list box.

Define Use this button to define the attributes to include on
(next to the Present list. When you click on this button,
Present list) the Present List dialog box appears.
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Accept List This list box contains the attributes to be included on
the Accept list. This list is always a subset of the Present
list. You define this list by clicking on the Define button
to the right of this list box.

Define Use this button to define the attributes to include
(next to on the Accept list. When you click on this button,
Accept list) the Accept List dialog box appears.

Purpose Type a purpose for the step in this list box. You may
type up to 32,000 characters.

Spell Check this button to spell check the dialog box.
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Add Create Step Dialog Box

Dialog Box
Illustration

Add Create Step Dialog Box

Dialog Box Use the information below to complete the Add Create
Components Step dialog box.

Component         Description                                                   
Entity Select from this drop-down list the entity whose

occurrence(s) you want to add.

This list includes entities in the current model view. To
change the model view, use the Change To command on
the View menu.

Purpose Type a purpose for the step in this list box. You may
type up to 32,000 characters.

Spell Click this button to spell check the dialog box.
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Add Delete Step Dialog Box

Dialog Box
Illustration

       Add Delete Step Dialog Box

Dialog Box Use the information below to complete the Add Delete Step dialog
Components box.

Component         Description                                                                 
Entity Select from this drop-down list the entity whose

occurrence(s) you want to delete.

This list includes entities in the current model view. To
change the model view, use the Change To command on
the View menu.

Purpose Type a purpose for the step in this list box. You may
type up to 32,000 characters.
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Add Do Step Dialog Box

Dialog Box
Illustration

         Add Do Step Dialog Box

Dialog Box Use the information below to complete the Add Do Step dialog box.
Components

Component         Description                                                                 
Process Select from this drop-down list the business process

that you want the current process to invoke.

The drop-down list will only let you choose from the
business processes that are available in the current model
view. The Do step will only invoke other business
processes.

Initiation List This list box contains the attributes to be included on
the Initiation list for the Do business process invoked
by this Add Do step.  You define this by clicking on
the Define button.
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Define Use this button to define the attributes to include
(next to on the Initiation list.  When you click on this button,
Initiation list) The Initiation List dialog box appears.

Return List This list includes all or some of the attributes
that are on the Return list of the Do business process
that this Add Do step invokes.

Include only those attributes that are needed in
subsequent steps of the current process.  You define
these attributes through the Define button.

Define Use this button to define the attributes to include
(next to on the Return list.  When you click on this button,
Return list) the Return List dialog box appears.

Purpose Type a purpose for this step in this text box. You
may type up to 32,000 characters.

Spell Click this button to spell check the dialog box.
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Add Do Create Step Dialog Box

Dialog Box
Illustration

    Add Do Create Step Dialog Box

Dialog Box Use the information below to complete the Add Do Create Step
Components dialog box.

Component         Description                                                                 
Entity Select from this drop-down list the entity for which

the current process invokes a Create data access 
process.

This list includes all entities within the current model
view. To change the model view, use the Change To
command on the View menu.

Initiation List This list box contains the attributes to be included on
the Initiation list for the Create data access process
invoked by this Do Create step. You define this list by
clicking on the Define button.

Define Use this button to define the attributes to include
(next to on the Initiation list. When you click on this button,
Initiation list) the Initiation List dialog box appears.
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Return List This list includes all or some of the attributes that
are on the Return list of the Create data access process
that this Do Create step invokes.

Include only those attributes that are needed in subsequent
steps of the current process. You define these attributes
through the Define button.

Define Use this button to define the attributes to include
(next to on the Return list. When you click on this button,
Return list) the Return List dialog box appears.

Purpose Type a purpose for this step in this list box. You may
type up to 32,000 characters.

Spell Click this button to spell check the dialog box.
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Add Do Delete Step Dialog Box

Dialog Box
Illustration

   Add Do Delete Step Dialog Box

Dialog Box Use the information below to complete the Add Do Delete
Components Step dialog box.

Component         Description                                                                 
Entity Select from this drop-down list the entity whose

occurrence(s) you wish to delete by invoking a Delete
data access process.

This list includes all entities within the current model
view. To change the model view, use the Change To
command on the View menu.

Initiation List This list box contains the attributes to be included on
the Initiation list for the Delete data access process
invoked by this Do Delete step. You define this list by
clicking on the Define button.

Define Use this button to define the attributes to include on
the Initiation list. When you click on this button, the
Initiation List dialog box appears.
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Purpose Type a purpose for this step in this list box. You may
type up to 32,000 characters.

Spell Click this button to spell check the dialog box.
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Add Do Read Step Dialog Box

Dialog Box
Illustration

   Add Do Read Step Dialog Box

Dialog Box Use the information below to complete the Add Do Read Step dialog
Components box.

Component         Description                                                                 
Entity Select from this drop-down list the entity you want

the Read data access process invoked by this Do Read
step to read.

This list includes all entities within the current model
view. To change the model view, use the Change To
command on the Process Map's View menu.

Qualify Exp Type into this box a qualifying expression that will
determine the contents of the Qualifying list.

The Qualifying list will determine which occurrences of
the entity to read and include on the return list and will
therefore always contain some or all of the primary keys
of the entity.
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The qualifying expression is the algorithm that qualifies
certain attribute occurrences for reading. This field is not
required. Specifying no qualifying expression will result
in all attribute occurrences to be read.

Return List This list box lists all attributes to be included on the
Return list. The Return list will contain those attributes
that will be used by the current process in subsequent
steps.

If the Return list is empty, the attributes that are read by
the Read data access process will simply be checked for
the attributes' existence.

You define attributes for the Return list through the
Define button.

Define Click on this button to define the attributes to
include on the Return list. When you click on this button,
the Return List dialog box appears.

Purpose Type a purpose for this in this text box. You may
type up to 32,000 characters.

Spell Click this button to spell check the dialog box.



128

Add Do Update Step Dialog Box

Dialog Box
Illustration

Add Do Update Step Dialog Box

Dialog Box Use the information below to complete the Add Do Update Step
Components dialog box.

Component         Description                                                                 
Entity Select from this drop-down list the entity  for which

you want to invoke an Update data access process through
this Do Update step.

This drop-down list will include all entities within the
model view accessed by the current process. To change
the model view, use the Change To command on the
Process Map's View menu.

Qualify Type in this box a qualifying expression  that will
determine the contents of the Qualifying list.
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The qualifying list will determine which occurrences of
the entity to update and include on the update list. The
qualifying expression is the algorithm that qualifies
certain attribute occurrences for updates.

Initiation List This list box contains all attributes that are included
on the Initiation list. You add attributes to the Initiation
list through the Define button next to this list box.

Define Use this button to add attributes to the Initiation list.
(next to When you click on this button, the Initiation
Initiation list) List dialog box appears.

Return List This list box contains all attributes that are included
on the Return list. You add attributes to the Return list
through the Define button next to this list box.

Define Use this button to add attributes to the Return list.
(next to When you click on this button, the Return List
Return list) dialog box  appears.

Purpose Type a purpose for this step in this text box. You
may type up to 32,000 characters.

Spell Click this button to spell check the dialog box.
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Add Evaluate Step Dialog Box

Dialog Box
Illustration

Add Evaluate Step Dialog Box

Dialog Box Use the information below to complete the Add Evaluate Step dialog
Components box.

Component         Description                                                                 
Expression Type a valid expression in this dialog box. The

expression will be used to decide among several possible
actions at this point in the process.

The Evaluate step is the decision point between two sets
of logic and the expression is the algorithm by which that
decision is made.

Purpose Type a purpose for this step in this list box. You may
type up to 32,000 characters.

Spell Click this button to spell check the dialog box.
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Add Examine Step Dialog Box

Dialog Box
Illustration

   Add Examine Step Dialog Box

Dialog Box Use the information below to complete the Add Examine Step dialog
Components box.

Component         Description                                                                 
Entity Select from this drop-down list the entity that

contains the attribute whose value will be the basis for
selection among several different actions at this point in
the process.

This list includes all entities within the current model
view. To change the model view, use the Change To
command on the View menu.

Attribute Select from this drop-down list the attribute whose
value will function as a decision point between two sets of
logic in the process.

The list contains all attributes that are part of the entity
you selected from the Entity drop-down list.

Purpose Type a purpose for this step in this list box. You may
type up to 32,000 characters.

Spell Click this button to spell check the dialog box.
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Add Next Step Dialog Box

Dialog Box
Illustration

Add Next Step Dialog Box

Dialog Box Use the information below to complete the Add Next Step dialog
Components box.

Component         Description                                                                 
Entity Select from this drop-down list the entity whose

occurrence you want to specify in the Next step.

This list includes all entities within the current model
view. To change the model view, use the Change To
command on the View menu.

Purpose Type a purpose for this step in this text box. You
may type up to 32,000 characters.

Spell Click this button to spell check the dialog box.
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Add Present Step Dialog Box

Dialog Box
Illustration

        Add Present Step Dialog Box

Dialog Box Use the information below to complete the Add Present Step dialog
Components box.

Component         Description                                                                 
Present List This list box lists those attributes that are provided

by the process to outside the process. The list may contain
attributes from more than one entity. You define the
attributes by clicking the Define button.

Define Use this button to define the attributes in the Present
list. When you click on this button, the Present List dialog
box appears.

Purpose Type a purpose for this step in this list box. You may
type up to 32,000 characters.

Spell Click this button to spell check the dialog box.
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Add Read Step Dialog Box

Dialog Box
Illustration

        Add Read Step Dialog Box

Dialog Box Use the information below to complete the Add Read Step dialog box.
Components

Component         Description                                                                 
Entity Select from this drop-down list the entity whose

occurrences you want to read.

This list includes all entities within the current model
view. To change the model view, use the Change To
command on the View menu.

There may only be one read step for each entity in the
process model.

Purpose Type a purpose for this step in this list box. You may
type up to 32,000 characters.

Spell Click this button to spell check the dialog box.
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Add Update Step Dialog Box

Dialog Box
Illustration

        Add Update  Step Dialog Box

Dialog Box Use the information below to complete the Add Update Step dialog
Components box.

Component         Description                                                                 
Entity Select from this drop-down list the entity whose

occurrences you want to update.

This list includes all entities within the current model
view. To change the model view, use the Change To
command on the View menu.

There may only be one update step for each entity in the
process model.

Purpose Type a purpose for this step in this list box. You may
type up to 32,000 characters.

Spell Click this button to spell check the dialog box.
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Accept List Dialog Box

Dialog Box
Illustration

        Accept List Dialog Box

Dialog Box Use the information below to complete the Accept List dialog box.
Components

Component         Description                                                                 
Attributes The attributes selected for inclusion in various

attribute lists appear in this list box. You add attributes
from the Candidates list box to this list box through the
arrow buttons.

Use this button to move attributes from the Candidates
list box to the Attributes list box. To do this, highlight
this, highlight the attributes in the Candidates list box,
then click on this button. The selected attributes will
appear in the Attributes list box.

Use this button to remove attributes from the Attributes
list box and return them to the Candidates list box. To do
this, highlight the attributes in the Attribute list box, then
click on this button. The selected attributes will return to
the Candidates list box.
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Use this button to move all attributes in the
Candidates list box to the Attributes list box. To do
this, simply click on this button. All attributes in the
Candidates list box will then appear in the Attributes
list box.

Use this button to return all attributes in the
Attributes list box to the Candidates list box. To do
this, simply click on this button. All attributes in the
Attributes list box will return to the Candidates list box.

Entity Select an entity from this drop-down list whose
attributes you want to be displayed in the Candidates list
box.

This drop-down list will include all entities within the
model view accessed by the current process. To change
the model view, use the Change To command on the
Process Map window's View menu.

Candidates This list box contains all attributes of the selected
entity. Choose the attributes from this list that you
want to include in the Attributes list box.

Optional Use this button to define an attribute in the
Attributes list as optional for the process step.
To do this, highlight the attribute in the Attributes list,
then click on this button. Square brackets ([]) are then
placed around the attribute name in the list.

Repeating Use this button to define an attribute in the
Attributes list as repeating for the process step.
To do this, highlight the attribute in the Attributes list,
then click on this button. Braces ({}) are then placed
around the attribute name in the list.

Modified Use this button to modify the attribute through an
expression. When you click on this button, the
Modified Attribute dialog box appears.
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Variable Use this button to define a variable for an attribute.
To do this, highlight the attribute in the attributes list, then
click on this button.  When you click on this button, the
Attribute Variable dialog box appears.  Parentheses are
placed around the variable in the attribute list.

Attribute Use this button to return a variable on the Attribute
list to its original attribute state.  To do this, highlight the
variable on the Attributes list, then click on this button.
The name of the attribute for which the variable was
created appears in the Attributes list.
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Initiation List Dialog Box

Dialog Box
Illustration

Initiation List Dialog Box

Dialog Box Use the information below to complete the Initiation List dialog box.
Components

Component         Description                                                                 
Attributes The attributes selected for inclusion in various

attribute lists appear in this list box. You add attributes
from the Candidates list box to this list box through the
arrow buttons.

Use this button to move attributes from the Candidates
list box to the Attributes list box. To do this, highlight the
attributes in the Candidates list box, then click on this
button. They will then appear in the Attributes list box.

Use this button to remove attributes from the
Attributes list box and return them to the Candidates
list box. To do this, highlight the attributes in the
Attribute list box, then click on this button. They will
then return to the Candidates list box.
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Use this button to move all attributes in the
Candidates list box to the Attributes list box. To do this,
simply click on this button. All attributes in the
Candidates list box will then appear in the Attributes list
box.

Use this button to return all attributes in the
Attributes list box to the Candidates list box. To do this,
simply click on this button. All attributes in the Attributes
list box will return to the Candidates list box.

Candidates This list box contains all attributes of the object
entity. Choose the attributes from this list that you want to
include in the Attributes list box.

Optional Use this button to define an attribute in the
Attributes list as optional for the process step.
To do this, highlight the attribute in the Attributes list,
then click on this button. Square brackets ([]) are then
placed around the attribute name in the list.

Repeating Use this button to define an attribute in the
Attributes list as repeating for the process step.
To do this, highlight the attribute in the Attributes list,
then click on this button. Braces ({}) are then placed
around the attribute name in the list.

Modified Use this button to modify the attribute through an
expression. When you click on this button, the
Modified Attribute dialog box appears.

Variable Use this button to define a variable for the attribute.
To do this, highlight the attribute in the Attributes list,
then click on this button.  When you click on this button,
the Attribute Variable dialog box appears.  Parentheses
are placed around the variable in the attribute list.

Attribute Use this button to return a variable on the Attribute
list to its original attribute state.  To do this, highlight the
variable on the Attribute list, then click on this button.
The name of the attribute for which the variable was
created appears in the Attributes list.
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Present List Dialog Boxes

Dialog Box
Illustration
(Choose Steps)

Present List Dialog Box (Choose Steps)

Dialog Box This dialog box is identical to the Accept List dialog box.
Components
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Dialog Box
Illustration
(Present Steps)

Present List Dialog Box (Present Steps)

Dialog Box This dialog box is identical to the Accept List dialog box.
Components
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Return List Dialog Box

Dialog Box
Illustration

         Return List Dialog Box

Dialog Box This dialog box is identical to the Initiation List dialog box.
Components
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Modified Attribute Dialog Box

Dialog Box
Illustration

    Modified Attribute Dialog Box

Dialog Box Use the information below to complete the Modified Attribute
Components dialog box.

Component         Description                                                                 
Attribute The name of the attribute you highlighted in the

previous dialog box appears in this box.

Expression Type a valid expression into this box. The expression
will be used to modify the attribute's value for the process
step.
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 ADD SESSION

Adding Sessions

Description The Add Session command allows you to add a session to the
model.  The Add Session command is available from all windows.

Usage Tips When you add a session, you specify its title and type.  In addition,
you can add notes about the session.

Procedure å To add a session:

1 Choose New from the Sessions menu.

Result:  The Add Session dialog box appears.

2 Complete the Add Session dialog box and
click on OK.

Result:  The session is added to the model.
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Add Session Dialog Box

Dialog Box
Illustration

Add Session Dialog Box

Dialog Box Use the information below to complete the Add Session dialog box.
Components

Component         Description                                                                 
Title Type the title of the session.  The title defaults to the

capitalization standards defined through the Admin
Utility Preferences/Naming command.

You may type up to 51 alphanumeric characters.
The @ symbol and quotation marks (“) are not
allowed.

Type Select a session type from the drop-down list.

Notes Type the notes of the session in the large text box.
The text can be up to 32,000 alphanumeric
characters long.



147

More This command button is available if custom fields
have been defined using Table/Custom Fields in the
Admin Utility.

Spell Click this button to spell check the dialog box.
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ADD STATEMENT

Adding Planning Statements

Description The Add Statement command allows you to add a planning
statement to the current model view.  It is available from the
Planning Outline, Planning Dictionary, Planning Dictionary,
Statement-View Matrix, Statement-Statement Matrix, and
Statement-Data Matrix windows.

Usage Tips When you add a statement, you specify its title, type, and text. For
more extensive editing capabilities, such as search and replace and character
formatting, use the Statement Editor window to add and edit statements.
You access the Statement Editor window through the Statement Editor
command on the Statement menu.

Statement types are for classification purposes only and have no processing
effect on the encyclopedia. Visible Advantage is shipped with several
predefined statement types. You may define additional statement types
through the Table command on the main Visible Advantage Admin Utility
window.

If you want a statement to add the statement to the entire model, use the
Copy To Model View command on the Statement menu.

If you want to add a statement to the current model view that has already
been added to another model view, use the Copy From Model View
command on the Statement menu.

Procedure å  To add a planning statement to the current model view in the
Planning Outline or Planning Dictionary window:

1 Choose Add... from the Statement menu.

Result: The Add Planning Statement dialog box appears.

2 Complete the Add Planning Statement dialog box and
click on OK.

Result: The statement is added appears in the active window.
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Add Planning Statement Dialog Box

Dialog Box
Illustration

                       

     Add Planning Statement Dialog Box

Dialog Box Use the information below to complete the Add Planning Statement
Components dialog box.

Component         Description                                                                 
Title Type a title for the planning statement into this

box.  The title defaults  to the capitalization
standards defined through the Visible Advantage
Admin Utility Preferences/Naming command.

You may type up to 51 alphanumeric characters.
The @ symbol and quotation marks (“) are not
allowed.

Type Select a type for the statement from the drop-down
list.  The list includes the standard statement types,
as well as any that have been defined through the
Visible Advantage Admin Utility Table command.



150

Text Type the text of the planning statement in the large
text box.  The text can be up to 32,000 alphanumeric
characters long.

See your Windows documentation for more
information on editing extended text in Windows
applications.

Current View Select this button to add the statement to the
current view only.

All Views Select this button to add the statement to all views.

Selected Views Use this button to select the views in which the
statement should be visible.  When you click on
this button, the Select Model Views dialog box
appears.

You select views through this dialog box in the
same way that you select statements in the
Planning Dictionary window.  See Select
Statements in this manual for information on
this type of dialog box.
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ADD STOP CONTROL

Adding Stop Controls

Description The Add Stop command adds a stop control to a process. A stop
control shows where a branch of the logic in a process ends. It also shows
the completion state for that branch.

A stop control assigned a successful completion state is displayed as double
horizontal bars. A failed completion state is displayed as a single horizontal
bar.

Usage Tips Since processes may consist of several logical paths, several stop
controls within one process are possible. Stop controls are always at the
end of a control flow.

Use this command to end a logical path of a process, assign a completion
state to it, and declare it a success or failure. Each process has at least one
stop control.

Procedure å  To add a stop control:

1 Select the step before which you want to place the stop
control.

2 Choose Add Stop... from the Control menu.

Result: The Add Stop Control dialog box appears.

3 Complete the Add Stop Control dialog box, then click on
OK.
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Add Stop Control Dialog Box

Dialog Box
Illustration

             Add Stop Control Dialog Box

Dialog Box Use the information below to complete the Add Stop Control dialog
Components box.

Component         Description                                                                 
Condition Choose a condition for the stop control from this

drop-down list.

This list includes all completion values defined for the
encyclopedia. You may define a new completion value
for the stop control  by typing a new name in this field. A
message will then ask if you want to add the new
completion value.

If you click on Yes, the Completion Values dialog box
appears, allowing you to add the completion value to the
completion table. See Completion Table in this manual
for dialog box component descriptions.

Success Select this button if you want to define the
completion value as a success. This completion value will
then default to success when it is used in other logical
paths in this process. However, you may use the value
differently in other processes within the process model.
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Failure Select this button if you want to define the
completion value as a failure. The value will then default
to failure when it is used in other logical paths in this
process. However, you may use the value differently in
other processes.
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ADD STORAGE

Adding Storage Access Mechanisms

Description The Add Storage Access Mechanism command, available from the
Design Map and Design Dictionary windows, allows you to add a storage
access mechanism to the encyclopedia for use within a database design.

Usage Tips This command adds storage access mechanisms only. If you want to
add a standard access mechanism (hashing, index, or storage) for the current
data structure, use the Add command on the Access menu.

You may add several types of storage access mechanisms through this
command. The types you can add depend on those defined for the current
data structure manager through the Visible Admin Table Data Structure
Managers command.

Procedure å  To add a storage access mechanism for a data item to the
current design object:

1 In the Design Dictionary's Data Items field, highlight the
data item for which you want to add a storage access mechanism.

2 Choose Add Storage... from the Access menu.

Result: The Add Storage Access Mechanism dialog box appears.

3 Select the type of storage access mechanism you want to add,
then click on OK.

The dialog box includes the storage access mechanism types
defined for the current data structure manager. Storage access
mechanism types can include cluster, view, direct, indexed
random, indexed sequential, inverted access, sequential, and
system controlled.

Result: The dialog box appears for the type of access mechanism
you selected.

4 Complete the dialog box, then click on OK.
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Add Cluster Access Mechanism Dialog Box

Dialog Box
Illustration

                   

Add Cluster Access Mechanism Dialog Box

Dialog Box Use the information below to complete the Add Cluster Access
Components Mechanism dialog box.

Component         Description                                                                 
Name Type the name of the cluster access mechanism into

this field. You may type up to 51 alphanumeric
characters. The @ symbol and quotation marks (“) are not
allowed.

Design Objects The name of the current design object appears in
this field. You can add other design objects to the cluster
through the Edit List button next to this list box (see
below).

Edit List Use this button to edit the list of design objects
(design in the Design Objects list box above. When you
objects) click on this button, the Select Design Objects dialog
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box appears. See Select Design Objects in this manual for
information on this dialog box.

Data Items The data item you selected before you chose the Add
Storage Access command appears in this list. You may
add more data items to the list by using the Edit List
command button (see below).

Edit List Use this button to edit the data items on the Data
(data items) Items list above. When you click on this button, the

Select Data Items dialog box appears. The Select Data
Items dialog box allows you to select the data items that
belong to the current data structure.

You select data items through this dialog box in the same
way that you select data structures in the Select Data
Structures dialog box. See Select Data Structures in this
manual for more information on using this type of dialog
box.

Purpose Type a purpose for the cluster access mechanism in
this text box.

Current View Select this button to add the cluster access
mechanism to the current view only.

All Design Select this button to add the cluster access
Object Views mechanism to all design object views.
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Add Database View Access
Mechanism Dialog Box

Dialog Box
Illustration

                

   Add Database View Access Mechanism Dialog Box

Dialog Box Use the information below to complete the Add Database View Access
Components Mechanism dialog box.

Component         Description                                                                 
Name Type the name of the view access mechanism into

this field. You may type up to 51 alphanumeric
characters. The @ symbol and quotation marks (“) are not
allowed.
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Design Objects The name of the current design object appears in
this field. You can add other design objects to this list
through the Edit List button next to this list box (see
below).

Edit List Use this button to edit the list of design objects in
(design the Design Objects list box above. When you click
objects) on this button, the Select Design Objects dialog box

appears. See Select Design Objects in this manual for
information on this dialog box.

Data Items The data item you selected before you chose the Add
Storage Access command appears in this list. You may
add more data items to the list by using the Edit List
command button (see below).

Edit List Use this button to edit the data items on the Data
(data items) Items list above. When you click on this button, the

Select Data Items dialog box appears. The Select Data
Items dialog box allows you to select the data items that
belong to the current data structure.

You select data items through this dialog box in the same
way that you select data structures in the Select Design
Objects dialog box. See Select Design Objects in this
manual for more information on using this type of dialog
box.

Expression Type an expression that qualifies the data items to be
included in the view access mechanism into this text box.
See the Appendices section of this manual for information
on using expressions.

Purpose Type a purpose for the view access mechanism in
this text box.

Current View Select this button to add the database access
Only mechanism to the current view only.

All Design Select this button to add the database access
Object Views mechanism to all design object views.
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Add System Controlled Access
Mechanism Dialog Box

Dialog Box
Illustration

                

Add System Controlled Access Mechanism Dialog Box

Dialog Box Use the information below to complete the Add System Controlled
Components Access Mechanism dialog box.

Component         Description                                                                 
Data Items The data item you selected before you chose the Add

Storage Access command appears in this list. You may
add more data items to the list by using the Edit List
command button (see below).

Edit List Use this button to edit the data items on the Data
Items list above. When you click on this button, the
Access Mechanism Components dialog box appears. The
Access Mechanisms Components dialog box allows you
to select the data items that belong to the current data
structure.

You select data items through this dialog box in the same
way that you select data structures in the Select Data
Structures dialog box. See Select Data Structures in this
manual for more information on using this type of dialog
box.
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Purpose Type a purpose for the system controlled access
mechanism in this text box.

Current View Select this button to add the system controlled access
Only mechanism to the current view only.

All Design Select this button to add the system controlled access
Object Views mechanism to all design object views.
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ADD USER

Adding Users

Description The Add User command, available through the Visible Advantage
Admin Utility, allows a system administrator to add an authorized user
to the current encyclopedia.

Procedure å  To add an authorized user to the encyclopedia:

1 Choose Add... from the User command menu.

Result: The Add User dialog box appears.

2 Complete the Add User dialog box, then click on
OK.

Repeat the above procedure for each new user you want to add to
the encyclopedia.
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Add User Dialog Box

Dialog Box
Illustration

Add User Dialog Box

Dialog Box Use the information below to complete the Add User dialog box.
Components

Component         Description                                                                 
Logon Type a Logon for the new user in this box.

The Logon can be from 1 to 15 alphanumeric characters
long and may include spaces. This is a required field.

As a security measure, each user is required to type a
valid logon each time the user opens the encyclopedia.

Password Type a password for the user in this box. The
password can be from 1 to 11 alphanumeric characters
long and may include spaces.

A password provides an additional level of security in
tracking, since it helps prevent different users from
accessing the encyclopedia with the same logon.
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The password is optional at this stage, but one may be
added or changed later with the Change Password
command on the Project menu.

If a password is defined here for user, the user must
supply it with a logon when the user opens the
encyclopedia. If a password is not defined here for a user,
it is not needed when the user opens the encyclopedia.

Name Type the name of the user in this box. The name can
be up to 30 alphabetic characters long and may include
spaces.

Group Select the name of the user group to which you want
to assign the user. This is a required field.

You define user groups through the Group/Add command
on the Visible Advantage Admin Utility
main menu.

System If you want the new user to have system
Administrator administrator privileges, select this box. System

administrators may perform commands on the Visible
Advantage Admin Utility menu.

Power User If you want the new user to have standard user
privileges plus the ability to add domains, functions,
and diagram filters.

Standard User If you do not want the new user to have system
administrator privileges, select this button. Standard users
may access and modify the encyclopedia, but may not
perform system administration commands.

Read Only If you want the new user to have read only privileges,
select this button.  Read only users may view, but not
change, edit dialog boxes.

Active Select this button to activate the new user in the
encyclopedia.
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Active status allows a user to access the encyclopedia
according to the users designated privileges (system
administrator or standard user).

Inactive When you want to remove a user from the
encyclopedia, any system administrator can enter
this dialog box and select this button.

Inactive status prevents a user from accessing the
encyclopedia, but does not remove the user from
encyclopedia documentation (user, session, and history
log reports).
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ADD USER GROUP

Adding User Groups

Description The Add User Group command, available from the Visible Advantage
Admin Utility, allows a system administrator to add a user group to the
encyclopedia. User groups allow the system administrator to assign specific
privileges to groups of users and track these groups to the sessions in which
they participated.

Procedure å  To add a user group to the encyclopedia:

1 Choose Add... from the Group command menu.

Result: The Add User Group dialog box appears.

2 Complete the Add User Group dialog box and
click on OK.



166

Add User Group Dialog Box

Dialog Box
Illustration

                  

      Add User Group Dialog Box

Dialog Box Use the information below to complete the Add User Group
Components dialog box.

Component         Description                                                                 
Name Type the name of the user group.

Purpose Type the purpose for the user group.
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ADD VALID WORD

Adding Valid Words

Description The Valid Words command allows you to add words to the standard
words dictionary.

Usage Tips The Valid Words command is available from all windows except
Generate SQL Schema.

Procedure å  To add valid words to the standard words dictionary:

1 Choose Standard Words Dictionary from the Encyclopedia
menu.

Result:  The Valid Words Dictionary dialog box appears.

2 Click on the Add button.

Result:  The Add Valid Word dialog box appears.

3 Complete the Add Valid Word dialog box and click on OK.

Result:  The Valid Words Dictionary dialog box reappears
with the word you added displayed in the large text box.
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Add Valid Words Dictionary
Dialog Box

Dialog Box
Illustration

 
                                               Add Valid Word Dialog Box

Dialog Box Use the information below to complete the Add Valid Word dialog
Components box.

Component         Description                                                                 
Word Type the word you wish to add to the standard words

dictionary.

Abbreviation Type an abbreviation that may be used for the word.
This field is optional; you may leave it blank.

Definition Type a definition for the word.  This field is
optional; you may leave it blank.

Change Select this button to change the abbreviation for
the data structure manager highlighted.
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When you select this button, the Design
Abbreviation dialog box appears.  Complete the
dialog box and click on OK.

Apply to All Select this button to apply the abbreviation to all
data structure managers.
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Design Abbreviation
Dialog Box

Dialog Box
Illustration

Design Abbreviation Dialog Box

Dialog Box Use the information below to complete the Design Abbreviation
Components dialog box.

Component         Description                                                                 
Abbreviation Type the abbreviation to be used for the data

structure manager shown in the Data Struct Mgr
field.



171

ADD VIEW

Adding Views

Description The Add View command allows you to add a new view to the
encyclopedia.

Usage Tips This command is available from all windows except the main Visible
Advantage window, the Session and Statement Editor windows, and the
Database Design windows.

When you add a view, you specify its type, purpose, and business level
(strategic, tactical, or operational). The default view type is Functional
Area.

A new view is added to the structured view hierarchy below the current
view. You may move a view to a new location in the view hierarchy
through the Move command on the View Hierarchy window's View menu.

Procedure å  To add a view:

1 Choose Add... from the View menu.

Result: The Add View dialog box appears.

2 Complete the Add View dialog box, then click on
OK.
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Add View Dialog Box

Dialog Box
Illustration

                              

            Add View Dialog Box

Dialog Box Use the information below to complete the Add View dialog
Components box.

Component         Description                                                                 
Name Type the name of the new model view in this box.

The name of the model view can be from 2 to 51
alphanumeric characters long.

Purpose Type the purpose of the model view in this scrolled
text box. The purpose of the model view explains its
business significance to the encyclopedia. You may type
up to 32,000 alphanumeric characters.

Model View Select this button to add as a model view.

Design View Select this button to add as a design view.
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Type Select a model view type from this drop-down list.
This list includes the default model view types, along with
any model view types added through the Visible
Advantage Utility Table View Types command.

Business Level Select a business level from this drop-down list.
Business level refers to the scope represented by the
model view (strategic, tactical, or operational).

Data Struct Select a data structure manager from this drop-down
Mgr list.

Subset View Select this check box to create a subset view.

More This command button is available when custom
fields have been defined using Table/Custom
Fields in the Admin Utility.
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ARRANGE ICONS

Arranging Icons on the Workspace

Description The Arrange Icons command places all icons (minimized Visible
Advantage windows) at the bottom of the workspace. The command is
useful when icons have become obscured by open windows or other icons.

Usage Tips This command is available on all windows except the main Visible
Advantage window.

Procedure å  To arrange the icons on your workspace:

Choose Arrange Icons from the Window menu.

Result: Any icons will appear in a row at the bottom of the workspace.
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ATTRIBUTE MODE

Design Reference in Attribute Mode

Description The Attribute Mode command displays the Design Reference
window by attribute, rather than by data structure, data item, or entity.

Usage Tips The four modes available in the Design Reference window— design
object, data item, entity, and attribute— allow you to reference the
information in a design based on that object.  Each mode displays the mode
object at the top of the window and all of its referenced objects or details
underneath it.

Procedure å  To run the Design Reference window in Attribute mode:

       ä Choose Attribute from the Mode menu.

Result:  A checkmark appears beside the command name
and the Design Reference window redisplays in Attribute
mode.

2  Note  If you are in either Design Object or Data Item
mode, the Select Model View dialog box appears.  Select the
model view, then continue as above.
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ATTRIBUTE-VIEW MATRIX

About the Attribute-View Matrix Window

Description The Attribute-View Matrix window allows you to view the model
views in which each attribute is visible.  You can also add attributes to and
remove them from model views through this window.  This command is
available from all windows.

Procedure å  To open an Attribute-View Matrix window:

1 Choose Attribute-View Matrix... from the Data menu on
the main Visible Advantage window.

From any other window, choose Data Modeling from the
main menu, then choose Attribute-View Matrix... from the
cascading menu.

Result:  The Attribute-Model View Matrix dialog box
appears.

2 Complete the Attribute-Model View Matrix dialog box
and click on OK.
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Attribute-Model View Matrix
Dialog Box

Dialog Box
Illustration

                    

             Attribute-Model View Matrix Dialog Box

Dialog Box Use the information below to complete the Attribute-Model View
Components Matrix dialog box.

Components       Description                                                                 
All Model Select this button to display model
View Types views of all types on the top axis.

Selected Model Select this button to display selected
View Types model view types, then click on

Select Types.  The Model View Types
dialog box appears.  Select the model
view types you want to display, then
click on OK.

Entire Model Select this button to display attributes
in the entire model.

Single Model Select this button to display attributes
View in one model view, then select the

model from the drop-down list.
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BOLD

Making Text Bold in a
Text Editor Window

Description The Bold command applies bold formatting to selected statement or
session text in the Statement Editor window.

Procedure å  To make statement or session text bold:

1 In the active Text Editor window, select the text you
want to make bold.

2 Choose Style from the Format menu.

3 Choose Bold from the cascading menu for the Style
command.

Result: The selected text appears bold in the Text Editor
window.

å To remove bold formatting from selected text:

1 In the active Text Editor window, select the text from which
you want to remove bold formatting.

2 Choose Style from the Format menu.

3 Choose Normal from the cascading menu for the Style
command.

Result: The selected text appears normal in the active Text
Editor window.
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CASCADE

Cascading Open Windows

Description The Cascade command arranges all open Visible Advantage
windows on the workspace so that their title bars are visible. See your
Windows documentation for more information on arranging windows on
the workspace. This command is available from all windows except the
main Visible Advantage window.

Procedure å  To cascade all open Visible Advantage windows:

Choose Cascade from the Window menu.

Result: The open windows are rearranged in a cascaded formation on the
workspace.
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CHANGE ATTRIBUTE

Changing Attributes

Description The Change Attribute command, available from both the Data Map
and Data Dictionary windows, allows you to change the type of the current
use of an attribute. Attribute types include primary key, foreign key, or non-
key attribute.

Usage Tips You may use this command to change:
o  A primary key to a non-key attribute, if the primary key is used in
     only one entity
o  A primary key to a foreign key, if there is at least one other use of
     the key as a primary key
o  A foreign key to a primary key
o  A non-key attribute to a primary key

All other attribute type changes violate data modeling rules and therefore
will generate an error message.

This command is available for multiple selected entities in the Data Map
window. See the User's Guide for instructions on selecting multiple entities
in the Data Map window.

In the Data Dictionary window, you may use this command to change
attributes for the currently displayed entity only.

Procedure å To change the type of an attribute from the Data Map window:

1 Select the entity or entities that contain the attribute you want
to change.

Result: The selected entities will be highlighted in the Data
Map window.

2 Choose Change... from the Attribute menu.

Result: The Select Attribute dialog box appears.

3 Select the attribute you want to change from the list box.

Result: The Change Attribute dialog box appears.



181

4 Select the attribute type to which you want to change
the attribute. This selection defaults to the attribute's current
type.

If an attribute type is not available for the current attribute
type, the type will be dimmed (see Usage Tips, above).

5 Click on OK.

Result: If you selected multiple entities, the Select Attribute 
dialog box reappears. (Repeat steps 3-4 for each selected
entity.)

Otherwise, the Data Map window reappears.

å  To change the type of one of the attributes displayed in the Data
Dictionary window:

1 Highlight the name of the attribute you want to change.

2 Choose Change... from the Attribute menu.

Result: The Change Attribute dialog box appears.

3 Select the attribute type to which you want to change
the attribute. This selection defaults to the attribute's current
type.

If an attribute type is not available for the current attribute
type, the type will be dimmed (see Usage Tips, above).

4 Click on OK.



182

CHANGE PASSWORD

Changing Passwords

Description The Change Password command, available from the main Visible
Advantage window, allows you to change the password or name of the user
currently logged onto the encyclopedia.

Usage Tips Passwords are case-sensitive (`abc' is different from `ABC'). Be sure
to note the case of your password when you type it into the Change
Password dialog box.

Procedure å To change your password:

1 Log onto the encyclopedia for which you want to change
your password.

2 Choose Change Password... from the Encyclopedia menu
from the main Visible Advantage window.

Result: The Change Password dialog box appears.

3 Type your new password into the Password box. Be sure to
note the case of your password, since it is case-sensitive.

4 If you want to change the name under which your logon and
password are listed, type a new name into the Name box.
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CHANGE TO DESIGN VIEW

Changing to Another Design View

Description The Change To Design  View command, available from both the
Design Dictionary, Design Map, and Design Reference windows, allows
you to change the design view currently displayed in the Design Dictionary
or Design Reference window.

Usage Tips Use this command when you want to display in the active window the
design objects contained in a different database design.

Procedure å To change the design view displayed in the active window:

1 Choose Change To...  from the View menu.

Result: The Select Design View dialog box appears.

2 Complete the dialog box, then click on OK.

Result:  The view you selected displays in the
active window.
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CHANGE TO MODEL VIEW

Changing to Another Model View

Description The Change To Model View command allows you to change the
model view displayed in the active window. A model view is a subset view
of the entire encyclopedia.

Usage Tips Use this command to change to the entire model, which contains all
objects in the encyclopedia, or to change to a model view added to the
encyclopedia through the Add command on any View menu.

Procedure å To change to another model view:

1 Choose Change To... from the View menu.

Result: The Select Model View dialog box appears.

2 Complete the dialog box, then click on OK.

Result: The objects in the model view you selected will
display in the active window.
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Select Model View Dialog Box

Dialog Box 
Illustration

                        

                     Select Model View Dialog Box

Dialog Box Use the information below to complete the Select Model View
Components dialog box.

Component         Description                                                                 
View Click on this button if you want to display a model

view that has been created for the encyclopedia.

Entire Model Click on this button if you want to display the entire
encyclopedia in the active window.

View Select the model view you want to open by 
highlighting its name in this list box.

This list includes all model views that have been 
created for the encyclopedia. If you selected
Entire Model in the Select area, the view list will be
dimmed.

Structured Click on this button if you want the list of model
views in the model view list box to be displayed in
hierarchical order.
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Alphabetical Click on this button if you want the list of model
views in the model view list box to be displayed in
alphabetical order.
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CHANGE TO PROCESS

Changing to Another Process

Description The Change To Process command, available from the Process Map
window, allows you to change the process displayed in the Process Map
window.  You may also add a new data access or business process through
this command.

Procedure å To display a different process in the Process Map window:

1 Choose Change To... from the Process menu.

Result: The Select Process dialog box appears.

2 If you want to change to a business process, select the
Business Process button. The Process list box will display all
business processes in the process model.

If you want to change to a data access process, select the Data
Access Process button. The Process list box will display all
data access processes in the process model.

3 Highlight the business or data access process you want to
display, then click on OK.

åTo add a new business or data access process through the Change To
Process command:

1 Choose Change To... from the Process menu.

Result: The Select Process dialog box appears.

2  If you want to add a business process, select the Business
Process button. The Process list box will display all business 
processes within the current model view.

If you want to add a data access process, select the Data
Access Process button. The Process list box will display all

 data access processes within the current model view.
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3 Click on the New button.

Result: If business processes were displayed in the Select
Process dialog box, the Add Business Process dialog box
appears.

If data access processes were displayed in the Select Process
dialog box, the Add Data Access Process dialog box appears.

4 Complete the Add Business Process or Add Data Access
Process dialog box, then click on OK.

For information on the dialog boxes, see Add Process in this
manual.
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Select Process Dialog Box

Dialog Box
Illustration

   Select Process Dialog Box

Dialog Box Use the information below to complete the Select Process dialog box.
Components

Component         Description                                                                 
Process All business or data access processes in the process

model are displayed in this list box.

Business Select this button to display business processes
Process in the Processes list.

You may then select a business process from the list or
add a business process with the New button.

Data Access Select this button to display data access processes
Process in the Processes list.

You may then select a data access process from the
list or add a data access process with the New 
button.
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New Use this button to add a new business or data access
process to the current model view.

If business processes are displayed in the Select Process
dialog box, the Add Business Process dialog box appears
when you click on this button.

If data access processes are displayed in the Select
Process dialog box, the Add Data Access Process dialog
box appears when you click on this button.
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CHECK-IN/MERGE
ENCYCLOPEDIA

Checking-in/Merging Copied Encyclopedias

Description The Check-in/Merge command, a part of the Visible Utilities
program, allows you to:
o    Merge two separately developed encyclopedias, including reverse

engineered encyclopedias.
q  Check-in (merge) a checked-out portion of an encyclopedia back

into the original encyclopedia.
 
 Visible Advantage will automatically determine which of these two
functions to perform based on the Encyclopedias selected for Check-
in/merge.

 
 Usage Tips The Check-in/Merge command is part of the Visible Advantage Utility

program that comes with Visible Advantage. To use Check-in/Merge, click
on the Visible Advantage Utility icon inside the Visible Advantage program
group.  The Check-in/Merge command is under the Copy/Merge menu.

 
 When you use the Check-in/Merge command to check-in a previously
checked-out encyclopedia, the checked-out objects are automatically
unfrozen in the encyclopedia from which they came.
 
 Check-in/Merge uses two encyclopedias, referred to as the Primary and the
Secondary encyclopedias.  It is important to note that the Secondary
Encyclopedia will be merged into the Primary Encyclopedia, permanently
altering the Primary Encyclopedia.  See the warning below about backups.
 
 The Check-in/Merge command generates the Merge Encyclopedia report,
which describes the merged objects in detail.
 

 Warning! Always back up both encyclopedias before performing a merge. An
 encyclopedia merge is a large and complex process, and it may produce
results that you were not expecting. Therefore it is always wise to have
backup copies so you can return to the two unmerged encyclopedias if
necessary.
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 Procedure å  To merge two encyclopedias:
 

 1 Choose Check-in/Merge from the Copy/Merge menu on the
Utilities program.

 
 Result: The Merge Encyclopedias dialog box appears.
 

2 Select a primary encyclopedia by clicking on the Select>>
button by the Primary field.  The Select Primary Encyclopedia
dialog box appears.

Select the encyclopedia you want to merge from the
Encyclopedias list box This is the primary
encyclopedia. If the encyclopedia is not listed, navigate
through the directories in the Path list box until it appears.
 

 3 Click on OK.
 

 Result: The Visible Advantage Logon dialog box appears.
 
 4 Type your logon for the encyclopedia and, if necessary, a

 password, then click on OK.
 
 If you typed a valid logon and password, the Merge Encyclopedias
dialog box reappears with the name of the
 primary encyclopedia displayed.

 
 Otherwise, an error message appears and you must return to the
logon dialog box to type a different logon (and password, if
necessary).
 

5 Select a secondary encyclopedia by clicking on the Select>>
button.  The Select Secondary Encyclopedia dialog box
appears.

 From the Encyclopedias list box, select the encyclopedia you
 want to merge with the primary encyclopedia. This is the
secondary encyclopedia.

 
 If the encyclopedia is not listed, navigate through the directories in
the Path list box until it appears.
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 6 Type your logon for the encyclopedia and, if necessary, a
 password, then click on OK.
 
 Result:  If you typed a valid logon and password, the Merge
Encyclopedias dialog box reappears with the name of the
 secondary encyclopedia displayed.

 
 Otherwise, an error message appears and you must return to the
logon dialog box to type a different logon (and password, if
necessary).

 
7 Complete the remaining portion of the  Merge Encyclopedias

dialog box and click on OK.

Result:  The Copy/Check-out dialog box appears.

8 Complete the Copy/Check-out dialog box and click on OK.

Result:  The Report Destination dialog box appears.

9 Complete the Report Destination dialog box and click on OK.

If there are domain conflicts, you will be prompted to select
whether to use the primary or secondary encyclopedia.

Result:  The encyclopedias are merged and a report generated.

If you selected Printer, the report is sent to the printer.

If you selected Screen, the report is displayed on the screen.

If you selected File, the report is printed to the file name you
specified.
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 Notes on Check-in/Merge Types

 
 Check-In Only objects that were checked-out to the secondary will be
 Secondary updated or deleted in the primary encyclopedia.

o  Objects deleted in Secondary will be deleted from primary.
o  All details about checked out objects will be replaced with the

information in the secondary encyclopedia.
o  Objects added to secondary are added to Primary.  If an object with the

same name is added to both encyclopedias, the details about the object
in the Primary encyclopedia will take precedence.  In this case,
relationships, associations and links to this “twice-added” object will
only be added to the primary in instances where they do not conflict
with existing relationships, associations and links in the primary.

Merge Objects in the secondary that do not have a matching name in the
Separate Primary will be added to the Primary. Objects that have the same name
Secondary will be combined based on the options you select.  If Design views are

merged, design objects are combined or kept separate, based on user
selection.

q  Combine. This is useful if two parts of a whole model are in.
different encyclopedias and need to be integrated.  An example of
this would be when the work of different individuals on different
parts of a systems design were done in separate encyclopedias.
The resulting encyclopedia would represent the combined work of
the different individuals.

q  Keep Separate. This is useful if a system that is different from those
systems that are already in the model is being merged in.  If you do not
wish the new system (represented by the design view(s) being merged
in) to share any objects (Data Structures, Data Items, Access
Mechanisms, Relationships, etc.) with the Design Objects in the
existing primary encyclopedia, this is the correct options to choose.

For example, this would be used if a legacy system were reverse
engineered  to be merged in the enterprise encyclopedia; and
although there were object names in common with the new
systems already in the enterprise encyclopedia, they represent
different objects that happen to have the same name.  The Keep
Separate option will ensure that they remain as separate objects
that share the same name, but different descriptions, data types,
lengths, etc.
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If Keep Separate is selected, the user must enter a meta id to
differentiate it from the other object(s) that share the same name.
For a detailed description of the function of meta ids, see the
Reference Manual.

In addition, you must select one of the following options:
ä Use meta id for all objects
ä Only use meta id for conflicting object names
ä Auto-rename
ä Use Prefix [5 character prefix]
ä Use Suffix [5 character suffix]

Merge Replace This feature is primarily intended to handle systems that have been
forward engineered in Visible Advantage and that have since been turned
over to a systems development groups that changed the design.
Because the changes made by the development team are not reflected in
Visible Advantage, the database is reverse engineered and is now about to
be merged in.

If the design is just merged and combined, any items that were deleted or
moved in the actual database will still be in their original locations.  If the
design is deleted in the primary prior to merge with the intent that the
information be replaced by the reverse engineered design, the links to the
logical model will be lost.

Merge Replace addresses this problem by making the resulting design
represent the actual database and preserving all of the logical links for the
objects that have not changed in the design. The primary distinction of
Merge Replace is that it applies only to design views with matching names
and data structure managers and will delete objects that are in the primary
design view that are not in the secondary design view.

When Merge encounters an object whose name has been changed in the
secondary encyclopedia, it reports both the old and new names
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Merge Encyclopedias Dialog Box

Dialog Box
Illustration

Merge Encyclopedias Dialog Box

Dialog Box Use the information below to complete the Merge Encyclopedia
Components dialog box.

Component         Description                                                                 
Primary Click this button to select the primary
Select encyclopedia.

Secondary Click this button to select the secondary
Select encyclopedia.

Ask for Select this button to be prompted which Admin table
Admin Table data to use to resolve conflicts.
Conflicts
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Combine Select this button to combine purposes.

Use Primary Select this button if you want to use the data from the
primary (original) encyclopedia to resolve general
conflicts.

An example of such a conflict is if an object with the
same name exists in both the primary and secondary
encyclopedias.

Use Select this button if you want to use the data from
Secondary the secondary encyclopedia to resolve conflicts.

Keep Select this button to keep design objects separate.
Separate When you select this button, the meta id and

autorename options become available.

Combine Select this button to combine design objects,

Use Meta Select this button to use the meta id for
Id for Con- conflicting object names.  When you select this
flicting Object button, the meta id field becomes available.
Names

Meta Id Type the meta id.

Autorename Select this button to automatically rename
for Conflicting conflicting object names.  When you select this
Object Names button, the prefix and suffix fields become available.

Use Prefix Select this button to use a prefix of up to five
characters.  Type the prefix in the field.

Use Suffix Select this button to use a suffix of up to five
characters.  Type the suffix in the field.

Replace Click this button to preserve the logical links for
Merge (Design objects that have not changed in the design.  Objects
View) that are in the primary design view but not in the

secondary will be deleted.
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CHECK-OUT/COPY

Checking-out and
Copying Encyclopedias

Description The Check-out/Copy command, a part of the Visible Advantage Utility
program, copies all or part of an encyclopedia to another drive or directory.
This allows you to transport the encyclopedia to another computer where
other users may view, report, export, or make off-line changes to it.

Check-out/Copy allows you to see, but not modify, objects in the new
subset encyclopedia (also known as Copy).  It also allows you to modify
objects in the subset encyclopedia if they are checked out to that subset
encyclopedia, enabling change controls on those objects (also known as
Check-out).

Usage Tips The Check-out/Copy command is part of the Visible Advantage Utility
program that comes with Visible Advantage. To use the Check-out/Copy
function, click on the Visible Advantage Utility icon  inside the Visible
Advantage program group.  The Check-out/Copy command is under
Copy/Merge menu.

When you use this command to check out all or part of an encyclopedia, the
checked out objects are automatically frozen in the encyclopedia from
which they came.  Objects that are copied out in the subset encyclopedia but
not checked-out are frozen in the subset encyclopedia.   Freezing objects
prevents users from modifying them while other users are accessing them
on another computer.  The general rule is that at any time, only one copy of
any object is unfrozen and available for update.

The Check-out/Copy command generates the Copy Encyclopedia report,
which describes the copied objects in detail.

Warning! The Check-out/Copy command is in no way similar to a DOS copy
command; it will not produce an exact duplicate of a file. Rather, the
Check-out command creates a separate subset of an encyclopedia so that
multiple users can work simultaneously on the different objects from the
same encyclopedia.

The checked out subset encyclopedia must always be merged back into the
original encyclopedia.  Therefore, do not use the Check-out command with
a checked out encyclopedia.
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If you want to make an exact duplicate of the entire encyclopedia, make
copies of all the files in the encyclopedia directory using File Manager,
Windows Explorer, or DOS.

Procedure å  To check out all or part of an encyclopedia to another drive or
directory:

1 Choose Check-out /Copy from the Copy/Merge menu of the
Utilities program.

Result: The Select Primary Encyclopedia dialog box appears.

2 Select from the Encyclopedias list box the encyclopedia you
want to copy. If the encyclopedia is not listed, navigate through the
directories in the Path list box until it appears.

3 Click on OK.

Result: The Visible Advantage Logon dialog box appears.

4 Type your logon for the encyclopedia and, if necessary, a
password.  Click on OK.

Result:  If you typed a valid logon and password, the Copy/Check-
out Encyclopedia dialog box appears.  Otherwise, an error message
appears and you must return to the logon dialog box to type a
different logon.

5 Complete the Copy/Check-out Encyclopedia dialog box, then click
on OK.

Result: The New Encyclopedia dialog box appears.

6 Complete the New Encyclopedia dialog box, then click
on OK.

Result:  The Report Destination dialog box appears.

7 Complete the Report Destination dialog box and click on OK to
check-out/copy the encyclopedia.
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Copy/Check-out Encyclopedia Dialog Box

Dialog Box
Illustration

            Copy/Check-out Encyclopedia Dialog Box

Dialog Box Use the information below to complete the Copy/Check-out
Components Encyclopedia dialog box.

Component         Description                                                                 
Selected Select this button if you want to copy only
Model views.  This button will be dimmed if there are
Views no views defined for the encyclopedia.  If you

select this button, you must select views through
the Select Views button (see below).

Select Views Use this button to select model views to copy to
the target encyclopedia.  This button is available
only if you selected the Selected Views button
(see above).

When you click on this button, the Select Views dialog
box appears.  The Select Views dialog box allows you to
select model views from a list of candidates.

Objects in Copy views will be copied to the new view in
read only (frozen) model unless those objects are also in
the Check-out views.  Objects in the copy view(s) are
intended to be used for reference/viewing purposes in the
new subset encyclopedia and will not be changed in the
new subset encyclopedia.
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Select Use this button to select model views to Check-out
Check-out objects to the target encyclopedia.
Views

When you click on this button, the Select Views dialog
box appears.  The Select Views dialog box allows you to
select model views from a list of candidates.

Objects in Check-out views will be copied to the new
view in write-capable (unfrozen) mode.  Objects in the
Check-out view(s) are intended to be modified and
updated in the new subset encyclopedia.  Objects in these
views will be frozen in the primary encyclopedia (the one
the objects are being checked-out from).  The object will
remain frozen in the primary encyclopedia until the
checked-out encyclopedia is checked-in using the Check-
in/Merge command.

Entire Select this button to copy the entire encyclopedia to
Encyclopedia the target encyclopedia, including all views defined for it.
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 COMPLETION TABLE

Creating a Completion Table

Description The Completion Table command, available from the Process Map
window, allows you to add completion values to the process model. A
completion value is assigned to each stop mechanism within a process.

Usage Tips If, when adding a stop mechanism, you specify a completion value that
is not included in the completion table, Visible Advantage will ask if you
want to add the value to your table of values. In this way, the completion
table can also be built while you build your processes.

The completion values you add through this command will be available for
all processes in the encyclopedia. However, the result for each completion
value (success or failure) may be different for each process in which it is
used.

Procedure å To add, change, and delete values in the completion table:

1 Choose Completion Table... from the Process menu.

Result: The Completion Values dialog box appears.

2 To add a value to the list, type the value into the Value box,
then click on Add.  The new value will then appear in the list
box below.

To edit a value, click on the value you want to edit so that it
appears in the Value box. Edit the value in the Value box,
then click on Change.

To delete a value, click on the value you want to edit so that it
appears in the Value box, then click on Delete.

3 When you are finished adding, editing, and deleting values,
click on OK.
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Completion Values Dialog Box

Dialog Box 
Illustration

Completion Values Dialog Box

Dialog Box Use the information below to complete the Completion Values
Components dialog box.

Component         Description                                                                 
Value The name of the completion value you are adding,

changing, or deleting. You make a value appear in this
box by clicking on it in the list box below it or by typing
in a new value.

Add Click on this button to add a value to the completion
table. To do this, type a value into the Value box, then
click on this button.

Change Click on this button to change a value in the
completion table. To do this, click on the value you want
to change so that it appears in the Value box. You may
then edit the value and click on this button.

When you change a value used in any process, every
occurrence of it will be updated.
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Delete Click on this button to delete a value in the
completion table.

To do this, click on the value you want to delete so that it
appears in the Value box, then click on this button. This
button is not available when a variable used in a process
is highlighted.

Show Unused Select this checkbox if you want to display only
Variables Only unused variables in the list box. Used variables may

not be deleted.
.
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CLOSE ALL

Closing All Windows

Description The Close All Windows command closes all open Visible Advantage
windows and displays the main Visible Advantage window.   This
command is available on all windows except the main Visible Advantage
window.

Procedure å To close all open Visible Advantage windows:

Choose Close All from the Window menu.

Result: All open windows close and the main Visible Advantage
window displays.
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CLOSE SESSION

Closing Sessions

Description The Close Session command, available from the main Visible
Advantage window, allows you to deactivate the current session.

Usage Tips A closed session may not be selected for association with encyclopedia
modifications through the Select Session command. Any closed session
may be reopened through the Reopen Session command.

Procedure å To close the current session:

1 Choose Sessions from the Encyclopedia menu on the main
Visible Advantage window.
or
Choose Encyclopedia Management from the main menu on
any other window.

2 Choose Close... from the cascading menu that appears.

Result: The Close Session dialog box appears. The name of 
the current session appears in the dialog box.

3 Click on OK.

The session is closed and the Select Session dialog box
appears.

4 If you want to select an existing open session for subsequent
encyclopedia modifications, select a session from the Session

  list box, then click on OK.

Result: The main Visible Advantage window redisplays.

If you want to create a new session for subsequent 
encyclopedia modifications, click on New in the Select
Session dialog box.

Result: The Add Session dialog box appears.
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5 Complete the Add Session dialog box (see New Session for
descriptions of dialog box components), then click on OK.
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CLOSE WINDOW

Closing the Active Window

Description The Close Window command closes the active window. This
command is available on all windows except the main Visible
Advantage window.

Procedure å  To close the active window:

Choose Close Window from the main menu.

Result: The active window closes.
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COMBINE DESIGN
 OBJECT

Combining Two Design Objects

Description The Combine design object command, available from the Design
Dictionary and Design Map windows, allows you to combine the data items
from another design object with the current design object.

Usage Tips When you use this command, the data items of the design object you
choose to combine with the current design object are moved to the current
design object.

Procedure å To combine another design object's data items with the
current design object:

1 From a Design Dictionary window, display the design object
with which you want to combine another design object.

From a Design Map window, select the design object with
which you want to combine another design object.

2 Choose Combine... from the Design Object menu.

Result: The Combine Design Objects dialog box appears.

3 Complete the Combine Design Objects dialog box, then click
on OK.
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Combine Design Objects Dialog Box

Dialog Box 
Illustration

Combine Design Objects Dialog Box

Dialog Box Use the information below to complete the Combine Design
Components Objects dialog box.

Component         Description                                                                 
Destination The name of the current or selected design object

displayed. You cannot change the entry in this
field.

Source Select from this drop-down list the name of the data
structure whose data items you want to combine with
the destination design object. The list includes all
design objects in the current database design.
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Properties The properties for the source design object appear
in this list box. These properties will be combined
with the properties for the source design object after
this command is completed.

You may edit the properties to be combined by using
the Combine, Split, and Remove buttons (see
below).

Combine Use this button to combine properties from the
Properties list.

Remove Use this button to remove properties from the
Properties list (see above).

Split Use this button to split properties from the
Properties list.
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COMPARE
 ENCYCLOPEDIA

Comparing Encyclopedias

Description The Compare command, a part of the Visible Advantage Utility program,
allows you to compare the data in two encyclopedias. You should use this
command before you merge two encyclopedias with the Copy/Merge
command.

Usage Tips The Compare command is part of the Visible Advantage Utility program
that comes with Visible Advantage. To use the Compare function, click on
the Visible Advantage Utility icon inside the Visible Advantage program
group.  The Compare command is under the Copy/Merge menu.

The Compare command generates a Compare Encyclopedia report,
detailing the differences between the two encyclopedias.

Procedure å  To compare two encyclopedias:

1 Choose Compare from the Copy/Merge menu.

Result: The Select Primary Encyclopedia dialog box appears.

2 Select the first encyclopedia you want to compare from the
Encyclopedias list box. This will be the primary
encyclopedia.

If the encyclopedia is not listed, navigate through the directories in
the Path list box until it appears.

3 Click on OK.

Result: The Visible Advantage Logon dialog box appears.

4 Type your logon for the encyclopedia and, if necessary, a
password, then click on OK.

If you entered a valid logon and password, the Compare
Encyclopedia dialog box appears.
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Otherwise, an error message appears and you must return to the
logon dialog box to type a different logon.

5 Click on Select at the secondary field.

Result:  The Select Secondary Encyclopedia dialog box.
appears.

6 Select the second encyclopedia you want to compare from the
Encyclopedias list box, then click on OK. This will be the
secondary encyclopedia.

If the encyclopedia is not listed, navigate through the directories in
the Path list box until it appears.

Result:  The Save As dialog box appears.

7 Complete the dialog box and click on OK.
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Compare Encyclopedias Dialog Box

Dialog Box
Illustration

Compare Encyclopedias Dialog Box

Dialog Box Use the Information below to complete the Compare Encyclopedias
Components dialog box.

Component         Description                                                                 
Primary Click this button to select the primary encyclopedia.
Select The default primary encyclopedia is the encyclopedia

you selected at the Select Primary Encyclopedia
dialog box.

Secondary Click this button to select the secondary
Select encyclopedia.

Report Select this button to report differences in matched
Differences in objects only.
Matched
Objects Only

Report All Select this button to report all differences.
Differences
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COMPLETION TABLE

Creating a Completion Table

Description The Completion Table command, available from the Process Map
window, allows you to add completion values to the process model.  A
completion value is assigned to each stop mechanism within a process.

Usage Tips If, when adding a stop mechanism, you specify a completion value that
is not included in the completion table, Visible Advantage will ask if you
want to add the value to your table of values.  In this way, the completion
table can also be built while you build your processes.

The completion values you add through this command will be available for
all processes in the encyclopedia.  However, the result for each completion
value (success or failure) may be different for each process in which it is
used.

Procedure å  To add, change, and delete values in the completion table:

1 Choose Completion Table…  from the Process menu.

Result:  The Completion Values dialog box appears.

2 To add a value to the list, type the value into the Value field,
then click on Add.  The new value will then appear in the list box
below.

To edit a value, click on the value you want to edit so that it
appears in the Value field.  Edit the value in the Value field,
then click on Change.

To delete a value, click on the value you want to edit so that it
appears in the Value field, then click on Delete.

3 When you are finished adding, editing, and deleting values,
click on OK.
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Completion Values Dialog Box

Dialog Box
Illustration

Completion Values Dialog Box

Dialog Box Use the information below to complete the Completion Values dialog
Components box.

Component         Description                                                                 
Value The name of the completion value you are adding,

changing, or deleting.  You make a value appear in
this box by clicking on it in the list box below it or by
typing in a new value.

Add Click on this button to add a value to the completion
table.  To do this, type a value into the Value field,
then click on this button.

Change Click on this button to change a value in the
completion table.  To do this, click on the value you
want to change so that it appears in the Value field.  You
may then edit the value and click on this button.

Delete Click on this button to delete a value in the
completion table.  To do this, click on the value you
want to delete so that it appears in the Value field,
 then click on this button.  This button is not available
when a variable used in a process is highlighted.
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Show Unused Select this checkbox if you want to display only
Variables Only unused variables in the list box.  Used variables may

not be deleted.
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CONTROL ENTITY

Defining Entity Control Links

Description The Control Entity command, available from both the Data Map and
Data Dictionary windows, allows you to define a controlled entity for
an entity.

Use this command to specify the secondary entities that are controlled by a
type entity. You may also use this command to show which entities a rule
entity controls.

Usage Tips You may display entity control links in the Data Map and Data
Dictionary windows through the Display/Options command. In the Data
Map window, the links appear as dotted arrows pointing from the
controlling entity to the controlled entity. In the Data Dictionary window,
the links appear in the Controls  and Controlled by fields.

To remove a controlling link, use the Uncontrol command on the Entity
menu.

This command is available for multiple selected entities in both the Data
Map and Data Dictionary windows. See the User's Guide for information on
selecting multiple entities in these windows.

Procedure å To define a controlled entity for each selected entity in the Data
 Map or Data Dictionary window:

1 Choose Control... from the Entity menu.

Result: The Control Entity dialog box appears for the first
selected entity.

2 Complete the Control Entity dialog box, then click on OK.

Result: If more than one entity is selected, the Control Entity
dialog box for the next selected entity appears. (Repeat the
previous step until you have defined control links for each selected
entity.)

If only one entity is selected, then the active window reappears.



219

Control Entity Dialog Box

Dialog Box 
Illustration

               

          Control Entity Dialog Box

Dialog Box Use the information below to complete the Control Entity dialog box.
Components

Component         Description                                                                 
Entity The name of the currently selected entity appears
(upper box) in this box.

Controls If you are defining a controlled entity for the
entity in the upper Entity box, select this button.

Is Controlled If you are defining a controlling entity for the entity
By in the upper Entity box, select this button.

Entity Select a controlled or controlling entity from this
(lower box) drop-down list. This list includes all entities in the

current model view.
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CONVERT

Converting IE: Advantage 6.1
Encyclopedias

Description Encyclopedias created using IE: Advantage 6.1 can be converted to
Version 7 format by using the Convert program.

The Convert program is executed by clicking on the Convert icon in the
Visible Advantage program group.  To properly perform a convert, you
must know the complete directory path/location of the IE: Advantage 6.1
encyclopedia you want to convert.

2 Note If you have IE: Advantage 6.0 encyclopedias, they must first be
converted to 6.1.

The Convert program will run two utilities on the 6.1 encyclopedia before
converting:  Keybuild and Scrub.  These will ensure the internal consistency
of your encyclopedia information prior to converting.  You must provide a
new directory name (up to 8 characters) for the Version 7 encyclopedia in
addition to the complete directory path/location of the IE: Advantage 6.1
encyclopedia.

2 Note Visible Advantage 7.x should be installed before converting any
encyclopedias.  If you have the client-server version of IE: Advantage 6.1,
you should unmount and back up your 6.1 format encyclopedias as
described in the client-server installation instructions.

Procedure å  To use the Convert program to convert an encyclopedia created in
IE: Advantage 6.1 into an encyclopedia that can be used by Version 7:

1 Verify that all Visible Advantage programs are not running.

2 Click on the Convert icon in the Visible Advantage program
group.

3 When prompted, enter the complete directory path for the IE:
Advantage 6.1 encyclopedia (for example, C:\iea614\xyz).

4 When prompted, accept the default directory where you installed
Visible Advantage (C:\iea70), or change to the directory you used.
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5 When prompted, enter the new directory name for the Version 7
encyclopedia (for example, new7xyz).

2 Note  This must be a new directory that does not currently
exist.

Result:  When the program finishes executing, the new directory
will contain an encyclopedia in Version 7 format with the
information from the IE: Advantage 6.1encyclopedia.  The
encyclopedia in the 6.1 directory has not been harmed and may
still be used with IE: Advantage 6.1x.  Using the example above,
the information in the 6.1 encyclopedia in C:\iea614\xyz is
converted to a new Version 7 encyclopedia in the directory
C:\iea70/new7xyz.

6 If you are using the client-server version of Visible Advantage,
mount the encyclopedia by choosing Encyclopedia from the
Visible Admin Utility menu, then select Mount from the menu.
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COPY ACCESS MECHANISM
FROM DESIGN VIEW

Copying Access Mechanisms
From Design Views

Description The Copy Access Mechanism from Design View command, available
from the Design Map and Design Dictionary windows, allows you to
copy an access mechanism from the design view.

Procedure å  To copy an access mechanism from a design view:

1 In the Design Map window, highlight the design object from
which you wish to copy an access mechanism.

From the Design Dictionary window, display the design
object.

2 Choose Copy Access Mechanism from Design View from
the Access menu.

Result:  The Copy Access Mechanism from View dialog
box appears.

3 Select the access mechanism you wish to copy, then click on
OK.
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COPY ACCESS MECHANISM
TO DESIGN VIEW

Copying Access Mechanisms to
Design Views

Description The Copy Access Mechanism to Design View command, available
from the Design Map and Design Dictionary windows, allows you to
copy the selected access mechanism to a design view.

Procedure å  To copy an access mechanism to a design view:

1 In the Design Map window, highlight the access mechanism
you wish to copy to a design view.

In the Design Dictionary window, display the design object
that contains the access mechanism you wish to copy.

2 Choose Copy to Design View from the Access menu.

Result:  The Copy Access Mechanism to Design View
dialog box appears.

3 Select the design view you wish to copy the access
Mechanism to, then click on OK.
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COPY ATTRIBUTE
FROM DESIGN

Copying Attributes from Design

Description The Copy Attribute From Design command, available from both the
Data Map and Data Dictionary windows, allows you to copy a data item in
a design  object as an attribute for the currently selected entity when using a
reverse engineering approach to Information Engineering.

Usage Tips From the Data Map window, you should only have one entity selected
when you choose this command, since it is not available for multiple
selected entities.

Procedure å  To copy a data item as an attribute for the currently selected
entity:

1 Choose Copy From Design... from the Attribute menu.

Result: The Copy Attribute From dialog box appears.

2 Complete the dialog box and click on OK.
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Copy Attribute From Database
Design Dialog Box

Dialog Box
Illustration

                         

             Copy Attribute From Design Dialog Box

Dialog Box Use the information below to complete the Copy Attribute From
Components Design dialog box.

Component         Description                                                                 
Design  Select the name of the design view in which
View the design object is located from this list. This list

includes all design views defined for the
encyclopedia.

Design Object Select the name of the design object that contains
the data item you want to copy into the data model from
this drop-down list. This list includes all design objects
within the design view you selected above.

Data Items All data items for the selected design object appear
in this list box. Highlight the name of the data item you
want to transfer as an attribute for the current entity.
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To select multiple data items, hold down the CTRL key
and click on each data item you want to transfer.

Expand Click on this checkbox to expand abbreviated names.
Abbreviated
Names
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COPY ATTRIBUTE
 FROM MODEL VIEW

Copying Attributes from Model Views

Description The Copy Attribute from Model View command, available from the
Data Dictionary window, allows you to copy attributes available in the
entire model for the selected entity but not available in this model
view.

Procedure å  To copy attributes from model view:

1 Display the entity that contains the attribute you wish to copy.

2 Choose Copy From Model View from the Attribute menu.

Result:  The Copy Attribute from Model View dialog box
appears.

3 Complete the dialog box, then click on OK.
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Copy Attribute From Model View
Dialog Box

Dialog Box
Illustration

            Copy Attribute from Model View Dialog Box

Dialog Box Use the information below to complete the Copy Attribute from
Components Model View dialog box.

Component         Description                                                                 
Attribute Select the attribute you wish to copy.

Model View Click the checkboxes for the view authorities you
Authority wish to select.
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COPY ATTRIBUTE
 TO DESIGN

Copying Attributes to Design

Description The Copy Attribute To Design command, available from both the Data
Map and Data Dictionary windows, allows you to copy an Attribute into a
design object as a data item.

Usage Tips This command is available for multiple selected entities in the Data
Map window. See the User's Guide for information on selecting multiple
entities in these windows. In the Data Dictionary window,
this command is available for the current entity only.

Procedure å To copy an attribute to a database design as a data item:

1 Choose Copy To Design... from the Attribute menu.

Result: The Copy Attribute To Design Object dialog box
appears.

2 Complete the Copy Attribute to Design Object dialog box and
click OK.
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Copy Attribute To Design
Object Dialog Box

Dialog Box
Illustration

      Copy Attribute to Design Object Dialog Box

Dialog Box Use the information below to complete the Copy Attribute to Design
Components Object dialog box.

Component         Description                                                                 
Design View Select the design view in which the destination

design object is located from the Design View
drop-down list.

Design Object Select the destination design object from the
drop-down list .  The list includes all design
objects within the selected design view.

Abbreviate Click on this checkbox to abbreviate names.
Names

Attribute Click on the radio button for the attribute
Aliases alias use you wish to select.
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COPY DESIGN OBJECT FROM
DATA MODEL

Copying Design Objects from Entities

Description The Copy Design Object From Data Model command, available from
the Design Dictionary and Design Map windows, allows you to copy an
entity from the data model into the current database design as a design
object.

Procedure å To copy an entity from the data model into the current
design view:

1 Choose Copy From Data Model... from the Design Object
 menu.

Result: The Copy Entity to Design dialog box
appears.

2 Complete the Copy Entity to Design dialog box,
then click on OK.
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Copy Entity to Design Dialog Box

Dialog Box
Illustration

       Copy Entity to Design Dialog Box

Dialog Box Use the information below to complete the Copy Entity to Design
Components dialog box.

Component         Description                                                                 
Entity Select from this drop-down list the entity you want to

copy into the current database design as a data structure.
The list includes all entities in the data model.
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Design After you select an entity, its name appears in this
Object field.  This will be the name of the design object.

You may edit the name, if necessary.

Edit Use this button to edit the details for the new design
object. When you click on this button, the Edit
Data Structure dialog box appears. See Add Data
Structure for information on this dialog box.

Data Items When you select an entity from the Entity list, its
attributes appear in this list as the new design object’s
data items.

Edit Use this button to edit the details for one of the
data items on the list. To do this, select the data item
you want to edit, then click on this button.

When you click on this button, the Edit Data Item dialog
box appears. See Add Data Item in this manual for
information on these dialog box fields.

Remove Use this button to remove a data item from the list
so it will not be added to the new design object. To do
this, select the data item you want to remove, then click
on this button.

Access Mech When you select an entity, its access mechanisms
appear in this list as the new design object’s access
mechanisms.

Remove Use this button to remove an access mechanism from
the list so it will not be added to the new design
object.  To do this, select the access mechanism you
want to remove, then click on this button.

Relationships When you select an entity, its associations appear
in this list as the new design object’s relationships.

Remove Use this button to remove a relationship from the list
so it will not be added to the new design object.  To
do this, select the relationship you want to remove,
then click on this button.
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Use Aliases Click this button to allow the use of aliases.

Abbreviate Click this button to abbreviate names.
Names
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COPY DESIGN OBJECT FROM
DESIGN VIEW

Copying Design Objects

Description The Copy Design Object From Design view command, available
from the Design Dictionary and Design Map windows, allows you to copy a
design object from another defined design view into the current design
view.

Procedure å  To copy a design object from another design view:

1 Choose Copy From Design View... from the Design Object
menu.

Result: The Copy Design Object From Design view
dialog box appears.

2 Select from the Design View list the design view
from which you want to copy the design object.

Result: The design objects in the selected design view
appear in the Design Objects list box.

3 Select the design object you want to copy, then click on
OK.
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COPY DESIGN OBJECT TO
 DATA MODEL

Copying Design Objects to
the Data Model

Description The Copy Design Object to Data Model command, available from the
Design Dictionary and Design Map windows, allows you to copy the
current or selected design objects to a model view in the data model as
entities.

Usage Tips This command is available for multiple selected design objects in the
Design Dictionary window. Use the Select Design Objects command to
select multiple design objects.

If an entity with the same name as a design object to be copied exists in the
destination model view, you will be prompted to rename the entity when it
is copied.

Procedure å  To copy the current or selected design objects to a model view
as entities:

1 Choose Copy To Data Model... from the Design Object
menu.

Result: The Copy Design Objects to Data Model dialog
box appears.

2 Select the Model View from the drop down list.

3 If you want to copy the design objects in batch mode,
select the Batch Mode button.  If you want to show each
entity, select the Show Each Entity button.

4 Select Create Associations to create associations.

5 Select Expand Abbreviated Names to display full names.

6 Click on OK.
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Copy Design Objects to Data Model

Dialog Box
Illustration

                             

                         Copy Design Objects to Data Model Dialog Box

Dialog Box Use the information below to complete the Copy Design Objects to
Components Data Model dialog box.

Component         Description                                                                 
Design Objects The name of the current or selected design object is

displayed here.

Model View Select a model view from the drop down list.

Batch Mode Select this button to copy in batch mode.

Show Each Select this button to show each entity.
Entity

Create Select this checkbox to create associations.
Associations

Expand Select this checkbox to expand abbreviated
Abbreviated names.
Names
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COPY DESIGN OBJECT TO
 DESIGN VIEW

Copying Design Object to
Design View

Description The Copy Design Object To Design View command, available from the
Design Dictionary and Design map windows, allows you to copy the
current or selected design objects to another design view.

Usage Tips This command is available for multiple selected design objects in the
Design Dictionary window. See Select Design objects in this manual for
information on selecting multiple design objects.

Procedure å To copy the current or selected design objects to another design
view:

1 Choose Copy To Design View... from the Design Object
menu.

Result: The Copy Design Object To View dialog box appears.

2 The names of the design objects to be copied appear in the
Design Objects field, and the names of the design views 
added to the encyclopedia appear in the Design View list
box.

Select the design view to which you want to copy the design
objects, then click on OK.
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 COPY ENTITY
 FROM DESIGN

Copying Entities From Design

Description The Copy Entity From Design command, available from the Data Map
and Data Dictionary windows, allows you to copy a design object in a
database design into the current model view as an entity when using a
reverse engineering approach to Information Engineering.

Usage Tips When copying multiple data structures into a model view, it is easier
to open the Design Dictionary window, select all data structures you want to
copy to the data model, and then use the Copy To Data Model command.
Through the Data Map and Data Dictionary windows, you can only copy
one data structure at a time into the data model.

Procedure å  To copy a design object  into the current model view as an
entity:

1 Choose Copy From Design... from the Entity menu.

Result: The Copy Design Object to Data Model dialog
box appears.

2 Complete the dialog box and click on OK.
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Copy Design Object to Data Model Dialog Box

Dialog Box
Illustration

                         

           Copy Design Object to Data Model Dialog Box

Dialog Box Use the information below to complete the Copy Design Object to
Components Data Model dialog box.

Component         Description                                                                 
Design Select the name of the design view in which
View the design object is located from this list. This list

includes all design views defined for the encyclopedia.

Design Select the name of the design object you want
Object to copy into the data model from this drop-down list.

This list includes all design objects within the design view
you selected above.
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Entity The name of the design object you selected appears
in this box. This will be the name of the new entity copied
from the design object.

If you want to change the name of the new entity, type a
new name over the existing entry.

Edit Click on this button if you want to edit the details for
the new entity. The Edit Entity dialog box appears (see
Edit Entity in this manual for information on dialog box
fields).

Attributes All data items for the selected design object appear
in this list. Unless you remove them from this list (see
Remove, below), they will be transferred into the data
model as attributes for the new entity.

Edit Use this button to edit the details for an attribute that
will be transferred to the data model. To do this, highlight
the name of the attribute, then click on this button. The
Edit Attribute dialog box for the attribute appears (see
Edit Attribute in this manual for information on dialog
box fields).

Remove Use this button to prevent one of the items on the list
from being transferred into the data model. To do this,
highlight the attribute name, then click on this button.

Associations All the associations for the selected design object
appear in this list.  Unless you remove them from this list
(see below), they will be transferred into the data model
as associations for the new entity.

Edit Click on this button if you want to edit the details
for the new association.  The Edit Association dialog
box appears (see Edit Association in this manual for
information on dialog box fields).

Remove Use this button to prevent one of the items on the
list from being transferred into the data model.  To
do this, highlight the association name, then click on
this button.
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COPY ENTITY
 FROM MODEL VIEW

Copying Entities From
Another Model View

Description The Copy From Model View command, available from the Data Map
and Data Dictionary windows, allows you to copy an entity from another
model view to the current model view.

Usage Tips Use this command when you want an entity in another model view to
be included in the current model view. Since the entire encyclopedia
contains all entities in the encyclopedia, the Copy From Model View
command is not available when the entire encyclopedia is displayed.

You have added an entity to a model view, and now you want that entity to
appear in the current model view. You use the Copy From Model View
command to copy the entity to the current model view.

You may also add entities to and remove them from model views through
the Entity-View Matrix window. See the User's Guide for more information
on using this window.

Procedure å To copy an entity to the current model view from another
model view:

1 Choose  Copy From Model View... from the Entity menu.

Result: The Copy Entity From Model View dialog box
appears.

2 Complete the Copy Entity From Model View dialog box, then
click on OK.
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Copy Entity From Model View
Dialog Box

Dialog Box
Illustration

                      

          Copy Entity From Model View Dialog Box

Dialog Box Use the information below to complete the Copy Entity From
Components Model View dialog box.

Component         Description                                                                 
Entity Select an entity from this drop-down list. This list

includes all entities not visible in the current model
view.

Model View Select the checkbox for each model view authority
Authority (Create, Read, Update, and/or Delete) the copied

entity should have in the current model view.

An entity's model view authority indicates the
modification or viewing authority given to a model view
in which an entity is visible.
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COPY ENTITY
 TO DESIGN

Copying Entities to Design

Description The Copy Entity To Design command, available from the Data Map
and Data Dictionary windows, allows you to copy an entity into a design as
a design object.

Usage Tips This command is available for multiple selected entities in both the
Data Map and Data Dictionary windows. See the User's Guide for
information on selecting multiple entities in these windows.

Procedure å  To copy selected entities to a design view:

1 Choose Copy To Design... from the Entity menu.

Result:  The Transfer Entities to Design dialog box
appears.

2 Complete the Transfer Entities to Design dialog box
and click on OK.
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Transfer Entities to Design Dialog Box

Dialog Box
Illustration

                 Transfer Entities to Design Dialog Box

Dialog Box Use the information below to complete the Transfer Entities to Design
Components dialog box.

Components       Description                                                                 
Entities Name of the entity you wish to transfer appears here.

Design View Select the design view from the drop-down list.

Batch Mode Select this button to transfer in batch mode.

Show Each Select this button to show each entity.
Entity

Abbreviate Select this checkbox to abbreviate names.
Names

Create Select this checkbox to create relationships.
Relationships
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Create Select this checkbox to create primary key
Primary Key constraints.
Constraints

Create Select this checkbox to create foreign key
Foreign Key constraints.
Constraints

Create Unique Select this checkbox to create unique indexes.
Indexes

Do Not Use Select this checkbox to never use an attribute’s
Attribute alias.
Alias

Use Attribute Select this checkbox to use an attribute alias only
Alias for for duplicates.
Duplicates
Only

Always Use Select this checkbox to always use an attribute
Attribute alias.
Alias
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COPY ENTITY
 TO MODEL VIEW

Copying Entities To Another
Model View

Description The Copy To Model View command, available from the Data Map and
Data Dictionary windows, allows you to copy selected entities from the
current model view to another model view.

Usage Tips Use this command when you want an entity or entities in the current
model view to be included in one or more other model views.

This command is available for multiple selected entities in both the Data
Map and Data Dictionary windows. See the User's Guide for instructions on
selecting multiple entities in these windows.

You may also add entities to and remove them from model views through
the Entity-View Matrix window. See the User's Guide for more information
on using this window.

+   Example  You have added several entities to the entire encyclopedia,
and now you want them to be visible in a subset model view, as well. To do
this, you select the entities, then use the Copy To Model View command on
the Entity menu.

2  Note  An association between two entities is visible in a model view
only if both entities in the association are visible in the model view;
therefore, if you want an association to be copied to a model view with an
entity, the entity at the opposite end of the association must already be
visible in the target model view.

Procedure å  To copy selected entities to another model view from the Data
Map or Data Dictionary window:

1 Choose Copy To Model View...  from the Entity menu.

Result: The Copy Entity To Model View dialog box appears.

2 Complete the Copy Entity To Model View dialog box, then
click on OK.
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Copy Entity To Model View Dialog Box

Dialog Box
Illustration

                                

             Copy Entity to Model View Dialog Box

Dialog Box Use the information below to complete the Copy Entity To Model
Components View dialog box.

Component         Description                                                                 
Entity The name of the current entity or of the entities that

have been selected is displayed.

Use Source Select this button if you want the entity to
View have the same model view authority in the
Authority destination model view as it has for the current

model view.

Set New Select this button if you want to define a different
View model view authority, then select the checkbox for
Authority each model view authority the copied entity or

entities should have in the model view to which they
are being copied.
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View This box contains a list of all model views defined
for the encyclopedia. Highlight the name of the model
view to which you want to copy the entity or entities.

Structured Select this button if you want the View box to
display the model view list in hierarchical order.

Alphabetical Select this button if you want the View box to
display the model view list in alphabetical order.

View Select the checkbox for each model view
Authority authority (Create, Read, Update, and/or Delete) the

copied entity should have in the target model view.  This
is only available if the Set New View
Authority option is selected (see above).



250

COPY PROPERTY
 FROM DATA MODEL

Copying Property from
the Data Model

Description The Copy Property From Data Model command, available from the
Design Dictionary and Design Map windows, allows you to copy one or
more attributes from the data model into the current data structure as
properties.

Procedure åTo copy one or more data items from the data model to the
current data structure:

1 Display the data structure to which you want to copy the
attribute(s) as data item(s).

2 Choose Copy From Data Model... from the Property menu.

Result: The Copy Attribute to Design dialog box appears.

3 Complete the dialog box, then click on OK.
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Copy Attribute to Design Dialog Box

Dialog Box
Illustration

     Copy Attribute to Design Dialog Box

Dialog Box Use the information below to complete the Copy Attribute to Design
Components dialog box.

Component         Description                                                                 
Entity Select from the Entity drop-down list the entity that

Contains the attribute you want to copy.

Attribute Select the attribute(s) you want to copy into the
Current data structure, then click OK.

2  Note  To select multiple consecutive attributes in the
list, hold down the SHIFT key and click on the first
attribute you want to copy, and then click on the last
attribute you want to copy. To select multiple non-
consecutive attributes, hold down the CTRL key and click
on each attribute you want to copy.
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Abbreviate Click this checkbox to abbreviate names.
Names

Do Not Use Select this button to never use an attribute alias.
Attribute
Alias

Use Attribute Select this button to use an attribute alias for
Alias for duplicates only.

Always Use Select this button to always use an attribute alias.
Attribute
Alias
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COPY PROPERTY
 TO DATA MODEL

Copying Properties to Data Models

Description The Copy Property to Data Model command, available from the
Design Dictionary and Design Map windows, allows you to copy
properties from the current design view to a model view.

Procedure å  To copy properties to a data model:

1 In the Design Dictionary window, display the design object
you wish to copy the property from.

In the Design Map window, highlight the design object.

2 Choose Copy to Data Model from the Property menu.

Result:  The Select Design Object Property dialog box
appears.

3 Select a property to copy and click on OK.

Result:  The Copy Data Item to Entity dialog box
appears.

4 Complete the Copy Data Item to Entity dialog box, then
click on OK.

Result:  The Add Attribute dialog box appears for the
attribute type you selected.

5 Complete the Add Attribute dialog box, then click on OK.
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Copy Data Item to Entity
Dialog Box

Dialog Box
Illustration

Copy Data Item to Entity Dialog Box

Dialog Box Use the information below to complete the Copy Data Item to
Components Entity dialog box.

Component         Description                                                                 
Model View Select a model view from the drop down list.

Entity Select an entity from the list.

Expand Click  on this checkbox to expand abbreviated
Abbreviated names.
Names
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COPY PROPERTY FROM
DESIGN OBJECT

Copying a Property from
a Design Object

Description The Copy Property From Design Object command, available from
the Design Dictionary and Design Map windows, allows you to copy one or
more properties from another design object within the current design view
into the currently displayed design object.

Procedure å  To copy one or more properties from another design object
the current design object:

1 Display the design object to which you want to copy the
properties.

2 Choose Copy From Design Object... from the Property
menu.

Result: The Copy Property From Design Object dialog box
appears.

3 Select from the Design Object drop-down list the data
structure that contains the property you want to copy. The
list includes all design objects in the current design view.

Result: The properties contained in the selected design object
appear in the Properties list box.

4 Select the property(s) you want to copy into the current design
object, then click on OK.

2  Note To select multiple consecutive properties in the list, hold
down the SHIFT key and click on the first property you want to
copy, and then click on the last property you want to copy. To
select multiple non-consecutive properties, hold down the CTRL
key and click on each property you want to copy.
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COPY PROPERTY
 FROM DESIGN VIEW

Copying a Property from
a Design View

Description The Copy Property from Design View command, available from the
Design Dictionary and Design Map windows, allows you to copy one
or more properties available in the entire model for the current design
object but not included in the current design view.

Procedure å  To copy properties from the current design view:

1 In the Design Dictionary window, display the design object
you wish to copy the property to.

In the Design Map window, highlight the design object.

2 Choose Copy Property from Design View  from the Property
menu.

Result:  The Copy Property from Design View dialog box
appears.

3 Highlight the property you wish to copy, then click on OK.
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COPY PROPERTY
 TO DESIGN OBJECT

Copying a Property to
a Design Object

Description The Copy Property To Design Object command, available from the
Design Dictionary window, allows you to copy a property from the
currently displayed design object to another design object in the current
design view.

Procedure å To copy a property from the current design object to another
design object:

1 Display the design object from which you want to copy the
property.

2 Choose Copy To Design Object... from the Property menu.

Result: The Copy Property To Design Object dialog box
appears.

3 Select the design view in which the design object is
located from the Design View drop-down list. The list
includes all design views defined for the encyclopedia.

Result: The design objects located in the selected design
view are listed in the Design Object list box.

4 From the Design Object list, select the design object to
which you want to copy the property, then click on OK.
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COPY PROPERTY
 TO DESIGN VIEW

Copying a Property to a
Design View

Description The Copy Property to Design View command, available from the
Design Map and Design Dictionary windows, allows you to copy one or
more properties from the current design view to another design view.

Procedure å  To copy properties to another design view from the Design
Map window:

1 Highlight the design object that contains the property you
wish to copy.

2 Choose Copy to Design View from the Property menu.

Result:  The Select Design Object dialog box appears.

3 Select the property you wish to copy, then click on OK.

Result:  The Copy Property to Design View dialog box
appears.

4 Select the design view you wish to copy the property to,
then click on OK.

å To copy properties to another design view from the Design
Dictionary window:

1 Display the design object that contains the property you
wish to copy.

2 Choose Copy to Design View from the Property menu.

Result:  The Copy Property to Design View dialog box
appears.
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3 Select the design view you wish to copy the property to,
then click on OK.
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COPY STATEMENT
 FROM MODEL VIEW

Copying Statements From
Model Views

Description The Copy Statement From Model View command, available from both
the Planning Outline and Planning Dictionary windows, allows you to copy
a statement from another model view to the current model view.

Usage Tips Use the Copy Statement From Model View command when you want a
statement in another model view to be included in the current model view.

Since all statements in the encyclopedia are included in the entire
encyclopedia, the Copy Statement From Model View command is not
available when the entire encyclopedia is displayed.

+   Example  You have added a statement to a model view, and now you
want to include that statement in the current model view. To do this, you
use the Copy From Model View command.

Procedure å  To copy a statement from another model view:

1 Choose Copy From Model View... from the Statement menu.

Result: The Copy Statement From Model View dialog box
appears.

2 Select the statement you want to copy from the Statement
drop-down list.

The list includes all planning statements in the encyclopedia
 that are not visible in the current model view.

3 If you also want to copy all entities, attributes, or associations
linked to the statement into the current model view, select the
Copy linked data dictionary objects checkbox.

If the statement is linked to an attribute, the entity or entities
containing the attribute are also copied into the model view. If the
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statement is linked to an association, both entities in the
association are copied into the model view.

4 Click on OK.
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COPY STATEMENT
 TO MODEL VIEW

Copying Statements To
Another Model View

Description The Copy Statement To Model View command, available from both
the Planning Outline and Planning Dictionary windows, allows you to copy
the current statement or selected statements to another model view.

Usage Tips Use this command when you want one or more statements in the
current model view to be included in another model view.

This command is available for multiple selected statements in both the
Planning Outline and Planning Dictionary windows. See the User's Guide
for instructions on selecting multiple statements in these windows.

+   Example   You have added a statement to the entire encyclopedia, and
now you want that statement to be included in other model views. To do
this, you use the Copy To Model View command to copy the statement to
each model view in which you want it to be visible.

Procedure å  To copy selected statements to another model view from the
Planning Outline or Planning Dictionary window:

1 Choose Copy To Model View... from the Statement menu.

Result: The Copy Statement To Model View dialog box
appears.

2 Complete the Copy Statement To Model View dialog box,
then click on OK.
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Copy Statement To Model View Dialog Box

Dialog Box
Illustration

                                 

           Copy Statement to Model View Dialog Box

Dialog Box Use the information below to complete the Copy Statement To Model
Components View dialog box.

Component         Description                                                                 
Statement The name of the selected statement(s) is displayed in

this box.

Structured Select this button if you want to display the model
view list in hierarchical order.

Alphabetical Select this button if you want to display the list in
alphabetical order.

View Highlight the model view in this list to which you
want to copy the statement or statements. All model views
defined for the encyclopedia are listed in this box.

Copy Linked Select this checkbox if you also want to copy all
Data Dictionary entities, attributes, and associations  linked to the
Entries to View statement to the target model view.
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If the statement is linked to an attribute, the entity or
entities containing the attribute are also copied into the
model view. If the statement is linked to an association,
both entities in the association are copied into the model
view.
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COPY TEXT

Copying Text in a
Text Editor Window

Description The Copy Text command copies selected text from the Statement
Editor window to the Windows clipboard. The Statement Editor window
appears when you use the Statement Editor command.

You can paste the clipboard text to a new location; the new location may be
in the Statement or Session Editor window, in any Visible Advantage dialog
box, or in any other Windows application.

Procedure å To copy selected text to the clipboard:

Choose Copy from the Edit menu.

Result: The text is placed on the clipboard.

å  To paste the clipboard text to a new location:

1 Click the location you want the pasted text to appear (the
insertion point).

2 Choose Paste from the Edit menu.

Result: The text appears in the new location.
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COPY VIEW

Copying Model Views

Description The Copy command, available from the Model View Hierarchy
window, allows you to copy the contents of one or more selected model
views to another model view.

Usage Tips Use this command when you want all of the objects and details
contained in the selected model view(s) to be visible in another model view.

This command is available for multiple selected model views. See the
User's Guide for instructions on selecting multiple model views in the
Model View Hierarchy window.

2Note  This command does not delete objects from the current model view.
If the target model view already contains objects visible in the selected
model view(s), those objects will be unaffected in the target model view.

Procedure å To copy the contents of selected model views to another model
view.

1 Choose Copy... from the View menu.

Result: The Copy View dialog box appears.

2 Select the view to which you want to copy the selected
model view(s) from the Copy To list box.

If you want to display the list in hierarchical order, select the
Structured button. If you want to display the list in alphabetical
order, select the Alphabetical button.

3 Click on OK.
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CUSTOM FIELDS

Defining Custom Fields

Description The Custom Fields command, available from the Visible Advantage
Admin Utility, allows you to define custom fields for object types.

Procedure å  To add a custom field:

1 Choose Custom Fields from the Table menu.

Result:  The Custom Field Maintenance dialog box appears.

2 Select the object type to which you want to add a custom
field, then click on Add.

Result:  The Custom Field dialog box appears.

3 Complete the dialog box, then click on OK.

Result:  The Custom Field Maintenance dialog box reappears
with the custom field you added displayed in the Custom
Fields text box.

4 Repeat steps 2 and 3 to continue to add custom fields.

5 Click on Close when you are finished adding custom fields.

å  To modify a custom field:

1 Choose Custom Fields from the Table menu.

Result:  The Custom Field Maintenance dialog box appears.

2 Select the object type for which you want to change a
custom field.

Result:  The custom fields  defined for that object type appear
in the Custom Fields text box.
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3 Select the custom field you want to change, then click on OK.

Result:  The Custom Field dialog box appears.

4 Make the changes, then click on OK.

Result:  The Custom Field Maintenance dialog box reappears.

5 Repeat steps 2, 3 and 4 to continue to change custom fields.

6 Click on Close when you are finished changing custom fields.

å  To delete a custom field:

1 Choose Custom Fields from the Table menu.

Result:  The Custom Field Maintenance dialog box appears.

2 Select the object type for which you want to delete a custom
field.

Result:  The custom fields defined for that object type appear
in the Custom Fields text box.

3 Select the custom field you want to delete, then click on
Delete.

Result:  The custom field is deleted.

4 Repeat steps  2 and 3 to continue to delete custom fields.

5 Click on Close when you are finished deleting custom fields.
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Custom Field Dialog Box

Dialog Box
Illustration

    Custom Field Dialog Box

Dialog Box Use the information below to complete the Custom Field dialog
Components box.

Component         Description                                                                 
Object Type The name of the selected object type is displayed

here.

Name Type the name of the custom field, or select a custom
field from the drop-down list.

Label Type the label for the custom field.  This field
defaults to the name of the custom field.

Type Select a field type from the drop-down list.

Length Type the length of the custom field.
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Precision Type the number of digits to the right of the decimal
point.  Available only if the custom field is of type
“real.”

Lines Type the number of lines for the custom field.
Default is “1.” Available only if the custom field is
of type “character.”

Choices This text box is available when the “Type” is
“Pick List.”  Type a choice in the first text line, then
click on Add.  The  name is entered in the large text
box.

To change the choice, highlight the choice in the
large text box.  The choice is entered in the first text
line.  Type the changes, then click on Change.  The
change is made in the large text box.

To delete a choice, highlight the choice in the large
text box, then click on Delete.
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CUT TEXT

Cutting Text in a Text
Editor Window

Description The Cut Text command deletes selected text from the Statement or
Session Editor window and places it on the Windows clipboard. The
Statement Editor window appears when you use the Statement Editor
command; the Session Editor window appears when you use the Session
Editor command.

If necessary, you can then paste the text into a new location; the new
location may be in the Statement or Session Text Editor window, in any
Visible Advantage dialog box, or in any other Windows application.

Procedure å  To cut selected text and place it on the clipboard:

Choose Cut from the Edit menu.

å To paste the clipboard text to a new location:

1 Click the location you want the pasted text to appear (the
insertion point).

2 Choose Paste from the Edit menu.
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DATA ACCESS METHODS

Defining Data Access
Methods

Description The Data Access Methods command, available from the main
Visible Advantage Admin Utility window, allows you to add, edit, and
delete data access method types for use in the current or future
encyclopedias.

Usage Tips The data access methods you define with this command are for the
current encyclopedia only. If you want to define data access methods for all
future encyclopedias, use the Encyclopedia Initializer command before you
use the Data Access Methods command.

Procedure å  To add a data access method for the current encyclopedia or
Encyclopedia Initializer:

1 Choose Data Access Methods... from the Table menu.

Result: The Edit Data Access Method Table dialog box appears.

2 Type the name of the new access method into the Entry field.
If you highlighted an entry in the type list box, you will have to
clear its entry from the field before typing the entry for the new
access method. You may type 1-31 alphabetic characters.

3 To add the new entry to the end of the access method list,
click on Append.

4 Repeat the procedure for each entry you want to add to the
access method type table.

5 Click on OK.

å  To edit an existing data access method for the current encyclopedia
or Encyclopedia Initializer.

1 Choose Data Access Methods... from the Table menu.

Result: The Edit Data Access Method Table dialog box appears.
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2 Highlight the entry in the list box that you want to edit.
Result: The data access method appears in the Entry field.

3 Edit the information in this field, check the options and items, and
then click on Change.

å  To delete a data access method for the current encyclopedia or
Encyclopedia Initializer:

1 Choose Data Access Methods... from the Table menu.

Result: The Edit Data Access Method Type Table dialog box
appears.

2 Highlight the entry in the large list box that you want to
delete.

Result: The data access method appears in the Entry field.

3 Click on Delete.
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Edit Data Access Method Table Dialog Box

Dialog Box
Illustration

        Edit Data Access Method Table Dialog Box

Dialog Box Use the information below to complete the Edit Data Access Method
Components Table dialog box.

Component         Description                                                                 
Entry The name of the data access method that is

highlighted in the data access method list box, or that you
enter when you are adding a new type.

Storage Access Select this checkbox to select storage access
Mechanism mechanism.

Options Select the options for the entry.  You may select more
than one option.
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Items Select the items for the entry.  You may select more
than one item.

Append Use this button to add a new data access method to
the end of the data access method list.

Change Use this button to edit a data access method in the
table. To do this, highlight the data access method in the
list, edit the Entry field, check the options and items, then
click on this button.

Delete Use this button to delete a data access method from
the table. To do this, highlight the data access method in
the list, then click on this button.
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DATA DICTIONARY

About the Data Dictionary
Window

Description The Data Dictionary command allows you to open a Data Dictionary
window. This window provides a textual view of the encyclopedia, listing
in alphabetical order each entity in the current model view, as well as the
details associated with each entity. This command is available from all
windows.

You may use the Data Dictionary window to add entities, attributes,
associations, and statement links to the encyclopedia.

Procedure å  To open a Data Dictionary window:

1 Choose Data Dictionary... from the Data menu on the main
Visible Advantage Window menu bar.
or
Choose Data Modeling/Data Dictionary... from the main menu
on any other menu bar.
or
Click on the Data Dictionary window icon on the main Visible
Advantage window.

Result: If model views have been defined for the encyclopedia, the
Select Model View dialog box appears. Otherwise, a Data
Dictionary window for the entire model displays.

2 Complete the Select Model View dialog box, then click on
OK.

Result: A Data Dictionary window for the model view you selected
displays.

Related Topics Use the table below to access related information about the Data
Dictionary window.

For information on...                     See...                                                
how to use each command individual command.
in the Data Dictionary window For example, to learn how to use
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the Add command on the Entity
menu, see Add Entity.

how to use the Data Dictionary the Data Modeling section
window's special features, such in the User's Guide.
as the tool bar, mouse
commands, and keyboard
shortcuts
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DATA ITEM MODE

Design Reference in
Data Item Mode

Description The Data Item Mode command, available from the Design Reference
window, displays the Design Reference window by data item.

Usage Tips The four modes available in the Design Reference window— design
object, data item, entity, and attribute— allow you to reference the
information in a database design based on that object. Each mode displays
the mode object at the top of the window and all of its referenced objects or
details underneath it.

Procedure å  To run the Design Reference window in Data Item mode:

Choose Data Item from the Mode menu.

Result: A checkmark appears beside the command name and the Design
Reference window redisplays in Data Item mode.
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DATA ITEM TYPES

Defining Data Item Types

Description The Data Item Types command, available from the Visible Advantage
Admin Utility, allows you to add, edit, and delete types that you can assign
to data items in the current or future encyclopedias.

Usage Tips The data item types you define with this command are for the current
encyclopedia only. If you want to define data item types for all future
encyclopedias, use the Encyclopedia Initializer command before you use the
Data Item Types command.

Procedure å  To add a data item type for the current encyclopedia or
Encyclopedia Initializer:

1 Choose Data Item Types... from the Table menu.

Result: The Edit Data Item Type Table dialog box appears.

2 Type the name of the new type into the Entry field. If you
highlighted an entry in the type list box, you will have to
clear its entry from the field before typing the entry for the
new type. You may type 1-31 alphabetic characters.

3 To add the new entry to the end of the type list, click on
Append.

4 Repeat this procedure for each entry you want to add to the
type table.

5 Click on OK.

å  To edit an existing data item type for the current encyclopedia or
Encyclopedia Initializer:

1 Choose Data Item Types... from the Table menu.

Result: The Edit Data Item Type Table dialog box appears.

2 Highlight the entry in the large list box that you want to edit.
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Result: The data item type appears in the Entry field.

3 Edit the information in this field, then click on
Change.

å  To delete a data item type for the current encyclopedia or
Encyclopedia Initializer:

1 Choose Data Item Types... from the Table menu.

Result: The Edit Data Item Type Table dialog box appears.

2 Highlight the entry in the large list box that you want to
delete.

Result: The data item type appears in the Entry field.

3 Click on Delete.
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Edit Data Item Type Table Dialog Box

Dialog Box
Illustration

 
          Edit Data Item Type Table Dialog Box

Dialog Box Use the information below to complete the Edit Data Item Type Table
Components dialog box.

Component         Description                                                                 
Entry The name of the data item type that is highlighted in

the data item type list box, or that you enter when you are
adding a new type.

Append Use this button to add a new data item type to the
end of the data item type list.

Change Use this button to edit a data item type in the table.
To do this, highlight the data item type in the list, edit the
Entry field, then click on this button.

Delete Use this button to delete a data item type from the
table. To do this, highlight the data item type in the list,
then click on this button.
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DATA MAP

About the Data Map Window

Description The Data Map command allows you to open a Data Map window. This
window provides a graphical view of the entities and associations in the
current model view. You may use the Data Map window to add entities,
attributes, and associations to the encyclopedia. This command is available
from all windows.

You may display and print data maps in either Information Engineering (IE)
or IDEF1X format. See Options in this manual for more information.

Procedure å  To open a Data Map window:

1 Choose Data Map... from the Data menu on the main
Visible Advantage window.
or
Choose Data Modeling/Data Map... from the main menu in
any other window.
or
Click on the Data Map window icon on the main Visible
Advantage window.

Result: If model views have been defined for the encyclopedia, the
Select Model View dialog box appears. Otherwise, a Data Map
window for the entire encyclopedia displays.

2 Complete the Select Model View dialog box, then click on 
OK.

Result: A Data Map window for the model view you selected
appears.

Related Topics Use the table below to access related information about the Data Map
window.

For more information on...            See...                                                
how to use each command the entry in this manual for
in the Data Map window the individual command. For

example, to learn how to use the
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Add command on the Entity menu,
see Add Entity.

how to use the Data Map the Data Modeling section
window's special features, in the User's Guide.
such as the tool bar, mouse
commands, and keyboard
shortcuts
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DATA STRUCTURE
 MANAGERS

Defining Data Structure Managers

Description The Data Structure Managers command, available from the
Visible Advantage Admin Utility, allows you to define data structure
managers that you can assign to database designs in the current or future
encyclopedias.

Usage Tips The data structure managers you define with this command are for the
current encyclopedia only. If you want to define data access methods for all
future encyclopedias, use the Encyclopedia Initializer command before you
use the Data Access Methods command.

The following data structure managers are predefined in Visible Advantage:
DB2, Microsoft SQL (Sybase), Oracle v.7, Supra, Sybase v.10, and
Watcom SQL. You can edit the following details for predefined data
structure managers or for any data structure managers you add through this
command:
o   Capacities
o   Data types
o   Data structure types
o   Access mechanisms
o   Domains
o   Default item type
o   SQL Schema Scripts

å  To add a data structure manager for the current encyclopedia or
Encyclopedia Initializer:

1 Choose Data Structure Managers... from Table menu.

Result: The Data Structure Managers dialog box appears. All data
structure managers defined for the encyclopedia appear in
alphabetical order in the large list box.

2 Click on Add.

Result: The Add Data Structure Manager dialog box appears.
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3 Complete the Add Data Structure Manager dialog box, then 
click on OK.

Result: The Data Structure Managers dialog box reappears.

4 Repeat steps 2 and 3 for each data structure manager you
want to add, then click on Close after you have added all necessary
data structure managers.

å  To edit an existing data structure manager for the current
encyclopedia or Encyclopedia Initializer:

1 Choose Data Structure Managers... from the Table menu.

Result: The Data Structure Managers dialog box appears.

2 Highlight the entry in the large list box that you want to edit,
then click on Change.

Result: The Edit Data Structure Manager dialog box appears. The
components of this dialog box are the same as the Add Data
Structure Manager dialog box.  See the Add dialog box for detailed
information on the components of this dialog box.

3 Edit the information in this dialog box, then click on
OK.
Result: The Data Structure Managers dialog box reappears.

4 Repeat steps 2-3 for each data structure manager you want to
edit, then click on Close.

å  To delete a data structure manager for the current encyclopedia or
Encyclopedia Initializer:

1 Choose Data Structure Managers... from the Table menu.

Result: The Data Structure Managers dialog box appears.

2 Highlight the entry in the large list box that you want to
delete, then click on Delete.
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Add Data Structure Manager Dialog Box

Dialog Box
Illustration

                      

         Add Data Structure Manager Dialog Box

Dialog Box Use the information below to complete the Add Data Structure
Components Manager dialog box.

Component         Description                                                                 
Name If you are adding a data structure manager, type its

name into this field.

Capacities Type the maximum capacity for each of the
following details into the respective fields: data structures,
data structure occurrences, data items per data structure,
data structure size, and name length.



287

Default Select from this list the data item type you want
Item Type to be the default type in dialog boxes. The list

includes all data item types added to the encyclopedia
through Data Item Types command.

Data Types Use this button to define the data types used by this
data structure manager. When you click on this button,
the Data Types dialog box appears.

Structure Use this button to define data structure types for this
Types data structure manager. When you click on this

button, the Data Structure Types dialog box appears.

Access Use this button to define data access methods for this
Methods data structure manager. When you click on this

button, the Access Methods dialog box appears.

Domain Map Use this button to assign a data type for each domain
in this data structure manager. When you click on this
button, the Domain Map dialog box appears.

Schema Use this button to define schema generation scripts.
Scripts When you click on this button, the Schema

Generation Scripts dialog box appears.
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Data Types Dialog Box

Dialog Box
Illustration

                           

            Data Types Dialog Box

Dialog Box Use the information below to complete the Data Types dialog box.
Components

Component         Description                                                                 
Data Type If you want to add a new data type, type its name

into this field. If you want to change or delete a data type,
select its name from the large list box so that it appears in
this field, then use the Change or Remove button.

Base Size The size of the data type in the applicable unit of
measure (bytes, words, etc.).

Length Type in the length multiplier.
Multiplier

Has Length Select this checkbox if the data type has a length.

Has Precision Select this checkbox if the data type has a precision.
This selection is not available unless the Has Length
checkbox is selected.
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SQL Needs Select this checkbox if SQL needs quotes.
Quotes

Item Type Select from this drop-down list the data item type to
which you want to assign the selected data type.

Add Use this button to add the data type— data item type
combination to the large list box. To do this, complete the
Data Type and Item Type fields, then click on this button.

Change Use this button to change a data type— item type
combination. To do this, highlight the entry in the large
list box, edit the information in the dialog box fields, then
click on this button.

Remove Use this button to remove a data type— item type
entry from the data structure manager. To do this,
highlight the entry in the large list box, then click on this
button.
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Data Structure Types Dialog Box

Dialog Box
Illustration

                              

                  Data Structure Types Dialog Box

Dialog Box Use the information below to complete the Data Structure Types
Components dialog box.

Component         Description                                                                 

Data Structure The names of the selected data structure types
Types are listed in this box. You add data structure types to

this list from the Candidates list box.

Use this button to select data structure type
candidates. Highlight the data structure type in the
Candidates list box, then click on this button. It will then
appear in the Data Structure Types list box.  To select
more than one data structure type, hold down the SHIFT
key, highlight the data structure types in the Candidates
list box, then click on this button.

Use this button to deselect data structures. Highlight
the data structure type in the Data Structure Types list
box, then click on this button. It will then return to the
Candidates list box.  To deselect more than one data
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structure type, hold down the SHIFT key, highlight the
data structure types, then click on this button.

Use this button to select all data structure type
candidates. When you click on this button, all data
structure types in the Candidates list box will be moved to
the Data Structure Types list box.

Use this button to deselect all selected data structure
types. When you click on this button, all data structure
types in the Data Structure Types list box will be returned
to the Candidates list box.

Make Default Use this button to make one of the data structure
types the default entry in dialog box fields. To do this,
highlight the data structure type in the Data Structure
Types list box, then click on this button.

Candidates This box contains all data structure types defined for
the current encyclopedia. You define data structure types
through the Data Structure Types command.
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Access Methods Dialog Box

Dialog Box
Illustration

                             

      Access Methods Dialog Box

Dialog Box Use the information below to complete the Access Methods dialog
Components box.

Component         Description                                                                 
Access Methods The names of the selected access methods are listed

in this box. You add access methods to this list from the
Candidates list box.

Use this button to select access method candidates.
Highlight the access method in the Candidates list box,
then click on this button. It will then appear in the Access
Methods list box. To select more than one access method,
hold down the SHIFT key, highlight the access methods,
then click on this button.

Use this button to deselect access methods. Highlight
the access method in the Access Methods list box, then
click on this button. It will then return to the Candidates
list box.  To deselect more than one access method, hold
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down the SHIFT key, highlight the access methods, then
click on this button.

Use this button to select all access method
candidates. When you click on this button, all access
methods in the Candidates list box will be moved to the
Access Methods list box.

Use this button to deselect all selected access
methods. When you click on this button, all access
methods in the Access Methods list box will be returned
to the Candidates list box.

Make Default Use this button to make one of the Access Methods
the default entry in dialog box fields. To do this, highlight
the access method in the Access Methods list box, then
click on this button.

Candidates This box contains all access methods defined for the
current encyclopedia. You define access methods through
the Data Access Methods command.
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Domain Map Dialog Box

Dialog Box
Illustration

             Domain Map Dialog Box

Dialog Box Use the information below to complete the Domain Map dialog box.
Components

Component         Description                                                                 
Data Type Use this drop-down list to select the data type you

want to assign to a domain. All data types that have been
added to the current data structure manager appear in this
list.

To assign a data type to a domain, click on the domain in
the Domain— Data Type list box, select the data type
from this list, then click on any other entry in the
Domain— Data Type list.

Data types are added to the data structure manager
through the Data Types button on the Add Data Structure
Manager dialog box.
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Length Use this field to define a length for the domain, if the
data type has a length. To do this, click on the domain in
the Domain— Data Type list box, type a length into this
field, then click on any other entry in the Domain— Data
Type list.

Default Select this checkbox to use as the default domain.

Domain - This table displays the domains and the data
Data Type types assigned to each of them.
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Schema Generation Scripts Dialog Box

Dialog Box
Illustration

                      

                   Schema Generation Scripts Dialog Box

Dialog Box Use the information below to complete the Schema Generation Scripts
Components dialog box.

Component         Description                                                                 
Label Type a label for the script.

Body When you click on a script in the Scripts box, the
script text appears here.

Scripts The list of scripts available is displayed here.

Add Click Add to add the script to the script list.

Change To change the script displayed in the Body text
box, type the change and click on the Change
command button to save the change.
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Remove To remove a script, highlight the script in the
Script box and click on the Remove command
button.
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DATA STRUCTURE
 TYPES

Defining Data Structure Types

Description The Data Structure Types command, available from the Visible
Advantage Admin Utility, allows you to add, edit, and delete types that you
can assign to data structures in the current or future encyclopedias.

Usage Tips The data structure types you define with this command are for the
current encyclopedia only. If you want to define data structure types for all
future encyclopedias, use the Encyclopedia Initializer command before you
use the Data Structure Types command.

Procedure å  To add a data structure type for the current encyclopedia or
Encyclopedia Initializer:

1 Choose Data Structure Types... from the Table menu.

Result: The Edit Data Structure Type Table dialog box appears.

2 Type the name of the new type into the Entry field. If you
highlighted an entry in the type list box, you will have to clear its
entry from the field before typing the entry for the new type. You
may type 1-31 alphabetic characters.

3 To add the new entry to the end of the type list, click on
Append.

4 Repeat this procedure for each entry you want to add to the
type table.

5 Click on OK.

å  To edit an existing data structure type for the current encyclopedia
or Encyclopedia Initializer:

1 Choose Data Structure Types... from the Table menu.

Result: The Edit Data Structure Type Table dialog box appears.
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2 Highlight the entry in the large list box that you want to edit.

Result: The data structure type appears in the Entry field.

3 Edit the information in this field, then click on Change.

å  To delete a data structure type for the current encyclopedia or
Encyclopedia Initializer:

1 Choose Data Structure Types... from the Table menu.

Result: The Edit Data Structure Type Table dialog box appears.

2 Highlight the entry in the large list box that you want to
delete.

Result: The data structure type appears in the Entry field.

3 Click on Delete.
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Edit Data Structure
Type Table Dialog Box

Dialog Box
Illustration

         Edit Data Structure Type Table Dialog Box

Dialog Box Use the information below to complete the Edit Data Structure
Components Type Table dialog box.

Component         Description                                                                 
Entry The name of the data structure type that is

highlighted in the data structure type list box, or that you
enter when you are adding a new type.

Append Use this button to add a new data structure type to
the end of the data structure type list.

Change Use this button to edit a data structure type in the
table. To do this, highlight the data structure type in the
list, edit the Entry field, then click on this button.

Delete Use this button to delete a data structure type from
the table. To do this, highlight the data structure type in
the list, then click on this button.
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DATA TYPES

Defining Data Types

Description The Data Types command, available from the Visible Advantage Admin
Utility, allows you to add, edit, and delete data types that you can use in the
current or future encyclopedias.

Usage Tips The data types you define with this command are for the current
encyclopedia only. If you want to define data types for all future
encyclopedias, use the Encyclopedia Initializer command before you use the
Data Types command.

Procedure å  To add a data type for the current encyclopedia or
Encyclopedia Initializer.

1 Choose Data Types... from the Table menu.

Result: The Edit Data Type Table dialog box appears.

2 Type the name of the new type into the Entry field. If  you
highlighted an entry in the type list box, you will have to clear its
entry from the field before typing the entry for the new type. You
may type 1-31 alphabetic characters.

3 If you want users to define a length for attributes and data
items assigned the new data type, select the Has Length checkbox.
When you do this, the Has Precision checkbox becomes available.
Select that checkbox, as well, if you want users to define a
precision for attributes and data items assigned the new data type.

4 To add the new entry to the end of the type list, click on
Append.

5 Repeat the procedure for each entry you want to add to the
type table.

6 Click on OK.
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å  To edit an existing data type for the current encyclopedia or
Encyclopedia Initializer:

1 Choose Data Types... from the Table menu.

Result: The Edit Data Type Table dialog box appears.

2 Highlight the entry in the large list box that you want to edit.

Result: The data type appears in the Entry field.

3 Edit the information in the Entry field, adjust the Has
Length and Has Precision fields, as necessary, then click on
Change.

2 Note  A message appears telling you that the value cannot be
edited if the data type is a system-defined value protected from
editing by Visible Advantage.

å  To delete a data type for the current encyclopedia or Encyclopedia
Initializer:

1 Choose Data Types... from the Table menu.

Result: The Edit Data Type Table dialog box appears.

2 Highlight the entry in the large list box that you want to 
delete.

Result: The data type appears in the Entry field.

3 Click on Delete.

2 Note  A message appears telling you that the value cannot be
deleted if the data type is a system-defined value protected from
deletion by Visible Advantage, or if it is referenced by any
encyclopedia objects.
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Edit Data Type Table Dialog Box

Dialog Box
Illustration

Edit Data Type Table Dialog Box

Dialog Box Use the information below to complete the Edit Data Type Table
Components dialog box.

Component         Description                                                                 
Entry The name of the data type that is highlighted in the

data type list box, or that you enter when you are adding a
new type.

Has Length Select this checkbox if you want users to define a
length for the data type when using it for attributes and
data items in the encyclopedia.

Has Precision Select this checkbox if you want users to define a
precision for the data type when using it for attributes and
data items in the encyclopedia.

Append Use this button to add a new data type to the end of
the data type list.
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Change Use this button to edit a data type in the table. To do
this, highlight the data type in the list, edit the Entry field
and/or the Has Length and Has Precision checkboxes,
then click on this button.

Delete Use this button to delete a data type from the table.
To do this, highlight the data type in the list, then click on
this button.
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DEFAULT PATH

Setting a Default Path

Description The Default Path command, available from the main Visible
Advantage window, allows you to define the path that appears in the New
Encyclopedia and Open Encyclopedia dialog boxes.

Usage Tips The default path you choose with this command will take effect the
next time you create or open an encyclopedia through the File menu, and
appears in the New Encyclopedia and Open Encyclopedia dialog boxes.

Procedure å  To set the default path for the New Encyclopedia and Open
Encyclopedia dialog boxes:

1 Choose Default Path... from the File menu on the Main
Visible Advantage window.

Result: The Set Default Path dialog box appears.

2 Complete the Set Default Path dialog box , then click on OK.
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Set Default Path Dialog Box

Dialog Box
Illustration

                              

           Set Default Path Dialog Box

Dialog Box Use the information below to complete the Set Default Path dialog
Components box.

Component         Description                                                                 
Path The directories and drives located on the your

computer appear in the scrolled list box. In the list box,
double-click on the letter of the drive you want to define
as the default drive. The drive letter will appear in the
Path field.

Once the correct drive is displayed, double-click on the
directory you want to define as the default directory. The
directory name will appear in the Path field after the
selected drive letter.
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DELETE ACCESS
 MECHANISM

Deleting Access Mechanisms

Description The Delete Access Mechanism command, available from the Design
Dictionary and Design Map windows, allows you to delete an access
mechanism defined for the current data structure.

Usage Tips Use this command to delete access mechanisms only— use the Delete
Storage Access Mechanism command on the Access menu to delete a
storage access mechanism.

Procedure å  To delete an access mechanism from the current data
structure:

1 In the Design Dictionary's Access Mech field, highlight the
access mechanism identifier you want to delete.

In the Design Map window, highlight the access mechanism
you wish to delete.

2 Choose Delete... from the Access menu.

Result: The Delete Access Mechanism dialog box appears.

3 The type and name of the access mechanism to be deleted
appear in the dialog box.

4 Click on the delete option you wish to select.

5 If you still want to delete the access mechanism, click on OK.

If you do not want to delete the access mechanism, click on
Cancel.
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Delete Access Mechanism
Dialog Box

Dialog Box
Illustration

                            Delete Access Mechanism Dialog Box

Dialog Box Use the information below to complete the Delete Association
Components dialog box.

Component         Description                                                                 
Delete in  Click on this button to delete the access mechanism
Current from the current model view only.
Design
View Only

Delete From Click on this button to delete the access mechanism
Entire from the entire model.
Encyclopedia
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DELETE ASSOCIATION

Deleting Associations

Description The Delete Association command, available from both the Data Map
and Data Dictionary windows, allows you to delete an association from the
current model view or the entire model. Deleting an association does not
delete the entities in an association.

Usage Tips When you delete an association, you may choose to delete the keys that
support the association in the association's owned entity.

This command is available for multiple selected entities in the Data Map
window. See the User's Guide for instructions on selecting multiple entities
in the Data Map window.

In the Data Dictionary window, the Delete Association command is
available for the currently displayed entity only. Note also that in the Data
Dictionary window, you may only delete an association if both its entities
are visible in the current model view. This means that you may not delete an
association that appears dimmed in the Associations field.

Procedure å  To delete an association for each selected entity in the Data
Map window:

1 Choose Delete... from the Association menu.

Result: The Select Association dialog box appears.

2 In the Select Association dialog box, highlight the association
or associations you want to delete, then click on OK.

Result: The Delete Association dialog box appears.

3 Complete the Delete Association dialog box, then click on
OK.

Result: The association will be deleted. If you selected multiple
associations, the Delete Association dialog box for the next
selected association appears. (Repeat this step for each selected
association.)
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If you selected multiple entities, the Select Association dialog box
for the next selected entity appears. (Repeat this step for each
selected entity.)

Otherwise, the Data Map window redisplays. (End of procedure.)

å  To delete an association for the current entity in the Data Dictionary
window:

1 In the Data Dictionary window's Associations field, highlight
the association you want to delete.

2 Choose Delete... from the Association menu.

Result: The Delete Association dialog box appears.

3 Complete the Delete Association dialog box.

4 If you still want to delete the association, click on OK.
If you want to cancel the Delete command, click on Cancel .
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Delete Association Dialog Box

Dialog Box
Illustration

                         

           Delete Association Dialog Box

Dialog Box Use the information below to complete the Delete Association
Components dialog box.

Component         Description                                                                 
Delete in Click on this button to delete the association in the
current model current model view only.
view only

Delete Click on this button to delete the association from
association the entire model.
from entire
model
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DELETE ATTRIBUTE

Deleting Attributes

Description The Delete Attribute command, available from both the Data Map and
Data Dictionary windows, allows you to:
o   Delete the current use or all uses of a primary key or foreign key
      attribute
o   Delete a non-key attribute from the entire model

Usage Tips When you use this command, you can delete a key attribute from the
current model view or from the entire encyclopedia. Since non-key
attributes have a single occurrence in the encyclopedia, they are deleted
from the entire encyclopedia only.

This command is available for multiple selected entities in the Data Map
window. See the User's Guide for instructions on selecting multiple entities
in the Data Map window.

In the Data Dictionary window, this command is available for the currently
displayed entity only.

Procedure å  To delete an attribute from selected entities in the Data Map
window:

1 Select the entity or entities from which you want to delete the
attribute.

2 Choose Delete... from the Attribute menu.

Result: The Select Attribute dialog box appears.

3 Select the attribute or attributes you want to delete, then click
on OK.

Result: Depending on the type of the attribute you selected, the
Delete Key Attribute or Delete Non-Key Attribute dialog box
appears for the first selected entity and attribute.

4 Click on OK.
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Result: If you selected multiple attributes, the dialog box for the
next selected attribute appears. (Repeat this step  for each selected
attribute.)

If you selected multiple entities, the Select Attribute dialog box for
the next selected entity appears. (Repeat steps 3-4 for each selected
entity.)

Otherwise, the Data Map window redisplays. (End of procedure.)

å  To delete an attribute from the current  entity in the Data
Dictionary window:

1 Highlight the name of the primary key, foreign key, or non-
key attribute you want to delete.

2 Choose Delete... from the Attribute menu.

Result: Depending on the type of the attribute you selected, the
Delete Key Attribute or Delete Non-Key Attribute dialog box
appears.

3 Complete the dialog box, then click on OK.
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Delete Key Attribute Dialog Box

Dialog Box
Illustration

               

   Delete Key Attribute Dialog Box

Dialog Box Use the information below to complete the Delete Key Attribute
Components dialog box.

Component         Description                                                                 
Attribute The name of the attribute to be deleted is displayed.

Delete This Select this button if you want to delete the
Key Use Only attribute from its use in the current entity only.

Delete the Key Select this button if you want to delete all uses
and All Its Uses of the attribute in the encyclopedia. Note that if you

select this option, the key will be deleted from the
encyclopedia.
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Delete Non-Key Attribute Dialog Box

Dialog Box
Illustration

                         

    Delete Non-Key Attribute Dialog Box

Dialog Box Use the information below to complete the Delete Non-Key Attribute
Components dialog box.

Component         Description                                                                 
Attribute The name of the attribute to be deleted is displayed.

Delete in This If you want to delete the attribute in the current
Model View Model view only, select this button. This selection
Only is dimmed to indicate it is not available when you

are in the entire encyclopedia, rather than in a model
view.

Delete in All If you want to delete the attribute in all model views,
Model Views select this button. If you select this option, the key

will be deleted from the entire encyclopedia.
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DELETE BUSINESS EVENT

Deleting Business Events

Description The Delete Business Event command, available from the Process
Hierarchy window, allows you to delete a business event from the current
model view or from the entire encyclopedia.

Usage Tips Business events also appear in planning windows as planning
statements assigned the Business Event type. If you delete a business event
from the Process Hierarchy window, it will also be deleted from planning
windows as a planning statement. Likewise, if you delete a planning
statement defined as a business event from a planning window, it will also
be deleted from the process hierarchy.

Procedure å  To delete a business event:

1 Choose Delete... from the Event menu.

Result: The Delete Business Event dialog box appears.

2 If you want to delete the business event from the current
model view only, click on Delete in current model view only.

If you want to delete the business event from the entire
encyclopedia, click on Delete from entire model.

3 Click on OK.
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DELETE CONTROL FLOW

Deleting a Control Flow

Description The Delete Control Flow command, available from the Process Map
window, deletes one or more control flows from the current process in the
Process Map window.

Usage Tips To select a single control flow, click on the control flow line so that a
solid rectangle appears in the center of the line. To select multiple control
flows, hold down the SHIFT key while you click on each control flow you
want to delete.

You may also select one or more control flows by holding down the left
mouse button and dragging the mouse cursor down and across the control
flow(s) you want to select.

Procedure å  To delete selected control flows from the current process:

1 Choose Delete... from the Flow menu.

Result: The Delete Control Flow dialog box appears.

2 The Flow box of the dialog box contains the flow(s) to be
deleted.

If you still want to delete the flow(s) listed in the Flow box, click
on OK.

If you do not want to delete the flow(s), click on Cancel.
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DELETE DATA ITEM

Deleting a Data Item

Description The Delete Data Item command, available from the Design Dictionary
and Design Map windows, allows you to delete the current occurrence or all
occurrences of a data item.

Usage Tips You may choose to delete a data item from the current data structure
only, or from the entire encyclopedia.

Procedure å  To delete a data item:

1 In the Design Dictionary's Property field, highlight the
data item you want to delete.

2 Choose Delete... from the Property menu.

Result: The Delete Property dialog box appears.

3 If you want to delete the data item from the current data
structure only, select the Delete in current design object only
button.

If you want to delete the data item from all data structures to which
it belongs, click on the Delete from all design objects button.

4 If you want to delete the data item from the current view only,
select Delete in current view only.

If you want to delete from all views, select Delete from all
views.

5 Click on OK.
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DELETE DESIGN OBJECT

Deleting Design Objects

Description The Delete Design Object command, available from the Design
Dictionary and Design Map windows, allows you to delete the current or
selected Design Objects.

Usage Tips This command is available for multiple selected Design Objects in the
Design Dictionary and Design Map windows. See Select Design Objects in
this manual for information on selecting design objects.

You may choose to delete the design object(s) from the current database
design only, or from the entire encyclopedia.

Procedure å  To delete the current or selected design objects:

1 Choose Delete... from the Design Object menu.

Result: The Delete Design Object dialog box appears.

2 If you want to delete the design object from the current
database only, select the Delete in current design view only
button.

If you want to delete the Design Object from all database designs
in which it belongs, click on the Delete from entire encyclopedia
button.

3 Click on OK.
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DELETE DESIGN OBJECT
RELATIONSHIP

Deleting Design Object
Relationships

Description The Delete Design Object Relationship command, available from the
Design Dictionary and Design Map windows, allows you to delete a
relationship for the current design object. Deleting a relationship does not
delete the design objects in the relationship.

Procedure å  To delete a relationship for the current design object:

1 In the Design Dictionary's Relationships field, highlight the
relationship you want to delete.

2 Choose Delete... from the Relationship menu.

Result: The Delete Relationship dialog box appears for the type of
relationship.

3 Select the keys to retain or delete by highlighting and clicking
on the arrow buttons.  The single arrow button moves the
highlighted key; the double arrow button moves all keys.

4 Click on OK.
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DELETE DESIGN VIEW

Deleting Design Views

Description The Delete Design View command, available from the Design
Dictionary and Design Map windows, allows you to delete a design view
from the encyclopedia. When you delete a design view, you also delete the
data structures and data items it contains.

Procedure å  To delete the design view currently displayed in the Design
Dictionary window:

1 Choose Delete... from the View menu.

Result: The Delete View dialog box appears.

2 The name of the current design view appears in the
View field.

3 Select the Delete Selected Views Only button if you want to
delete the selected view(s) only, but none of its subviews.

4 Select the Delete Selected Views and Their Subviews
button if you want to delete the selected views and model
view(s) and all of the model views beneath it in the model
view hierarchy.
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DELETE ENCYCLOPEDIA

Deleting Encyclopedias

Description The Delete Encyclopedia command, available from the Visible
Advantage Admin Utility, allows you to delete all files associated with the
current encyclopedia.

Procedure å  To delete all files for the current encyclopedia:

1 Choose Delete... from the Encyclopedia menu.

Result: The following warning message appears:

! WARNING: This will permanently DELETE all data, files, and
sub-directories of the current encyclopedia. Continue delete?

2 Do you still want to delete the encyclopedia?

If no, click on Cancel.

Result: The encyclopedia files will not be deleted. (End of
procedure.)

If yes, click on OK.

Result: The following warning message appears:

Are you sure you want to delete the current encyclopedia?

3 If for any reason you are not sure about executing this
command, click on Cancel.

If you are sure you want to delete the current encyclopedia, click
on OK.
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DELETE ENTITY

Deleting Entities

Description The Delete Entity command, available from both the Data Map and
Data Dictionary windows, allows you to delete selected entities.

Usage Tips When you use this command, you may choose whether to delete the
entity from the current model view only or from the entire encyclopedia.

This command is available for multiple selected entities in both the Data
Map window and the Data Dictionary window. See the User's Guide for
instructions on selecting multiple entities in these windows.

Procedure å  To delete selected entities in the Data Map or Data Dictionary
window:

1 Choose Delete... from the Entity menu.

Result: The Delete Entity dialog box appears.

2 If you want to delete the entity from the current model view
only, select the Delete in current model view only button. If the
entire encyclopedia is displayed in the active window, this option
will be dimmed.

If you want to delete the entity from the entire encyclopedia, select
the Delete entity from entire model button.

3 Click on OK.
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DELETE MODEL VIEW

Deleting Model Views

Description The Delete Model View command, available from both the Data Map
and Data Dictionary windows, allows you to:
o   Delete the current or selected model views from the encyclopedia.
o   Delete the current or selected model views and all of their
     subviews from the encyclopedia. A subview of a model view is any
     model view that appears beneath it in the model view hierarchy.

This command is available in all windows except the main Visible
Advantage window, the Statement Editor window, and the design phase
windows.

Usage Tips When a model view is deleted, views of the objects contained in it
(object views) are deleted, but the objects themselves remain in the
encyclopedia. You may not use the Delete Model View command when the
entire model is displayed, since it contains views of all encyclopedia
objects.

If you delete the selected model view(s) only, its child views become
children of the deleted model view's parent view.

This command is available for multiple selected model views in the  View
Hierarchy window. See the User's Guide for instructions on selecting
multiple model views in this window.

Procedure å  To delete selected model views from the Model View Hierarchy
window or the current model view from any other window:

1 Choose Delete... from the View menu.

Result: The Delete View dialog box appears.

2 Complete the Delete View dialog box, then click on
OK.

Result: If the model view contains objects, the following message
appears:

Model view is not empty. OK to delete it?
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3 If you still want to delete the model view, click on OK.
Otherwise, click on Cancel.
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Delete View Dialog Box

Dialog Box
Illustration

                         

               Delete View Dialog Box

Dialog Box Use the information below to complete the Delete View dialog box.
Components

Component         Description                                                                 
View The name of the current model view is displayed. If

you are in the Model View Hierarchy window and have
selected multiple model views, the names of all selected
model views appear in the box.

Delete Selected Select this button if you want to delete the selected
Views Only view(s), but none of its subviews.

Delete Selected Select this button if you want to delete the selected
Views and model view(s) and all of the model views beneath
Their Subviews it in the model view hierarchy.
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DELETE PLANNING
 STATEMENT

Deleting Planning Statements

Description The Delete Planning Statement command, available from the Planning
Outline and Planning Dictionary windows, allows you to delete
planning statements.

Procedure å  To delete a planning statement from the Planning Outline
window:

1 Highlight the statement to delete.

2 Choose Delete from the Statement menu.

Result:  The Delete Planning Statement dialog box appears.

3 Complete the Delete Planning Statement dialog box, then
click on OK.

å  To delete a planning statement from the Planning Dictionary
window:

1 Display the statement you want to delete.

2 Choose Delete from the Statement menu.

Result:  The Delete Planning Statement dialog box appears.

3 Complete the Delete Planning Statement dialog box, then
click on OK.
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Delete Planning Statement
Dialog Box

Dialog Box
Illustration

  Delete Planning Statement Dialog Box

Dialog Box Use the information below to complete the Delete Planning
Components Statement dialog box:

Component         Description                                                                 
Title The statement you selected is displayed here.

Delete in Click on this button to delete the statement from the
Current Model current view only.
View Only

Delete State- Click on this button to delete the statement from the
ment from the entire model.
Model
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DELETE PROCESS

Deleting a Process

Description The Delete Process command, available from both the Process
Hierarchy and Process Map windows, allows you to delete selected
processes in the Process Hierarchy window or the currently displayed
process in the Process Map window.

Procedure å  To delete selected processes in the Process Hierarchy window
or the current process in the Process Map window:

1 Choose Delete... from the Process menu.

Result: The Delete Process dialog box appears.

2 The Name box of the dialog box contains the process to
be deleted.

If you still want to delete the process listed in the Name box, click
on OK.

If you do not want to delete the process, click on Cancel.
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DELETE PROCESS
 CONTROL

Deleting Process Controls

Description The Delete Process Control command, available from the Process Map
window, deletes selected parallel control(s), conditional control(s), or
process stop(s) from the process map.

Procedure åTo delete one or more selected controls from the process map:

1 Choose Delete... from the Control menu.

Result: The Delete Control dialog box appears.

2 The selected control(s) is identified in the dialog box.
If you still want to delete the control(s), click on OK.
If you do not want to delete the control(s), click on Cancel.
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DELETE PROCESS STEP

Deleting a Process Step

Description The Delete Process Step command, available from the Process Map
window, allows you to delete selected process steps in the Process Map
window.

Procedure å  To delete process steps in the Process Map window:

1 Choose Delete... from the Step menu.

Result: The Delete Step dialog box appears.

2 The Step box of the dialog box contains the name of the
step to be deleted.

If you still want to delete the process step listed in the box, click on
OK.

If you do not want to delete the process step, click on Cancel.

.



332

DELETE STORAGE
ACCESS MECHANISM

Deleting Storage Access
Mechanisms

Description The Delete Storage Access Mechanism command, available from the
Design Dictionary and Design Map windows, allows you to delete the
storage access mechanism defined for the current data structure.

Usage Tips Use this command to delete storage access mechanisms only— use the
Delete Access Mechanism command on the Access menu to delete an
access mechanism.

Procedure å  To delete the storage access mechanism from the current data
structure:

1 Choose Delete Storage... from the Access menu.

Result: The Delete Access Mechanism dialog box appears
with the type and name of the storage access mechanism to be
deleted appear in the dialog box.

2 If you want to delete the storage access mechanism in the
current design view only, click on Delete in current design
view only.

If you want to delete the storage access mechanism from the
entire encyclopedia, click on Delete from entire
encyclopedia.

3 To delete the storage access mechanism, click on OK.

If you do not want to delete the storage access mechanism, click on
Cancel.
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DELETE USER GROUP

Deleting User Groups

Description The Delete User Group command, available from the Visible
Advantage Admin Utility, allows you to delete a defined user group from
the encyclopedia.

Procedure å  To delete a user group:

1 Choose Delete from the Group menu.

Result: The Delete Group dialog box appears.

2 Select the user group from the list, then click on OK.

2 Note  The user group must be empty before it can be deleted.
If the user group contains users, an error message is displayed.
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DESELECT ALL

Deselecting All Objects

Description The Deselect All command removes selection status from all currently
selected objects in a window. This command is available from the following
windows: Model View Hierarchy, Planning Outline, Data Map, and Design
Map.

Procedure å  To deselect all objects in an applicable window:

Choose Deselect All from the Select menu.

Result: All objects that were selected before you chose the command are
deselected.
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DESIGN DICTIONARY

Opening the Design Dictionary
Window

Description The Design Dictionary command allows you to open a Design
Dictionary window. This window provides a textual view of the data
structures, data items, data structure relationships, access mechanisms, and
other design details in the current database design. This command is
available from all windows.

Usage Tips You may use the Design Dictionary window to add data structures,
data items, and all other design objects and details to the encyclopedia.

Procedure å To open a Design Dictionary window:

1 From the main Visible Advantage window, choose Design
Dictionary... from the Design menu.
or
Click on the Design Dictionary window icon on the main Visible
Advantage window workspace.

From any other window, choose Design from the main menu, then
choose Design Dictionary... from the cascading menu.

Result: The Select Design View dialog box appears.

2 The Select Design View dialog box contains a list of all
database designs defined for the encyclopedia.

Highlight the name of the database design you want to display in
the Design Dictionary window, then click on OK.

Related Topics Use the table below to access related information about the Design
Dictionary window.

For more information on...            See...                                                
how to use each command in the entry in this manual for the
the Design Dictionary window individual command.
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how to use the Design the Database Design section
Dictionary window's special in the User's Guide.
features, such as the tool bar,
mouse commands, and
keyboard shortcuts



337

DESIGN MAP

Opening the Design Map Window

Description The Design Map command allows you to open a Design Map window.
This window provides a graphical view of the data structures, data items,
data structure relationships, access mechanisms, and other design details in
the current database design.  This command is available from all windows.

Usage Tips You may use the Design Map window to add data structures, data
items, and other design objects and details to the encyclopedia.

Procedure å  To open a Design Map window:

1 From the main Visible Advantage window, choose Design
Map…  from the Design menu.
or
Click on the Design Map window icon on the main Visible
Advantage window workspace.

From any other window, choose Design from the main menu,
then choose Design Map…  from the cascading menu.

Result:  The Select Design View dialog box appears.

2 The Select Design View dialog box contains a list of all
database designs defined for the encyclopedia.

Highlight the name of the database design you want to display
in the Design Map window, then click on OK.

Related Topics Use the table below to access related information about the Design
Map window.

For more information on…            See…                                                
how to use each command in the entry in this manual for the
the Design Map window individual command.
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how to use the Design Map the Design section in the User’s
window’s special features, Guide.
such as the tool bar, mouse
commands, and keyboard
shortcuts
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DESIGN OBJECT MODE

Design Reference in Design
Object Mode

Description The Design Object Mode command, available from the Design
Reference window, displays the Design Reference window by Design
Object.

Usage Tips The four modes available in the Design Reference window— design
object, data item, entity, and attribute— allow you to reference the
information in a database design based on that object. Each mode displays
the mode object at the top of the window and all of its referenced objects or
details underneath it.

Procedure å  To run the Design Reference window in Design Object mode:

Choose Design Object from the Mode menu.

If the current mode is entity or attribute, the Select Design View
dialog box appears.  Choose a view and click on OK.

Result: A checkmark appears beside the command name and the Design
Reference window redisplays in Design Object mode.
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DESIGN REFERENCE

Opening the Design Reference
Window

Description The Design Reference command allows you to open a Design
Reference window. This window provides a cross-reference of each data
structure, data item, entity, and attribute that is or may be involved in the
database design. You can view the Design Reference window in four
different modes, one for each type of object (data structure, data item,
entity, and attribute). This command is available from all windows.

Usage Tips Through this window, you may view the cross-references between
database design and data modeling objects; link data structures to entities in
the data model; and edit the details for the data structures, data items,
entities, and attributes displayed in the window.

Procedure å  To open a Design Reference window:

1 From the main Visible Advantage window, choose Design
Reference... from the Design menu.
or
Click on the Design Reference window icon on the main Visible
Advantage window workspace.

From any other window, choose Design from the main menu, then
choose Design Reference... from the cascading menu.

Result: The Select Design View dialog box appears.

2 The Select Design View dialog box contains a list of all
database designs defined for the encyclopedia.

Highlight the name of the database design you want to display in
the Design Reference window, then click on OK.
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DESIGNATE ATTRIBUTE
 AUTHORITY

Designating an Attribute's Authority

Description The Designate Attribute Authority command, available from the Data
Dictionary window, allows you to override the sole/shared model view
authority status designated by Visible Advantage for each attribute.

Usage Tips This command is available only when a model view is displayed; it is
dimmed when the entire encyclopedia is displayed in the Data Dictionary
window.

This command allows you to:

Let Visible Advantage designate the sole/shared Read and Update status for
an attribute based on its presence/designation in other model views (this is
the default setting),
or
Override Visible Advantage's sole/shared Read and Update designation for
an attribute. Any incorrect designations at the time of Model Analysis will
be reported.

2  Note  To pass Model Analysis, an attribute's sole/shared designation
must be consistent with its presence/designation in other model views.
Model Analysis reports any sole/shared designation inconsistencies.

Procedure å  To override the sole/shared Read and Update designation for
an attribute:

1 In the Data Dictionary window, click on the name of the
attribute whose model view designation you want to designate.

2 Choose Designate Authority... from the Attribute menu.

Result: The Designate Attribute Authority dialog box appears.

3 Complete the Designate Attribute Authority dialog box, then
click on OK.
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Designate Attribute Authority Dialog Box

Dialog Box
Illustration

                     

           Designate Attribute Authority Dialog Box

Dialog Box Use the information below to complete the Designate Attribute
Components Authority dialog box.

Component         Description                                                                 
Attribute The name of the attribute whose model view

authority you are designating appears in this box.

Read Select this checkbox if you want the current model
view to be able to read the attribute. This box will already
be selected if it was selected when the attribute was added
or last edited.

When you select this checkbox, the Derived/Designated
selections in the Read area will become available.

Update Select this checkbox if you want the current model
view to be able to update the attribute. This box will
already be selected if it was selected when the attribute
was added or last edited.
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When you select this checkbox, the Derived/Designated
selections in the Update area will become available.

Derived/ Select the Derived button if you want Visible
Designated Advantage to derive the attribute's sole/shared

designation for its Read authority. When you select this
button, you do not make any sole/shared selection. This is
the default setting.

Select the Designated button if you want to override
Visible Advantage's designation for the attribute's
sole/shared designation for its Read authority.

When you select the Designated button in the Read area,
the Read sole/shared selections are available.

When you select the Designated button in the Update
area, the Update sole/shared selections are available.

Sole/Shared The selections in this area will only be available if
you selected the Designated button for the Read and/or
Update authority.

Select the Sole button if you want the model view to have
sole read or update authority for the attribute, even if
Visible Advantage derives a shared authority for the
attribute, based on its presence/designation in other model
views.

Select the Shared button if you want the model view to
have shared read or update authority for the attribute,
even if Visible Advantage derives a sole authority for the
attribute, based on its presence/designation in other model
views.
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DESIGNATE ENTITY
AUTHORITY

Designating an Entity's Authority

Description The Designate Entity Authority command, available from the Data
Dictionary window, allows you to override the sole/shared model view
authority status designated by Visible Advantage for each entity.

Usage Tips This command is available only when a model view is displayed; it is
dimmed when viewing the entire model in the Data Dictionary window.

This command allows you to:

Let Visible Advantage designate the sole/shared Create, Read, Update, and
Delete status for an entity based on its presence/designation in other model
views. This is the default setting.
or
Override Visible Advantage's sole/shared Create, Read, Update, and Delete
designation for an entity.

2  Note  To pass Model Analysis, an entity's sole/shared designation must
be consistent with its presence/designation in other model views. Model
Analysis will report any sole/shared designation inconsistencies.

This command is available for multiple entities selected with the Select
Entities command on the Entity menu.

Procedure å  To designate the authority of selected entities in the current
model view:

1 Choose Designate Authority... from the Entity menu.

Result: The Designate Entity Authority dialog box appears.

2 Complete the Designate Entity Authority dialog box, then
click on OK

.
Result: If you selected multiple entities, the Designate Entity
Authority dialog box for the next selected entity appears.

Otherwise, the active Data Dictionary window redisplays.
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Designate Entity Authority Dialog Box

Dialog Box
Illustration

                        

                  Designate Entity Authority Dialog Box

Dialog Box Use the information below to complete the Designate Entity
Description Authority dialog box.

Component         Description                                                                 
Entity The name of the currently selected entity appears in

this box.

Create Select this checkbox if you want the current model
view to be able to create the entity. This box will already
be selected if it was selected when the entity was added or
last edited.

When you select this checkbox, the Derived/Designated
selections in the Create area will become available.
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Read Select this checkbox if you want the current model
view to be able to read the entity. This box will already be
selected if it was selected when the entity was added or
last edited.

When you select this checkbox, the Derived/Designated
selections in the Read area will become available.

Update Select this checkbox if you want the current model
view to be able to update the entity. This box will already
be selected if it was selected when the entity was added or
last edited.

When you select this checkbox, the Derived/Designated
selections in the Update area
will become available.

Delete Select this checkbox if you want the current model
view to be able to delete the entity. This box will already
be selected if it was selected when the entity was added or
last edited.

When you select this checkbox, the Derived/Designated
selections in the Delete area will become available.

Derived/ Select the Derived button if you want Visible
Designated Advantage to derive the entity's sole/shared

designation for its Create, Read, Update, or Delete
authority. When you select this button, you do not make
any sole/shared selection. This is the default setting.

Select the Designated button if you want to override
Visible Advantage's designation for the entity's
sole/shared designation for its Create, Read, Update, or
Delete authority.

When you select the Designated button in the Create,
Read, Update, or Delete area, the sole/shared selections in
each selected area are available.

Sole/Shared The selections in this area will only be available if
you selected the Designated button for the Create, Read,
Update, and/or Delete authority.
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Select the Sole button if you want the model view to have
sole read or update authority for the entity, even if Visible
Advantage derives a shared authority for the entity, based
on its presence/designation in other model views.

Select the Shared button if you want the model view to
have shared read or update authority for the entity, even if
Visible Advantage derives a sole authority for the entity,
based on its presence/designation in other model views.



348

DESIGNATED CLUSTER
END POINT

Designating Cluster End Points

Description The Designate Cluster End Point command, available from the Data
Dictionary window, designates the current entity as a cluster end point. A
cluster is a group of entities that represents a meaningful subset of the data
model.

Visible Advantage derives an entity to be a cluster end point if there are no
other entities dependent on it. You can use this command to designate a
cluster end point even if other entities are dependent on it. This is useful
when you want an entity to be the focal point for a cluster.

Usage Tips The Designated Cluster End Point command toggles between an active
and inactive state. When the current entity has been designated as a cluster
end point, there is a checkmark beside the command. When the command is
inactive, there is no checkmark beside the command.

If the entity dependency for the entity changes, Visible Advantage will
automatically re-evaluate the derived end point status. An entity may be
both a designated and derived end point.

Both derived and designated cluster end points for the data model are
reported in the Cluster report. You name a derived or designated end point
through the Name End Point command on the Entity menu.

Procedure å  To designate the current entity as an end point:

Choose Designated Cluster End Point from the Entity menu.

Result: A checkmark will appear beside the command, and the Cluster End
Pt. field will appear in the Data Dictionary record for the current entity.

å  To remove the end point designation for the current entity:

Choose Designated Cluster End Point from the Entity menu.

Result: The checkmark beside the command will disappear, indicating that
the current entity is no longer a designated end point. The Cluster End Pt.
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field will disappear from Data Dictionary window if the current entity is not
a derived end point.
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DOCUMENTS

Publishing Encyclopedia Documents

Description The Documents command allows you to assemble encyclopedia reports
into a comprehensive document. This command is available from all
windows.

You can configure each document with a table of contents, consecutive
page numbering, an index of selected objects, and an appendix of report
options. You save each document configuration so that it can be reprinted
and modified over the life of the project.

Usage Tips Use this command when you want to configure encyclopedia reports so
that you receive consistent reports throughout a project.

+  Example  You want to print consistent Planning Statement, Entity, and
Attribute reports at the end of certain project phases. You want the reports
to be assembled into a single document with consecutive page numbering, a
table of contents, and an index of planning statements, entities, and
attributes.

To do this, you use the Documents command to configure and save a
document with the desired options. Each time you print the configured
document, the reports will include the same individual report options, as
well as document features (page numbering, table of contents, and index).

Procedure å  To configure and save a document made up of encyclopedia
reports:

1 Open the encyclopedia for which you want to configure a
document.

2 Choose Documents... from the File or Main menu.

Result: The Documents dialog box appears.

3 Click on Add.

Result: The Add Document dialog box appears.
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4 Complete the Add Document dialog box, then
click on OK.

Result: The Documents dialog box reappears with the new
document name in the Documents list box.

5 Do you want to print the document?

If yes, make sure the document name is highlighted in the
Documents list box, then click on Print.

Result: The Report Destination dialog box appears. Select a
destination (Printer, File, or Screen), then click on OK to print
the document.

If no, click on Cancel.

å  To modify an existing document configuration:

1 Open the encyclopedia in which you configured the
document.

2 Choose Documents... from the File or Main menu.

Result: The Documents dialog box appears.

3 In the Documents list box, highlight the name of the
document you want to modify, then click on Modify.

Result: The Edit Document dialog box appears.

4 Complete the Edit Document dialog box  for a description
of the dialog box components), then click on OK.

Result: The Documents dialog box reappears.

5 Do you want to print the modified document?

If yes, make sure the document name is highlighted in the
Documents list box, then click on Print.



352

Result: The Report Destination dialog box appears. Select a
destination (Printer, File, or Screen), then click on OK to print
the document to the selected device.

If no, click on Cancel.

å  To print an existing document:

1 Open the encyclopedia in which you configured the
document.

2 Choose Documents... from the File menu.

Result: The Documents dialog box appears.

3 In the Documents list box, highlight the name of the
document you want to print, then click on Print.

Result: The Report Destination dialog box appears. Select a
destination (Printer, File, or Screen), then click on OK to print
the document to the selected device.

å  To delete an existing document:

1 Open the encyclopedia in which you configured the
document.

2 Choose Documents... from the File menu.

Result: The Documents dialog box  appears.

3 In the Documents list box, highlight the name of the
document you want to delete, then click on Delete.
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Documents Dialog Box

Dialog Box
Illustration

                                    

                   Documents Dialog Box

Dialog Box Use the information below to complete the Documents dialog box.
Components

Component         Description                                                                 
Documents This list contains all documents configured and

saved for the current encyclopedia.

Close Use this button when you have finished adding,
changing, or printing your document.

Print Use this button to print a document. In the
Documents list, highlight the document you want to print,
then click on this button to print the document.

Add Use this button to configure a new document for the
encyclopedia.

When you click on this button, the Add Document dialog
box appears.

Modify In the Documents list, highlight the document you
want to modify, then click on this button to modify the
document's individual report or publishing options.
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Delete Use this button to delete a configured document from
the encyclopedia. In the Documents list, highlight the
document you want to delete, then click on this button to
delete the document.
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Add Document Dialog Box

Dialog Box
Illustration

                            

             Add Document Dialog Box

Dialog Box Use the information below to complete the Add Document dialog box.
Components

Component         Description                                                                 
Title Type the name of the new document into this box.

The name may contain up to 51 characters.

Purpose Type a purpose for the document into this text box.
You may type up to 32,000 characters.

Report Types This box contains a list of all reports available in
Visible Advantage. To include a report in the current
document, highlight the report type in this list, then click
on the Add button (see below).

Document This box contains a list of the report types added to
Reports the current document through the Add button.
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Add Use this button to add a report type to the document.
In the Report Types list box, highlight the report type
you want to add to the document, then click on this
button.

When you click on the Add button, the dialog box for the
selected report type appears. Once you complete the
report dialog box and click on OK, the report type will
appear in the Document Reports box.

See the Reports section of this manual for information on
completing each report dialog box.

Modify Use this button to modify the options for a document
report. In the Document Reports list box, highlight the
name of the report whose options you want to modify,
then click on this button.

When you click on the Modify button, the dialog box for
the selected document report appears. You may then edit
the information in the dialog box and click on OK.

Remove Use this button to remove a report from the
document. In the Document Reports list box, highlight
the name of the report you want to remove, then click on
this button.

Table of Select this checkbox if you want to include a table of
Contents contents for the current document.

The table of contents will print at the beginning of the
document and will contain the name of each report and
the page number on which it begins.

Appendix Select this checkbox if you want to include an
appendix for the current document.
The appendix will contain a list of all selected options for
each document report, as  defined in the dialog box for
each report.

Index Select this checkbox if you want to include an index
for the current document.



357

When you select this checkbox, the Index Objects list
becomes available.

The index will print at the end of the document and will
contain a list of the objects selected from the Index
Objects list and the page numbers on which occurrences
of each can be found.

Index Objects Select each encyclopedia object you want to include
in the document index.

You select multiple consecutive index objects by holding
down the shift key while selecting objects.

You select multiple disparate index objects by holding
down the control key while selecting objects.

Continuous Select this button if you want the page numbering
within the document to be continuous across all reports.

By Section Select this button if you want the page numbering to
restart at `1' at the beginning of each report.
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DOMAINS

Defining Attribute Domains

Description The Domains command, available from the Data Map, Data
Dictionary, Design Map, and Design Dictionary windows, allows you to
add, change, and delete the domain sets for the current encyclopedia.

Usage Tips The domain sets you define with this command appear in the Domain
field in the Add/Update Primary Key, Add/Update Foreign Key,
Add/Update Non-Key Attribute, and Add Data Item dialog boxes.

If you want to define domain sets for encyclopedias that will be created in
the future, use the Encyclopedia Initializer command before you define the
domain sets.

Procedure å  To add a domain set:

1 Choose Domains... from the Attribute or Property menu.

Result: The Domain Sets dialog box appears.

2  Note  Adding a property domain makes that domain available to
attributes.  Adding an attribute domain makes that domain
available to properties.

2 Type a name for the new domain set, then click on Add.

Result: The Add Domain Set dialog box appears.

3 Complete the information requested in the Add Domain Set
dialog box.

To define domain ranges for the Ranges list box, click on Define
Ranges button. The Domain Ranges dialog box  appears.
Complete the dialog box, then click on OK to return to the Add
Domain Set dialog box.

To define allowed values for the Values list box, click on the
Define Values button. The Domain Values dialog box  appears.
Complete the dialog box, then click on OK to return to the Add
Domain Set dialog box.
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To define subdomains for the Subdomains list box, click on the
Add Subdomains button. The Subdomains dialog box appears.
Complete the dialog box, then click on OK to return to the Add
Domain Set dialog box.

4 Click on OK in the Add Domain Set dialog box, then on
Close in the Domain Sets dialog box.

å  To change the settings for an existing domain set:

1 Choose Domain... from the Attribute or Property menu.
Result: The Domain Sets dialog box appears.

2 Highlight the name of the domain set you want to change,
then click on Change.

Result: The Edit Domain Set dialog box appears.

3 Complete the Edit Domain Set dialog box.

To change the domain ranges in the Ranges list box, click on
Define Ranges button. The Domain Ranges dialog box  appears.
Complete the dialog box, then click on OK to return to the Edit
Domain Set dialog box.

To change the allowed values in the Values list box, click on the
Define Values button. The Domain Values dialog box appears.
Complete the dialog box, then click on OK to return to the Edit
Domain Set dialog box.

To change the subdomains in the Subdomains list box, click on
the Add Subdomains button. The Subdomains dialog box appears.
Complete the dialog box, then click on OK to return to the Edit
Domain Set dialog box.

4 Click on OK in the Edit Domain Set dialog box, then
Close in the Domain Sets dialog box.
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å  To delete a domain set:

1 Choose Domain... from the Attribute or Property menu.

Result: The Domain Sets dialog box appears.

2 Highlight the name of the domain set you want to delete, then
click on Delete.

If the domain set is referenced by any encyclopedia objects, a
message appears informing you of this. You may not delete a
domain set that is used by objects in the encyclopedia.

å To combine two domain sets:

1 Choose Domain…  from the Attribute or Property menu.

Result:  The Domain Sets dialog box appears.

2 Click on Combine.

Result:  The Combine Domain Sets dialog box appears.

3 Select the Source Domain from the drop-down list.  Select
the Target Domain from the drop-down list.

4 Click on Combine.



361

Domain Sets Dialog Box

Dialog Box
Illustration

                 Domain Sets Dialog Box

Dialog Box Use the information below to complete the Domain Sets dialog box.
Components

Component         Description                                                                 
Name Type a name for the new domain set into this box.

Domain Sets This box contains a list of the domain sets that have
been defined.

Close Use this button when you are finished adding,
changing, and deleting domain sets.

Add Use this button to add a new domain set.

When you click on this button, the Add Domain Set
dialog box appears.

Change Use this button to change a domain set listed in the
Domain Sets list box. Highlight a domain set name, then
click on this button to change its settings.

When you click on this button, the Edit Domain Set
dialog box appears.
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Delete Use this button to delete a domain set from the
Domain Sets list box. Highlight a domain set name, then
click on this button to delete it.

Combine Use this button to combine two domain sets.

When you click on this button, the Combine Domain
Sets dialog box appears.

Combining one domain into another will move all
attributes and data items that use the Source domain to the
Target domain.  Domains must have the same logical data
type in order for them to be combined.  All of the data
items will inherit the domain implementations of the
Target domain in the process.  Once the Combine has
been completed, all links to the source domain have been
moved to the Target domain and the Source domain can
be deleted.
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Add Domain Set Dialog Box

Dialog Box
Illustration

                            

            Add Domain Set Dialog Box

Dialog Box Use the information below to complete the Add Domain Set
Components dialog box.

Component         Description                                                                 
Name Type the name of the new domain set into this box.

The name may contain up to 51 characters.

Purpose Type a purpose for the domain set into this text box.

Data Type Select a data type for the domain set from this drop-
down list.

The list includes all predefined data types, as well as any
defined through the Admin Utility/Table/Data Types
command.

Global Select this checkbox to make the dimension definition
Dimensions (length and precision) available at the Domain level.
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If checked, all attributes and data items that use the
Domain will inherit the length and precision of the
domain;  no length or precision can be specified for the
attribute or data item.  If unchecked, length and precision
will be available at the attribute level, subject to
characteristics of the data type specified in the data type
selected in the drop-down list above.

Length The number of digits in the domain. A default value
for the selected data type will appear in this box. You may
override the default length by typing a new value over it.

Precision The number of digits to the right of the decimal
point for the domain.

A default value for the selected data type will appear in
this box. You may override the default precision by
typing a new value over it.

Define Ranges Use this button to define one or more ranges for the
domain set. The ranges you define will appear in the
Ranges list box.

When you click on this button, the Domain Ranges dialog
box  appears.

Define Values Use this button to define one or more predefined
allowed values for the domain set. The values you define
will appear in the Values list box.

When you click on this button, the Domain Values dialog
box appears.

Add Use this button to define subdomains for the domain
Subdomains set.

When you click on this button, the Subdomains dialog
box appears.

Ranges This list box contains the ranges defined for the
domain set through the Define Ranges button.
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Values This list box contains the values defined for the
domain set through the Define Values button.

Subdomains This list box contains the subdomains defined for the
domain set through the Add Subdomain button.
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Domain Ranges Dialog Box

Dialog Box
Illustration

                                 

                               Domain Ranges Dialog Box

Dialog Box Use the information below to complete the Domain Ranges
Components dialog box.

Component         Description                                                                 
Min Type a minimum range value for the domain set in

this box. You may type a negative or positive value.

Max Type a maximum range value for the domain set in
this box. You may type a negative or positive value.

Ranges The ranges defined for the domain set are listed in
this box.

Add Use this button to add Min and Max values as
ranges for the domain set. Type values into the Min and
Max boxes, then click on this button. The values appear in
the Ranges list box.

Change Use this button to change a range in the Ranges list
box. Highlight the range you want to change, change the
range values in the Min and Max fields, then click on this
button to change the defined range.
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Delete Use this button to delete a range in the Ranges list
box. Highlight the range you want to delete, then click on
this button to delete the selected range.
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Domain Values Dialog Box

Dialog Box
Illustration

                                        

                              Domain Values Dialog Box

Dialog Box Use the information below to complete the Domain Values dialog
Components box.

Component         Description                                                                 
Value Type an allowed value for the domain set into this

box.

Values This box contains a list of the allowed values defined
for the domain set.

Add Use this button to add a value to the Values box.
Type a value into the Value field, then click on this
button.

Change Use this button to change a value in the Values list
box. Highlight the value you want to change, change its
value in the Value box, then click on this button.

Delete Use this button to delete a value from the Values list
box. Highlight the value you want to delete, then click on
this button to delete the value.
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Subdomains Dialog Box

Dialog Box
Illustration

                                    

                Subdomains Dialog Box

Dialog Box Use the information below to complete the Subdomains dialog
Components box.

Component         Description                                                                 
Domain Select the name of the domain you want to define as

a subdomain from this drop-down list. The list includes
all defined domains for the current encyclopedia.

Subdomains This list contains all domains defined as subdomains
for the current domain set.

Add Use this button to add a new domain to the
Subdomain list. Select a domain from the Domain drop-
down list box, then click on this button to add it to the
Subdomains box.

Delete Use this button to delete a domain from the
Subdomains list box. In the Subdomains box, highlight
the name of the domain you want to delete, then click on
this button.
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Combine Domain Sets Dialog Box

Dialog Box
Illustration

             Combine Domain Sets Dialog Box

Dialog Box Use the information below to complete the Combine Domain
Components Sets dialog box.

Component         Description                                                                 
Source Select the source domain from the drop-down list.
Domain

Target Select the target domain from the drop-down list.
Domain
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EDIT ACCESS MECHANISM

Editing Access Mechanisms

Description The Edit Access Mechanism command, available from the Design
Dictionary and Design Map windows, allows you to edit an access
mechanism for a data structure.

Usage Tips You may edit only access mechanisms with this command.  If you
want to edit a storage access mechanism, use the Edit Storage
command on the Access menu.

Procedure å  To edit an access mechanism in the Design Dictionary window:

1 In the Design Dictionary’s Access Mech field,
highlight the access mechanism you want to edit.

2 Choose Edit…  from the Access menu.

Result:  The dialog box for editing the access mechanism
appears.  The dialog box that appears depends on the type
of access mechanism highlighted in the Design Dictionary
window.

3 Edit the information in the dialog box, then click on OK.

For information on the fields in the various access mechanism
dialog boxes, see Add Access Mechanism in this manual.

å To edit an access mechanism in the Design Map window:

1 Select the access mechanism you want to edit.

2 Choose Edit…  from the Access menu.
or
Double click on the access mechanism.
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Result:  The dialog box for editing the access mechanism
appears.  The dialog box that appears depends on the type of
access mechanism highlighted in the Design Map window.

3 Edit the information in the dialog box, then click on OK.

For information on the fields in the various access mechanism
dialog boxes, see Add Access Mechanisms in this manual.
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EDIT ASSOCIATION

Editing Associations

Description The Edit Association command, available from both the Data Map and
Data Dictionary windows, allows you to edit an association between two
entities in the current model view.

Usage Tips Use the Edit Association command to:
o   Change the association's type
o   Edit the purpose of the association
o   Reverse the left and right entities in the association

This command is available for multiple selected entities in the Data Map
window. See the User's Guide for instructions on selecting multiple entities
in the Data Map window.

In the Data Dictionary window, this command is available for the currently
displayed entity only.

Procedure å  To edit an association for one or more selected entities from the
Data Map window:

1 Select the entities for which you want to update associations.

2 Choose Edit... from the Association menu.

Result: The Select Association dialog box appears.

3 Highlight the association or associations you want to
edit, then click on OK.

Result: The Edit Association dialog box appears.

4 Edit the information in the Edit Association dialog box
(see Add Association in this manual for a description of the dialog
box components), then click on OK.

Result: If you selected multiple associations, the Edit Association
dialog box for the next selected association appears. (Repeat this
step for each selected association.)
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If you selected multiple entities, the Select Association dialog box
for the next selected entity appears. (Repeat steps 3-4 for each
selected entity.)

Otherwise, the Data Map window redisplays.

å  To edit an association for the current entity in the Data
Dictionary window:

1 In the Data Dictionary window's Associations
field, highlight the association you want to edit, then choose Edit...
from the Association menu.

Result: The Edit Association dialog box appears.

2 Edit the information in the Edit Association dialog box
(see Add Association in this manual for a description of the dialog
box components), then click on OK.
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EDIT ATTRIBUTE

Editing Attributes

Description The Edit Attribute command, available from both the Data Map and
Data Dictionary windows, allows you to edit the details associated with an
attribute.

Usage Tips This command is available for multiple selected entities in the Data
Map window. See the User's Guide for instructions on selecting multiple
entities in the Data Map window.

In the Data Dictionary window, this command is available for the currently
displayed entity only.

Procedure å  To edit an attribute for selected entities in the Data Map
window:

1 Select the entity or entities that contain the attributes
you want to edit.

2 Choose Edit... from the Attribute menu.

Result: The Select Attribute dialog box appears.

3 Select the attribute or attributes you want to edit, then
click on OK.

Result: Depending on the type of attribute selected, the Edit
Primary Key, Edit Foreign Key, or Edit Non-Key Attribute dialog
box for the first selected attribute appears.

4 Complete the dialog box (see Add Attribute for a description
of the fields in each type of dialog box), then click on OK.

Result: If you selected multiple attributes, the dialog box for the
next selected attribute appears. (Repeat this step for the next
selected attribute.)

If you selected multiple entities, the Select Attribute dialog box for
the next selected entity appears. (Repeat steps 3-4 for each selected
entity.)
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Otherwise, the Data Map window redisplays.

å  To edit an attribute for the currently displayed entity in the Data
Dictionary window:

1 In the Data Dictionary window, highlight the name of the
attribute you want to edit, then choose Edit... from the Attribute
menu.

Result: The Edit Attribute dialog box for the selected attribute
appears.

2 Edit the details in the Edit Attribute dialog box (see
Add Attribute for a description of these fields), then click on OK.
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EDIT BUSINESS EVENT

Editing Business Events

Description The Edit Business Event command, available from the Process
Hierarchy window, allows you to edit a business event in the process
model.

Usage Tips You may also edit business events through the Planning Outline
window and the Statement Editor window. Any planning statement
assigned the business event type is a business event.

Procedure å  To edit a business event:

1 Choose Edit... from the Event menu.

Result: The Edit Business Event dialog box appears.

2 Update the information in the Edit Business Event dialog
box (see Add Business Event for a description of dialog box
components), then click on OK.
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EDIT CONTROL

Editing Controls

Description The Edit Control command, available from the Process Map window,
allows you to edit the condition and result (success or failure) of a stop
control in the current process.

Usage Tips Since parallel controls and condition ends have no details to edit,
this command is not used to edit those process model components.

Procedure å  To edit the selected process stop in the current process:

1 Choose Edit... from the Control menu.

Result: The Edit Stop Control dialog box appears.

2 Edit the information in the Edit Stop Control dialog box
(see Add Stop Control for a description of dialog box
components), then click on OK.
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EDIT CONTROL FLOW

Editing Control Flows

Description The Edit Control Flow command, available from the Process Map
window, allows you to edit one or more control flows in the currently
displayed process in the Process Map window.

Usage Tips To select a single control flow, click on the control flow line so that a
solid rectangle appears in the center of the line.

You may also  select control flow by holding down the left mouse button
and dragging the mouse cursor down and across the control flow you want
to select.

Procedure å  To edit one or more selected control flows:

1 Choose Edit... from the Flow menu.

Result: The Edit Control Flow dialog box appears.

2 Update the information in the Edit Control Flow dialog box
(see Add Control Flow in this manual for a description of dialog
box components), then click on OK.



380

EDIT DATA ITEM

Editing Data Items

Description The Edit Data Item command, available from the Design Dictionary
and Design Map window, allows you to edit a data item for the
currently displayed data structure.

Usage Tips You may also edit a data item by double-clicking on it in either the
Design Dictionary or Design Reference window.

Procedure å  To edit a data item for the currently displayed data structure
in the Design Dictionary window:

1 In the Design Dictionary window's Data Items field,
highlight the data item you want to edit.

2 Choose Edit... from the Property menu.

Result: The Edit Data Item dialog box appears.

3 Update the information in the Edit Data Item dialog box (see
Add Data Item for a description of dialog box components), then
click on OK.

å  To edit a data item for the currently displayed data structure in the
Design Map window:

1 Select a data structure.

2 Choose Edit…  from the Property menu.

Result:  The Select Design Object Property dialog box
appears.

3 Select the property you wish to edit and click on OK.

Result:  The Edit Data Item dialog box appears.

4 Update the information in the Edit Data Item dialog box (see
Add Data Item for a description of the dialog box
components), then click on OK.
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EDIT DATA STRUCTURE

Editing Data Structures

Description The Edit Data Structure command, available from the Design
Dictionary and Design Map windows, allows you to edit the current or
selected data structures.

Usage Tips You may also edit a data structure by double-clicking on it in either
the Design Dictionary or Design Reference window.

In the Design Dictionary and Design Map windows, this command is
available for multiple selected data structures. See Select Data Structures in
this manual for instructions on selecting multiple data structures.

Procedure å  To edit the current or selected data structures:

1 Choose Edit... from the Design Object menu.

Result: The Edit Data Structure dialog box appears.

2 Update the information in the Edit Data Structure dialog box
(see Add Data Structure in this manual for dialog box fields), then
click on OK.

Result: If you selected multiple data structures, the Edit Data
Structure dialog box for the next selected data structure appears.
(Repeat step two for each selected data structure.)

Otherwise, the Design Dictionary or Design Map window
redisplays.
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EDIT DATA STRUCTURE
 MANAGER

Editing the Data Structure Manager

Description The Data Structure Manager command, available from the Table
menu of the Visible Advantage  Admin Utility, allows the system
administrator to specify the storage and to manipulate data in the
implemented system.

Procedure å  To edit a data structure manager:

1 Choose the Visible Advantage Admin Utility from the
Program Manager window.

2 Select the Table menu.

3 Choose the Data Structure Managers option from the
Table menu.

Result:  A list of the available Data Structure Managers appears.

This list includes Visible Advantage predefined Data Structure
Managers: DBS, Microsoft SQL (Sybase), or Oracle, and any user-
defined data structure managers.

4 Highlight the Data Structure Manager to be edited.

To edit , either double click on the highlighted item or click on the
Change option.

Result:  The Edit Data Structure Manager dialog box appears.  (See
Data Structure Managers for information on dialog box fields.)
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EDIT DATA STRUCTURE
RELATIONSHIP

Editing Data Structure Relationships

Description The Edit Data Structure Relationship command, available from the
Design Dictionary and Design Map windows, allows you to edit a
relationship for the current data structure.

Procedure å  To edit a data structure relationship for the current data
structure in the Design Dictionary window:

1 In the Design Dictionary window's Relationships
field, highlight the relationship you want to edit.

2 Choose Edit... from the Relationship menu.

Result: The Edit Relationship dialog box appears.

3 Update the information in the Edit Relationship dialog box
(see Add Relationship for information on dialog box fields),
then click on OK.

å  To edit a data structure relationship for the current data
structure in the Design Map window:

1 Select one or more data structures.

2 Choose Edit…  from the Relationship menu.

Result:  The Select Design Object Relationship dialog
box appears.

3 Select the relationship you wish to edit.

Result:  The Edit Relationship dialog box appears.

4 Update the information in the Edit Relationship dialog
box (see Add Relationship for information on dialog box
fields), then click on OK.
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EDIT ENTITY

Editing Entities

Description The Edit Entity command, available from both the Data Map and Data
Dictionary windows, allows you to edit details for an entity in the current
model view.

Usage Tips This command is available for multiple selected entities in both the
Data Map and Data Dictionary window. See the User's Guide for
instructions on selecting multiple entities in these windows.

In the Data Map window, you may edit a single entity by double-clicking
on it. In the Data Dictionary window, you may edit a single entity by
double-clicking on its name in the Entity field.

Procedure å  To edit the details for selected entities in the Data Map or Data
Dictionary window:

1 Select the entities you want to edit.

2 Choose Edit... from the Entity menu.

Result: The Edit Entity dialog box for the first selected entity
appears.

3 Edit the information in the Edit Entity dialog box (see Add
Entity for a description of the dialog box fields), then click on OK.

Result: If you selected multiple entities, the Edit Entity dialog box
for the next selected entity appears. (Repeat this step for each
selected entity.)

Otherwise, the active window redisplays.
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EDIT MODEL VIEW

Editing Model Views

Description The Edit Model View command allows you to edit the name, purpose,
type, or business level of selected model views in the Model View
Hierarchy window or the current model view in any other window. This
command is available from all windows except the main Visible Advantage
window, the Encyclopedia Management windows, the Statement Editor
window, the Database Design window and the System Building window.

Usage Tips You can use this command to edit multiple selected model views in the
View Hierarchy window. See the User's Guide  for instructions on selecting
multiple model views in the Model View Hierarchy window.

In any other window, this command is available for the current model view
only.

Procedure å  To edit the details of selected model views in the Model View
Hierarchy window:

1 Choose Edit... from the View menu.

Result: The Edit View dialog box appears for the first selected
model view.

2 Edit the information in the Edit View dialog box (see
Add Model View in this manual for a description of the dialog box
fields), then click on OK.

Result: If you selected multiple model views, the Edit View dialog
box for the next selected model view appears. (Repeat the previous
step for each selected model view.)

Otherwise, the Model View Hierarchy window redisplays.

å  To edit a model view's details from any other window,
including non-design phase windows:

1 Choose Edit... from the View menu.
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Result:  The Edit View dialog box appears.

2 Edit the information in the Edit View dialog box (see
Add View in this manual for a description of the dialog box fields),
then click on OK.
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EDIT PROCESS

Editing Processes

Description The Edit Process command allows you to edit a business process or
data access process. This command is available from both the Process
Hierarchy and Process Map windows; however, in the Process Hierarchy
window, you may edit only business processes.

Usage Tips This command is available for multiple selected processes in the
Process Hierarchy window. In the Process Map window, this command is
available for the current process only.

Procedure å  To edit selected processes in the Process Hierarchy window:

1 Choose Edit... from the Process menu.

Result: The dialog box for updating the first selected process
appears. This may be the Edit Business Process dialog box or the
Edit Data Access Process dialog box, depending on the type of the
first selected process.

2 Complete the Edit Business Process dialog box or Edit Data
Access Process dialog box, then click on OK. See Add Process in
this manual for descriptions of dialog box components.

Result: If you selected multiple processes, the dialog box for
editing the next selected process appears. (Repeat this step for each
selected process.)

å  To edit the current process in the Process Map window:

1 Choose Edit... from the Process menu.

Result: The dialog box for updating the current process appears.
This may be the Edit Business Process dialog box or the Edit Data
Access Process dialog box, depending on the type of the current
process.
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2 Complete the Edit Business Process dialog box or Edit Data
Access Process dialog box, then click on OK. See Add Process in
this manual for descriptions of dialog box components.
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EDIT PROCESS STEP

Editing Process Steps

Description The Edit Process Step command, available from the Process Map
window, allows you to edit the details for selected steps in the current
process.

Procedure å  To edit the selected process steps:

1 Choose Edit...  from the Step menu.

Result: The dialog box for editing the first selected step appears.

2 Edit the information in the dialog box, then click on
OK.

See Add Process Step in this manual for descriptions of dialog box
components.
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EDIT SESSION

Editing Session Details

Description The Edit Session command allows you to edit the title, type, and/or
notes for the current session. This command is available from all windows.

Procedure å  To edit the current session's details:

1 Choose Sessions from the Encyclopedia menu on the main
Visible Advantage window.
or
Choose Encyclopedia Management from the main menu on
any other menu, then choose Sessions from the cascading menu.

2 Choose Edit... from the cascading menu for the Sessions
command.

Result:  The Edit Session dialog box appears.

3 Complete the Edit Session dialog box (see New Session for a
description of the fields in this dialog box), then click on
OK.
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EDIT STATEMENT

Editing Planning Statements

Description The Edit Statement command, available from both the Planning
Outline and Planning Dictionary windows, allows you to edit the title, type,
and/or text of the selected statements in the Planning Outline window or
current planning statement in the Planning Dictionary window.

Usage Tips This command is available for multiple selected statements in both the
Planning Outline and Planning Dictionary windows. See the User's Guide
for information on selecting multiple statements in these windows.

When you edit a statement assigned the type business event, the changes
will affect the business event in the Process Hierarchy window, as well as in
the planning windows.

For more extensive editing capabilities, such as search and replace and
character formatting, use the Statement Editor window to add and edit
statements. You access the Statement Editor window through the Statement
Editor command on the Plan menu.

Procedure å  To edit selected planning statements in the Planning Outline or
Planning Dictionary window:

1 Choose Edit... from the Statement menu.

Result: The Edit Planning Statement dialog box appears.

2 Edit the information in the Title and Type fields, if
necessary, and the text of the statement in the large text box.

3 Click on OK.

Result: If you selected multiple statements, the Edit Planning
Statement dialog box for the next selected statement appears.
(Repeat steps 2 and 3 for each selected statement.)

Otherwise, the active planning window redisplays.
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EDIT STORAGE ACCESS
 MECHANISM

Editing Storage Access Mechanisms

Description The Edit Storage Access Mechanism command, available from the
Design Dictionary and Design Map windows, allows you to edit the storage
access mechanism for the current data structure.

Usage Tips You may edit only storage access mechanisms with this command. If
you want to edit a standard access mechanism, use the Edit command on the
Access menu.

Procedure å  To edit the storage access mechanism for the current data
structure in the Design Dictionary window:

1 Choose Edit Storage... from the Access menu.

Result: The dialog box for editing the storage access mechanism
defined for the current data structure appears. The dialog box that
appears depends on the type of access mechanism added to the
data structure.

2 Edit the information in the dialog box, then click on
OK.

For information on the fields in the various access mechanism
dialog boxes, see Add Storage Access Mechanism in this manual.

å  To edit the storage access mechanism for the current data
structure in the Design Map window:

1 Select the storage access mechanism and then choose Edit
Storage…  from the Access menu.
or
Double click on the storage access mechanism.

Result:  The dialog box for editing the storage access
mechanism defined for the current data structure appears.
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The dialog box that appears depends on the type of access
mechanism added to the data structure.

2 Edit the information in the dialog box, then click on OK.

For information on the fields in the various access mechanism
dialog boxes, see Add Storage Access Mechanism in this
manual.
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EDIT USER

Editing User Accounts

Description The Edit User command, available from the Visible Advantage
Admin Utility, allows a system administrator to edit the logon, password,
name, user group, privilege (standard user or system administrator), or
status (active or inactive) of an authorized user of the current encyclopedia.

Usage Tips Only system administrators may use the Visible Advantage
Admin Utility.

Procedure å  To edit the information for an existing user:

1 Choose Edit... from the User menu.

Result:  The Select User dialog box appears.

2 From the Logon list box, select the logon of
the user you want to edit. The list includes the logons of all active
and inactive users of the encyclopedia.

3 Click on OK.

Result: The Edit User dialog box appears.

4 Complete the Edit User dialog box (see Add User for a
description of the dialog box fields), then click on OK.
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EDIT USER GROUP

Editing User Groups

Description The Edit User Group command, available from the Visible
Advantage Admin Utility, allows the system administrator to edit the name
and purpose of a user group.

Procedure å  To edit a user group:

1 Choose Edit... from the Group menu.

Result: The Select Group dialog box appears.

2 Select the name of the group you want to edit, then click on
OK.

Result: The Edit User Group dialog box appears.

3 Edit the name and purpose of the user group, then click on
OK.
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EDIT VALID WORD

Editing Valid Words
Description The Valid Words command allows you to edit words in the standard

words dictionary.

Usage Tips The Valid Words command is available from all windows except
Generate SQL Schema.

Procedure å  To edit words in the standard words dictionary:

1 Choose Standard Words Dictionary from the Encyclopedia
menu.

Result:  The Valid Words Dictionary dialog box appears.

2 Choose the word you want to edit, then click on Change.

Result:  The Edit Valid Word dialog box appears.

3 Make the changes, then click on OK.

2 Note  The Edit Valid Word dialog box is the same as the
Add Valid Word dialog box.
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EDIT VIEW

Editing Design Views

Description The Edit View command, available from the Design
Dictionary and Design Map windows, allows you to edit a database design's
name, purpose, and data structure manager (DB2, Oracle, etc.).

Procedure å  To edit the details for the current design view:

1 Choose Edit... from the View menu.

Result: The Edit View dialog box for the current design
view appears.

2  Note  If you want to edit the details for a different design view,
use the Change To command on the Design menu to change to that
design before using the Edit command.

2 Update the information in the Edit View dialog box, then
click on OK.
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Edit View Dialog Box

Dialog Box
Illustration

                                 

                 Edit View Dialog Box

Dialog Box Use the information below to complete the Edit View Dialog Box.
Components

Component         Description                                                                 
Name The name of the view is displayed here.

Purpose The purpose of the view is displayed here.

Model View Select this button for a model view.

Design View Select this button for a design view.

Type Select a type from the drop-down list.
You may select Application Design View
or Database Design View or any user-
configured view.
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Business Select a business level from the drop-down
Level list.

Data Select a data structure manager from the
Structure drop-down list.
Manager
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EDITOR FONT

Changing the Font in an
Editor Window

Description The Editor Font command, available from the Statement Editor
window, allows you to change the font, size, and style for the text that
displays in and prints from the Statement Editor window.

Usage Tips The Statement Editors window appears when you use the Statement
Editor command. The font you select through this command will be used if
you print the displayed statement or session text through the Print command
on the Editor window's File menu.

This command uses the standard Windows dialog box for changing fonts
and font styles. The fonts that appear in the Font dialog box depend on the
fonts installed on your computer. See your Windows documentation for
more information on adding fonts and font sizes in Windows applications.

2  Note  For information on using the Font command, available from the
Planning Outline and any Matrix, see Font in this manual. For information
on using the Report Font command, available from both the main Visible
Advantage and the Report-Viewing windows, see Report Font.

Procedure å  To change the font in the Statement Editor window:

1 Choose Editor Font... from the Format menu.

Result:  The Font dialog box appears.

2 Complete the Font dialog box, then click on
OK.
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Font Dialog Box

Dialog Box
Illustration

                              

                     Font Dialog Box

Dialog Box Use the information below to complete the Font dialog box.
Components

Component         Description                                                                 
Font All fonts installed through Windows are displayed in

this list box. Scroll through the list and highlight the
desired font, or type its name into the Font box.

Font Style The available styles for the selected font appear in
this list box. Highlight the desired style, or type it
into the Font Style box.

Size The available sizes for the font and font style you 
selected appear in this list box. Highlight the desired 
size, or type it into the Size box.

Strikeout Select this checkbox if you want the editor text to
have a strikeout (line through the text) effect.

Underline Select this checkbox to underline the editor text.

Color Select a color from this drop-down list box. The
default color is black.
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ENCYCLOPEDIA
 INITIALIZER

Using the Encyclopedia Initializer

Description The Encyclopedia Initializer command, available from the Visible
Advantage Admin Utility, opens the Encyclopedia Initializer, which allows
the system administrator to change default settings under the Project and
File menus. These default settings will be in effect for all new
encyclopedias.

Usage Tips This command is useful for setting standards for all encyclopedias.
Without this command, you would have to define the desired settings for
each new encyclopedia.

+   Example  A project manager has defined additional planning statement,
session, and model view types. Before creating an encyclopedia, she uses
the Encyclopedia Initializer command to add these types. The types she
defined will now be in effect for all new encyclopedias.

Remember, the changes you make through the Encyclopedia Initializer
command affect only encyclopedias created after this command is used.
These changes are in effect until the next time you change the settings
through the Encyclopedia Initializer command.

Procedure å  To set initial default settings for encyclopedias:

1 Select the Initializer... from the Encyclopedia menu. Only
users defined as system administrators may use this command.

Result: The Visible Advantage Logon dialog box appears.

2 Type in the system administrator Logon, then click on OK.

Result: The Encyclopedia Initializer will open. It looks and works
like any other encyclopedia, except only certain commands are
available.

3 Change the desired settings by choosing the appropriate
command.
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4 Close the Encyclopedia Initializer by creating or opening an
encyclopedia or by closing Visible Advantage Admin.

Result: The changes you made in the Encyclopedia Initializer will
affect all new encyclopedias.
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ENTITY MODE

Design Reference in Entity Mode

Description The Entity Mode command, available from the Design Reference
window, displays the Design Reference window by entity, rather than by
design object, data item, or attribute.

Usage Tips The four modes available in the Design Reference window— design
object, data item, entity, and attribute— allow you to reference the
information in a database design based on that object. Each mode displays
the mode object at the top of the window and all of its referenced objects or
details underneath it.

Procedure å  To run the Design Reference window in Entity mode:

Choose Entity from the Mode menu.

Result: A checkmark appears beside the command name and the Design
Reference window redisplays in Entity mode.

2 Note  If you are in Design Object or Data Item mode, the
Select Model View dialog box appears.  Select the model view, then click
on OK.
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ENTITY-VIEW MATRIX

About the Entity-View
Matrix Window

Description The Entity-View Matrix window allows you to view the model views
in which each entity is visible. You can also add entities to and remove
them from model views through this window. This command is available
from all windows.

Procedure å  To open an Entity-View Matrix window:

1 From the main Visible Advantage window, choose Entity-
View Matrix... from the Data menu.

From any other window, choose Data Modeling from the main
menu, then choose Entity-View Matrix... from the cascading
menu.

Result: The Entity-Model View Matrix dialog box appears.

2 If you want to display entities of all types on the left axis of
the matrix, select the All Entity Types button.

If you want to display entities of selected types, select the Selected
Entity Types button, then click on Select Types in the Left Axis
area. The Entity Types dialog box appears. Select the entity types
you want to display, then click on OK to return to the Entity-
Model View Matrix dialog box.

3 If you want to display model views of all types on the top
axis, select the All Model View Types button.

If you want to display selected model view types, select the
Selected Model View Types button, then click on Select Types.
The Model View Types dialog box appears. Select the
model view types you want to display, then click on OK.

4 If you want to display entities in the entire model, click on
the Entire Model button.
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If you want to display entities in one model view, click on the
Single Model View button, then select the model from the
drop-down list.

5 Click on OK in the Entity-Model View Matrix dialog box.
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EVENT-PROCESS MATRIX

Opening an Event-Process
Matrix Window

Description The Event-Process Matrix window allows you to view the
interrelationships between business events and processes. The process
invoked by each event is shown in the Process Hierarchy window. This
matrix is the only window that shows the multiple events to which each
process responds. This command is available from all windows.

You may also add and edit relationships between events and processes
through this window.

Procedure å  To open an Event-Process Matrix window:

1 From the main Visible Advantage window, choose Event-
Process Matrix... from the Process menu.

From any other window, choose Process Modeling from the main
menu, then choose Event-Process Matrix... from the cascading
menu.

Result: The Select Model View dialog box appears.

2 The Select Model View dialog box contains a list of all model
views defined for the encyclopedia.

If you want to display the model view list in hierarchical order,
select the Structured button. If you want to display the model
view list in alphabetical order, select the Alphabetical button.

3 Highlight the name of the model view that contains the
business events you want to display in the Event-Process Matrix
window. If you want to display all business events in the
encyclopedia, select Entire Model in the Select area.

4 Click on OK.
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EXIT

Exiting Visible Advantage

Description The Exit command, available from the main Visible Advantage
window, allows you to exit Visible Advantage.

Procedure å  To exit from the main Visible Advantage window:

Choose Exit from the File menu.
or
Double-click on Visible Advantage's Control-menu box in the
upper left-hand corner of the window.

å  To exit Visible Advantage from any other window:

1 Choose Close All from the Window menu.

Result: The main Visible Advantage window appears.

2 Choose Exit from the File menu.
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EXPAND ALL

Expanding All Hierarchy/Outline Levels

Description The Expand All command displays all levels of the hierarchy or
outline, regardless of the model views or statements selected. This
command is available from the View Hierarchy window.

Usage Tips Several symbols can appear inside the model view boxes, statement
icons, and process icons. These symbols let you know whether there are any
levels to expand beneath a model view or statement.
The symbols are explained below.

Symbol                Meaning                                                                     
+ (plus sign) One or more collapsed levels are beneath the object.

- (minus sign) All collapsed levels beneath the object have been
expanded.

 [no symbol] There are no levels beneath the object.

+   Example  In the Planning Outline window, the statement icon has a plus
sign in it; this means that there is at least one contracted statement beneath
it.

Procedure å  To expand all levels of the model view hierarchy:

Choose Expand All from the Hierarchy menu.

å  To expand all levels of the planning outline:

Choose Expand All from the Outline menu.

.
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EXPAND ONE BRANCH

Expanding One
Hierarchy/Outline Branch

Description The Expand One Branch command displays all collapsed levels of the
model view hierarchy or planning outline beneath one or more selected
model views or statements. This command is available from the View
Hierarchy window.

Usage Tips Several symbols can appear inside the model view boxes, statement
icons, and process icons. These symbols let you know whether there are any
levels to expand beneath a model view or statement.
The symbols are explained below.

Symbol                Meaning                                                                     
+ (plus sign) One or more collapsed levels are beneath the object.

- (minus sign) All collapsed levels beneath the object have been
expanded.

 [no symbol] There are no levels beneath the object.

+   Example In the Planning Outline window the statement icon has a plus
sign in it; this means that there is at least one contracted statement beneath
it.

Procedure å  To expand all levels of the view hierarchy beneath selected
views:

Choose Expand One Branch from the Hierarchy menu.

å  To expand all levels of the planning outline beneath selected
statements:

Choose Expand One Branch from the Outline menu.
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EXPAND ONE LEVEL

Expanding One
Hierarchy/Outline Level

Description The Expand One Level command displays a collapsed level of the
model view hierarchy or planning outline hierarchy beneath one or more
selected model views or statements. This command is available from the
View Hierarchy window.

Usage Tips Several symbols can appear inside the model view boxes, statement
icons, and process icons. These symbols let you know whether there are any
levels to expand beneath a model view or statement. The symbols are
explained below.

Symbol                Meaning                                                                     
+ (plus sign) One or more collapsed levels are beneath the object.

- (minus sign) All collapsed levels beneath the object have been
expanded.

 [no symbol] There are no levels beneath the object.

+   Example  If in the Planning Outline window the statement icon has a
plus sign in it, there is at least one contracted statement beneath it.

Procedure å  To expand the first level of the view hierarchy beneath
selected views:

Choose Expand One Level from the Hierarchy menu.

å  To expand the first level of the planning outline beneath
selected statements:

Choose Expand One Level from the Outline menu.
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EXPORT

Exporting Encyclopedias

Introduction The Export command allows you to export an encyclopedia to a VSC file or
a Microsoft Access (.mdb) file from a Visible Advantage encyclopedia.
These files are produced by other Visible products (VSC files), by another
CASE tool, from scratch using a text editor, or from a previously performed
Visible Advantage export (.mdb files).

Usage Tips Export is the only function within the Utilities menu that can be
performed a user who is not a system administrator.  Any user may
export data from the encyclopedia.

When you export information from a Visible Advantage encyclopedia, you
log into the source encyclopedia, specify the portion of the encyclopedia
you want to export (entire model or selected model views), then select the
destination location for the files you will export.

Exported Files The files you Export from Visible Advantage will default to these
Files names and will default to the directory in which the encyclopedia is stored:

VSC export.ad
Access imp-exp.mdb

The Exported After you export an encyclopedia to VSC or .mdb format, you can
Information then import it into another CASE tool or, if applicable, back into Visible

Advantage.

To import the files back into Visible Advantage, use the Import command
under the Import menu in the Visible Advantage Utilities program

Warning! VSC files may not support all of the configurable options that
you have selected in Visible Advantage.  To export and then re-import data,
use the .mdb format.  If you export to .ad and then import back into Visible
Advantage, you may lose something in the translation.
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Procedure å  To export an encyclopedia to a VSC file:

1 Choose To VSC File from the Export menu.

Result:  The Select Encyclopedia dialog box appears.

2 Complete the Select Encyclopedia dialog box and click on
OK.

Result:  The Logon dialog box appears.

3 Complete the Logon dialog box and click on OK.

Result:  The Model View dialog box appears.

4 Complete the Model View dialog box and click on OK.

Result:  The Save As dialog box appears.

5 Complete the Save As dialog box and click on OK.

Result:

The encyclopedia is exported.
or
If there are undefined domains, the Domain Data Type dialog
box appears.  Select a domain type from the drop-down list,
and click on OK to export the encyclopedia.

å To export an encyclopedia to Access:

1 Choose To Access from the Export menu.

Result:  The Select Encyclopedia dialog box appears.

2 Complete the dialog box and click on OK.

Result:  The Logon dialog box appears.
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3 Complete the Logon dialog box and click on OK.

Result:  The Save As dialog box appears.

4 Complete the Save As dialog box and click on OK.

Result:  The export file is created.
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Model View Dialog Box

Dialog Box
Illustration

         Model View Dialog Box

Dialog Box Use the information below to complete the Model View dialog box.
Components

Component         Description                                                                 
Selected Select this button to export selected model views.
Model View When you select this button, the Select View button

is available.

Select View Click on this button to display the Select Views
dialog box.  Select the views and click on OK.

Entire Select this button to export the entire encyclopedia.
Encyclopedia
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FIND

Finding Text

Description The Find command allows you to locate a text string in text displayed
in the Statement Editor or Report-Viewing windows.

Usage Tips The Statement Editor window appears when you use the Statement
Editor command.  The Report-Viewing window appears when you generate
a report and route its output to the screen.

This command operates on the text either before or after the current cursor
position. If you want to search the entire statement or session text, place the
text cursor at the beginning of the statement or session text and choose
Down in the Direction area of the Find dialog box.

Procedure å To find a text string in the text displayed in the
Statement Editor or Report-Viewing windows:

1 Choose Find... from the Search menu.

Result: The Find dialog box appears.

2 Complete the Find dialog box, then click on Find Next to
have Visible Advantage search for the text you specified.

Result: If a match is found, the first occurrence of the specified
text is highlighted in the active window. You may repeat this step
to find each successive occurrence of the specified text.

If no match is found, the message No more matching strings were
found appears. Click on OK to return to the Find dialog box.

3 When you are finished searching for the text string, click on
Close in the Find dialog box.
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Find Dialog Box

Dialog Box
Illustration

                                    

                        Find Dialog Box

Dialog Box Use the information below to complete the Find dialog box.
Components

Component         Description                                                                 
Find What Type the text string you want to find inside this box.

Match Whole Select this checkbox if you would like to find an
Word Only exact match for the entire string for which you are

searching. Otherwise, the search will find occurrences of
the text string that are part of other words, as well as those
that appear as separate words.

+  Example If you specify the word `inform' in the Find
What box and do not select the Match Whole Word
Only checkbox, Visible Advantage will find the word
`information', as well as the word `inform'. If you do
select the Match Whole Word Only checkbox, Visible
Advantage will narrow its search to occurrences of the
word `inform' only.

Match Case Select this checkbox if you would like to find only
those occurrences of the specified text string that match
the case (upper-, lower-, or mixed-case) of the text you
typed in the Find What box.

Otherwise Visible Advantage will find occurrences of the
text string that use any combination of upper- and lower-
case letters.
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Up Select this button to search the text before the
current cursor position in the Text Editor window.

Down Select this button to search the text after the current
cursor position in the Text Editor window.

Find Next Click on this button to find the next occurrence of
your selected string.
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FIND NEXT

Finding Next Text Occurrences

Description The Find Next command allows you to locate in the active
Statement Editor or Report-Viewing windows subsequent occurrences of
the text string last specified through the Find command on the Search menu.

Usage Tips The Statement Editor window appears when you use the Statement
Editor command. The Report-Viewing window appears when you generate
a report and route its output to the screen.

The Find Next command searches the text after the last located text string.
For information on using the Find command, see Find in this manual.

Procedure å  To find subsequent occurrences of the text last specified
through the Find command:

Choose Find Next from the Search menu.

Result: If a match is found, its occurrence in the text will be highlighted.
You may repeat the command to locate each later occurrence of the text
string.

If no further matches are found, the message No more matching strings
were found appears.
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FIND PREVIOUS

Finding Previous Text Occurrences

Description The Find Previous command allows you to locate in the active
Statement Editor or Report-Viewing windows previous occurrences of the
text string last specified through the Find command on the Search menu.

Usage Tips The Statement Editor window appears when you use the Statement
Editor command. The Report-Viewing window appears when you generate
a report and route its output to the screen.

The Find Previous command searches the text before the last located text
string. For information on using the Find command, see Find in this manual.

Procedure å  To find previous occurrences of the text string last specified
through the Find command on the Search menu:

Choose Find Previous from the Search menu.

Result: If a match is found, the first occurrence will be highlighted in the
active window. You may repeat the command to search for each previous
occurrence of the text string.

If no previous matches are found, the message No more matching strings
were found appears.
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FONT

Changing a Window's Display Font

Description The Font command allows you to change the font size or style for
display text. This command is available from the following windows: View
Hierarchy, Planning Outline, Data Map, Design Map, or any matrix.

Usage Tips Font information for each window is stored with the current window,
rather than with the current model view or encyclopedia. This means that if
you change the font for a specific window, the font you choose will remain
active not only for the current model view and the current encyclopedia, but
also for any new encyclopedias you subsequently create.

This command uses the standard Windows dialog box for changing fonts,
font styles, and font sizes. The fonts that appear in the Font dialog box
depend on the fonts installed through Windows (TrueType, Adobe Type
Manager, or other package). See your Windows documentation for more
information on adding fonts and font sizes in Windows applications.

2 Note  For information on using the Editor Font command, available from
the Statement/Session Editor window, see Editor Font in this manual. For
information on using the Report Font command, available from both the
main Visible Advantage window and the Report-Viewing window, see
Report Font in this manual.

Procedure å  To change the display font from the Design Map and Data
Map windows:

1 Choose Font... from the Display menu.

Result: The Select Fonts dialog box appears.

2 Click on Select Typeface and Style.

Result:  The Font dialog box is displayed.

3 Complete the Font dialog box,  then click on
OK.
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å  To change the display font from other applicable windows:

1 Choose Font…  from the Display menu.

Result:  The Font dialog box is displayed.

2 Complete the Font dialog box, then click on OK.
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Font Dialog Box

Dialog Box
Illustration

                              

         Font Dialog Box

Dialog Box Use the information below to complete the Font dialog box.
Components

Component         Description                                                                 
Font All fonts installed through Windows are displayed in

this list box. Scroll through the list and highlight the
desired font, or type its name into the Font box.

Font Style The available styles (regular, italic, bold, or bold
italic) for the selected font appear in this list box.
Highlight the desired style, or type it into the Font Style
box.

Size The available sizes for the font and font style you
selected appear in this list box. Select the desired size. In
the View Hierarchy , Design Map, and Data Map
windows, the size you select here will not affect the
window display.
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FREEZE ALL OBJECTS

Freezing All Encyclopedia Objects

Description This command freezes all objects in an encyclopedia.  It is not really part of
the Copy, Check-in/Out or Merge process, but rather allows you to use the
freeze feature of Visible Advantage to create backup copies of
encyclopedias that cannot be modified and can serve as reference backup.

This is useful to preserve information in a backed up encyclopedia that is
used for ad-hoc reporting by users who may inadvertently change
information in the encyclopedias when performing inquiries.

Usage Tips The Freeze All  command is part of the Visible Advantage Utility program
that comes with Visible Advantage. To use the Freeze function, click on the
Visible Advantage Utility icon inside the Visible Advantage program
group.  The Freeze command is under the Copy/Merge menu.

The Freeze command generates a Compare Encyclopedia report, detailing
the differences between the two encyclopedias.

2 Note If you want to unfreeze all objects in the encyclopedia,
select the Clear Checked-out function.

Procedure å  To copy all or part of an encyclopedia to another drive or
directory:

1 Choose Freeze All from the Copy/Merge menu of the
Utilities program.

Result: The Open Encyclopedia dialog box appears.

2 Select from the Encyclopedias list box the encyclopedia you want
to copy from. If the encyclopedia is not listed, navigate through the
directories in the Path list box until it appears.

3 Click on OK.

4 Type your logon for the encyclopedia and, if necessary, a
password. Click on OK.
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Result:  If you typed a valid logon and password, the Freeze All
Objects dialog box appears.   The list box displays the
encyclopedia(s) checked out.

Otherwise, an error message appears and you must return to the
logon dialog box to type a different logon.

5 Click on OK to freeze the objects.
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Freezing and Unfreezing Concepts

Freezing When you check-out an encyclopedia, you check-out one or more
Objects selected views.  After you complete the check-out operation, the

checked-out objects are frozen in the encyclopedia from which they were
copied.  The objects that were copied out in the subset but not checked out
(usually for viewing and modeling perspective purposes) are frozen in the
subset but not in the primary encyclopedia.  This prevents users from
modifying any objects that have been copied to another drive or directory
for multi-user support, ensuring that any one object is available for update
(i.e., unfrozen) in only one place.

Freezing may also be done on an entire encyclopedia (see Freeze All).  This
is a method of exercising change control over a version of an encyclopedia
that is archived for documentation and/or historical purposes.

Unfreezing Once the checked-out and original encyclopedias have been merged back
Objects together through the Check-in/Merge command, the frozen objects are

automatically unfrozen in the merged encyclopedia.

The Unfreeze/Clear Check-out command may also be used to unfreeze
objects.  This is used when you want to permanently disconnect the
checked-out encyclopedia from the primary encyclopedia and not merge
back in the changes made in the checked-out copy.  Performing this
command against a checked-out encyclopedia will cause Visible Advantage
to function as it the check-out encyclopedia will cause Visible Advantage to
function as if the check-out was never made.

The Unfreeze/Clear Check-out is also used to reverse the Freeze All
command.
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FUNCTIONS

Defining Functions

Description The Functions command allows you to add, change, and delete
functions and operators. You use these functions and operators in derived
attribute formulas during Data Modeling. This command is available from
the following windows: Data Map, Data Dictionary, Design Map, and
Design Dictionary.

Usage Tips You can use any function you add through this command in the Add
Non-Key Attribute dialog box Formula field when defining a derived
attribute in the Data Map, Data Dictionary, Design Map, or Design
Dictionary window.

See the Appendices section of this manual for information on valid syntax
for expressions in data and process modeling windows.

Procedure å  To add a new function:

1 Choose Functions... from the Attribute menu in the Data
Map and Data Dictionary windows, or from the Property menu in
the Design Map and Design Dictionary windows.

Result: The Functions dialog box appears.

2 Type the name of the new function in the Name box, then
click on the Add button.

Result: The Add Function dialog box appears.

3 Complete the Add Function dialog box.

If you want to add a data type to the function argument, select a
data type from the Data Type drop-down list, then click on the
Add button. It will then appear in the Arguments list box.

To change an argument listed in the Arguments list box, highlight
the argument, select a new data type from the Data Type drop-
down list, then click on the Change button.
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To delete an argument in the Arguments list box, highlight it and
then click on the Delete button.

4 Click on OK in the Add Function dialog box.

Result: The Functions dialog box appears.

5 If necessary, repeat the above steps to add more functions to
the encyclopedia.

When you are finished adding functions, click on Close in the
Functions dialog box.

å  To delete a function:

1 Choose Functions... from the Attribute menu
in the Data Map and Data Dictionary windows, or from the
Property menu in the Design Map and Design Dictionary
windows.

Result: The Functions dialog box appears.

2 Highlight the name of the function you want to delete, then
click on the Delete button.

If the function is referenced by any encyclopedia objects, a
message appears informing you of this. You may not delete any
functions used by encyclopedia objects.

å  To change a function:

1 Choose Functions... from the Attribute menu in the Data
Map and Data Dictionary windows, or from the Property menu in
the Design map and Design Dictionary windows.

Result: The Functions dialog box appears.

2 Highlight the name of the function you want to change, then
click on the Change button.

Result: The Edit Function dialog box appears.
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3 Change the information in the Edit Function dialog box.

If you want to add a data type to the function argument, select a
data type from the Data Type drop-down list, then click on the
Add button. It will then appear in the Arguments list box.

To change an argument listed in the Arguments list box, highlight
the argument, select a new data type from the Data Type drop-
down list, then click on the Change button.

To delete an argument in the Arguments list box, highlight it and
then click on the Delete button.

4 Click on OK in the Add Function dialog box.

Result: The Functions dialog box appears.

5 Click on Close when you are finished editing functions.
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Functions Dialog Box

Dialog Box
Illustration

                                 

                 Functions Dialog Box

Dialog Box Use the information below to complete the Functions dialog box.
Components

Component         Description                                                                 
Name Type the name of the function or operator you would

like to add, change, or delete. If the function exists, you
may select it from the large list box beneath the Name
box.

In the large list box, the name of the function or operator
is typically the only part of the string that is not enclosed
in parentheses.

The first parentheses contain the data type of the function
(numerical, character, etc.). The second parentheses
contain the data type of each of the function's arguments;
if an argument is an entity, the word  ENTITY  is listed
along with the other arguments.

You may use where clauses, and parentheses may be used
to establish precedence. For a complete list of allowed
symbols, see the Appendix.
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+  Example  The user-defined function Count (ENTITY,
where EMPLOYEE.job code = JOB.job code)) is a
function named Count that counts all occurrences of an
entity where the attribute job code is equal to another
entity's occurrence of that attribute.

2 Note  There may be functions and operators with the
same name that involve different data types.

Functions Select this checkbox if you want to list all defined
functions in the list box (count, sum, etc.).

Unary Select this checkbox if you want to list all defined
Operators unary operators in the list box (positive, negative,

etc.).

Binary Select this checkbox if you want to list all defined
Operators binary operators in the list box (greater than, less

than, addition, subtraction, etc.).

2 Note  You can select multiple checkboxes. For
example, if you want to display all functions and
operators, select all three checkboxes. If you want to
display a list of all operators only, select the Unary
Operators and Binary Operators checkboxes.

Add Click on this button to add a new function to the list.
The Add Function dialog box appears.

Change Select a function or operator from the list box, then
click on this button to edit its settings. The Edit Function
dialog box appears.
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Delete Select a function or operator from the list box, then
click on this button to delete it. You may not delete a
function or operator that is being used in the
encyclopedia.
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Add Function Dialog Box

Dialog Box
Illustration

    Add Function Dialog Box

Dialog Box Use the information below to complete the Add Function dialog
Components box.

Component         Description                                                                 
Name Type the name of the new function in this box. If you

selected a function in the Functions dialog box before you
clicked on Add, this box will contain the name of the
selected function.

Purpose Type the purpose of the new function in this box.
The purpose is especially important if the name of the
function or operator is a symbol.

Data Type Choose a data type from this drop-down list.  The
data types of the function's arguments will be displayed in
brackets behind its name in the Functions dialog box.
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The drop-down list will include all defined data types. If
you want to add new data types, use the Admin
Utility/Table/Data Types command.

Literal Check this box if the function is to be a literal.

Value Select this button if the function argument is a value.
This is the default setting. You may then select a data type
from the Data Type list box below and add the argument
to the Arguments list.

Entity Select this button if the function argument is an
entity. When you click on this button, the Data Type list
box below will be dimmed.

Add Click on this button to add the argument you defined
through the Value, Entity, and/or Data Type settings.

Change Select an argument from the Arguments list, change
the Value, Entity, and/or Data Type settings, then click
on this button to make the changes.

Delete Select an argument from the Arguments list, then
click on this button to delete it.
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GENERAL
PREFERENCES

Defining General Preferences

Description The General Preferences command, available from the main
Visible Advantage window, allows you to define a monochrome or
color display for use with Visible Advantage.

Usage Tips If you have a monochrome monitor, setting this option to Monochrome
will improve the display quality.

Procedure å  To define general preferences for the current encyclopedia:

1  Choose General Preferences from the Project menu.

Result: The General Preferences dialog box appears.

2 Select Color Monitor or Monochrome Monitor,
depending on the type of display you are using, then click on
OK.
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GENERATE DATA
ACCESS PROCESSES

Generating Data Access Processes

Description The Generate Data Access Processes command, available from the
main Visible Advantage window, allows you to generate all required data
access processes for all or selected entities in all or selected model
views.

Usage Tips The generated data access processes are added to the process model
and may be viewed or edited through the Process Map window.

This command produces the DAP Generation Report, which details the data
access processes generated for the entities selected.

Procedure å  To generate data access processes:

1 From the main Visible Advantage window, choose Generate
Data Access Processes.…  from the Process menu.

From any other window, choose Process Modeling from the main
menu, then choose Generate Data Access Processes... from the
cascading menu.

Result: The Generate Data Access Processes dialog box appears.

2 Complete the Generate Data Access Processes dialog box,
then click on OK.

Result: The Report Destination dialog box appears.

3 Select a report destination (Printer, File, or Screen), then
click on OK. 

Result: If you selected Printer, the report will be sent to the
printer.

If you selected File, you will be prompted for the name of the file
to which you want the report to be sent.
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If you selected Screen, the report-viewing window and menu bar
appear. Refer to the Reports section of the User's Guide for more
information on viewing reports on the screen.
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Generate Data Access Processes Dialog Box

Dialog Box
Illustration

   Data Access Generation Dialog Box

Dialog Box Use the information below to complete the Generate Data Access
Components Processes dialog box.

Component         Description                                                                 
All Entities Select this button if you want to generate data access

processes for all entities in the model view(s)
selected in the Model View area below.

By Current Select this button if you want to generate data access
User processes only for those entities created or modified

by the current user that are visible in the model
view(s) selected in the Model View area
below.

By Current Select this button if you want to generate data
Session access processes only for those entities created or

modified during the current session that are visible 
in the model view(s) selected in the Model View
area below.

Selected Select this button if you want to generate data access
Entities processes only for selected entities that are visible in
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the model view(s) selected in the Model View area below.
To select the entities to include, click on the Select
Entities button, described below.

Select Entities Use this button to select the entities for which to
generate data access processes. This button is
available only if you selected the Selected Entities button,
described above. Click on this button to display the Select
Entities dialog box.

Entire Model Select this button if you want to include entities in
the entire encyclopedia.

Selected Model Select this button if you want to include entities in
Views selected model views only. To select the model

views, click on the Select Views button,
described below.

Select Views Use this button to select the model views for which
to generate data access processes. This button is available
only if  you selected the Selected Model Views button,
described above. Click on this button to display the Select
Model Views dialog box.

By Name Select this button to alphabetize the data access
processes in the DAP Generation report by entity name.

By Type Select this button to sort the data access processes in
the DAP Generation report by entity type.

By Phase Select this button to sort the data access processes in
the DAP Generation report by entity phase.
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GENERATE SQL SCHEMA

Generating SQL Schema

Description The Generate SQL Schema command, available from all windows,
produces an SQL relational database schema for a database design that uses
an SQL-based data structure manager. This command is available from all
windows.

Usage Tips The schema generated by this command conforms to the format of the
data structure manager assigned to the database design for which the
schema is generated. Visible Advantage is shipped with the following
predefined SQL data structure managers: DB2, Microsoft SQL (Sybase),
and Oracle.

You may edit these data structure managers or add new ones through the
Admin Utility/Table/Data Structure Managers command. When you edit a
data structure manager, you may define the following SQL output options:
o  Support for "NOT NULL", "UNIQUE", "CREATE INDEX"
     clauses
o  Requirement of "VALUES" clause
o  Statement separator options (semicolon, forward slash, or no
     separator)
o  Representation of literals (single or double quotes)

Objects in an encyclopedia are translated in the schema as follows:
o  Entities become tables
o  Attributes become fields or columns within each entity table
o  Attribute values become table occurrences for static entities

Procedure å To generate SQL schema for the current encyclopedia:

1 Choose Generate SQL Schema... from the Build menu on
the main menu bar or from the main menu on any other
menu bar.

Result: The Generate SQL Schema dialog box appears.

2 Complete the Generate SQL dialog box, then click on OK.
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Result: If the database design you selected is based on an SQL data
structure manager, the Report Destination dialog box appears.
(Proceed to next step.)

If the database design you selected is not based on an SQL data
structure manager, an error message appears. To make the data
structure manager SQL-based, go the main Visible Advantage
Admin Utility window and use the Table/Data Structure Managers
command. (End of procedure.)

3 Select a report destination (Printer, File, or Screen), then
click on OK.

Result: If you selected Printer, the report will be sent to the
printer.

If you selected File, you will be prompted for the name of the
file to which you want the report to be sent.

If you selected Screen, the report-viewing window and menu
bar appear. Refer to the Reports section of the User's Guide
for more information on viewing reports on the screen.
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Generate SQL Schema Dialog Box

Dialog Box
Illustration

                             

       Generate SQL Schema Dialog Box

Dialog Box Use the information below to complete the Generate SQL Schema
Components dialog box.

Component         Description                                                                 
Design View Select the design view from the drop-down list.

Candidates This box contains all scripts defined for the
current encyclopedia.

Include This box contains all scripts included in the
current encyclopedia.

Use this button to select one or more script
candidates.  To select one candidate, highlight the
candidate in the Candidates list, then click on this
button.  The candidate will then appear in the
Include list box.  To select more than one candidate, hold
down the CTRL key, highlight the candidates, then click
on this button.
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Use this button to deselect one or more scripts.
Highlight the script in the Include list, then click on this
button.  The script will then appear in the
Candidate list box.  To deselect more than one
candidate, hold down the CTRL key, highlight the
candidates, then click on this button.

Use this button to select all script candidates.
When you click on this button, all script
candidates will be moved to the Include list
box.

Use this button to deselect all scripts.  When you
click on this button,, all scripts will be moved to
the Candidate list box.
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IMMEDIATE MODE

Running Matrix Windows
in Immediate Mode

Description The Immediate Mode command saves your matrix changes as you edit
a matrix, rather than only when you use the Write Matrix command. This
command is available in all matrices.

Usage Tips The Immediate Mode command toggles between an active and inactive
state. When the command is active, a checkmark displays next to the
command name on the Matrix menu; when the command is inactive, no
checkmark displays.

Procedure å  To activate Immediate Mode in the active matrix window:

Choose Immediate Mode from the Matrix menu.

Result: A checkmark appears beside the Immediate Mode command.
Subsequent changes you make to the matrix are written to the encyclopedia
database immediately after you make them.

å  To deactivate Immediate Mode in the active matrix window:

Choose Immediate Mode from the Matrix menu.

Result:  The checkmark beside the Immediate Mode command disappears.
Subsequent changes you make to the matrix will not be made until you
choose Write Matrix from the Matrix menu.
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IMPORT

Importing Encyclopedias

Description The Import Facility allows you to import a VSC (Visible Systems
Corporation proprietary format)or a Microsoft Access (.mdb) file into
Visible Advantage as a new encyclopedia. These files are produced by other
Visible products (VSC files), by another CASE tool, from scratch using a
text editor, or from a previously performed Visible Advantage export (.mdb
files).

Usage Tips When you import information into Visible Advantage as an encyclopedia,
you specify new encyclopedia information (title, logon, password and
directory), along with the location of the files you want to import.

Imported The files you import into Visible Advantage will default to these
Files names:

VSC import.ad
Access imp-exp.mdb

The Imported Once you import an external file into Visible Advantage, you access
Encyclopedia and modify the resulting encyclopedia in the same way as you would any

other encyclopedia. If you need to export the encyclopedia back to VSC or
.mdb format, use the Export command under the Export menu in the Visible
Advantage Utilities program.

Procedure å  To import an encyclopedia from a VSC file:

1 Choose Import from VSC File from the Import menu.

Result:  The Open Encyclopedia dialog box appears.

2 Complete the Open Encyclopedia dialog box and click on OK.

Result:  The New Encyclopedia dialog box appears.

3 Complete the New Encyclopedia dialog box and click on OK.

Result:  The encyclopedia is imported.
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å To import an encyclopedia from Access:

1 Choose Import from Access from the Import menu.

Result:  The Open dialog box appears.

2 Select the encyclopedia you want to import from the list of
encyclopedias displayed in the list box.

3 Click on OK.

Result:  The encyclopedia is imported.



447

INPUT LIST

Displaying and Hiding the Input List

Description The Input List command, available from the Process Map window,
displays the Input List box in the Process Map window when it is hidden,
and hides the Input List box when it is displayed.

The Input List box contains a list of attributes that the current
business process uses for its completion.

Procedure å  To display or hide the Input List box:

Choose Input List from the Display menu.

Result: If the Input List box was hidden when you choose the
command, the list appears in the active Process Map window.

If the Input List was displayed when you chose the command, the list
disappears from the active Process Map window.
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INVOCATION LIST

Displaying and Hiding
the Invocation List

Description The Invocation List command, available from the Process Map
window, displays the Invocation List box in the Process Map window when
it is hidden, and hides the Invocation List box when it is displayed.

The Invocation List box contains a list of attributes that the current business
or data access process invokes for its completion.

Procedure å  To display or hide the Invocation List box:

Choose Invocation List from the Display menu.

Result: If the Invocation List box was hidden when you chose the
command, the list appears in the active Process Map window.

If the Invocation List was displayed when you chose the command, the list
disappears from the active Process Map window.
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KEYS

Defining Association Keys

Description The Keys command, available from the Data Dictionary window,
allows you to define the key attributes that support an association.

Usage Tips Visible Advantage considers any primary and/or foreign keys shared
by both entities in an association to be potential supporting keys. In the
Association Keys dialog box, you choose which shared keys you want to
define as actual supporting keys for the association.

+   Example  An association exists between the entities JOB and
EMPLOYEE.  JOB contains the primary key “job code,” and EMPLOYEE
contains the primary key “employee number” and the foreign key “job
code.” The key “job code” supports this association, since it is contained in
both entities.

Procedure å  To define supporting keys for one of the current entity's
associations:

1 In the Data Dictionary window, highlight the association for
which you want to define supporting keys.

2  Choose Edit... from the Association menu.

Result: The Edit Association dialog box appears.

3 Click on Keys.

Result:  The Association Keys dialog box appears.

4 Complete the Association Keys dialog box,
then click on OK.

2  Note  See Add Association for a description of this
dialog box.
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LARGER

Enlarging Graphical Objects in a Window

Description The Larger command allows you to make the objects in a graphical
window larger. This command is available from the following windows:
View Hierarchy, Design Map, and Data Map.

Procedure å  To enlarge objects in the View Hierarchy, Design Map, and
Data Map window:

Choose Larger from the Display menu.

Result: The objects in the active window appear larger. You may repeat the
above step until the objects are the size you desire.
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LINE WRAP

Wrapping Text to the Next Line

Description The Line Wrap command, available from Statement Editor windows,
automatically wraps text to the next line when you reach the end of a
line.

Usage Tips This command is available from the Statement Editor window.
The Statement Editor window appears when you use the Statement Editor
command.

This command toggles between an active and inactive state. When the
command is active, a checkmark appears next to the command; when the
command is inactive, no checkmark appears next to the command.

Procedure å To activate the line wrap feature of the Statement
Editor window:

Choose Line Wrap from the Format menu.

Result: Line Wrap is turned on and a checkmark appears next to the
command.
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LINK ASSOCIATION
 TO STATEMENT

Linking Associations to Statements

Description The Link Association To Statement command, available from the Data
Dictionary window, allows you to link an association to a planning
statement in the current model view.

Usage Tips When you link an association to a planning statement, the link
information will appear in the Data Links field in the Planning Dictionary
window. The link will also be included in applicable reports.

Procedure å  To link an association to a planning statement:

1 Highlight the association to which you want to link a
planning  statement. The association you select must be visible in
the current model view. This means that you cannot select an
association that is dimmed in the Data Dictionary window.

2 Choose Link To Statement... from the Association menu.

Result: The Link Association to Planning Statement dialog box
appears.

3 Select the type of planning statement to which you want to
link the data model

4 Select a planning statement title from the Title drop-down
list, then click on OK. The list includes all titles of the type
specified in the Type field above that are visible in the current
model view.
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LINK ATTRIBUTE
TO PROPERTY

Linking Attributes to Properties

Description The Link Attribute to Property command, available from the
Data Map and Data Dictionary windows, allows you to define a link
between an attribute and one or more properties within a database design.

Usage Tips After you link an attribute to a property, the link information is
displayed in the Logical Links field for the data structure record in the
Design Dictionary window and in various fields in the Design Reference
window. The information is also included on applicable reports.

Procedure å  To link an attribute to one or more properties from the Data
Map window:

1 Choose Link to Property... from the Attribute menu.
Result: The Select Attribute dialog box appears.

2 Select the attribute you want to link, then click on OK.

Result: The Link Attribute to Property dialog box appears.

3 Complete the dialog box, then click on OK.

å  To link an attribute to one or more properties from the Data
Dictionary window:

1 In the Attributes field, highlight the name of
the attribute you want to link.

2 Choose Link to Property... from the Attribute 
menu.

Result: The Link Attribute to Property dialog box
appears.

3 Complete the dialog box, then click on OK.
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Link Attribute to Property
Dialog Box

Dialog Box
Illustration

                            

               Link Attribute to Property Dialog Box

Dialog Box Use the information below to complete the Link Attribute to Property
Components dialog box.

Component         Description                                                                 
Attribute The name of the attribute to be linked to the data

item(s).

Design Select the name of the design view in which the
View data item's data structure is located. The list includes

all design views defined for the encyclopedia.

Design Select the name of the design object to which the
Object data item belongs. The list includes all design objects

within the design view you specified in the Design 
View.

Property Highlight the name of the property you want to link
to the attribute.
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2  Note  You may select multiple sequential properties by
holding down the SHIFT key while clicking on the first
property you want to select, then clicking on the last
property you want to select. You may select multiple non-
sequential properties by holding down the CTRL key and
clicking on each property you want to select.
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LINK ATTRIBUTE
 TO STATEMENT

Linking Attributes to Statements

Description The Link Attribute to Statement command, available from the Data
Dictionary window, allows you to link an attribute to a planning statement
in the current model view.

Usage Tips After you link an attribute to a statement, the link information is
displayed in the Data Links field in the Planning Dictionary window and in
the Model Links field of the Data Dictionary window. The link is also
included on applicable reports.

Procedure å  To link an attribute to a planning statement:

1 Highlight the attribute to which you want to link a planning
statement.

2 Choose Link to Statement... from the Attribute menu.

Result: The Link Attribute to Planning Statement dialog box
appears.

3 Select the type of planning statement to which you want to
link the attribute from the drop-down list.

The list includes standard statement types, along with any
additional types added through the Table/Statement Types
command.

4 Select a planning statement title from the Title drop-down
list, then click on OK. The list includes all titles of the type
specified in the Type field above that are visible in the current
model view.
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LINK DESIGN OBJECT
 TO ENTITY

Linking Design Objects to Entities

Description The Link Design Object to Entity command, available from the
Design Dictionary and Design Map windows, allows you to link a design
object to an entity in the data model.

Usage Tips When you link a design object to an entity through the Link Design
Object To Entity command, you have a chance to link the design object's
properties to the linked entity's attributes.

Design object-entity links are displayed in the Design Reference window.

Procedure å  To link the current design object to an entity in the data
model:

1 Choose Link to Entity... from the Design Object menu.

Result: The Link Design Object to Entity dialog box 
appears.

2 Complete the Link Design Object to Entity dialog box.

3 If you want to link any of the design object's properties to
one of the entity's attributes, highlight the property, then click on
the Link button. The Select Attributes dialog box appears, allowing
you to select the attributes to which you want to link the property.

4 Repeat the previous step for each property you want to link
to the entity's attributes.

5 When you are finished linking properties, click on OK
in the Link Design Object to Entity dialog box.
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Link Design Object to Entity Dialog Box

Dialog Box
Illustration

                            

              Link Design Object to Entity Dialog Box

Dialog Box Use the information below to complete the Link Design Object
Components To Entity dialog box.

Component         Description                                                                 
Design Object The name of the design object to be linked to an

entity appears in this field.

Entity Select from this drop-down list the entity to which
you want to link the design object.

Properties The properties that belong to the design object
appear in this list box. You can link any of the properties
to the linked entity's attributes through the Link button
(see below).

Link Use this button to link a property to one or more
of the entity's attributes. To do this, highlight the property
in the Properties list box, then click on the Link button.

When you click on this button, the Select Attributes
dialog box appears. The Select Attributes dialog box
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works in the same way as the Select Data Items dialog
box.
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LINK ENTITY TO
 DESIGN OBJECT

Linking Entities to Design Objects

Description The Link Entity to Design Object command, available from both the
Data Map and Data Dictionary windows, allows you to define a link
between an entity and a design object within a design view.

Usage Tips When you link an entity to a design object, you may also choose to
link its attributes to the design object's properties.

This command is available for multiple selected entities in both the Data
Map and Data Dictionary windows. See the User's Guide for instructions on
selecting multiple entities in those windows.

After you link an attribute to a property, the link information is displayed in
the Physical Links field in the Data Dictionary window and the Logical
Links field in the Design Dictionary window. The information is also
included on applicable reports.

Procedure å  To link an entity to a design object:

1 Choose Link to Design Object... from the Entity menu.

Result: The Link Entity to Design Object dialog box appears.

2 Complete the Link Entity to Design Object dialog box.

To link one of the entity's attributes to one or more of the design
object's properties, highlight an attribute and then click on Link.

Result: The Select Properties dialog box appears.

3 Complete the Select Properties dialog box, then click on OK.

Result: The Link Entity to Design Object dialog box reappears.

4 Click on OK.
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Link Entity to Design Object
Dialog Box

Dialog Box
Illustration

                         

                Link Entity to Design Object Dialog Box

Dialog Box Use the information below to complete the Link Entity to Design
Components  Object dialog box.

Component         Description                                                                 
Entity The name of the entity to be linked to the design

object.

Design  Select the name of the design view in which the
View design object is located. The list includes all

design views defined for the encyclopedia.

Design Object Select the name of the design object to which you
want to link the entity. The list includes all design objects
within the design view you specified in the Database
Design field.

Attributes Highlight the name of the attribute you want  to link
to the design object's properties, then click on Link to
display the Select Properties dialog box.
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Link Click on this button to select the properties to which
you want to link the attribute you highlighted in the
Attributes list box. When you click on this button, the
Select Properties dialog box appears.
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Select Properties Dialog Box

Dialog Box
Illustration

                            

               Select Properties Dialog Box

Dialog Box Use the information below to complete the Select Properties dialog
Components box.

Component         Description                                                                 
Properties The names of the selected properties are listed in

this box.

Initially, this list box is empty. You add properties to this
list from the Candidates list box.

Candidates This box contains all properties that belong to the
design object selected in the Link Entity To Design
Object dialog box.

Use this button to select one or more properties
candidates. To select one property, highlight the
property in the Candidates list box, then click on this
button. It will then appear in the Properties list box.
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To select more than one property, hold down the
CTRL key and highlight the properties.

Use this button to deselect one or more properties. To
select one property, highlight the property in the
Properties list box, then click on this button. It will then
return to the Candidates list box.   To select more than
one property, hold down the CTRL key and highlight the
properties.

Use this button to select all property candidates.
When you click on this button, all properties in the
Candidates list box will be moved to the Properties list
box.

Use this button to deselect all selected Properties.
When you click on this button, all Properties in the
Properties list box will be returned to the Candidates list
box.
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LINK ENTITY
 TO STATEMENT

Linking Entities to Statements

Description The Link Entity to Statement command, available from the Data
Dictionary and Data Map windows, allows you to link selected entities to a
planning statement in the current model view.

Usage Tips After you link an entity to a planning statement, the link information
appears in the Model Links field in the Data Dictionary window and the
Data Links field in the Planning Dictionary window. The link is also
included on applicable reports.

This command is available for multiple selected entities in the Data
Dictionary window. See Select Entities in this manual for instructions on
selecting multiple entities.

Procedure å  To link selected entities to a planning statement:

1 Choose Link to Statement... from the Entity menu.

Result: The Link Entity to Statement dialog box appears.

2 Select the type of planning statement to which you want to
link the entity from the Type drop-down list.

The list includes standard statement types, along with any
additional types added through the Admin Utility Table/Statement
Types command.

3 Select a planning statement title from the Title drop-down
list, then click on OK. The list includes all titles of the type
specified in the Type field above that are visible in the current
model view.
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LINK PROPERTY
 TO ATTRIBUTE

Linking Properties to Attributes

Description The Link Property to Attribute command, available from the Design
Dictionary and Design Map windows, allows you to link a property to one
or more attributes in the data model.

Usage Tips When you link a data structure to an entity through the Link Data
Structure to Entity command, you can also link the data structure's
properties to the linked entity's attributes. See Link Data Structure to Entity
in this manual for more information. Data item-attribute links are displayed
in the Design Reference window.

Procedure å  To link a property to one or more attributes in the data model
from the Design Dictionary window:

1 In the Design Dictionary window's Data Items field, highlight
the name of the property you want to link to an attribute.

2 Choose Link to Attribute... from the Property menu.

Result: The Link Property to Attribute dialog box appears.

3 Complete the Link Property to Attribute dialog box, then
click on OK.

å  To link a property to one or more attributes in the data model
from the Design Map window:

1 In the Design Map window, highlight the design object that
has the property you want to link to an attribute.

Result:  The Select Design Object Property dialog box
appears.

2 Select the design object property you want to link, then click
on OK.

Result:  The Link Property to Attribute dialog box appears.
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3 Complete the Link Property to Attribute dialog box, then
click on OK.
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Link Property to Attribute Dialog Box

Dialog Box
Illustration

                                  

       Link Property to Attribute Dialog Box

Dialog Box Use the information below to complete the Link Property to
Components Attribute dialog box.

Component         Description                                                                 
Property The name of the property to be linked to an attribute

appears in this field.

Entity Select from this drop-down list the entity containing
the attribute to which you want to link the property.

Attribute When you select an entity from the Entity drop-down
list, the attributes that belong to the selected entity appear
in the Attribute list box. You select from this list the
attribute(s) to which you want to link the property.

2 Note You may select multiple sequential list properties
by holding down the SHIFT  key while clicking on the
first property you want to select, then clicking on the last
property you want to select. You may select multiple non-
sequential properties by holding down the CTRL key an
clicking on each property you want to select.
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LINK STATEMENT
 TO ASSOCIATION

Linking Statements to
Associations

Description The Link Statement to Association command, available from both the
Planning Outline and Planning Dictionary windows, allows you to link
selected planning statements to one or more association(s) in the current
model view. An association is visible in a model view only if both entities
in the association are visible in the current model view.

Usage Tips After you link planning statements to an association, the link
information appears in the Data Links field in Planning Dictionary window
and is included on any applicable reports.

This command is available for multiple selected statements in both the
Planning Outline and Planning Dictionary windows. See the User's Guide
for instructions on selecting multiple statements in these windows.

Procedure å  To link selected planning statements to one or more
associations:

1 Choose Link to Association... from the Link menu.

Result: The Link Statement to Association dialog box appears.

2 From the Entity drop-down list, select one of the entities in
the association to which you want to link the statement.
This list includes all entities in the current model view. After you
select an entity, a list of associations for that entity appears in the
Associations box.

Result: A list of associations for the entity you selected appears in
the Associations list box.

3 From the Associations list, select the association(s) to which
you want to link the statement, then click on OK.

2 Note  You may select multiple sequential list items by holding
down the SHIFT key while clicking on the first item you want to
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select, then clicking on the last item you want to select. You may
select multiple non-sequential items by holding down the CTRL
key and clicking on each item you want to select.
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LINK STATEMENT
 TO ATTRIBUTE

Linking Statements to Attributes

Description The Link Statement to Attribute command, available from both the
Planning Outline and Planning Dictionary windows, allows you to link the
current planning statement to an attribute in the current model view.

Usage Tips When you link a planning statement to an attribute the link
information appears in the Data Links field in the Planning Dictionary
window. This information is also included on any applicable reports.

This command is available for multiple selected statements in both the
Planning Outline and Planning Dictionary windows. See the User's Guide
for instructions on selecting multiple statements in these windows.

Procedure å  To link selected statements to an attribute in the current model
view:

1 Choose Link to Attribute... from the Link menu.

Result: The Link Statement to Attribute dialog box appears.

2 Select an attribute from the Attribute drop-down list, then
click on OK. The list includes all attributes in the current model
view.
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 LINK STATEMENT TO
DESIGN OBJECT

Linking Statements to
Design Objects

Description The Link Statement command, available from the Planning Outline
and Planning Dictionary windows, allows you to define a link between 
a statement and a design object.

Procedure å  To link a design object to a statement:

1 In the Planning Outline window, highlight the statement you
want to link.  In the Planning Dictionary window, display the
statement you want to link.

2 Choose Link to Design Object from the Link menu.

Result:  The Link Statement to Design Object dialog box
appears.

3 Complete the Link Statement to Design Object dialog box,
then click on OK.
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Link Statement to Design
Object Dialog Box

Dialog Box
Illustration

                Link Statement to Design Object Dialog Box

Dialog Box Use the information below to complete the Link Statement to Design
Components Object dialog box.

Component         Description                                                                 
Statement The statement you selected to link.

Design View Select the design view you want to link from the
drop-down list.  The list includes all design views
defined for the encyclopedia.

Design Object Select the design object you want to link from the
drop-down list.  The list includes all design objects
within the design view you specified in the Design
View field.



474

LINK STATEMENT
 TO ENTITY

Linking Statements to Entities

Description The Link Statement to Entity command, available from both the
Planning Outline and Planning Dictionary windows, allows you to link the
current planning statement to an entity in the current model view.

Usage Tips When you link a planning statement to an entity, the link information
appears in the Data Links field in the Planning Dictionary window and in
the Stmt Links (statement links) field in the Data Dictionary window. The
link information is also included on applicable reports.

This command is available for multiple selected statements in both the
Planning Outline and Planning Dictionary windows. See the User's Guide
for instructions on selecting multiple statements in these windows.

Procedure å To link selected statements to an entity in the current model
view:

1 Choose Link to Entity... from the Link menu

Result: The Link Statement to Entity dialog box appears.

2 Select an entity from the Entity drop-down list, then click on
OK. This list includes all entities in the current model view.
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LOCATE ATTRIBUTE

Locating Attributes

Description The Locate Attribute command, available from both the Data Map and
Data Dictionary windows, allows you to locate an individual use of an
attribute in the current model view.

Usage Tips Since an attribute may be located in multiple entities, you specify the
entity record in which to locate the attribute. When Visible Advantage
locates an attribute in a specified entity record, the entity record displays in
the active window.

Procedure å To locate an occurrence of an attribute in the current model
view from the Data Map or Data Dictionary window:

1 Choose Locate... from the Attribute menu.

Result: The Locate Attribute dialog box appears.

2 Select an attribute name from the Attribute drop-down list.
This list includes all attributes in the current model view.

Result: A list of entities in which the selected attribute can be
found appears in the Entity box.

3 Select the entity in which you want to locate the attribute,
then click on OK.
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LOCATE DESIGN OBJECT

Locating Design Objects

Description The Locate Design Object command is available from the Design
Dictionary and Design Map windows.  It is also available from the Design
Reference window if you are in the design object mode.  The Locate Design
Object command allows you to locate a design object within the current
design view.

Usage Tips When the Design Reference window is displayed in design object
mode, you may locate a design object from that window through the object
command on the Locate menu.

Procedure å  To locate a design object in the Design Dictionary window:

1 Choose Locate... from the Design Object menu.

Result: The Locate Design Object dialog box appears.

2 Select the design object you want to locate from the Design
Object drop-down list box, then click on OK.
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LOCATE ENTITY

Locating Entities

Description The Locate Entity command, available from both the Data Map and
Data Dictionary windows, allows you to locate an entity in the current
model view.

Procedure å To locate an entity in the current model view in the Data Map
or Data Dictionary window:

1 Choose Locate... from the Entity menu.

Result: The Locate Entity dialog box appears.

2 From the Entity drop-down list, select the name of the entity
you want to locate, then click on OK.
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LOCATE MODEL VIEW

Locating Model Views

Description The Locate Model View command, available from the View
Hierarchy window, allows you to locate a model view in the View
Hierarchy window. When a model view is located, the current model view
cursor moves to the located model view.

Procedure å To locate a model view in the View Hierarchy window:

1 Choose Locate... from the View menu.

Result: The Select View dialog box appears.

2 Select the model view you want to locate from the View list
box.

If you want to display the list in hierarchical order, select the
Structured button; if you want to display the list in alphabetical
order, select the Alphabetical button.

2  Note If you are in the Model View, you must also select
either View or the Entire Model by clicking on the
appropriate button.

3 Click on OK.
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LOCATE NEXT
 STATEMENT

Locating the Next Statement

Description The Locate Next Statement command, available from the Planning
Outline window, locates the next occurrence of the statement last specified
in the Locate Statement dialog box. This command is useful for finding
each occurrence of a statement in the planning outline.

Procedure å To locate the next occurrence of a statement:

Choose Locate Next from the Statement menu.

Result: The next occurrence of the statement last specified in the Locate
Statement dialog box is highlighted in the planning outline. If there are no
successive occurrences of the statement, the first occurrence of this
statement is highlighted.

Repeat this procedure to find successive occurrences of the statement.
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LOCATE PROPERTY

Locating Properties

Description The Locate Property command, available from the Design Dictionary
and Design Map windows, allows you to locate a property within the
current design view.

Usage Tip When the Design Reference window is displayed in Property mode,
you may locate a property from that window through the Object
command on the Locate menu.

Procedure å  To locate a property in the Design Dictionary and Design Map
windows:

1 Choose Locate... from the Property menu.

Result:  The Locate Property dialog box appears.

2 Select the property you want to locate from the Property
drop-down list box.

Result:  The design objects to which the selected property
belongs appear in the Design Objects list box.

3 In the Design Objects list box, highlight the design object
where you want to locate the property, then click on OK.
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LOCATE STATEMENT

Locating Planning Statements

Description The Locate Statement command, available from both the Planning
Outline and Planning Dictionary windows, allows you to locate a planning
statement in the current model view. When a statement is located, it is
highlighted in the active planning window.

Procedure å  To locate a statement in the current model view:

1 Choose Locate... from the Statement menu.

Result: The Locate Planning Statement dialog box appears.

2 From the Title drop-down list, select the statement you want
to locate, then click on OK.
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MANUAL POSITIONING

Manually Positioning
Data Map Entities

Description The Manual Positioning command, available from the Data Map
and Design Map windows, allows you to turn the manual positioning
feature of the Data Map and Design Map windows on and off. Manual
Positioning allows you to manually place each object in the map windows,
rather than having Visible Advantage automatically determine its
placement.

Using This  This command toggles on and off each time you choose
Command the command. When a checkmark appears beside the command,

Manual Positioning is active; when no checkmark appears beside the
command, Manual Positioning is inactive.

The Manual Positioning mode is saved with the current model view. This
means that if you turn the command on and leave the model view or close
the encyclopedia, the mode is still active when you return
to the model view.

When Manual Positioning is active, you may move an object around the
map by holding down the left mouse button and dragging the object to its
new location. The new location must be vacant; that is, not already
occupied by another object. When you turn Manual Positioning off by
choosing the command again, the map redraws the objects by phase.

You may prefer the Manual Positioning mode if you are creating a  map for
presentation purposes and want to control where each object appears on the
map.

Under normal circumstances, however, we recommend you make manual
positioning inactive. When manual positioning is inactive, Visible
Advantage positions objects by phase (either horizontally or vertically, as
defined through the Display menu/Options command in the Data Map and
Design Map windows).
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Procedure å To enable manual positioning:

1 Choose Options from the Display menu.

Result:  The Map Display Options dialog box appears.

2 Select Manual in the Drawing Mode box, then click on
OK.

å  To disable manual positioning:

1 Choose Options from the Display menu.

Result:  The Map Display Options dialog box appears.

2 Select Auto in the Drawing Mode box, then click on
OK.
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MOUNT

Mounting an Encyclopedia

Description Visible Advantage has both a stand-alone and a client-server edition.
Encyclopedias created on the stand-alone edition are not available under the
client-server edition until they have been copied to the server’s catalog
using the Mount command.  Similarly, client-server encyclopedias are not
available to stand-alone users until they have been copied to their
workstations using the Unmount command.

The Mount command is available only in the client-server edition of Visible
Advantage 7.0 or higher.  This command is accessed from the Admin
program, under the Encyclopedia menu.

2  Note  The Mount command can only be used on encyclopedias created
on or converted to Visible Advantage 7.0.  If you want to create a client-
server copy of an IE:Advantage 6.1 encyclopedia, you must first convert it
using the process described in the Setup section of the User’s Guide.

Procedure å  To create a client-server copy of an encyclopedia using the Mount
command:

1 Start the Visible Advantage Admin program from Windows.

2 If you have not set up automatic Raima server login, supply the
server name, user name, and password to log on to the Raima
database server.

3 Open the Encyclopedia menu, and click on the Mount command.

4 Select the encyclopedia you want to convert to client-server, and
click on OK.

5 Provide your ID and password, and click on OK.

6 Select the encyclopedia you want to convert to client-server, and
click on OK.  Note that the dialog box remains on the screen while
the encyclopedia is being processed.  Do not click on any of the
screen buttons while the Mount command is processing; doing so
may cause the process to abort.
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Result:  The new client-server copy of the encyclopedia will be
created, while no changes will be made to the original stand-alone
copy.
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MOVE ATTRIBUTE

Moving Attributes

Description The Move Attribute command, available from both the Data Map and
Data Dictionary windows, allows you to move an occurrence of a non-key
attribute from the current entity to another entity in the current
model view.

Usage Tips Use this command when you want to remove a non-key attribute from
the current entity and add it to another entity. Each non-key attribute may
belong to only one entity in the encyclopedia. Data modeling rules dictate
that you may not use this command to move primary or foreign key
attributes.

+  Example You have added the non-key attribute wage to the entity JOB.
You then decide that the attribute should belong to the entity EMPLOYEE.
You use the Move command, specifying EMPLOYEE as the target entity.
The attribute wage  is then deleted from the entity JOB and added to the
entity EMPLOYEE.

Procedure å  To move a non-key attribute from a selected entity to another
entity from the Data Map window:

1 Choose Move... from the Attribute menu.

Result: The Select Attribute dialog box appears. All attributes that
belong to the current entity are listed in the list box.

2 Select the attribute you want to move, then click on
OK.

.
Result: The Move Attribute dialog box appears.

3 From the Move To drop-down list box, select the entity to
which you want to move the attribute. The list includes all entities
in the current model view.

4 Click on OK.
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å  To move a non-key attribute from the current entity to another
entity from the Data Dictionary window:

1 Choose Move... from the Attribute menu

Result: The Move Attribute dialog box appears.

2 From the Move To drop-down list box, select the entity to
which you want to move the attribute. The list includes all entities
in the current model view.

3 Click on OK.
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MOVE PROPERTY FROM
 DESIGN OBJECT

Moving Properties from
a Design Object

Description The Move Property From Design object command, available from
the Design Dictionary and Design Map windows, allows you to move a
property from another design object in the current design view to the
current design object.

Procedure å  To move a property from another design object to the current
design object:

1 In the Design Dictionary window, display the design object
to receive the property.

In the Design Map window, select the design object to receive
the property.

2 Choose Move From Design Object... from the Property
menu.

Result: The Move Property From Design object dialog box
appears.

3 From the Design Object drop-down list, select the design
object that contains the property you want to move.

Result: The properties that belong to the selected design object
appear in the Properties list box.

4 Highlight the name of the property you want to move to the
current design object, then click on OK.
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MOVE PROPERTY TO
DESIGN OBJECT

Moving Properties to
a Design Object

Description The Move Property To Design Object command, available from the
Design Dictionary and Design Map windows, allows you to move a
property from the current design object to another design object in any
design view.

Procedure å  To move a property from the current design object to another
design object in the Design Dictionary window:

1 In the Design Dictionary window, display the design object
that contains the property you wish to move.  Highlight the
property to be moved.

2 Choose Move To Design Object... from the Property
menu.

Result: The Move Property To Design Object dialog box appears.

3 From the Design View drop-down list, select the
design view that contains the design object to which you want to
move the property.

Result: The design objects within the selected design view appear
in the Design Object list box.

4 Highlight the name of the design object to which you want to
move the property, then click on OK.

å To move a property from the current design object to another
design object in the Design Map window:

1 Select the design object that contains the property you wish to
move.

2 Choose Move to Design Object…  from the Property menu.
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Result:  The Select Design Object Property dialog box
appears.

3 Select the name of the property you want to move, then click
on OK.

Result:  The Move Property to Design Object dialog box
appears.

4 From the Design View drop-down list, select the design view
that contains the design object to which you want to move the
property.

Result:  The design objects within the selected design view
appear in the Design Object list box.

5 Highlight the name of the design object to which you want to
move the property, then click on OK.
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MOVE VIEW

Moving Views

Description The Move View command, available from the View Hierarchy window,
allows you to move one or more selected views to another position in the
view hierarchy.

Usage Tips Use this command when you want one or more views to be
subview(s) of another view.

Procedure å  To move the current view:

1 Choose Move... from the View menu.

Result: The Move View dialog box appears.

2 Select the view to which you want to move the
selected  view(s) from the Move To list box.

If you want to display the list in hierarchical order, select the
Structured button. If you want to display the list in alphabetical
order, select the Alphabetical button.

3 Click on OK.
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NAME CLUSTER
 END POINT

Naming Cluster End Points

Description The Name Cluster End Point command allows you to name the
designated or derived cluster end point represented by the current entity. A
cluster end point is an entity that represents a meaningful subset of the data
model.  This command is available from the Data
Dictionary window.

Usage Tips This command is dimmed to indicate it is not available if the current
entity is not a designated or derived cluster end point.

You designate an entity as a cluster end point through the Designated End
Point command on the Entity menu. Visible Advantage automatically
detects if an entity is a derived end point.

Procedure å To name the end point represented by the current entity:

1 Highlight [unnamed] in the Cluster End Pt. field.

2 Choose Name Cluster End Point...  from the
Entity menu

Result: The Cluster Name dialog box appears.

3 Type a name for the cluster into the Cluster
Name box, then click on OK.

Result: The name of the end point appears in the Cluster End Pt.
field.

å To edit the name of a cluster end point:

Highlight the name of the cluster in the Cluster End field, then choose
Name Cluster End Point... from the Entity menu.

Result: The Cluster Name dialog box appears, allowing you to edit the
cluster's name.
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NAMING PREFERENCES

Description The Naming Preferences command, available from the Visible
Advantage Admin Utility, allows you to set capitalization standards for
each type of encyclopedia object for the current encyclopedia or the
Encyclopedia Initializer.

Usage Tips You may choose one of the following preferences:
o   All uppercase
o   All lowercase
o   Each word initially capitalized
o   Free form (the name is capitalized the way you type it in when you

                                   add the object)

The naming preferences you define with this command are for the current
encyclopedia only. If you want to define naming preferences for all future
encyclopedias, use the Encyclopedia Initializer command before you use the
Naming Preferences command.

Procedure åTo define naming preferences for each object/detail in the
current encyclopedia or the Encyclopedia Initializer:

1 Choose Naming... from the Preferences cascading menu.

Result: The Naming Preferences dialog box appears.

2 Select a naming preference for each object from its respective
drop-down list, then click on OK.

For each object or detail, you have the following choices: all
uppercase, all lowercase, each word initially capitalized, or free
form (the name is capitalized the way you type it in when you add
the object).
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Naming Preferences Dialog Box

Dialog Box
Illustration

           Naming Preferences Dialog Box

Dialog Box Use the information below to complete the Naming Preferences
Components dialog box.

Component         Description                                                                 
Attribute Choose a capitalization preference for attribute

names.

Comp Value Choose a capitalization preference for completion
values.

Property Choose a  capitalization  preference for property
names.

Design Choose a capitalization preference for design object
Object names.

Domain Choose a capitalization preference for domains.

Entity Choose a capitalization preference for entity names.

Fn Keyword Choose a capitalization preference for foreign key
words.
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Model View Choose a capitalization preference for model view
names.

Note Choose a capitalization preference for note titles.

Organization Choose a capitalization preference for organization
names.

Process Choose a capitalization preference for process
names.

Session Choose a capitalization preference for session titles.

Statement Choose a capitalization preference for statement
titles.
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NAVIGATE
 ASSOCIATION

Navigating Through Associations

Description The Navigate command displays the record for the entity at the
opposite end of an association.

Usage Tips This command is only available for associations in which both entities
in the association are visible in the current model view. This means that the
command may not be used for associations that appear dimmed in the Data
Dictionary window.

To return to the original entity after you use this command, simply choose
the Navigate command again.

+  Example  You use the Navigate command to display the entity at the
opposite end of an association. You then choose Navigate again to return to
the original entity record.

Procedure å To display the entity at the opposite end of an association:

1 In the Data Dictionary window, display the record for one of
the entities in the association.

2 In the Associations field, highlight the association through
which you want to navigate.

3 Choose Navigate from the Association menu.

Result: The record for the entity at the opposite end of the selected
association is displayed in the active Data Dictionary window.



497

NEW ENCYCLOPEDIA

Creating New Encyclopedias

Description The New Encyclopedia command allows you to create a new
encyclopedia.

Usage Tips It is preferable to designate an initial system administrator who will
create the encyclopedia. The initial system administrator may then add other
authorized users to the encyclopedia through the Visible Admin Utility
User/Add command.

When you create a new encyclopedia, you must define a logon that will
allow you to access the encyclopedia. For additional security, you may also
define a password for your logon.

The session feature allows documentation of additions and changes to the
encyclopedia. To use this feature, you simply define a session with which
all encyclopedia changes will be associated until a different session is
selected.

To define a default path for new encyclopedias, use the Default Path
command on the File menu.

Procedure å  To create an encyclopedia:

1 Choose New... from the Encyclopedia menu.

Result: The New Encyclopedia dialog box appears.

2 Complete the New Encyclopedia dialog box, then click on
OK.
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New Encyclopedia Dialog Box

Dialog Box
Illustration

                                

             New Encyclopedia Dialog Box

Dialog Box Use the information below to complete the New Encyclopedia
Components dialog box.

Component         Description                                                                 
Title Type a title for the encyclopedia in this box. The title

can be from 2 to 51 alphanumeric characters long
and may include spaces. This is a required field.

Purpose Type a purpose for the encyclopedia in this text box.
The purpose can be up to 32,000 alphanumeric characters
long.

Logon Type a logon for yourself in this box. The logon can
be from 2 to 15 alphanumeric characters long, may
include spaces and is not case-sensitive (`abc' is the same
as `ABC' and `Abc'). This is a required field.
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As a security measure, you will be required to type this
logon each time you open the encyclopedia. Any system
administrator may later change your logon through the
File/System Administration/User Accounts/Edit User
command.

Password If desired, type a password for yourself in this box.
The password can be 1 to 11 alphanumeric characters
long, may include spaces, and is case sensitive.

If you define a password here, you will be required to
supply the password with your logon each time you open
the encyclopedia.

Directory When the desired path appears in the Path field,
type the name of the new encyclopedia's directory in the
Directory field. The directory name must be unique, can
be from 1 to 8 alphanumeric characters long, and may not
include spaces.

Path Each Visible Advantage encyclopedia must be
located in a new directory. Before Visible Advantage can
create the new directory, you must specify its name and
where you want it to be located.

In the Path list box, double-click on the letter of the drive
where you want the new encyclopedia's directory to be
located. You may have to scroll through the list to reach
the drive letters.

The drive letter appears in the Path field and the names of
the directories on the specified drive are displayed in the
Path list box. To move up one directory level, double-
click on the [..] symbol in the Path list box.

If you want the new encyclopedia's directory to be a
subdirectory of an existing directory, double-click on the
name of that directory in the Path list box. The directory
name will appear after the drive letter in the Path field.
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NEW SESSION

Adding New Sessions

Description The New Session command allows you to add a new session with
which encyclopedia changes will be associated.

Usage Tips When you add a new session, you specify its title, type, and notes. For
more extensive editing capabilities, such as search and replace and character
formatting, use the Session Editor command on the Encyclopedia menu.

The session you add will not become the active session until you activate it
through the Select Session command.

Procedure å To add a new session:

1 Choose Sessions from the Encyclopedia menu on the main
Visible Advantage window.
or
Choose Encyclopedia Management from the main menu on any
other window, then choose Sessions from the cascading menu.

2 Choose New...  from the cascading menu from the
Sessions command.

Result: The Add Session dialog box appears.

3 Complete the Add Session dialog box, then click on OK.
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Add Session Dialog Box

Dialog Box
Illustration

                             

                       Add Session Dialog Box

Dialog Box Use the information below to complete the Add Session dialog
Components box.

Component         Description                                                                 
Title Type the session title into this box. You may type up

to 51 alphanumeric characters.

Type Select a session type from this drop-down list.

This list includes the standard session types, along with
any types added through the Table command on the main
Visible Advantage Admin Utility window.

Notes Type notes for the session in this text box. Session
notes might include session attendees, the date the session
first convened, and any stated objectives for the session.
Your notes may be up to 32,000 characters long.
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NORMAL

Returning Graphic Objects
to Normal Scale

Description The Normal command allows you to return graphic objects to  normal,
or default, scale.

Usage Tips Use this command after using the Larger, Smaller, or Window
command to rescale the objects in a graphic window.

This command is available in the Model View Hierarchy, Design Map, and
Data Map windows.

Procedure å To return objects in a graphic window to normal scale:

Choose Normal from the Display menu.

Result: The objects in the active window are redrawn to normal scale.
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NORMAL TEXT

Removing Formatting from
Editor Text

Description The Normal command, available from the Statement Editor window,
removes special formatting (bold or underline) from selected statement
text in the Statement Editor window.

Procedure å  To remove special formatting from selected Editor window
text:

1 Select the text from which you want to remove bold or
underline formatting.

2 Choose Style from the Format menu.

3 Choose Normal from the cascading menu for the Style
command.

Result: The selected text appears normal in the Statement Editor
window.
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NOTES

Adding Notes to the Encyclopedia

Description The Notes command allows you to attach notations to specific objects
in the encyclopedia. These notes can serve as reminders about certain
objects or they can be used to communicate with other encyclopedia users.

Usage Tips The Notes command is available from all windows except the matrix
windows, Statement Editor windows, and the Design Reference window.
The command is located on the menu for the window's principal object.

+  Example  If you are using the Data Dictionary or Data Map window, the
Notes command is located on the Entity menu; if you are using the Planning
Outline or Planning Dictionary, the Notes command is located on the
Statement menu.

If a note has been attached to the currently selected object in a window
where the Notes command is available, a checkmark appears next to the
Notes command.

You can print the notes you add to the encyclopedia in the form of a Notes
report or through the Notes option on reports for principal objects
(statements, entities, etc.). See the Reports section of this manual and the
User's Guide for more information.

Procedure å  To add a note to the encyclopedia:

1 Choose Notes... from the menu for the active window's
principal object (see Usage Tips, above).

Result: The Notes dialog box appears.

2 Click on the Compose button.

Result: The Add Note dialog box appears.

3 Type a title for the note into the Title field, then type the text
of your note into the Text field.
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4 Attach your note to specific objects in the encyclopedia. To do
this, click on the button in the Attach area that corresponds with
the object type to which you want to attach the note (User, View,
Statement, Entity, or Design Object).

Result: A Select or Locate dialog box for the type of object
appears, allowing you to select an object for note attachment.

5 Select the object name or title from the Select or Locate
dialog box, then click on OK.

Result: The Add Note dialog box reappears, and the object name or
title appears in the Attached list box.

6 Repeat the previous two steps for each object to which you
want to attach the note, then click on OK in the Add Note dialog
box.

Result: The Notes dialog box appears, and the title of  the new note
appears in the Notes list box.

7 Click on Close in the Notes dialog box.

å To modify an existing note in the encyclopedia:

1 Choose Notes... from the menu for the active
window's principal object (see Usage Tips, above).

Result: The Notes dialog box appears.

2 Highlight the title of the note in the Notes list box. If the title
of your note is not displayed in the list, click on the All Notes
button in the Include area.

3 Click on Modify.

Result: The Edit Note dialog box appears.

4 Edit the title and/or text of the note.

To attach additional objects to the note, use the buttons in the
Attach area.
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To remove existing object attachments, highlight the object
attachment in the Attached list box, then click on Detach.

5 When you are finished editing the note and its object
attachments, click on OK.

Result: The Notes dialog box reappears.

6 Click on Close in the Notes dialog box.

å To read a note:

1 Choose Notes... from the menu for the active window's
principal object (see Usage Tips, above).

Result:  The Notes dialog box appears.

2 Highlight the title of the note in the Notes list box. If
the title of your note is not displayed in the list, click on the
All Notes button in the Include area.

3 Click on Read.

Result: The Read Note dialog box appears.

4 View the note, then click on OK.

Result: The Notes dialog box reappears.

5 Click on Close in the Notes dialog box.

å To delete a note from the encyclopedia:

1 Choose Notes... from the menu for the active window's
principal object (see Usage Tips, above).

Result: The Notes dialog box appears.



507

2 Highlight the title of the note in the Notes list box. If
the title of your note is not displayed in the list, click on the All
Notes button in the Include area.

3 Click on Delete.

4 Click on Close.
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Notes Dialog Box

Dialog Box
Illustration

                                     

                          Notes Dialog Box

Dialog Box Use the information below to complete the Notes dialog box.
Components

Component         Description                                                                 
Notes The notes added to the encyclopedia appear in this

list box. Use the buttons and checkboxes in the Include
area to filter the notes that appear in this list.

Notes attached Click on this button to display in the Notes list
to selected box only those notes attached to the objects
[objects] you select through the Select button.

Select Click on this button to select objects whose attached
notes you want to display in the Notes list box.

When you click on this button, a dialog box for selecting
the active window's principal object appears. This may be
the Select Views, Select Statements, Select Entities, or
Select Design Objects dialog box, depending on the active
window.
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For information on completing these dialog boxes, see
Select Statements, Select Entities, or Select Data
Structures in this manual.

All Notes Click on this button to include all notes in the
Notes list box that have been written by the current user.

Show notes Click on this checkbox if you want to include
authored by in the Notes list box only those notes that have
current user 
only

Read Use this button to read a note. In the Notes list,
highlight the title of the note, then click on this button.
The Read Note dialog box appears, allowing you to view,
but not edit, the note.

Compose Use this button to add a new note to the
encyclopedia. When you click on this button, the Add
Note dialog box appears.

Modify Use this button to edit the title, text, and object
attachments for the note. In the Notes list, highlight the
title of the note you want to modify, then click on this
button. The Edit Note dialog box appears.

Delete Use this button to delete a note. In the
Notes list, highlight the title of the note, then click on this
button.
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Add Note Dialog Box

Dialog Box
Illustration

                       Add Note Dialog Box

Dialog Box Use the information below to complete the Add Note dialog box.
Components

Component         Description                                                                 
Author The logon of the current user appears in this field.

Title Type a title for the note into this field.

Text Type the text of the note into this box. You can type
up to 32,000 alphanumeric characters.

Attached The object attachments for the note are listed in this
box. Use the buttons in the Attach area to attach the note
to specific objects.

User Use this button to attach the note to an encyclopedia
user. This is the same as addressing the note to the user.

When you click on this button, the Select User dialog box
appears.
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View Use this button to attach the note to a view
defined for the encyclopedia.

When you click on this button, the Select Model View
dialog box appears.

Statement Use this button to attach the note to a planning
statement defined for the encyclopedia.

When you click on this button, the Locate
Planning Statement dialog box appears.

Entity Use this button to attach the note to an entity defined
for the encyclopedia.

When you click on this button, the Locate Entity dialog
box appears.

Design Use this button to attach the note to a design object
Object defined for the encyclopedia.

When you click on this button, the Locate Design Object
dialog box appears.

Detach Use this button to remove an attachment between a
note and an object. In the Attached list, highlight the
object you want to detach, then click on this button.
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OPEN ENCYCLOPEDIA

Opening Encyclopedias

Description The Open Encyclopedia command, available from the main Visible
Advantage window, allows you to access an existing encyclopedia.

Usage Tips Only authorized users of an encyclopedia may open it. When you open
an encyclopedia, you must supply a valid logon and, if one has been defined
for your logon, a password. Users defined as system administrators may add
other authorized users through the User/Add  command.

You may also select or add a session with which the encyclopedia
modifications you make will be associated. Associating encyclopedia
modifications with a specific session provides thorough documentation of
the encyclopedia's development.

Procedure å  To open an existing encyclopedia:

1 Choose Open... from the File menu.

Result: The Open Encyclopedia dialog box appears.

2 Complete the Open Encyclopedia dialog box, then click on
OK.

Result: The Visible Advantage Logon dialog box appears.

3 Type your logon into the  Logon field. Your entry should
be the logon specified when you were added as
an authorized user of the encyclopedia.

2  Note  The Logon field is not case-sensitive.

4 If a password has been defined for your logon, you must type
it into the Password field. To ensure security as you type your
password, asterisks will appear in the field.

2  Note  The password field is case-sensitive.

If a password  has not been defined for your logon, leave the
Password field blank.
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5 Click on OK.

Result: If the logon and password you typed were valid, the Select
Session dialog box appears. (Proceed to step 6.)

If the logon and password you typed were not  valid, the Invalid
Logon error message dialog box appears. If this happens, click on
OK to return to the Visible Advantage Logon dialog box. You may
then type a correct logon or cancel the dialog box.

6 Do you want to select an existing session for your
encyclopedia modifications?

If yes, select a session in the Select Session dialog box, then click
on OK. The Session list includes all open sessions. Open sessions
are those that have not been closed through the
Project/Sessions/Close command. (End of procedure.)

Do you want to create a new session for your encyclopedia
modifications?

If yes, click on the New command button in the Select Session
dialog box. The Add Session dialog box appears. (Proceed to step
7.)

7 Complete the Add Session dialog box, then click on OK.
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Open Encyclopedia Dialog Box

Dialog Box
Illustration

          Open Encyclopedia Dialog Box

Dialog Box Use the information below to complete the Open Encyclopedia dialog
Components box

Component         Description                                                                 
Encyclopedias A list of directories and titles is in this box. The list

includes all encyclopedias located in the path displayed in
the Path field.

If the encyclopedia you want to open is listed here,
highlight its name.

Path The drives available on your computer are in this list
box.

If the encyclopedia you want to open is not listed in the
Encyclopedias list box, navigate through this list box to
display the encyclopedia's drive in the Path field (above
the list box).

2  Note  The encyclopedia's directory may be in a sub-
directory. If so, double-click its name so that it appears in
the Path field after the selected drive letter.



515

OPEN STATEMENT

Opening Statements

Description The Open Statement command, available from the Statement Editor
window, allows you to open a statement text file so that you may edit the
statement text.

Procedure å To open a statement file in the Statement Editor window:

1 Choose Open...  from the File menu.

Result: The Select Statement dialog box appears.

2 Select the statement you want to open from the Statement list
box, then click on OK.
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OPTIONS

Overview

Description The Options command allows you to set display preferences in certain
Visible Advantage windows. The Options command is available from all
windows except the Design Reference, Statement Editor, main Visible
Advantage, and Matrix windows.

Usage Tips Most display options are stored with the entire encyclopedia, rather
then with the current model view. Those stored with the current model view
are noted, where applicable.

In This This chapter contains the following topics:
Section

Topic                                                                           
Setting View Hierarchy Options
Setting Planning Outline Options
Setting Planning Dictionary Options
Setting Data Map Options
Setting Data Dictionary Options
Setting Process Map Options
Setting Design Dictionary Options
Setting Design Map Options
View Display Options Dialog Box
Outline Display Options Dialog Box
Planning Dictionary Options Dialog Box
Data Map Display Options Dialog Box
Data Dictionary Display Options Dialog Box
Process Map Display Options Dialog Box
Design Dictionary Display Preferences Dialog Box
Design Map Display Options Dialog Box
Color Dialog Box



517

SETTING VIEW
 HIERARCHY OPTIONS

Description In the View Hierarchy window, use the Options command to:
o   Add or remove the shadow effect on the model views in the
      window
o   Adjust the row spacing of the model view hierarchy diagram
o   Change the model view and text colors in the window

Usage Tips All Model View Hierarchy display options are stored with the entire
encyclopedia.

Procedure å  To set View Hierarchy window display options:

1 Choose Options... from the Display menu.

Result: The View Display Options dialog box appears.

2 Complete the View Display Options dialog box.

If you want to change the color of the model views in the model
view diagram, click on View Color. The Color dialog box appears.

If you want to change the color of the text inside the model view
boxes, click on View Text Color. The Color dialog box appears.

3 When you are finished completing the dialog box, click on
OK.
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SETTING PLANNING
 OUTLINE OPTIONS

Description In the Planning Outline window, use this command to:
o   Define the type of line numbering scheme to display in the
      planning outline
o   Show or hide statement types and priorities

Usage Tips All Planning Outline options are stored with the entire encyclopedia.

Procedure å  To set planning outline display options for the current model
view:

1 Choose Options... from the Display menu.

Result: The Outline Display Options dialog box appears.

2 Complete the Outline Display Options dialog box, then click
on OK.
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SETTING PLANNING
DICTIONARY OPTIONS

Description In the Planning Dictionary window, use this command to show or hide
parent and child statements, data links, model views, and time/date stamps.

Usage Tips All Planning Dictionary options are stored with the entire
encyclopedia.

Procedure å  To set planning dictionary display options for the current
model view:

1 Choose Options...  from the Display menu.

Result: The Planning Dictionary Display Options dialog box
appears.

2 Complete the Planning Dictionary Display Options dialog
box, then click on OK.
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SETTING DATA
MAP OPTIONS

Description In the Data Map window, use the Options command to:
o   Change entity box and text color and display or hide entity
      shadowing
o   Show or hide view authorities, entity types, control lines, key
      attributes, non-key attributes, association names, association
      cardinalities, and/or static values
o   Change the data map's orientation (horizontal or vertical)
o   Optimize entity groupings for maximum space efficiency
o   Adjust the data map's row and column spacing
o   Choose automatic or manual drawing mode

Usage Tips Color and shadowing settings are stored with the entire encyclopedia.
All other Data Map display options are stored with the current model view
only.

Procedure å  To set display options for the Data Map window:

1 Choose Options... from the Display menu.

Result:  The Map Display Options dialog box appears.

2 Complete the Map Display Options dialog box.

If you want to change the color of the entities in the data map,
click on Entity Color.  The Color dialog box appears.

If you want to change the color of the text on the entities, click on
Entity Text Color. The Color dialog box appears.

3 When you are finished completing the dialog box, click on
OK.



521

SETTING DATA
DICTIONARY OPTIONS

Description In the Data Dictionary window, use the Options command to show or
hide cluster end points, attributes, associations, control links, statement
links, model views, model links, and time/date stamps in the Data
Dictionary window.

Usage Tips All Data Dictionary display options are stored with the entire
encyclopedia.

Procedure å  To set display options for the Data Dictionary window:

1 Choose Options... from the Display menu.

Result: The Data Dictionary Display Options dialog box appears.

2 Complete the Data Dictionary Display Options dialog box,
then click on OK.
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SETTING PROCESS
MAP OPTIONS

Description In the Process Map window, use the Options command to:
o   Show or hide each step's attribute list(s)
o   Change step box and text color and display or hide entity
      shadowing

Usage Tips All Process Map display options are stored with the entire
encyclopedia.

Procedure å  To set display options for the Process Map window:

1 Choose Options... from the Display menu.

Result: The Process Map Display Options dialog box appears.

2 Complete the Process Map Display Options dialog box.

If you want to change the color of the steps in the process map,
click on Step Color. The Color dialog box appears.

If you want to change the color of the text inside the steps, click on
Step Text Color. The Color dialog box appears.

3 When you are finished completing the dialog box, click on
OK.
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SETTING DESIGN
 DICTIONARY OPTIONS

Description In the Design Dictionary window, use the Options command to show
or hide the following data structure details:
o   Properties
o   Data access mechanisms
o   Design views
o   Relationships
o   Model links
o   Time/date stamps

Usage Tips All Design Dictionary display options are stored with the entire
encyclopedia.

Procedure å To set display options for the Design Dictionary window:

1 Choose Options... from the Display menu.

Result: The Design Dictionary Display Options dialog box
appears.

2 Complete the dialog box, then click on OK.
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SETTING DESIGN MAP
OPTIONS

Description In the Design Map window, use the Options command to show or hide
the following:
o   Change box and text color
o   Display or hide properties, view authorities, types and static values
o   Change design map’s orientation (horizontal or vertical)
o   Adjust the design map’s row and column spacing
o   Choose automatic or manual drawing mode
o   Display or hide relationship names and cardinalities and
      access mechanism relationships
o   Optimize box groupings for maximum space efficiency

Procedure å  To set display options for the Design Map window:

1 Choose Options…  from the Display menu.

Result:  The Design Map Display Options dialog box
appears.

2 Complete the dialog box, then click on OK.
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View Display Options Dialog Box

Dialog Box
Illustration

                   View Display Options Dialog Box

Dialog Box Use the information below to complete the View Display Options
Components dialog box.

Component                       Description                                                   
Shadowed Views Select this checkbox if you want the model

view boxes in the diagram to display with a
shadowed effect.

View Color Click on this button if you want to change
the color of the model view boxes in the
model view diagram.  The color dialog box
appears when you click on this button.

View Text Color Click on this button if you want to change
the color of the text inside the model view
boxes.  The color dialog box appears when
you click on this button.
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Outline Display Options Dialog Box

Dialog Box
Illustration

                                         

                      Outline Display Options Dialog Box

Dialog Box Use the information below to complete the Outline Display Options
Components dialog box.

Component         Description                                                                 
Numbering Select a line numbering scheme from this drop-down

list. The available options are explained below.

None Lines are not numbered.

Outline Lines are numbered using the following scheme:
numbering I-II-III (first level), A-B-C (second level), 1-2-3

(third level), a-b-c (fourth level).

Line numbering Lines are numbered sequentially.

Specification Lines are numbered using the following
numbering scheme: 1-2-3 (first level), 1.1-1.2-1.3

(second level), 1.1.1-1.1.2-1.1.3 (third level), and so
on.

Show Select this checkbox if you want each statement's
Statement type to appear in parentheses after its title.
Types

Show Priorities Select this checkbox if you want each statement's
priority level to appear in brackets after its title.
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Planning Dictionary Display
Options Dialog Box

Dialog Box
Illustration

                                

                Planning Dictionary Display Options

Dialog Box Use the information below to complete the Planning Dictionary
Components Display Options dialog box.

Component         Description                                                                 
Show Parent Select this checkbox if you want to display the Is
Statements Part Of field, listing each statement's parent

statement.

Show Child Select this checkbox if you want to display the
Statements Consists Of field, listing each statement's child

statements.

Show Data Select this checkbox if you want to display
Links the Data Links field, which lists the dictionary

objects linked to each statement.

Show Model Select this checkbox if you want to display
Views the Model Views field, which lists the names of all

model views in which each statement is visible.

Show Time/ Select this checkbox if you want to display the
Date Stamps Created and Modified fields, which show the date

and time each statement was created and last
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modified, as well as the name of the user responsible
for the creation and last modification.
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Data Map Display Options Dialog Box

Dialog Box
Illustration

                              

            Data Map Display Options Dialog Box

Dialog Box Use the information below to complete the Map Display Options
Components dialog box.

Component         Description                                                                 
Entity Text Select the checkbox for each item you want to

display on the entity boxes. This includes, view
authorities, entity types, key and non-key attributes, and
static values.

Shadow Select this checkbox to display the entities
Entities with a shadowed effect.

Variable Width Select this checkbox to display the entities with
variable width.
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Entity Color Click on this button to define the color of the entity
boxes in the Data Map window. The Color dialog box
appears when you click on this button.

Entity Text Click on this button to define the color of the text
Color in the data map entity boxes. The Color dialog box

appears when you click on this button.

Auto Select this button for automatic drawing mode.

Manual Select this button for manual drawing mode.

Row Select the number of rows you want placed between
each entity in the data map diagram. Increasing the
number in the Row box makes the data map diagram
taller.

You do this by clicking on the up and down arrows until
the desired number of rows between each entity appears
in the Row box.

Col Select the number of columns you want placed
between each entity in the data map diagram. Increasing
the number in the Col box makes the data map diagram
wider.

You do this by clicking on the up and down arrows until
the desired number of columns between each entity
appears in the Col box.

For small model views, a column spacing of `1' is
adequate. For larger data models (over 200 entities), you
will need to increase the column spacing to allow room
for association lines between entities.

Association Select this checkbox if you want to display
Names association names.

Association Select this checkbox if you want to display
Cardinalities association cardinalities.

Control Select this checkbox if you want to display control
Lines link lines between entities. Control links are
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displayed as dotted arrows pointing from the
controlling entity to the controlled entity.

Optimize Select this checkbox if you want Visible Advantage
Entity to arrange entities so that the association lines are
Groupings as short as possible (useful for large models).

Horizontal Select this button if you want to orient the data map
horizontally (association lines left to right).

Vertical Select this button if you want to orient the data map
vertically (association lines top to bottom).
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Data Dictionary Display Options Dialog Box

Dialog Box
Illustration

                                   

          Data Dictionary Display Options Dialog Box

Dialog Box Use the information below to complete the Data Dictionary Display
Components Options dialog box.

Component                       Description                                                   
Cluster End Points Select this checkbox if you want to display

the Cluster End Pt field for entities that are
derived or designated cluster end points.

Attributes Select this checkbox if you want to display
the Attributes field, which lists each entity's
attributes.

Associations Select this checkbox if you want to display
the Associations field, which lists the
associations for each entity.

Controls Select this checkbox if you want to display
the Controls and Controlled By fields. The
Controls field lists the entities that are controlled
by the current entity; the Controlled By field lists
the entities that control the current entity.
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Show Model Views Select this checkbox if you want to display
the Model Views field, which lists the model
views in which each entity is visible.

Show Model Select this checkbox if you want to display
Links the Model Links field, which lists the

models linked to each entity.

Show Time/ Select this checkbox if you want to display
Date Stamps the Created and Modified fields, which

show the date and time each entity was created
and last modified, as well as the name of the
user(s) responsible for the creation and last
modification.
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Process Map Display Options Dialog Box

Dialog Box
Illustration

 Process Map Display Options Dialog Box

Dialog Box Use the information below to complete the Process Map Display
Components Options dialog box.

Component                       Description                                                   
Display Step Lists Select this checkbox to display each process

step's attribute list(s) (Initiation, Return,
etc.).

Shadow Steps Select this checkbox to display the steps
with a shadowed effect.

Step Color Click on this button to define the color of
the step boxes in the Process Map window. The
Color dialog box appears when you click on this
button.

Step Text Color Click on this button to define the color of
the text in the process map step boxes. The
Color dialog box appears when you click on
this button.
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Design Dictionary Display
Preferences Dialog Box

Dialog Box
Illustration

                                      

                      Design Dictionary Display Preferences Dialog Box

Dialog Box Use the information below to complete the Design Dictionary Display
Components Preferences dialog box.

Component         Description                                                                 
Properties Select this checkbox if you want to display the

properties that belong to each design object in the Design
Dictionary window.

Data Access Select this checkbox if you want to display
Mechanisms the access mechanisms for each design object.

Design Select this checkbox if you want to display
Views the design view to which the design objects

belong.

Relationships Select this checkbox if you want to display the
relationships for each design object.

Model Select this checkbox if you want to display
Links the links between design objects and other

encyclopedia objects (statements, entities, etc.)

Time/Date Select this checkbox if you want to display the time
Stamps and date each design object was created and last

modified.
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Design Map Display Options
Dialog Box

Dialog Box
Illustration

                  Design Map Display Options Dialog Box

Dialog Box Use the information below to complete the Design Map Display
Components Options dialog box.

Component         Description                                                                 
Properties Select the checkbox for each item you want to

display on the boxes.  This includes key data items,
non-key data items, and object properties.

Other Text Select the checkbox for each item you want to
Inf. display on the boxes.  This includes view

authorities, types, static values, and access
mechanisms.

Shadow Select this checkbox to display the boxes with
Boxes a shadowed effect.
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Variable Select this checkbox to display the boxes with
Width variable width.

Box Color Click on this button to define the color of the
boxes in the Design Map window.  The Color
dialog box appears when you click on this
button.

Box Text Click on this button to define the color of the
Color text in the design map boxes.  The Color dialog

box appears when you click on this button.

Auto Click this button for automatic drawing mode.

Manual Select this button for manual drawing mode.

Row Select the number of rows you want placed
between each box in the design map diagram.
Increasing the number in the Row box makes
the design map diagram taller.

You do this by clicking on the up and down
arrows until the desired number of rows between
each box appears in the Row box.

Col Select the number of columns you want placed
between each box in the design map diagram.
Increasing the number in the Col box makes the
design map diagram wider.

You do this by clicking on the up and down arrows
until the desired number of columns between each
box appears in the Col box.

For small views, a column spacing of ‘1’ is
adequate.  For larger design models, you will
need to increase the column spacing to allow
room for relationship lines between entities.

Relationship Select this checkbox if you want to display
Names relationship names.
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Relationship Select this checkbox if you want to display
Cardinalities relationship cardinalities.

Access Mech Select this checkbox if you want to display
Relationships access mechanism relationships.

Optimize Box Select this checkbox if you want Visible
Groupings Advantage to arrange boxes so that the relationship

lines are as short as possible (useful for large
models).

Horizontal Select this button if you want to orient the design
map horizontally (relationship lines left to right).

Vertical Select this button if you want to orient the design
map vertically (relationship lines top to bottom).
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Color Dialog Box

Dialog Box
Illustration

                              

                         Color Dialog Box

Dialog Box Use the information below to complete the Color dialog box.
Components

Component         Description                                                                 
Basic Colors If you want to choose one of the 48 predefined basic

colors, click on one in this area. The selected color
appears on the left side of the Color/Solid box.

Custom Colors If you want to define a custom color, click on one of
the boxes in this area, then adjust the color using the Hue,
Sat, Lum or Red, Green, Blue fields and click on the Add
to Custom Colors button.

Hue, Sat, Lum You may change a custom color by entering values
in these fields, which represent the Hues color
model.

Hue, saturation, and luminosity may also be adjusted by
sliding the color refiner cursor (the black cross in the
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center of the large color spectrum box) until the desired
color appears on the left side of the Color/Solid box.

Red, Green, You may also define a custom color by entering
Blue values in these fields, which represent the RGB

(Red/Green/Blue) color model.

Red, green, and blue values may also be adjusted by
sliding the color refiner cursor (the black cross in the
center of the large color spectrum box) until the desired
color appears on the left side of the Color/Solid box.

Add to Custom Click on this button to add the color displayed
Colors in the Color/Solid box to the Custom Colors palette.
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OUTPUT LIST

Displaying and Hiding the Output List

Description The Output List command, available from the Process Map window,
displays the Output List box in the Process Map window when it is hidden,
and hides the Output List box when it is displayed.

The Output List box contains the sum of all Present lists of a process,
showing all data the process provides.

Procedure å  To display or hide the Output List:

Choose Output List from the Display menu.

Result: If the Output List box was hidden when you chose the command,
the list appears in the active Process Map window.

If the Output List was displayed when you chose the command, the list
disappears from the active Process Map window.
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PARAMETERS

Setting Matrix Window Parameters

Description The Parameters command, available from all matrix windows, allows
you to select the objects and/or object types to display on the left and top
axes of the active matrix window.

Usage Tips This command is available from all matrix windows. The dialog box
that appears for the command, however, depends on the current matrix
window. Each matrix window has a distinct dialog box.

+   Example  If you are working in the Entity-View Matrix window and
you choose this command, the Entity-Model View Matrix dialog box
appears.

Procedure å  To set matrix window parameters for the current matrix
window:

1 Choose  Parameters...  from the Matrix menu.

Result: The dialog box for choosing the objects/object types for the
left and top axes appears.

2 Complete the dialog box, then click on OK.

For information on completing the dialog box, see the section in
this manual for opening the type of matrix window in which you
are working.

+   Example  To read about the fields in the parameters dialog box
for the Statement-View Matrix window, see Statement-View
Matrix in this manual.
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PASTE

Pasting Text in a Text Editor Window

Description The Paste command, available from the Statement text editor
windows, pastes text from the Windows clipboard to a location in the
Statement Editor window.

Selected text is copied or cut to the Windows clipboard through the Copy
and Cut commands on the Statement/Session Editor window's Edit menu.

Procedure å  To paste clipboard text to a new location:

1 Click on the location you want the pasted text to appear (the
insertion point).

2 Choose Paste from the Edit menu.

Result: The text appears in the new location.
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PLANNING DICTIONARY

Opening a Planning
Dictionary Window

Description The Planning Dictionary command allows you to open a Planning
Dictionary window. This window provides a textual record of the
statements in the current model view. This command is available from all
windows.

Usage Tips Planning statements are listed in alphabetical order in the Planning
Dictionary window. The Planning Dictionary window may be sized and
converted to an icon using standard Windows commands.

Procedure å  To open a Planning Dictionary window:

1 Choose Planning Dictionary...  from the Plan menu on the
main Visible  Advantage window.
or
Choose Planning from the main menu on any other window, then
choose Planning Dictionary... from the Planning cascading menu.

Result: If model views have been defined for the encyclopedia, the
Select Model View dialog box appears. (Proceed to next step.)

Otherwise, the Planning Dictionary window for the entire
encyclopedia appears. (End of procedure.)

2 The Select Model View dialog box contains a list of all model
views defined for the encyclopedia.

If you want to display the model view list in hierarchical order,
select the Structured button. If you want to display the model
view list in alphabetical order, select the Alphabetical button.

3 Highlight the name of the model view you want to display in
the Planning Dictionary window. If you want to display the entire
encyclopedia, select Entire Model in the Select area.

4 Click on OK.
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Related Topics The table below shows where you can find information related to the
Planning Dictionary command.

For More Information On...                        See...                                  
how to use each command in the entry in this manual for the
the Planning Dictionary window individual command. For example,

to learn how to use the Add
command on the Statement menu,
see Add Statement

how to use the Planning the Planning section in the
Dictionary window's special User's Guide
features, such as the tool bar,
mouse commands, and
keyboard shortcuts,
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PLANNING OUTLINE

Opening a Planning
Outline Window

Description The Planning Outline command allows you to open a Planning
Outline window. The Planning Outline window provides a structured
outline of the planning statements that direct the construction of various
parts of the encyclopedia. This command is available from all windows.

Usage Tips The Planning Outline window may be sized and converted to an icon
using standard Windows commands.

The planning outline shows relationships between the planning statements,
such as which policy statement(s) supports an objective statement. You may
add, edit, and delete statements and statement links through the Planning
Outline window.

If you want to view and/or edit a detailed view of the statements in an
encyclopedia, use the Planning Dictionary window, which provides an
alphabetical listing of planning statements.

Procedure å  To open a Planning Outline window:

1 Choose Planning Outline...  from the Plan menu on the main
Visible Advantage window.
or
Click on the Planning Outline window icon on the main
Visible Advantage window.
or
Choose Planning from the main menu on any other window,
then choose Planning Outline... from the Planning cascading
menu.

Result: If any model views have been defined for the encyclopedia,
the Select Model View dialog box appears. (Proceed to next step.)

Otherwise, the Planning Outline window for the entire
encyclopedia appears. (End of procedure.)
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2 The Select Model View dialog box contains a list of all model
views defined for the encyclopedia.

If you want to display the model view list in hierarchical order,
select the Structured button. If you want to display the model
view list in alphabetical order, select the Alphabetical button.

3 Highlight the name of the model view you want to display in
the Planning Outline window. If you want to display the entire
encyclopedia, select Entire Model in the Select area.

4 Click on OK.

Related Topics The table below shows you where to find information related to the
Planning Outline command.

For More Information On...          See...                                                
how to use each command in the entry in this manual for the 
the Planning Outline window individual command. For example,

to learn how to use the Add
command on the Statement menu,
see Add Statement.

how to use the Planning the Planning section in the
Outline window's special User's Guide.
features, such as the tool bar,
mouse commands, and
keyboard shortcuts,
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POPULATE

Populating Tables

Description The Populate command allows you to record predefined values for a
static entity's attributes or a static design object’s data items.

Usage Tips This command is available only for static entities and data structures.
If the current entity's/data structure's nature has been defined as dynamic,
rather than static, this command is dimmed to indicate that it is not
available.

The values you enter through this command are included as data in any
database generated with the Generate SQL Schema command on the
Implementation menu.

Procedure å  To populate a table for the current entity or data structure:

1 Choose Populate... from the Entity menu (Data
Dictionary/Data Map) or from the Design Object menu
(Design Dictionary).

Result: The Populate dialog box appears. The current entity's
attributes or design object’s data items are listed across the top of
the dialog box.

2 Type a value for each attribute or data item. To do this, you
must first click on the cell that intersects with the attribute/data
item and row number for which you want to add a value. Each
value may be up to 31 alphanumeric characters long and may
include spaces.

If you want to insert a row of values between two existing rows in
the table, highlight the number of the row before which you want
to insert the new row, then click on Insert.

If you want to delete a row, highlight the number of the row you
want to delete, then click on Delete.

3 Repeat the previous step for each static value you want to add.

4 When you are finished adding values, click on OK.
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Populate Dialog Box

Dialog Box
Illustration

                    

                 Populate Dialog Box

Dialog Box Use the information below to complete the Populate dialog box.
Components

Component         Description                                                                 
Insert Use this button to insert a row between two existing

rows. Highlight the number of the row before which
you want to insert the new row, then click on this
button.

Delete Use this button to delete an existing row. Highlight
the number of the row you want to delete, then click
on this button.
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PRINT DATA MAP

Printing Data Maps

Description The Print Data Map command, available from the Data Map window,
allows you to print the data map diagram displayed in the Data Map
window.

Usage Tips When you print a data map, you can specify a title and subtitle to be
printed at the top of the data map. You can also include entity details, page
numbers, and crop marks on the printed data map, and define the size of the
diagram.

If the data map is displayed in IDEF1X format when you choose this
command, it will print in that format. See the Appendices section of this
manual for more information on data maps printed and displayed in
IDEF1X format.

Procedure å  To print a data map diagram:

1 Choose Print Data Map...  from the Display menu.

Result: The Print Data Map dialog box appears.

2 Complete the dialog box, then click on OK.
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Print Data Map Dialog Box

Dialog Box
Illustration

                                        

                Print Data Map Dialog Box

Dialog Box Use the information below to complete the Print Data Map dialog box.
Components

Component         Description                                                                 
Entire Model Select this button to print the entire model view.

Single Model Select this button to print a single model view.
View Select the view from the drop down list.

Title Type a title for the data map into this box. The title
appears in large letters at the top of the printed data map
diagram.

Subtitle The name of the model view appears in this box. If
you wish, you may type a new subtitle for the data map.
The subtitle appears beneath the title at the top of the data
map diagram.
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Scale Slide this scroll bar until the values in the Grid Size
and/or Pages fields correspond to the desired diagram
size.

The Pages value tells you how many pages wide and high
the diagram will cover at the scale value selected. This
scroll bar allows you to define the size of the printed data
map.

Page Numbers Select this checkbox if you want the data map pages
to be numbered.

The numbering scheme is `C/R', where `C' is the column
number for the data map page assembly, and `R' is the
row number. This numbering scheme makes it easy to
paste the pages of the data map together.

Crop Marks Select this checkbox if you want crop marks to print
on the data map pages. Crop marks are guides that show
you where to cut each data map page before pasting the
pages together.

Printer Setup Use this button to define the printer to which the
data map will be printed.

When you click on this button, the Windows Printer Setup
dialog box appears. See your Windows documentation for
information on installing and selecting printers in
Windows applications.
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PRINT DESIGN MAP

Printing the Design Map

Description The Print Design Map command, available from the Design Map
window, allows you to print the design map diagram.

Procedure å  To print the design map:

1 Choose Print Design Map…  from the Display menu.

Result:  The Print Design Map dialog box appears.

2 Complete the dialog box, then click on OK.
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Print Design Map Dialog Box

Dialog Box
Illustration

       Print Design Map Dialog Box

Dialog Box Use the information below to complete the Print Design Map dialog
Components box.

Component         Description                                                                 
View Select the view from the drop-down list.

Template Select the template from the drop-down list.

Title Type a title for the map in this box.  The title
will print at the top of the printed map.  This
field defaults to the name of the encyclopedia.

Subtitle Type a subtitle for the map in this box.  The
subtitle will print below the title.  This field
defaults to the name of the template.
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Scale Slide this scroll bar until the values in the
Grid Size and/or Pages fields correspond to the
desired diagram size.

Page Numbers Select this checkbox if you want to print page
numbers on the printed diagram.

The numbering scheme is ‘C/R,’ where ‘C’ is
the column number for the diagram page assembly,
and ‘R’ is the row number.  This numbering scheme
makes it easy to paste the pages of the diagram
together.

Crop Marks Select this checkbox if you want to print crop marks
showing you where to trim the map pages before you
paste them together.

Printer Click on this button to access the Printer Setup
Setup dialog box.  See Printer Setup in this manual for

more information.
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PRINT PROCESS MAP

Printing Process Maps

Description The Print Process Map command, available from the Process Map
window, allows you to print the process map diagrams from the
encyclopedia's process model.

Usage Tips When you print process maps, you can include all or selected processes
and those that access the entire model or selected model views. You can
also print attribute lists, page numbers, and crop marks, as well
as define the size of the diagrams.

Procedure å  To print process map diagrams:

1 Choose Print Process Map... from the Display menu.

Result: The Print Process Map dialog box appears.

2 Complete the dialog box, then click on OK.
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Print Process Map Dialog Box

Dialog Box
Illustration

       Print Process Map Dialog Box

Dialog Box Use the information below to complete the Print Process Map dialog
Components box.

Component         Description                                                                 
All Processes Select this button if you want to print a map for each

process in the process model.

Selected Select this button if you want to print a process
Processes map only selected processes in the process model.

You  click on Select Processes button to select the
processes you want to include.

Select  Use this button to select the processes for which
Processes you want to print process maps. When you click on

this button, the Select Processes dialog box appears.

The Entire Select this button if you want to print
Model processes that access entities in the entire
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encyclopedia, rather than a single or selected model
views.

Selected Select this button if you want to print process
Model Views maps that access entities in selected model views.

You use the Select Model Views button to select the
model views.

Select Model Use this button to select the model views that
Views contain the entities accessed by the processes for

which you want to print process maps.

Attribute Lists Select this checkbox if you want the attribute list(s)
for each process step to be printed on the process
map diagram(s).

Page Numbers Select this checkbox if you want the process map
pages to be numbered.

The numbering scheme is `C/R', where `C' is the column
number for the process map page assembly, and `R' is the
row number. This numbering scheme makes it easy to
paste the pages of the map together.

Crop Marks Select this checkbox if you want crop marks to print
on the map pages. Crop marks are guides that show you
where to cut each map page before pasting the pages
together.

Scale to Page Select this button if you want Visible Advantage
to scale the process map(s) so that each one fits on a
page.

Specify Scale Select this button if you want to scale the process
map(s) to a specified scale. To specify the scale, click on
the up and down arrows to the right of this selection
button until the desired scale appears in the field.

The number in the field represents the number of inches
between process steps on the printed process map(s). If
you increase the scale number, your process map diagram
may not fit on a single page.
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Printer Setup Use this button to define the printer to which the
process map(s) will be printed.

When you click on this button, the Windows Printer Setup
dialog box appears. See your Windows documentation for
information on installing and selecting printers in
Windows applications.
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Select Processes Dialog Box

Dialog Box
Illustration

Select Processes Dialog Box

Dialog Box Use the information below to complete the Select Processes dialog
Components box.

Component                       Description                                                   
Selected Processes The names of the selected processes are

listed in this box.

Initially, this list box is empty. You add
processes to this list from the Candidates list
box.

Use this button to select process candidates. 
Highlight the processes in the Candidates
list box, then click on this button. They will
then appear in the Selected Processes list
box.
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Use this button to deselect processes.
Highlight the processes in the Selected
Process list box, then click on this button. They
will then return to the Candidates list box.

Use this button to select all process
candidates. When you click on this button,
all processes in the Candidates list box will
be moved to the Selected Processes list box.

Use this button to deselect all selected
processes. When you click on this button, all
processes in the Selected Processes list box
will be returned to the Candidates list box.

Candidates This box contains all processes that access
the selected model view(s) that are of the type(s)
specified in the Include area (business processes
and/or data access processes).

If both  Include checkboxes are selected, then all
processes that access the selected model view(s)
are listed in this list box.

Business Processes Select this checkbox to include business
processes in the Candidates list box.

Data Access Processes Select this checkbox to include data access
processes in the Candidates list box.
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PROCESS-ATTRIBUTE MATRIX

Opening a Process-Attribute
Matrix Window

Description The Process-Attribute Matrix window is a graphical matrix table listing an
encyclopedia’s processes on the left axis and the attributes in the
encyclopedia or a single or selected model view(s) on its top axis.  Inside
each cell is a letter for each type of access the process has for the attribute
(create, read, update or delete).

Procedure å  To open a Process-Attribute Matrix window:

1 From the main Visible Advantage window, choose
Process-Attribute... from the Process menu.
or
From any other window, choose Process Modeling from the
main menu, then choose Process-Attribute from the cascading
menu.

Result:  The Process-Attribute Matrix dialog box appears.

2 Select each checkbox for the process type(s) you want to display
on the left and top axes (business processes and/or data access
processes).

3 If you want to display the processes that access all attributes in
the encyclopedia, click on Entire Model.  If you want to display
the processes that access the attributes in one model view, click on
the Single Model View button, then select the model view from
the drop-down list.

4 Click on OK.
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PROCESS-ENTITY MATRIX

Opening a Process-Entity
Matrix Window

Description The Process-Entity Matrix command allows you to open a Process-
Entity Matrix window for a single model view or for the entire
encyclopedia. The Process-Entity Matrix window allows you to view
relationships between the processes and entities in the encyclopedia. This
command is available from all windows.

Procedure å  To open a Process-Entity Matrix window:

1 From the main Visible Advantage window, choose Process-
Entity Matrix... from the Process menu.

From any other window, choose Process Modeling from the main
menu, then choose Process-Entity Matrix... from the cascading
menu.

Result: The Process-Entity dialog box appears.

2 Select the process types you want to display on the left axis of
the matrix (business processes and/or data access processes).

3 If you want to display all types of entities on the top axis of
the matrix, select the All Entity Types button.

If you want to display selected types of entities on the top axis,
select the Selected Entity Types button, then click on Select
Entity Types. The Entity Types dialog box appears. Select the
entity types, then click on OK to return to the Process-Entity
Matrix dialog box.

4 If you want to display all entities in the encyclopedia, select
Entire Model in the Select area. If you want to display the entities
in one model view, click on the Single Model View button, then
select the model view from the drop-down list.

5 Click on OK.
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PROCESS HIERARCHY

Opening a Process Hierarchy Window

Description The Process Hierarchy command allows you to open a Process
Hierarchy window, which provides a structured hierarchy of the following
process model components:
o   Business events
o   Business processes initiated by each business event
o   Data access processes that access the data model

This command is available from all windows.

Usage Tips The Process Hierarchy window may be sized and converted to an icon
using the standard Windows commands.

The Process Hierarchy window shows relationships between the different
processes such as which business event causes which business process and
which data access process(es) or other business processes a business
process causes. You may add, edit, and delete processes and their
dependencies through the Process Hierarchy window.

If you want to view and/or edit a detailed process, along with its steps and
control flows, use the Process Map window, which provides a graphical
map of a particular process and its components.

Procedure å  To open a Process Hierarchy window:

1 Choose Process Hierarchy... from the Process menu on the
main menu bar or from the Main menu on any other menu bar.

Result: The Select Model View dialog box appears.

2 The Select Model View dialog box contains a list of all model
views defined for the encyclopedia.

If you want to display the model view list in hierarchical order,
select the Structured button. If you want to display the model
view list in alphabetical order, select the Alphabetical button.
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3 Highlight the name of the model view you want to display in
the Process Hierarchy window. If you want to display the entire
encyclopedia, select Entire Model in the Select area.

4 Click on OK.

Related Topics The table below shows you where to find information related to the
Process Hierarchy command.

For more information on...                          See...                                  
how to use each command in the entry in this manual for the
the Process Hierarchy window individual command. For example,

to learn how to use the Add
command on the Process menu, see
Add Process.

how to use the Process the Process Hierarchy Window
Hierarchy window's special section in the User's Guide
features, such as the tool bar,
mouse commands, and
keyboard shortcuts,
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PROCESS MAP

Opening a Process Map Window

Description The Process Map command allows you to open a Process Map
window. This window provides a graphical representation of a selected
process, its steps, control flows and other components in the current model
view. This command is available from all windows.

Usage Tips The Process Map window may be sized and converted to an icon
using standard Windows commands. When a Process Map window is
activated, the Process Map menu bar appears across the top of the
workspace.

Procedure å  To open a Process Map window:

1 Choose Process Map... from the Process menu on the main
menu bar or from the main menu on any other menu bar.
or
Click on the Process Map icon on the main Visible
Advantage window.

Result: The Select Model View dialog box appears.

2 The Select Model View dialog box contains a list of all model
views defined for the encyclopedia.

If you want to display the model view list in hierarchical order,
select the Structured button.  If you want to display the model
view list in alphabetical order, select the Alphabetical button.

3 Highlight the name of the model view you want to display in
the Process Map window.

If  you want to display the entire encyclopedia, select Entire
Model in the Select area.

4 Click on OK.

Result: The Select Process dialog box appears.
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5 Complete the Select Process dialog box, then click on OK.
 See Change To Process in this manual for information on
completing the Select Process dialog box.

Related The table below shows you where to find information related to the
Topics Process Map command.

For more information on...                          See...                                  
how to use each command in the entry in this manual for the
the Process Map window individual command. For example,

to learn how to use the Add command
on the Step menu, see Add Step

how to use the Process Map the Process Map Window section
window's special features, such 
as the tool bar, mouse
commands, and keyboard
shortcuts
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PROCESS-PROCESS
 MATRIX

Opening a Process-Process Matrix Window

Description The Process-Process Matrix window allows you to view the invocation
relationships between processes, providing a useful overview of the
processes invoked by other processes in the model. The Process-Process
matrix is not active. This means that you can only view the information in
it, you cannot change it. This command is available from all windows.

Procedure å  To open a Process-Process Matrix window:

1 From the main Visible Advantage window, choose
Process-Process Matrix... from the Process menu.
or
From any other window, choose Process Modeling from the
main menu, then choose Process-Process Matrix from the
cascading menu.

Result: The Process-Process Matrix dialog box appears.

2 Select each checkbox for the process type(s) you want to
display on the left and top axes (business processes and/or data
access processes).

3 If you want to display the processes that access all entities in
the encyclopedia, click on Entire Model. If you want to display
the processes that access the entities in one model view, click on
the Single Model View button, then select the model view from
the drop-down list.

4 Click on OK.



569

PRINT VIEW TREE

Printing the View Tree Diagram

Description The Print View Tree command, available from the View
Hierarchy window, allows you to print the view hierarchy diagram.

Usage Tips If the view tree diagram is too large to fit on one page, use the Crop
Marks feature in the Print View Tree dialog box. This option prints lines
showing where you should trim your printed diagram pages before you
paste the pages together.

Procedure å  To print the model view tree diagram:

1 Choose Print View Tree... from the Display menu.

Result: The Print View Tree dialog box appears.

2 Complete the dialog box, then click on OK.



570

Print View Tree Dialog Box

Dialog Box
Illustration

                                        

            Print View Tree Dialog Box

Dialog Box Use the information below to complete the Print View Tree
Components dialog box.

Component         Description                                                                 
Title Type a title for the diagram into this box. The title

will print at the top of the printed diagram. This field
defaults to the name of the encyclopedia.

Subtitle Type a subtitle for the diagram into this box. The
subtitle will print below the title. This field defaults to
View Hierarchy.

Scale Slide this scroll bar until the values in the Grid Size
and/or Pages fields correspond to the desired diagram
size.

The Pages value tells you how many pages wide and high
the diagram will cover at the scale value selected.

View Types Select this checkbox if you want to include
view types on the printed diagram.
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Page Numbers Select this checkbox if you want to print page
numbers on the printed diagram.

The numbering scheme is `C/R', where `C' is the column
number for the diagram page assembly, and `R' is the row
number. This numbering scheme makes it easy to paste
the pages of the diagram together.

Crop Marks Select this checkbox if you want to print crop marks
showing you where to trim the diagram pages before you
paste them together.

Printer Setup Click on this button to access the Printer Setup
dialog box. See Printer Setup in this manual for more
information.
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PRINTER SETUP

Setting Up Printers

Description The Printer Setup command allows you to access the Windows Control
Panel Printer Setup dialog boxes. This command is available from all
windows.

Usage Tips The dialog boxes that this command invokes depend on what printers
have been installed and defined as active in your Windows configuration.
See your Windows documentation for information on setting up printers in
Windows applications.

Procedure å  To access the Windows Printer Setup dialog box from within
Visible Advantage:

Choose Printer Setup... from the File menu.
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PURGE CLUSTER

Purge Cluster Run

Description This command allows the system administrator to delete a parent
entity in a data model along with its children and other dependent
relationships.

Procedure å  To purge a cluster run:

1 Choose the Visible Advantage Admin Utility icon from the
Program Manager window.

2 Open the Encyclopedia containing the Cluster to be purged.

3 Choose Purge Cluster Run from the cascading Encyclopedia
menu.

Result:  The Purge Cluster Run dialog box appears.

4 Choose the cluster to be deleted.  Click on OK.

Result:  The Cluster is purged from the encyclopedia.
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PURGE HISTORY LOG

Purging the History Log

Description The Purge History Log command, available from the Visible
Advantage Admin Utility program on the Program Manager window,
allows a system administrator to purge the history file of all data as of a
specified date.

Procedure å  To purge the history log file:

1 Choose the Visible Advantage Admin Utility icon from
the Program Manager window

2 Open the Encyclopedia containing the History Log to be
purged.

3 Choose Purge History Log... from the cascading menu for
the System Administration command.

Result: The Purge History Log dialog box appears.

4 Complete the Purge History Log dialog box,  then click on
OK.
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Purge History Log Dialog Box

Dialog Box
Illustration

                                           

           Purge History Log Dialog Box

Dialog Box Use the information below to complete the Purge History Purge
Components History Log dialog box.

Component         Description                                                                 
Purge All Select this button if you want to purge all history

from the history file.

Purge Up To Select this button if you want to purge all history
before a specified date.

Purge Date Type the date before which all history will be
purged. Use the mm/dd/yy format.

First Entry The first date that the current history log was
Date updated appears in this box. This is not an input

field.
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REDISPLAY

Redisplaying the Active Window

Description The Redisplay command redraws the information inside the active
window.

Usage Tips Occasionally, the words, lines, and images in a window become
misaligned. Redrawing the window with this command corrects this
misalignment.

This command is available in all windows except the main Visible
Advantage window.

Procedure å  To redraw the active window:

Choose Redisplay from the Window menu.
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REMOVE STATEMENT
 FROM PARENT

Removing a Statement from
an Outline Parent

Description The Remove From Parent command allows you to remove one or more
statements from their current child positions in the outline.

Usage Tips To be eligible for this command, all selected statements must belong to
more than one parent statement. Therefore, the command will be dimmed
when any of the selected statements is the last occurrence of the statement
in the outline.

When you want to remove a statement from its last position in the outline,
use the Delete command on the Statement menu.

Procedure å  To remove selected statements from their current outline
positions:

1 Select Remove From Parent... from the Statement menu.

Result: The Remove Planning Statement From Parent dialog box
appears.

2  Note  The command will not be available if any of the selected
statements is the last occurrence of the statement.

2 The Title field displays the name of all selected statements,
which will be removed from their parents through this command.

If you still want to complete the command, click on OK.
Otherwise, click on Cancel.
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RENAME ENCYCLOPEDIA

Renaming Encyclopedias

Description The Rename Encyclopedia command allows you to change the title
and/or purpose of the current encyclopedia. The name of the directory in
which the encyclopedia is located stays the same.  This command is
available from the Visible Advantage Admin Utility main menu.

Procedure å  To change the title of the current encyclopedia:

1 Choose Rename... from the Encyclopedia menu.

Result: The Rename Encyclopedia dialog box appears.

2 Change the information in the Title and/or Purpose box,
then click on OK.
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REOPEN SESSION

Reopening Sessions

Description The Reopen Session command allows you to reactivate a session that
has been deactivated through the Close Session command.

Procedure å  To reopen a session:

1 Choose Sessions from the Project menu on the main Visible
Advantage window.
or
Choose Project Management from the main menu on any other
window, then choose Sessions from the cascading menu.

2 Choose Reopen... from the cascading menu for the Sessions
command.

Result: If there are closed sessions for the encyclopedia, the
Reopen Session dialog box appears. (Proceed to next step.)

If there are no closed sessions for the encyclopedia, a message box
appears. (Click on OK. End of procedure.)

3 Highlight the title of the session you want to reopen in the
Session list box. This list includes all sessions that have been
closed through the Close Session command.

4 Click on OK.
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REPLACE

Replacing Text in a
Text Editor Window

Description The Replace command allows you to search and replace text inside the
Session or Statement Editor windows.

Procedure å  To search and replace text in an editor window:

1 Choose Replace... from the Search menu.

Result: The Replace dialog box appears.

2 Complete the Replace dialog box.

Click on Find Next to find the first occurrence of the text to be
replaced.

If an occurrence is found, it is highlighted in the editor window.
(Proceed to next step.)

If an occurrence is not found a message indicating this appears in
the window. (End of procedure.)

3 Click on Replace to replace only the currently highlighted
occurrence of the specified text.

Click on Replace All to replace the current occurrence and all
future occurrences of the specified text.

Click on Cancel if you do not want to replace any text.
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Replace Dialog Box

Dialog Box
Illustration

                                      

                        Replace Dialog Box

Dialog Box Use the information below to complete the Replace dialog box.
Components

Component         Description                                                                 
Find What Type the text string you want to find inside this box.

Replace With Type the text string with which you want to replace
the found text.

Match Whole Select this checkbox if you would like to find an
Word Only exact match for the entire string for which you are

searching. Otherwise, the search and replace will find
occurrences of the text string that are part of other words,
as well as those that appear as separate words.

+   Example  If you specify the word `inform' in the Find
What box and do not select the Match Whole Word
Only checkbox, Visible Advantage will find the word
`information', as well as the word `inform'.

If you do select the Match Whole Word Only checkbox,
Visible Advantage will narrow its search to occurrences
of the word `inform' only.
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Match Case Select this checkbox if you would like to find only
those occurrences of the specified text string that match
the case (upper-, lower-, or mixed-case) of the text you
typed in the Find What box.

Otherwise, Visible Advantage will find occurrences of the
text string that use any combination of upper- and lower-
case letters.

Find Next Click on this button to find the next occurrence of
your selected string.

Replace Click on this button to replace the current occurrence
of the text string.

Replace All Click on this button to replace all occurrences of the
text string.
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REPORT FONT

Changing the Font for a Report

Description The Report Font command, available from main Visible Advantage
window, allows you to change the font, font size, or font style for the
reports and documents you print from the software tool.

Usage Tips The font you select through this command will be used until you use
the command again to select a new font.

This command uses the standard Windows dialog box for changing fonts
and font styles. The fonts that appear in the Font dialog box depend on the
fonts installed on your computer. See your Windows documentation for
more information on adding fonts and font sizes in Windows applications.

2  Note  For information on using the Font command, available from the
Planning Outline window or any Matrix window, see Font in this manual.

For information on using the Editor Font command, available from both the
Session and Statement Editor windows, see Editor Font in this manual.

Procedure å To change the font for reports and documents:

1 From the main Visible Advantage window, choose Report
Font... from the main menu.

Result: The Font dialog box appears.

2 Complete the Font dialog box, then click on OK.
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REPORTS

Overview

Description You can print a wide variety of reports that document the data in your
encyclopedias. This section explains the basic procedure for printing a
report and describes the specific options available for each report, along
with the fields that appear on the report.

For additional information on reports, including samples and report field
descriptions, see the Reports section in the User's Guide. For information
on how to configure and save report documents, see Documents in this
manual.

In This Section This section covers the following topics.

Topic                                                                           
Printing Reports
View Report
Planning Statement Report
Entity Report
Attribute Report
Cluster Report
Domain Report
Process Report
Process Hierarchy Report
Design Object Report
Data Item Report
Model Analysis Report
Notes Report
Session Report
History Log Report
Valid Words Dictionary Report
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Printing Reports

Description The basic procedure is the same for printing each type of report. This
section explains this procedure.

Usage Tips Any report may be directed to a printer, text file, or the screen. If you
direct output to the screen, the Report-Viewing window appears, allowing
you to search for text strings within the report, save the report to a text file,
or print it. For information on the Report-Viewing window, see Reports in
the User's Guide.

Procedure å  To print a report:

1 From the main Visible Advantage window, choose Reports
from the File menu, then choose the name of the report you want to
print from the cascading menu that appears.

Result: The dialog box for the report you selected appears.

2 Complete the dialog box, then click on OK. See the following
pages for information on completing the dialog box for each
report.

Result: The Report Destination dialog box appears.

3 Select a report destination (Printer, File, or Screen). If you
select Printer, be sure your printer is turned on and is online.

4 Click on OK.

Result: If you selected Printer, the report will be sent to the
printer.

If you selected File, you will be prompted for the name of the file
to which you want the report to be sent.

If you selected Screen, the report-viewing window and menu bar
appear. Refer to the Reports section of the User's Guide for more
information on viewing reports on the screen.
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View Report Dialog Box

Dialog Box
Illustration

                               

               View Report Dialog Box

Report The View report prints information on all or selected model views,
Description including the following special options: hierarchy family links,

attached notes, and the statements, entities, and designs within each
reported model view. You can sort the View report by hierarchy level, by
statement title, or by statement type.

A totals page prints at the end of the View report, detailing the number of
each type of model view and the total number of model views reported.

Dialog Box Use the information below to complete the View Report dialog box.
Components

Component         Description                                                                 
All Views Select this button to include all views.

By Current Select this button to include only those views created
User or modified by the current user.
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By Current Select this button to include only those model views
Session created or modified during the current session.

Selected Select this button to include only selected  views. To
Views select views, click on the Select Views button,

described below.

Select Views Select the views to include in the report. This
button is available only if the Selected Views
button, described above, is selected.

When you click on this button, the Select Views dialog
box appears.

Purposes Select this checkbox to include the purpose for each
reported view.

Notes Select this checkbox to include the notes attached to
each reported view.

Note Texts Select this checkbox to include the text of each
reported note.

Family Links Select this checkbox to include the parent and child
views of each reported, as defined by the view
hierarchy.

Statements Select this checkbox to include the statements visible
in each reported view.

Entities Select this checkbox to include the entities visible in
each reported model view.

Design Select this checkbox to include the design objects
Objects related to each reported design view.

Time Stamps Select this checkbox to include the date and time the 
model view as created and last modified, along with
the user who created/modified it and the session in which
it was created/modified.

Status Select this checkbox to include the status of the view.
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Structured Select this button to sort the report hierarchically, as
defined by the view hierarchy.

By Name Select this button to sort the report alphabetically by
name of reported model views.

By Category Select this button to sort the report by category.

By Type Select this button to sort the report by type of
reported model views.

View Fields Click on this button to select the custom fields to
include in the report.  This button is only available
if custom fields have been defined using Admin
Utility Table/Custom Fields.

Titles Only Select this checkbox to include only the titles of the
reported model views, with no details.

New Page Select this checkbox to start each reported model
view on a new page.
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Planning Statement Report Dialog Box

Dialog Box
Illustration

                                

                Planning Statement Report Dialog Box

Report The Planning Statement report prints information on all or
Description selected planning statements and business events, including the

following special options: statement text, dictionary links, attached notes,
and outline family links. You can sort the Planning Statement report by
hierarchy level, by statement title, or by statement type.

A totals page prints at the end of the Planning Statement report, detailing
the number of each type of statement and the total number of entities
reported.

Dialog Box Use the information below to complete the Planning Statement
Components Report dialog box.
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Component         Description                                                                 
All Statements Select this button to include in the report all

statements visible in the selected model view(s) (see
below).

By Current Select this button to include in the report all
User statements created or modified by the current user

that are visible in the selected model view(s).

By Current Select this button to include in the report all
Session statements created or modified in the current session

that are visible in the selected model view(s).

Selected Select this button to include in the report only
Statements selected statements within the selected model

view(s). To select the statements, click on the Select
Statements button, described below.

Select Select the statements to include in the report. When
Statements you click on this button, the Select Statements dialog

box appears. See Select Statements in this manual for a
description of the fields in this dialog box.

Outline Select this checkbox to arrange the report in outline
format as defined in the planning outline.

By Title Select this checkbox to arrange the report
alphabetically by statement title.

By Type Select this checkbox to arrange the report by
statement type.

All Statement Select this button to include statements of all types
Types that meet the specifications defined in the Include

and Model Views areas.

Selected Select this button to include only statements of
Statement selected types that meet the specifications defined in
Types the Include and Model Views areas. To select

statement types, click on the Select Statement
Types button, described below.



591

Select Select the types of statements to include in the
Statement report. When you click on this button, the Select
Types Statement Types dialog box appears.

This dialog box allows you to select statement types by
moving them from the Available list box to the Selected
list box.

Entire Model Select this button to include in the report all
statements in the encyclopedia that meet the
specifications defined in the Include area.

Selected  Select this button to include in the report only those
Views statements visible in selected views that meet the

specifications defined in the Include area. To select
views, click on the Select Views button, described
below.

Select Views Select the views to include in the report.
When you click on this button, the Select Views dialog
box appears.

This dialog box works the same way as the Select
Statements dialog box. See Select Statements in this
manual for information on completing this type of dialog
box.

Statement Use this button to select custom fields.
Fields

Statement Select this checkbox to include the text of each
Text reported statement.

Model Select this checkbox to indicate the links between
Links each reported statement and entities, attributes,

design objects, and associations in the data model.

Outline Select from this drop-down list the outline
Numbering numbering format you want to use. This option is

available only if the Outline button in the Sort Order
area is selected.
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Outline Links Select this checkbox to indicate the parent and child
statements as defined in the planning outline for
each reported statement.

Priorities Select this checkbox to include the priority of each
statement in each position in the outline hierarchy.
This option is available only if the Outline button in the
Sort Order area is selected. This is necessary because a
single statement can have a different priority assigned to
it at each position in the outline.

Notes Select this checkbox to indicate any notes attached to
each reported statement.

Note Texts Select this checkbox to include the text of each
reported statement's notes.

Time Stamps Select this checkbox to include the date and time
each reported statement was created and last
modified.

Status Select this checkbox to include the status of each
reported statement.

Titles Only Select this checkbox to print only the title and, if
selected, outline numbers on the report.

New Page Select this checkbox to start each reported statement
on a new page.
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Entity Report Dialog Box

Dialog Box
Illustration

                                   

                 Entity Report Dialog Box

Report The Entity report prints information on all or selected entities,
Description including the following special options: attributes and details; attribute

and entity views; associations and details; attached notes; and control,
statement, and design links.

A totals page prints at the end of the Entity report, detailing the number of
each type of entity reported and the total number of entities reported.

Dialog  Box Use the information below to complete the Entity Report
Components dialog box.

Component         Description                                                                 
All Entities Select this button to include in the report all entities

visible in the selected model view(s) (see below).
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By Current Select this button to include in the report all entities
User created or modified by the current user that are

visible in the selected model view(s).

By Current Select this button to include in the report all entities
Session created or modified in the current session that are

visible in the selected model view(s).

Selected Select this button to include in the report only
Entities selected entities within the selected model view(s).

To select the entities, click on the Select Entities
button, described below.

Select Entities Select the entities to include in the report. When you
click on this button, the Select Entities dialog box
appears. See Select Entities in this manual for a
description of the fields in this dialog box.

By Name Select this button to sort by name.

By Type Select this button to sort by type.

By Phase Select this button to sort by phase.

Entire Model Select this button to include in the report all entities
in the encyclopedia  that meet the specifications
defined in the Include area.

Selected Select this button to include in the report only those
Model Views entities visible in selected model views and that meet

the specifications defined in the Include area. To
select model views, click on the Select Views button,
described below.

Select Views Select the model views to include in the report.
When you click on this button, the Select Model Views
dialog box appears.

This dialog box works the same way as the Select
Statements dialog box. See Select Statements in this
manual for information on completing this type of dialog
box.
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Entity Fields Select this button to select the custom entity fields to
include in the report.

Attribute Select this button to select the custom attribute fields
Fields to include in the report.

Association Select this button to select the custom association
Fields fields to include in the report.

Status Select this checkbox to include the status of the
reported entities.

Keys Select this checkbox to include the primary and
foreign keys for each reported entity.

Non-Keys Select this checkbox to include the non-key
attribute(s) for each reported entity.

Attribute Select this checkbox to include details for each
Details reported attribute (key and non-key), such as its

domain, entity of origin, nature, and edit rule.

Attribute Select this checkbox to include the model views and
Views authorities for each reported attribute.

Associations Select this checkbox to include the associations for
each reported entity.

Assoc Details Select this checkbox to include the association
details for each reported association.

Entity Control Select this checkbox to indicate the entities
controlled by or that control each reported entity.

Entity Views Select this checkbox to include the model views in
which each reported entity is visible.

Model Links Select this checkbox to indicate the model objects
linked to each reported entity.

Where Used Select this checkbox to include where the reported
entity is used.
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Entity Select this checkbox to include the purpose text for
Purposes each reported entity.

Other Select this checkbox to include the purpose text for
Purposes each reported attribute and association.

Notes Select this checkbox to indicate any notes attached to
each reported  entity.

Note Texts Select this checkbox to include the text of each
reported entity's notes.

Entity Time Select this checkbox to include the date and time
Stamps each reported entity was created and last modified.

Other Time Select this checkbox to include the date and time
Stamps that the attributes and associations for each reported

entity were created and last modified.

New Page Select this checkbox to begin each reported entity on
a new page.

All Views If the Attribute Views and/or Entity Views
checkboxes are selected in the Print area, the report will
print all model views in which the reported attributes
and/or entities are visible.

Selected Views If the Attribute Views and/or Entity Views
checkboxes are selected in the Print area, the report will
print only those model views selected through the Select
Views button in which the reported attributes and/or
entities are visible.

Selected and If the Attribute Views and/or Entity Views
Child Views checkboxes are selected in the Print area, the report

will print only those model views selected through the
Select Views button and their child views in which the
reported attributes and/or entities are visible.



597

Attribute Report Dialog Box

Dialog Box
Illustration

                               

               Attribute Report Dialog Box

Report The Attribute report prints information on all or selected attributes,
Description including the following special options: keys and non-keys, attribute

details, owning entities, attribute views, statement and design links.

A totals page prints at the end of the Attribute report, detailing the number
of each type of attribute reported and the total number of attribute reported.

Dialog Box Use the information below to complete the Attribute Report dialog
Components box.

Component         Description                                                                 
All Attributes Select this button to include all attributes visible in

the selected model view(s) (see below).

By Current Select this button to include all attributes created or
User modified by the current user that are visible in the

selected model view(s).
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By Current Select this button to include all attributes created or
Session modified in the current session that are visible in the

selected model view(s).

Selected Select this button to include only selected attributes
Attributes within the selected model view(s). To select the

attributes, click on the Select Attributes button,
described below.

Select Select the attributes to include in the report. When
Attributes you click on this button, the Select Attributes dialog

box appears.  This dialog box works the same way as the
Select Entities dialog box. See Select Entities in this
manual for a description of the fields in this dialog box.

By Name Select this button to arrange the report alphabetically
by attribute name.

By Type Select this button to arrange the report alphabetically
by attribute type (elemental and group attributes).

Entire Model Select this button to include in the report all
attributes in the encyclopedia that meet the
specifications defined in the Include area.

Selected Select this button to include only those attributes
Views visible in selected model view(s) that meet the

specifications defined in the Include area. To select
model views, click on the Select Views button,
described below.

Select Views Select the model view(s) to include in the report.
When you click on this button, the Select Model Views
dialog box appears.

This dialog box works the same way as the Select Entities
dialog box.

Attribute Select this button to select custom attribute fields to
Fields include in the report.

Keys Select this checkbox to include primary and foreign
keys.
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Non-Keys Select this checkbox to include non-key attributes.

Attribute Select this checkbox to include details for each
Details reported attribute (key and  non-key), such as its

domain, entity of origin, nature, and edit rule.

Entities Select this checkbox to include the entities to which
each reported attribute belongs.

Attribute Select this checkbox to indicate the model views in
Views which each attribute is visible, including the model 

view authority each model view has for each
attribute.

Statement Select this checkbox to indicate the planning
Links statements to which each attribute has been linked.

Design Links Select this checkbox to indicate the design objects
and data items to which each attribute has been
linked.

Where Used Select this checkbox to indicate where each reported
attribute is used.

Purposes Select this checkbox to include the purpose text for
each attribute.

Time Stamps Select this checkbox to indicate the date and time
each attribute was created
and last modified.

New Page Select this checkbox to begin each new reported
attribute on a new page.
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Cluster Report Dialog Box

Dialog Box
Illustration

                         

                         Cluster Report Dialog Box

Report The Cluster report generates the clusters for the encyclopedia
Description or individual model views and includes the analysis information in a

report.

Cluster analysis provides a precise determination of separately
implementable subsets of the data model based on data dependency. Cluster
analysis is precise. It is not an approximation, nor does it require guesswork
on the part of users.

When you print a Cluster report, you can save the cluster information in a
cluster file; you may then compare clusters analyzed in subsequent Cluster
reports to those reported in an existing cluster file.
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The name of the file to which cluster information has been saved appears at
the end of the Cluster report.

Dialog Box Use the information below to complete the Cluster Report dialog box.
Components

Component         Description                                                                 
Entire Model Analyze the clusters in the entire encyclopedia.

Selected Views Analyze the clusters in selected model views only.
To select the model views, use the Select Views button,
described below.

Select Views Select the model view(s) whose clusters you want to
analyze. This button is not available if the Selected Views
button is not selected.

When you click on this button, the Select Model Views
dialog box appears.

View Select this checkbox to include the model view
Authorities authority for each reported entity.

Core Entities Select this checkbox to include only core entities in
Only the cluster. A cluster of core entities includes only

mandatory parent entities— "mandatory-away"
associated or control-linked entities are not included. Core
entities are marked in the Cluster report by bold text.

Relationships Select this checkbox to include an explanation of
why each entity is included in the cluster.

Generate new Generate a file to contain the cluster information
cluster file from this report. This enables you to compare the

cluster information to cluster files generated in the future,
or print a report from the cluster information.

Reprint Old Select this button to reprint the old cluster run.
Cluster Run

Save New Select this checkbox to save the new cluster run.
Cluster Run

Title Select the title from the drop-down list.
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Compare to Compare the clusters detected in this report
previous with those detected in a previously run report.
cluster file To do this, a cluster file must have been generated

for the previous cluster information (use the Generate new
cluster file option).

File name Select the name of the previous cluster file, to
(Old Cluster which you want to compare the new cluster
File area) information. When you click on the name of

the previous cluster file in this list box, the file name
appears in the File Name field.
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Domain Report Dialog Box

Dialog Box
Illustration

                

       Domain Report Dialog Box

Report The Domain report prints information about the domains that have
Description been defined for the encyclopedia, including the following options:

purposes, details, and data conversions necessary for each data structure
manager.

Dialog Box Use the information below to complete the Domain Report dialog box.
Components

Component         Description                                                                 
Purposes Select this checkbox to include the purpose of each

domain.

Details Select this checkbox to include the data type and
length for each domain.

Implementa- Select this checkbox to include the data type of each
tions domain when used with each data structure manager

defined for the encyclopedia.
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Process Report Dialog Box

Dialog Box
Illustration

            Process Report Dialog Box

Report The Process report prints information on all or selected processes,
Description including the following special options: business events; Invocation,

Result, Input, and Output lists; notes; and completion tables.

A totals page including the number of each process type prints at the end of
the Process report.

Dialog Box Use the information below to complete the Process Report dialog box.
Components

Component         Description                                                                 
All Processes Include all processes in the report that are visible in

the selected model view(s).

By Current Include all processes created or modified by the
User current user that are visible in the selected model

view(s).
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By Current Include all processes created or modified during
Session the current session that are visible in the selected

model view(s).

Selected Include only selected processes within the selected
Processes model view(s). To select the processes, click on the

Select Processes button, described below.

Select Select the processes to include in the report.
Processes Click on this button to display the Select Processes

dialog box.

Entire Model Include processes that access or respond to data in
the entire encyclopedia and meet the specifications
defined in the Include area.

Selected Model Include only those processes that access or respond
Views to data in selected model view(s) and meet the

specifications defined in the Include area. To select model
views, click on the Select Views button, described below.

Select Views Select the applicable model view(s) for the report.
Click on this button to display the Select Model Views
dialog box.

Business Include business events in the report.
Processes

Data Access Include data access processes in the report.
Processes

Business Include business events in the report.
Events

Invocation Include a list of attributes that invoke each reported
Lists process, if applicable.

Result Lists Include a list of attributes that result from the
completion of each reported process, if applicable.

Input Lists Include a list of attributes accepted by each reported
process, if applicable.
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Output Lists Include a list of attributes presented by each reported
process, if applicable.

Completion Indicate the valid completion states for each
Tables reported process.

Notes Indicate the notes attached to each reported process.

Note Text Include the text of each note attached to reported
processes.

Purposes Include the purpose of each process.

Time Stamps Indicate the date and time each process was created
and last modified.

By Name Arrange the report alphabetically by process name.

By Type Arrange the report by process type (business
processes, data access processes).
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Process Hierarchy Report Dialog Box

Dialog Box
Illustration

           Process Hierarchy Report Dialog Box

Report The Process Hierarchy report prints the process hierarchy for
Description the entire encyclopedia or for selected model views. The report offers

the following options: business events, business processes, data access
processes, notes, completion states.

A totals page detailing the number of each reported object prints at the end
of the Process Hierarchy report.

Dialog Box Use the information below to complete the Process Hierarchy
Components Report dialog box.

Component         Description                                                                 
Entire Model Include the data access processes that access the data

in the entire encyclopedia and the business processes that
respond to business events in the entire encyclopedia.

Selected Model Include the data access processes that access the
Model data in the selected model view(s) and the business
Views processes that respond to business events in the

selected model view(s).  To select the model view(s),
use the Select Views button.
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Select Views Select the applicable model view(s) for the report.
This button is available only if you select the Selected
Model Views button.  Click on this button to display the
Select Model Views dialog box.

Business Include business events in the report.
Events

Business Include business processes in the report.
Processes

Data Access Include data access processes in the report.
Processes

Purpose Include the purpose of each process.

Notes Indicate the notes attached to each reported process.

Note Text Include the text of each note attached to each
reported process.

Completion Indicate the valid completion states for each process.
States

Time Stamps Indicate the date and time each process was created
last modified.
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Design Object Report Dialog Box

Dialog Box
Illustration

                                

                    Design Object Report Dialog Box

Report The Design Object report prints information on all or selected design
Description objects, including the following special options: data items and details,

relationships and details, database designs, data model links, notes, and
table entries.

A totals page prints at the end of the design object report, detailing statistics
for the design object(s) reported.

Dialog Box Use the information below to complete the Design Object Report
Components dialog box.

Component         Description                                                                 
All Design Select this button to include in the report all design
Objects objects that reside in the selected database designs.
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By Current Select this button to include in the report all design
User objects created or modified by the current user.

By Current Select this button to include in the report all design
Session objects created or modified during the current

session.

Selected  Select this button to include in the report only
Design selected design objects.  To select design objects, use
Objects the Select Data Structures button.

Select Select the design object to include in the report.
Design This button is available only when the Selected
Objects Design Objects button is selected.  Click on this

button to display the Select Design Objects dialog
box.

All Views Select this button to include in the report the design
objects in all views.

Selected Select this button to include in the report the design
Views  objects in selected views. To select the views, click

on the Select Views button.

Select Views Select the views  that contain the design
objects  you want to include in the report. This
button is available only when the Selected Views button
is selected. Click on this button to display the Select
Views dialog box.

Design Object Select this button to select the custom design object
Fields fields you want to include in the report.

Property Select this button to select the custom property fields
Fields you want to include in the report.

Relationship Select this button to select the custom relationship
Fields fields you want to include in the report.

All Types Select this button to include all design object types.

Selected Select this button to include only selected design
Types object types.
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Select Types Select this button to select the design object types to
include.  Click on this button to display the Select
Design Object Types dialog box.

Details Select this checkbox if you want to print details for
each reported design object. Details include code, type,
and volume.

Properties Select this checkbox to include the properties for
each reported design object.

Property Select this checkbox to include property details for
Details each reported design object.

Relationships Select this checkbox to include design object
relationships.

Relationship Select this checkbox to include details for each
Details reported design object relationship.

Access Select this checkbox to include access mechanisms.
Mechanisms

Views Select this checkbox to indicate the views in which
each reported design object resides.

Model Select this checkbox to indicate the entities and
Links attributes to which each design object has been

linked.

Table Entries Select this checkbox to indicate the values of each
property for each static design object.

Design Object Select this checkbox to include the purpose of each
Purposes reported design object.

Other Select this checkbox to include the purpose of each
Purposes reported property and  design object relationship.

Notes Select this checkbox to indicate the notes attached to
each reported design object.
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Note Text Select this checkbox to include the text of each note
attached to reported design objects.

Time Stamps Select this checkbox to indicate the date and time
each design object was created and last modified.

Other Time Select this checkbox to indicate the date and time
Stamps each data item and data structure relationship was

created and last modified.

New Page Start each new design object on a new page.
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Data Item Report Dialog Box

Dialog Box
Illustration

              Data Item Report Dialog Box

Report The Data Item report prints information on all or selected data
Description items, including the following special options: owning data

structures, database designs, and data model links.

A totals page prints at the end of the Data Item report, detailing the statistics
for the data items reported.

Dialog Box Use the information below to complete the Data Item Report dialog
Components box.

Component         Description                                                                 
All Data Items Select this button to include in the report all data

items that reside in the selected database designs.

By Current Select this button to include in the report all data
User items created or modified by the current user.

By Current Select this button to include in the report all data
Session items created or modified during the current session.
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Items in Select this button to include in the report only
Selected selected design objects. To select design objects, use
Design the Select Design Objects button.
Objects

Select Design Select the design objects to include in the report. This
Objects button is available only when the Selected Design

Objects button is selected.  Click on this button to display
the Select Design Objects dialog box.

All Views Select this button to include in the report the data
items in all views.

Selected Select this button to include in the report the data
Views  items in selected views. To select the views, click on

the Select Views button.

Select Select the views  that contain the data items you
Views want to include in the report. This button is

available only when the Selected Views  button is
selected.  Click on this button to display the Select Views
dialog box.

Data Item Select the custom data item fields that you want to
Fields include in the report.

Data Item Select this checkbox to include data item details in
Details the report. These include the data item's data type

and type (buffer, column, etc.).

Design Select this checkbox to indicate the design object(s)
Objects to which each data item belongs.

Views Select this checkbox to indicate the views in which
each data item resides.

Logical Links Select this checkbox to indicate the entity/entities
and attribute(s) linked to each data item.

Purposes Select this checkbox to include the purpose of each
data item.
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Time Stamps Select this checkbox to include the date and time
each data item was created and last modified.

New Page Select this checkbox to start each new data item on a
new page.
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Model Analysis Report Dialog Box

Dialog Box
Illustration

                            

                   Model Analysis Report Dialog Box

Report The Model Analysis report automates the consistency quality-checking
Description required to enforce the rigor of business-driven Information Engineering.

The level of detail for this analysis is determined by the methodology phase
selected (planning through design) and the model view(s) you include in the
analysis. Model Analysis also checks to ensure that all necessary object
details have been defined.

See the Appendices section of the Reference Manual for a complete
checklist of all items analyzed during Model Analysis.

Dialog Box Use the information below to complete the Model Analysis
Components Report dialog box.

Component         Description                                                                 
Planning Select this checkbox to analyze objects in the

planning phase of the encyclopedia. This includes
data added through any of the planning windows.
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Data Modeling Select this checkbox to analyze objects in the data
modeling phase of the encyclopedia. This includes data
added through any of the data modeling windows.

Process Select this checkbox to analyze objects in the process
Modeling modeling phase of the encyclopedia. this includes

data added through any of the process modeling
windows.

Design Select this checkbox to analyze objects in the
database design phase of the encyclopedia. This
includes data added through the Design Dictionary
window.

Completeness Select this checkbox if you want to check for analysis
items that are in the completeness category.

Warnings Select this checkbox if you want to check for analysis
items that are in the warnings category.

Errors Select this checkbox if you want to check for analysis
items that are in the errors category.

Purposes If Completeness is selected in the Level area, select
this checkbox if you want to check purposes
for completeness.

Planning If Completeness is selected in the Level area, select
Links this checkbox if you want to check planning links for

completeness.

Design If Completeness is selected in the Level area, select
Links this checkbox if you want to check design links for

completeness.

Strategic If Data Modeling is selected in the Phase area,
select this button if you want to check the data model for
items required only at the strategic level.

Tactical If Data Modeling is selected in the Phase area,
select this button if you want to check the data model
view items required through the tactical level.
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Operational If Data Modeling is selected in the Phase area,
select this button if you want to check the data model
view items required through the operational level.

Entire Model If Planning, Data Modeling, and/or Process
Modeling is selected in the Phase area, analyze the
selected phases' objects in the entire model.

Selected If Planning, Data Modeling, and/or Process
Views Modeling is selected in the Phase area, analyze the

selected phases' objects in selected model views. Use the
Select Views button to select the model views.

Select Views Select the model views you want Model Analysis to
check. This button is available only if you selected the
Selected Model Views button.   Click on this button to
display the Select Model Views dialog box.
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Notes Report Dialog Box

Dialog Box
Illustration

              

           Notes Report Dialog Box

Report The Notes report prints notes written for the encyclopedia
Description  (all notes, those written by the current user, or those written to the

current user). You can optionally include the note text and/or any object
links for the notes.

A totals page prints at the end of the Notes report, detailing the statistics for
the notes reported.

Dialog Box Use the information below to complete the Notes Report dialog box.
Components

Component         Description                                                                 
All Notes Select this button if you want to include all notes in

the report.

Notes Created Select this button if you want to include only notes
By Current User created by the current user.

Notes to Select this button if you want to include notes
Current User attached to the current user.
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Note Text Select this option if you want to include the text of
reported notes.

Links Select this option if you want to include a list of
objects to which the note has been attached.

Time Stamps Select this button if you want to include the date and
time the note was created and last modified.

New Page Select this option if you want each note to begin on a
new page.
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Session Report Dialog Box

Dialog Box
Illustration

                        

           Session Report Dialog Box

Report The Session report prints information on all or selected sessions,
Description including session notes, if specified.

Dialog Box Use the information below to complete the Session Report dialog box.
Components

Component         Description                                                                 
All Sessions Select this button to include all sessions.

Current Select this button to include only the current session.
Session

Text Select this button to include session note text.

Time Stamps Select this button to include date/time stamps for
each reported session.

Session Fields Select this button to select the custom session fields
to include in the report.
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By Title Select this button to sort the report alphabetically by
session title.

By Type Select this button to sort the report by type.

Titles Only Select this checkbox to include only the title of each
session, with no details.

New Page Select this checkbox to begin each reported
session on a new page.
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History Log Report Dialog Box

Dialog Box
Illustration

                                             

             History Log Report Dialog Box

Report The History Log report prints the contents for the history log file,
Description which contains a record of each change made to the encyclopedia

since the last time the file was purged through the Purge History Log
command.

You may choose one of three increasingly detailed levels for the History
Log report: transaction summary, partial transaction detail, and complete
transaction detail.

Dialog Box Use the information below to complete the History Log Report dialog
Components box.

Component         Description                                                                 
Transaction Select this button if you want to print a summary
Summary of transactions, with no detail. This summary

includes the type of transaction (create, update, delete),
along with the name of the object of the transaction, and
the time/date stamp for the transaction.

Partial Select this button if you want to include in the report
Transaction the actions taken during each transaction.
Detail
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Complete Select this button if you want to include details
Transaction about each action taken during each transaction.
Detail

First Entry This field displays the first date recorded in the
Date history log. This is either the date the encyclopedia

was created or the last date the history log was
purged.

You purge history log data through the Purge History Log
File command.

Start Date Type into this field the date from which you want to
include transactions. This field uses mm/dd/yy format.

End Date Type into this field the date until which you want to
include transactions. This field uses mm/dd/yy format.
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Valid Words Dictionary Report Dialog Box

Dialog Box
Illustration

                                             

                              Valid Words Dictionary Report Dialog Box

Report The Valid Words Dictionary Report prints a report of all the
Description words contained in the standard words dictionary.  This

Dictionary is primarily used for standard abbreviations that
Can be applied when copying data from logical to physical
Views and vice versa.

Dialog Box Use the information below to complete the Valid Words Dictionary
Components Report Dialog Box.

Component         Description                                                                 
Definitions Select this checkbox to print definitions.

Standard Select this checkbox to print standard
Abbreviations abbreviations.

Design Select this checkbox to print design
Abbreviations abbreviations.
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Glossary Select this checkbox to print the report in
Format glossary format.

All Data Select this button to include all data structure
Structure managers in the report.
Managers

Selected Data Select this button to include only selected data
Structure structure managers in the report.
Managers

Select Data Select the data structure managers you want to
Structure include in the report.  This button is available only
Managers if you selected the Selected Data Structure

Managers button.
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RESULT LIST

Displaying and Hiding the Result List

Description The Result List command displays the Result List box in the Process
Map window when it is hidden, and hides the Result List box when it is
displayed.

The Result List box contains the aggregate of unaccounted for components
of the Accept and Return lists in the process.

Procedure å  To display or hide the Result List:

Choose Result List from the Display menu.

Result: If the Result List box was hidden when you chose the command, the
list appears in the active Process Map window.  If the Result List was
displayed when you chose the command, the list disappears from the active
Process Map window.
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REVERSE ENGINEERING

Reverse Engineering a Database

Description The Reverse Engineering utility allows you to recover database design
information about Data Structures (tables), Data Items (fields), Access
Mechanisms (Indexes, Primary Keys, Foreign Keys), and relationships.
Reverse engineering through the ODBC connection allows the utility to get
information about the database structure directly from the database’s
catalog.  Reverse engineering from an SQL script will get information about
the database structure that is contained in the SQL DDL (Data Definition
Language) in the text file.

Usage Tips Use this utility when you wish to derive a design model from an existing
system for use with Visible Advantage.

Procedure å  To Reverse Engineer a database through an ODBC connection:

1 Choose 32 bit ODBC …  or 16 bit ODBC ... from the Reverse
Engineering menu in the Utility program.

Result: The New Encyclopedia dialog box appears.

2 Complete the dialog box and click on OK.

Result:  The Extract Database Location Information dialog
box appears.

3 Complete the dialog box and click on OK.

Result:  The Select Data Source dialog box appears.

4 Complete the dialog box and click on OK to reengineer
the database.

å To Reverse Engineer a database from an SQL file:

1 Choose SQL Script ... from the Reverse Engineering menu in the
utilities program.

Result: The New Encyclopedia dialog box appears.
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2 Complete the dialog box and click on OK.

Result:  The Select SQL Dialect dialog box appears.

3 Select the SQL file that contains the SQL DDL script and
click on OK.

Result:  The Parse Option dialog box appears.

4 Enter the default authorization/owner ID and click OK
to reverse engineer the database.
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Extract Database Location
Information Dialog Box

Dialog Box
Illustration

  Extract Database Location Information
Dialog Box

Dialog Box Use the information below to complete the Extract Database
Components Location Information dialog box.

Component         Description                                                                 
Project The project file name.  This information is read only;

you may not edit this information.

DB Engine Select the ODBC source from those that have been
set up previously within Windows.

Connect String Type the connect string to use.

Database Type the database name.

Schema Type the schema name.

User Type the user name.

Password Type the password.
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Preserve for Click on this checkbox to preserve the
Entire Session user name and password for the entire session.
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Select Data Source
Dialog Box

Dialog Box
Illustration

Select Data Source Dialog Box

Dialog Box Use the information below to complete the Select Data Source dialog
Components box.

Component         Description                                                                 
File Source Tab
Look In Select the source from the drop-down list.  Options

are displayed in the list box.

DSN Name Type in the data source name.

New Click on this button if the DSN name is new.  When
you click this button, the Create New Data Source
dialog box is displayed.  Follow the instructions on
screen to create the new data source.
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Machine Data Source
List Box Select a source from the list displayed.

New Click on this button if the source name is new.  When
you click this button, the Create New Data Source
dialog box is displayed.  Follow the instructions on
screen to create the new data source.
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SAVE AS STATEMENT

Saving Text as Another
Statement

Description The Save As command, available from the Statement Editor windows,
allows you to save the text inside the window under a different
statement title.

Procedure å  To save the statement or session text inside the text  editor
window under a different name:

1 Choose Save As... from the File menu.

Result: The Statement Title or Session Title dialog box appears.

2 Type a new title and type into the dialog box, then click on
OK.
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SAVE STATEMENT

Saving Statements and Sessions

Description The Save command saves the current statement or session in the
Statement Editor window.

Procedure å  To save the session or statement text inside the active editor
window:

Choose Save from the File menu.
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SCALE

Scaling Matrix Windows

Description The Scale command allows you to control the size of the rows and
columns in any Matrix window.

Usage Tips This command allows you to adjust the size of matrix components
(rows, columns, and labels).

2  Note  As an alternative to using the Scale command, you may adjust the
top label height and left label width by holding down the left mouse button
and dragging the label separator lines. See the User's Guide for more
information on mouse operations in the Matrix windows.

Procedure å  To scale the matrix in the active Matrix window:

1 Choose Scale... from the Display menu.

Result: The Scale Matrix dialog box appears.

2 Complete the Scale Matrix dialog box, then click on OK.
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Scale Matrix Dialog Box

Dialog Box
Illustration

        

             Scale Matrix Dialog Box

Dialog Box Use the information below to complete the Scale Matrix dialog box.
Components

Component         Description                                                                 
Row Height Type the desired height in inches of each row in the

matrix.

Col Width Type the desired width in inches of each column in
the matrix.

Top Label Type the desired height in inches of the top row
Height containing the header labels.

Left Label Type the desired width in inches of the
Width left column containing the header labels.
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SCRUB

Scrubbing the Encyclopedia

Description Scrub, available from the File menu of the Visible Advantage Utility, is
a utility that scans the entire encyclopedia and cleans up (“scrubs”)
anomalies in the encyclopedia.

Procedure å  To run scrub:

1 Choose Scrub from the Advantage Utility File menu.

Result:  The Scrubber Utility dialog box appears.

2 Complete the dialog box, then click on Start.
Make sure that the Don’t Fix Errors option is selected.

3 Scrub scans the encyclopedia and displays the number of
errors and warnings (if any).

4 If there are errors or warnings, call technical support.
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SELECT ALL

Selecting All Objects in a Window

Description The Select All command selects all objects in the active window for
subsequent copy or delete commands.

Usage Tips Once objects are selected, you may:
o   Use the Copy To Model View command to make them visible in
      another model view or to a database design (entities only)
o   Use the Delete command to delete them from the current model

       view

You may deselect all objects by choosing the Deselect All command
from the Select menu.

Procedure å  To select all objects in the active View Hierarchy, Planning
Outline, Design Map, or Data Map window:

Choose Select All from the Select menu.
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SELECT CLUSTER

Selecting Clusters

Description The Select Cluster command selects all entities within the cluster
represented by all selected entities.

Usage Tips This command is especially useful for copying all entities in one or
more clusters to another model view.

If you select entities that are neither designated or derived cluster end
points, Visible Advantage will temporarily designate them as end points
for this command.

Once clusters are selected, you may:
o   Use the Copy To Model View command to make them visible in
      another model view or to a database design (entities only)
o   Use the Delete command to delete them from the current model
      view

You may deselect all entities by using the Deselect All command on the
Select menu.

Procedure å  To select all entities in one or more clusters:

1 Select all cluster end point entities whose represented clusters
you want to select.

If you select entities that are neither designated or derived cluster
end points, Visible Advantage will temporarily designate them as
end points for this command.

2 Choose Select Cluster from the Select menu.

Result: All entities in the clusters represented by the selected entity
or entities are selected.



641

SELECT CURRENT

Selecting the Current Object

Description The Select Current command selects or deselects the current
statement in the active window.

Usage Tips This command toggles between an active and inactive state. When this
command is active, there is a checkmark beside the command and the
current object is selected. When this command is inactive, there is no
checkmark beside the command and the current object is not selected.

Once an object is selected, you may:
o   Use the Copy To Model View command to make it visible in
      another model view
o   Use the Delete command to delete it from the current model view

Procedure å  To select the current object in the Planning Outline window:

Choose Select Current from the Select menu.
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SELECT DESIGN OBJECTS

Selecting Design Objects

Description The Select Design Objects command, available from the Design
Dictionary window, allows you to select multiple design objects within the
current design view. Once they are selected, you may execute a command
for all of them at once, or for one after another, depending on the nature of
the command.

Usage Tips The design object selections you make with this command are in
effect until you display a different design object in the Design Dictionary
window. After you display a new design object, your selections are cleared.

In the Design Dictionary window, the following commands are available for
multiple selected design objects:
o   Edit Design Object
o   Delete Design Object
o   Copy Design Object To Entity
o   Link Design Object to Entity

Procedure å  To select multiple design objects in the Design Dictionary
window:

1 Choose Select...  from the Design Object menu.

Result: The Select Design Objects dialog box appears.

2 Complete the Select Design Objects dialog box, then click on
OK.
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Select Design Objects Dialog Box

Dialog Box
Illustration

                               

         Select Design Objects Dialog Box

Dialog Box Use the information below to complete the Select Design Objects
Components dialog box.

Component         Description                                                                 
Design Objects The names of the selected design objects are listed

in this box.

Initially, this list box contains the name of the design
object currently displayed in the Design Dictionary
window. You add design objects to this list from the
Candidates list box.

Use this button to select one or more design object
candidates. Highlight the design object in the
Candidates list box, then click on this button. It will
then appear in the Design Objects list box. To select
multiple candidates, hold down the CTRL key,
highlight the design objects in the Candidates list
box, then click on this button.
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Use this button to deselect one or more design
objects. Highlight the design object in the Design
Objects list box, then click on this button. It will
then return to the Candidates list box.  To deselect
multiple candidates, hold down the CTRL key,
highlight the design objects in the Candidates list
box, then click on this button.

Use this button to select all design object candidates.
When you click on this button, all design objects in the
Candidates list box will be moved to the Design Objects
list box.

Use this button to deselect all selected design
objects. When you click on this button, all design objects
in the Design Objects list box will be returned to the
Candidates list box.

Candidates This box lists all design objects in the current
database design.

Properties Select this checkbox to include properties.

All Types Select this button to include all types of design
objects.

Select Types Select this button to select the types of design
objects to include.  When you select this button
the Select Types button becomes available.

Select Types Use this button to display the Select Design
Object Types dialog box and select design object
types.
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Select Design Object Types Dialog Box

Dialog Box
Illustration

                                 

                     Select Dialog Object Types Dialog Box

Dialog Box Use the information below to complete the Select Dialog Object
Components Types dialog box.

Component         Description                                                                 
Design Object The types of design objects are listed in this box.
Types

Initially, this list box contains the type of the design
object currently displayed in the Design Dictionary
window. You add design object types to this list from the
Candidates list box.

Use this button to select one or more design object
type candidates. Highlight the design object type in
the Candidates list box, then click on this button. It
will then appear in the Design Object Types list
box. To select more than one design object type,
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hold down the CTRL key, highlight the Candidates,
then click on this button.

Use this button to deselect one or more design object
types.  Highlight the design object type in the
Design Object Types list box, then click on this
button. It will then return to the Candidates list
box.  To deselect more than one design object type,
hold down the CTRL key, highlight the Candidates,
then click on this button.

Use this button to select all design object type
candidates. When you click on this button,
all design object types in the Candidates list box will be
moved to the Design Objects Types list box.

Use this button to deselect all selected design
object types. When you click on this button, all design
object types in the Design Objects list box will be
returned to the Candidates list box.

Candidates This box lists all design object types in the current
design view.
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SELECT ENTITIES

Selecting Entities

Description The Select Entities command, available from the Data Dictionary
window, allows you to select multiple entities in the Data Dictionary
window. Once they are selected, you may execute a command for all of
them at once, or for one after another, depending on the nature of the
command.

Usage Tips The entity selections you make with this command are in effect until
you return to the Data Dictionary window and display a different entity in
the window. After you display a different entity, your selections are cleared.

In the Data Dictionary window, the following commands are available for
multiple selected entities:
o   Edit Entity
o   Delete Entity
o   Copy Entity To Model View
o   Designate Entity Authority
o   Name Cluster End Point
o   Control Entity
o   Populate Static Table
o   Copy Entity To Design
o   Add Attribute
o   Add Association

2 Note  In the Data Map window, you may also select multiple entities. See
the User's Guide for information on this.

Procedure å  To select multiple entities in the Data Dictionary window:

1 Choose Select Entities... from the Entity menu.

Result: The Select Entities dialog box appears.

2 Complete the Select Entities dialog box, then click on OK.
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Select Entities Dialog Box

Dialog Box
Illustration

                          

             Select Entities Dialog Box

Dialog Box Use the information below to complete the Select Entities dialog box.
Components

Component         Description                                                                 
Selected The names of the selected entities are listed in this
Entities box.

Initially, this list box contains the name of the entity
currently displayed in the Data Dictionary window.
You add entities to this list from the Candidates list
box.

Use this button to select one or more entity
candidates. Highlight the entity in the Candidates
list box, then click on this button. It will then appear
in the Selected Entities list box. To select more
than one entity, hold down the CTRL button,
highlight the entities, then click on this button.
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Use this button to deselect one or more entities.
Highlight the entity in the Selected Entities list box,
then click on this button. It will then return to the
Candidates list box.  To deselect more than one
entity, hold down the CTRL key, highlight the
Candidates, then click on this button.

Use this button to select all entity candidates. When
you click on this button, all entities in the Candidates list
box will be moved to the Selected Entities list box.

Use this button to deselect all selected entities.
When you click on this button, all entities in the
Selected Entities list box will be returned to the
Candidates list box.

Clusters Use this button to select all entities within the
clusters represented by the entities listed in the
Selected Entities box.

When you click on this button, entities within the
selected entities' clusters are moved from the Candidates
list box to the Selected Entities list box.

Candidates This box contains all entities in the current model
view that belong to the group(s) specified in the Include
area (cluster end points, static entities, and dynamic
entities).

If all Include checkboxes are selected, then all entities in
the current model view are listed in this list box.

End Points Select this checkbox if you want only cluster
Only end points to appear in the Candidates list

box.

Static Entities Select this checkbox if you want only static entities
to appear in the Candidates list box.
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Dynamic Select this checkbox if you want only dynamic
Entities entities to appear in the Candidates list box.
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SELECT
 NEIGHBORHOOD

Selecting an Entity Neighborhood

Description The Select Neighborhood command, available from the Data Map
window, selects all entities that are associated with all currently selected
entities. Selected objects are represented in the Data Map window by
reverse video.

Procedure å  To select the neighborhood of one or more currently selected
entities:

Choose Select Neighborhood from the Select menu.

Result: All entities associated with the previously selected entities are
selected. You may deselect all entities by using the Deselect All command
on the Select menu.



652

SELECT SESSION

Selecting Sessions

Description The Select Session command allows you to choose an existing session
with which any subsequent changes during the current logon will be
associated. This command is available from all windows.

Usage Tips Sessions that have been closed through the Close Session command
will not appear in the Select Session dialog box. Use the Reopen Session
command to reopen a closed session.

Procedure å   To select a session:

1 Choose Sessions from the Encyclopedia Menu on the main
Visible Advantage window.
or
Choose Encyclopedia Management from the main menu on
any other window, then choose Sessions from the cascading
menu.

2 Choose Select...  from the cascading menu for the Sessions
command.

Result: The Select Session dialog box appears.

3 Do you want to specify an existing session?
If yes, highlight the name of the session, then click on OK. All
active sessions are listed. (End of procedure.)

Do you want to add a new session? If yes, click on
New.

Result: The Add Session dialog box appears. (Proceed to next
step.)

4 Complete the Add Session dialog box (see Add Session for a
description of dialog box fields), then click on OK.
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SELECT STATEMENTS

Selecting Statements

Description The Select Statements command, available from the Planning
Dictionary window, allows you to select multiple planning statements in the
Planning Dictionary window.

Usage Tips The statement selections you make with this command are in effect
until you return to the Planning Dictionary window and display a different
statement in the window. After you display a new statement, your selections
are cleared.

In the Planning Dictionary window, the Copy Statement To Model View
command is available for multiple selected statements.

2 Note  In the Planning Outline window, you may select multiple
non-consecutive statements by holding down the CTRL key and clicking on
each statement you want to select.

You may select multiple consecutive statements by holding down the
SHIFT key and clicking on the first and last statements in the series you
want to select.

Procedure å  To select multiple statements in the Planning Dictionary
window:

1 Choose Select...  from the Statement menu.

Result: The Select Statements dialog box appears.

2 Complete the Select Statements dialog box,  then click
on OK.
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Select Statements Dialog Box

Dialog Box
Illustration

                                

              Select Statements Dialog Box

Dialog Box Use the information below to complete the Select Statements
Components dialog box.

Component                       Description                                                   
Selected Statements The names of the selected statements are

listed in this box.

Initially, this list box contains the name of the
statement currently displayed in the Planning
Dictionary window. You add statements to this
list from the Candidates list box.

Use this button to select one or more
statement candidates. Highlight the
statement in the Candidates list box, then
click on this button. It will then appear in
the Selected Statements list box.  To select
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more than one statement, hold down the
CTRL key, highlight the Candidates, then
click on this button.

Use this button to deselect one or more
statements. Highlight the statement in the
Selected Statements list box, then click on this
button. It will then return to the Candidates list
box. To deselect more than one statement, hold
down the CTRL key, highlight the Candidates,
then click on this button.

Use this button to select all statement
candidates. When you click on this button, all
statements in the Candidates list box will be
moved to the Selected Statements list box.

Use this button to deselect all selected
statements. When you click on this button, all
statements in the Selected Statements list box
will be returned to the Candidates list box.

Candidates This box lists all statements in the current
model view.
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SELECT SUB-TREE

Selecting Model View Sub-Trees

Description The Select Sub-Tree command, available from the View
Hierarchy window, selects all model views beneath one or more selected
model views.

Usage Tips Once model views are selected, you may:
o   Use the Edit command to edit their titles and details
o   Use the Delete command to delete them
o   Use the Move command to move them to a new location in the
      model view hierarchy

You may deselect all model views by using the Deselect All command on
the Select menu.

Procedure å  To select all model views beneath one or more selected model
views:

Choose Select Sub-Tree from the Select menu.



657

SESSION TYPES

Defining Session Types

Description The Session Types command, available from the Visible Advantage
Admin allows you to add, edit, and delete types that you can assign to
sessions in the current or future encyclopedia.

Usage Tips The session types you define with this command are for the current
encyclopedia only. If you want to define session types for all future
encyclopedias, use the Encyclopedia Initializer command before you use the
Session Types command.

Procedure å  To add a session type for the current encyclopedia or
Encyclopedia Initializer:

1 Choose Session Types... from the Table menu.

Result: The Edit Session Type Table dialog box appears.

 2 Type the name of the new type into the Entry field. If you
highlighted an entry in the type list box, you will have to
clear its entry from the field before typing the entry for the
new type. You may type 1-31 alphabetic characters.

3 To add the new entry to the end of the type list, click on
Append.

4 Repeat the procedure for each entry you want to add to the
type table.

5 Click on OK.

å  To edit an existing session type for the current encyclopedia or
Encyclopedia Initializer:

1 Choose Session Types... from the Table menu.

Result: The Edit Session Type Table dialog box appears.

2 Highlight the entry in the large list box that you want to edit.
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Result: The session type appears in the Entry field.

3 Edit the information in this field, then click on Change.

åTo delete a session type for the current encyclopedia or
Encyclopedia Initializer:

1 Choose Session Types... from the Table menu.

Result: The Edit Session Type Table dialog box appears.

2 Highlight the entry in the large list box that you want to
delete.

Result: The session type appears in the Entry field.

3 Click on Delete.
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Edit Session Type Table Dialog Box

Dialog Box
Illustration

  Edit Session Type Table Dialog Box

Dialog Box Use the information below to complete the Edit Session Type
Components Table dialog box.

Component         Description                                                                 
Entry The name of the session type that is highlighted in

the session type list box, or that you enter when you
are adding a new type.

Append Use this button to add a new session type to the end
of the session type list.

Change Use this button to edit a session type in the table. To
do this, highlight the session type in the list, edit the
Entry field, then click on this button.

Delete Use this button to delete a session type from the
table. To do this, highlight the session type in the list, then
click on this button.
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 SMALLER

Shrinking Graphical Objects
in a Window

Description The Smaller command allows you to make the objects in a graphical
window smaller. This command is available from the following windows:
View Hierarchy, Data Map, Process Map, and Design Map.

Procedure å  To shrink objects:

Choose Smaller from the Display menu.

Result: The objects in the active window appear smaller. You may repeat
the above step until the objects are the size you desire.
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SORT STATEMENT
 CHILDREN

Sorting Outline Children

Description The Sort Children command, available from the Planning Outline
window, allows you to sort statement children (those that appear beneath a
statement in the outline) either by title or priority.

Usage Tips This command sorts the children of all selected statements. If you
want to sort the children of all statements, use the Outline/Sort Top Level
command and the Select/Select All commands before using this command.
You should also select all statements before using this command.

Procedure å  To sort statement children:

1 Select the statements whose children you want to sort. These
statements then appear highlighted in the Planning Outline
window.

2 Choose Sort Children... from the Outline menu.

Result: The Sort Children dialog box appears.

3 Complete the Sort Children dialog box, then click on OK.
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Sort Children Dialog Box

Dialog Box
Illustration

                                            

             Sort Children Dialog Box

Dialog Box Use the information below to complete the Sort Children dialog box.
Components

Component         Description                                                                 
Statement The title(s) of the selected statement(s) displays in

this box. If multiple statements are selected, the titles will
not fit completely in the box.

By Priority Select this button if you want to sort the statement
children by priority.

By Title Select this button if you want to sort the statement
children alphabetically by title.

Ascending Select this button if you want to sort statements in
ascending (lowest to highest) order.

Descending Select this button if you want to sort statements in
descending (highest to lowest) order.
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SORT TOP LEVEL

Sorting the Top Outline Level

Description The Sort Top Level command, available from the Planning Outline
window, sorts the outer-most outline level in the current model view either
by title or priority.

Usage Tips This command sorts all statements in the top outline level, regardless
of which statements are selected.

Use this command before using the Sort Children command when you want
to sort all statements in the current model view.

Procedure å  To sort all planning statements in the top outline level:

1 Choose Sort Top Level... from the Outline menu.

Result: The Sort Top Level dialog box appears.

2 Complete the Sort Top Level dialog box, then click on OK.
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Sort Top Level Dialog Box

Dialog Box
Illustration

                     

                   Sort Top Level Dialog Box

Dialog Box Use the information below to complete the Sort Top Level dialog box.
Components

Component         Description                                                                 
By Priority Select this button if you want the statements to be

sorted by priority.

By Title Select this button if you want the statements to be
sorted alphabetically by title.

Ascending Select this button if you want the statements to be
sorted in ascending (lowest to highest) order.

Descending Select this button if you want the statements to be
sorted in descending (highest to lowest) order.
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SPELL CHECK

Spell Checking in a Text Editor Window

Description The Spell Check command, available from the Statement Editor
windows, allows you to check the spelling of the text inside the active
Statement Editor window.

Usage Tip Spell checking is also available in many dialog boxes by clicking on
the Spell button.

Procedure å  To spell check the text inside the editor window:

1 Choose Spell Check... from the Edit menu.

Result: If any misspelled words are found, the spell-checking
dialog box appears. (Proceed to next step.)

If no misspelled words are found, the active window redisplays.
(End of procedure.)

2 If you want to retain the word the way you spelled it and add
it to your dictionary of correctly spelled words, click on the Add to
user dictionary button.

If you want to change the word to one of the suggested spellings,
select the desired suggested spelling and then click on OK.

If you want to ignore the misspelling and proceed, click on the
Ignore button.

If you want to exit the spell-checking dialog box, click on Exit.
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SPLIT DESIGN OBJECT

Splitting a Design Object

Description The Split Design Object command, available from the Design
Dictionary window, allows you to split the current design object into two
design objects.

Procedure å  To split the current design object into two design objects:

1 In the Design Dictionary window, display the design object
you want to split.

2 Choose Split... from the Design Object menu.

Result: The Split Design Object dialog box appears.

3 All of the information in the dialog box is filled in with the
details from the current design object except for its name.

Type a name into the Name field, and edit any of the other fields,
as necessary.

4 If you want to add any of the current design object's data
items to the new design object, click on Edit Property List. The
Select Properties dialog box appears. Select the properties you
want to include in the new design object, then click on OK to
return to the Split Design Object dialog box.

5 When you are finished editing the information, click on
OK in the Split Design Object dialog box.
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Split Design Object Dialog Box

Dialog Box
Illustration

                Split Design Object Dialog Box

Dialog Box Use the information below to complete the Split Design Object
Components dialog box.

Component         Description                                                                 
Name Type a name for the new design object that results

from this command into this box.

Meta Id Type a meta id for the design object.  The meta id
is used to differentiate when two or more design
objects have the same name.

Purpose The purpose for the split design object appears in
this text box. You may edit the purpose, if
necessary.

Code The code, or alias, for the split design object
appears in this box. You may edit the code for the
new data structure.
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Type The split design object type appears in this
box. You may choose a new type from this drop-
down list, if necessary.

Storage Choose a storage access mechanism from this
Access drop-down list. All storage access mechanisms
Mechanism defined for the current design object manager are

included on the list.

Dynamic Select this nature if the design object's property
values will be user-defined. This is the default nature
value.

Static Select this nature if the user will select the design
object's property values from a predefined set of values.

Use the Populate command on the Design Object menu to
enter the predefined values for a static design object's
properties.

Volume Type into this field the expected maximum number
of times the design object will appear in the
implemented system.

Edit Use this button to add properties to the new design
Property object from the split design object. When you
List click on this button, the Edit Property List dialog

box appears.
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STATEMENT-DATA
 MATRIX

Opening a Statement-Data
Matrix Window

Description The Statement-Data Matrix command allows you to open a Statement-
Data Matrix window. This window lists in matrix format the supporting
object links defined for each planning statement in the current model view.
You can also add and remove Statement-Data links by making changes to
the matrix and saving those changes. This command is available from all
windows.

Procedure å  To open a Statement-Data Matrix window:

1 Choose Statement-Data Matrix... from the Plan menu on
the main Visible Advantage window.

From any other window, choose Planning from the Main menu,
then choose Statement-Data Matrix... from the cascading menu.

Result: The Statement-Data Matrix dialog box appears.

2 In the Left Axis area, select the statement types you want to
display in the window. If you want to display all types, select the
All Statement Types button. If you want to select specific
statement types, click on Select Types. The Statement Types
dialog box appears, allowing you to select statement types. After
you finish selecting statement types, click on OK.

In the Top Axis area, click on each checkbox that corresponds
with the data objects you want to display in the window (Entities,
Attributes, or Associations).

3 If you want to display the statements and data model objects
in the entire model, click on the Entire Model button. If you want
to display only statements from one model view, click on the
Single Model View button, then select the model view from the
drop-down list.

4 Click on OK in the Statement-Data Matrix dialog  box.
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STATEMENT EDITOR

Opening a Statement
Editor Window

Description The Statement Editor window allows you to create, edit, format,
spell-check, and search/replace text in a planning statement. You can
also print the statement text or save it to a file. This command is
available from all Visible Advantage windows.

Usage Tips You do not have to use the Statement Editor window to edit statement
text; you can use the Edit statement command to edit notes if you do not
need any extensive word processing or formatting features.

Procedure å  To open a Statement Editor window:

Choose Statement Editor... from the Planning menu on the
main Visible Advantage window.
or
Choose Planning from the main menu on any other window, then choose
Statement Editor... from the cascading menu.

Related Use the table below to access related information
Topics about the Statement Editor window.

For More Information On...          See...                                                
how to use each command in the entry in this manual for the
the Statement Editor window individual command. For example,

to learn how to use the Editor Font
command on the Format menu, see
Editor Font.

how to use the Statement the Planning section in the
Editor window's special User’s Guide
features, such as the tool bar,
mouse commands, and
keyboard shortcuts,
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STATEMENT PRIORITY

Setting Statement Priorities

Description The Statement Priority command, available from the Planning Outline
window, lets you determine a ranking order of a particular statement in
relation to other statements contained in the view or the entire encyclopedia.
This ranking order is displayed in brackets after the statement in the
Planning Outline window and in the Priority box on the Planning Outline
window tool panel.

Usage Tips Use this command to assign a number to some or all statements in the
current model view to signify their relative importance to one another.
A statement included in more than one model view can have a different
priority for each model view in which it appears. The same priority may be
assigned to multiple statements.

2 Note  As an alternative to using the menu command, you may also
assign a priority to a statement through the Planning Outline window tool
panel. Simply type the priority into the Priority box on the tool panel and
press ENTER.

Procedure å  To assign a priority to a statement:

1 Choose Priority... from the Statement menu.

Result: The Statement Priority dialog box appears.

2 Type a priority into the Priority box.

3 Click on OK.
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STATEMENT-STATEMENT MATRIX

Opening a Statement-Statement
Matrix Window

Description The Statement-Statement Matrix window command, available from all
windows, allows you to view, add, and remove the parent-child
relationships between statements.

Procedure å  To open a Statement-Statement Matrix window:

1 Choose Statement-Statement Matrix... from the Plan menu
on the main Visible Advantage window.

From any other window, choose Planning from the main menu,
then choose Statement-Statement Matrix... from the cascading
menu.

Result: The Statement-Statement Matrix dialog box appears.

2 Select the statement types you want to display on the matrix
axes. To do this, click on the appropriate buttons in the dialog box.
If you want to select specific types, use the Select Types buttons in
each area (Left Axis and Top Axis).

A dialog box allowing you to select the statement types appears.
When you are finished selecting types for each axis, click on OK
to return to the Statement-Statement Matrix dialog box.

3 If you want to display the statements in the entire model,
click on the Entire Model button. If you want to display only
statements from one model view, click on the Single Model View
button, then select the model view from the drop-down list.

4 Click on OK in the Statement-Statement Matrix dialog box.
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STATEMENT TITLE
 AND TYPE

Assigning Titles to Statements

Description The Statement Title and Type command, available from the Statement
Editor window, lets you assign a title and type for a statement when adding
a statement or editing an existing one.

Usage Tips The Statement Editor window appears when you choose Statement
Editor... from the Plan menu.

As an alternative to using this command, you may also assign a title and
type to a statement through the Statement Editor window tool bar. To assign
a title, simply type one into the Title box on the tool bar and press ENTER.
To assign a type, select one from the Type drop-down list on the tool panel.

Procedure å  To title a statement:

1 Choose Statement Title and Type... from the Statement
Editor window's File menu.

Result: The Statement Title dialog box will appear.

2 Type or change the title in the Title field and/or the type in
the Type field, then click on OK.
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STATEMENT TYPES

Defining Statement Types

Description The Statement Types command, available from the main Visible
Advantage Admin Utility window, allows you to add, edit, and delete types
that you can assign to planning statements in the current
encyclopedia.

Usage Tips The statement types you define with this command are for the current
encyclopedia only. If you want to define statement types for all future
encyclopedias, use the Encyclopedia Initializer command before you use the
Statement Types command.

Procedure å  To add a statement type for the current encyclopedia or
Encyclopedia Initializer:

1 Choose Statement Types... from the Table menu.

Result: The Edit Statement Type Table dialog box appears.

2 Type the name of the new type into the Entry field. If you
highlighted an entry in the type list box, you will have to
clear its entry from the field before typing the entry for the
new type. You may type 1-31 alphabetic characters.

3 To add the new entry to the end of the type list, click on
Append.

4 Repeat the procedure for each entry you want to add to the
type table.

5 Click on OK.

å  To edit an existing statement type for the current encyclopedia
or Encyclopedia Initializer:

1 Choose Table, then Statement Types... from the cascading
menu.

Result: The Edit Statement Type Table dialog box appears.
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2 Highlight the entry in the large list box that you want to edit.

Result: The statement type appears in the Entry field.

3 Edit the information in this field, then click on Change.

å  To delete a statement type for the current encyclopedia or
Encyclopedia Initializer:

1 Choose Table, then Statement Types... from the cascading
menu.

Result: The Edit Statement Type Table dialog box appears.

2 Highlight the entry in the large list box that you want to
delete.

Result: The statement type appears in the Entry field.

3 Click on Delete.
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Edit Statement Type Table Dialog Box

Dialog Box
Illustration

                Edit Statement Type Table Dialog Box

Dialog Box Use the information below to complete the Edit Statement Type Table
Components dialog box.

Component         Description                                                                 
Entry The name of the statement type that is highlighted in

the statement type list box, or that you enter when you are
adding a new type.

Append Use this button to add a new statement type to the
end of the statement type list.

Change Use this button to edit a statement type in the table.
To do this, highlight the statement type in the list, edit the
Entry field, then click on this button.

Delete Use this button to delete a statement type from the
table. To do this, highlight the statement type in the list,
then click on this button.
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STATEMENT-VIEW MATRIX

Opening a Statement-View
Matrix Window

Description The Statement-View Matrix window command, available from all
windows, allows you to view the model views in which each planning
statement is visible. You can also add statements to and remove them from
model views through this window by making changes to the matrix and
saving those changes.

Procedure å  To open a Statement-View Matrix window:

1 Choose Statement-View Matrix... from the Plan menu on
the main Visible Advantage window.

From any other window, choose Planning from the main menu,
then choose Statement-View Matrix... from the cascading menu.

Result: The Statement-Model View Matrix dialog box
appears.

2 If you want to display statements of all types on the left axis
of the matrix, select All Statement Types.

If you want to display statements of selected types, select Selected
Statement Types, then click on Select Types in the Left Axis
area. The Statement Types dialog box appears. Select the statement
types you want to display, then click on OK to return to the
Statement-Model View Matrix dialog box.

3 If you want to display model views of all types on the top
axis, select All Model View Types. If you want to display model
views of selected types, select Selected Model View Types, then
click on Select Types. The Model View Types dialog box appears.
Select the model view types you want to display, then click on OK
to return to the Statement-Model View Matrix dialog box.
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4 If you want to display the statements in the entire model,
click on the Entire Model button. If you want to display only
statements from one model view,  click on the Single Model View
button, then select the model view from the drop-down list.
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SYNCHRONIZE

Synchronizing Visible Advantage
Windows

Description The Synchronize command causes all open Visible Advantage
windows to be updated simultaneously. This command is available in all
windows except the main Visible Advantage window.

Usage Tips The Synchronize command is useful when you want to see how the
changes you make affect other parts of the encyclopedia.

To maximize the usefulness of this command, you should first use the Tile
command on the Window menu so all open windows are visible. Windows
allows up to eight windows to be open at the same time.

The Synchronize command toggles between an active and inactive state.
When the command is active, a checkmark appears next to the command
name; when the command is inactive, no checkmark appears next to the
command name.

2  Note  Because every open window must be redrawn each time
you make a change in the active window, Synchronize slows data entry.

Procedure å  To synchronize all open windows:

1 Although it is not necessary for the command's operation, it
is useful to use the Tile command so that all open windows
are visible.

To do this, choose Tile from the Window menu.

2 Choose Synchronize from the Window menu.

Result: A checkmark appears next to the Synchronize command.
You may deactivate the command by choosing it again.
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TABLE

Maintaining Tables

Description The Table command, available from the Visible Advantage Admin
Utility main window, allows system administrators to maintain tables
in the current encyclopedia.

Tables you may edit are:
o   View Types
o   Statement Types
o   Session Types
o   Data Types
o   Design Object Types
o   Design Object Relationship Reasons
o   Property Type Rules
o   Property Relationship Reasons
o   Data Structure Managers
o   Data Structure Types
o   Data Item Types
o   Data Access Methods
o   Custom Fields
o   Domains
o   Functions
o   Standard Words
o   Diagram Filters

Usage Tips Only system administrators logged onto an encyclopedia may maintain
tables.

Procedure å  To maintain tables:

1 Choose Table from the main menu.

2 Select the table type you wish to edit from the cascading
menu.

Result:  The appropriate Edit dialog box appears for the type
of table you selected.

3 Complete the dialog box and click on OK.
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2  Note  For information on each type of Edit dialog box, see
the appropriate command in this reference manual.
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TILE

Tiling Open Windows on the Workspace

Description The Tile command arranges all open windows in smaller sizes so that
all are completely visible on the workspace. This command is available
from all windows except the main Visible Advantage window.

Usage Tips This command is especially useful when you use it with the
Synchronize command. See Synchronize in this manual for details.

Procedure å  To arrange all open Visible Advantage windows in a tile
formation:

Choose Tile from the Window menu.
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TOOL BAR

 Displaying and Hiding the Tool Bar

Description The Tool Bar command is a toggle that turns the tool bar display on
and off. This command is available in all windows.

Usage Tips This command toggles between an active and inactive state. When
there is a checkmark beside the Tool Bar command, the tool bar is
displayed; when there is no checkmark beside the command name, the tool
bar is hidden.

The Tool Bar command affects all Visible Advantage windows, not just the
active window.

Procedure å  To display or hide the tool bar:

Choose Tool Bar from the Window menu of any window.

Result: If the tool bar was hidden when you chose this command, a
checkmark will appear beside the command and the tool bar will display at
the top of the active window.

If the tool bar was displayed when you chose this command, the checkmark
beside the command will disappear and the tool bar will be hidden in the
active window.
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UNCONTROL ENTITY

Removing Entity Control Links

Description The Uncontrol command, available from both the Data Map and Data
Dictionary windows, allows you to remove a control link for the current
entity.

Usage Tips To use this command, there must be at least one controlled or
controlling entity defined for the current entity.

Control links are represented in the Data Map window by a dotted arrow
pointing from the controlling entity to the controlled entity.

If an entity controls another entity, the controlled entity name is listed in the
Data Dictionary window's Controls  field. If an entity is controlled by
another entity, the controlling entity name is listed in the Data Dictionary
window's Controlled by field.

This command is available for multiple selected entities in the Data Map
window. See the User's Guide for instructions on selecting entities in the
Data Map window. In the Data Dictionary window, this command is
available for the currently displayed entity only.

Procedures å  To remove a control link for the selected entities in the Data
Map window:

1 Highlight the entity for which you wish to remove a control.

2 Choose Uncontrol... from the Entity menu.

Result: The Delete Entity Control dialog box for the first selected
entity appears.

3 In the Delete Entity Control dialog box, select the entity from
which you want to remove the control, then click on OK.

Result: If you selected more than one entity, the Delete Entity
Control dialog box for the next selected entity appears. (Repeat
this step for each selected entity.)
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Otherwise, the active Data Map window reappears. (End of
procedure.)

å To remove an entity control link when you are working in the
 Data Dictionary window:

1 In the Controls or Controlled by field, highlight the name of
the entity for which you want to remove a control link.

2 Choose Uncontrol from the Entity menu.
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UNDERLINE

Underlining Text in an Editor Window

Description The Underline command underlines selected text in the Statement
Editor window.

Procedure å To underline statement text:

1 In the Statement Editor window, select the text you
want to underline.

2 Choose Style from the Format menu.

3 Choose Underline from the cascading menu for the Style
command.

Result: The selected text appears underlined in the active window.

å To remove underlining from selected text:

1 In the Statement Editor window, select the text
from which you want to remove underlining.

2 Choose Style from the Format menu.

3 Choose Normal from the cascading menu for the Style
command.

Result: The selected text appears normal in the active window.
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UNDO

Reversing Your Last Editing Action

Description The Undo Editing command allows you to reverse your last editing
action in the Statement Editor window.

Usage Tips This command is useful when you mistakenly delete text or want to
undo a search-and-replace operation you just completed.

Procedure å  To undo your last editing action:

Choose Undo Editing from the Edit menu.
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UNFREEZE/
CLEAR CHECK-OUT

Unfreezing/Clearing a
Checked-out Encyclopedia

Description This command unfreezes all objects that were checked out in a previous
encyclopedia check-out and clears the copy as if it were never made.  It
should only be used when you wish to discard the checked-out encyclopedia
and not Check-in/Merge it back in.  It is also used to reverse a Freeze All
command.

Usage Tips The Clear Check-out command is part of the Visible Advantage Utility
program that comes with Visible Advantage. To use the Clear Check-out
function, click on the Visible Advantage Utility icon inside the Visible
Advantage program group.  The Clear Check-out command is under the
Copy/Merge menu.

Procedure å  To clear a checked-out encyclopedia:

1 Choose Clear Check-out from the Copy/Merge menu.

Result: The Open Encyclopedia dialog box appears.

2 Select from the Encyclopedias list box the encyclopedia you want
to unfreeze/clear check-out. If the encyclopedia is not listed,
navigate through the directories in the Path list box until it appears.

3 Click on OK.

4 Type your logon for the encyclopedia and, if necessary, a
password. Click on OK.

Result:  If you typed a valid logon and password, the Clear
Encyclopedia Copy dialog box appears.

Otherwise, an error message appears and you must return to the
logon dialog box to type a different logon.
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5 To clear selected subset encyclopedias, click the Selected
Checked-out button, then select the encyclopedias in the checked-
out list box.

If there are no copies to be cleared, or to clear all
encyclopedias, click on the All Checked-out (Unfreeze All)
button to cycle through all objects in the encyclopedia and
ensure that each is unfrozen.
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UNLINK ASSOCIATION
FROM STATEMENT

Unlinking Associations
from Statements

Description The Unlink Association From Statement command, available from the
Data Dictionary window, allows you to unlink an association from one or
more planning statements.

Procedure å  To unlink an association from one or more planning
statements:

1 In the Associations field, highlight the association from
which you want to unlink a planning statement.

2 Choose Unlink From Statement... from the Association
menu.

Result: The Unlink Statement dialog box appears.

3 The Unlink Statement box lists all statements to which the
selected  association has been linked.

Highlight the statement(s) from which you want to unlink the
association, then click on OK.

2 Note  To highlight multiple consecutive list items, hold down
the SHIFT key and click on the first item you want to highlight,
and then click on the last item you want to highlight. To highlight
multiple non-consecutive items, hold down the CTRL key and
click on each item you want to highlight.
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 UNLINK ATTRIBUTE
 FROM PROPERTY

Unlinking Attributes from
Properties

Description The Unlink Attribute From Property command, available from both
the Data Map and Data Dictionary windows, allows you to remove a link
between an attribute and one or more properties within a database
design.

Procedure å To remove a link between an attribute and one or more
properties  while working in the Data Map window:

1 Select the entity that contains the attribute for which you want
to remove the property link(s).

2 Choose Unlink From Property... from the Attribute menu.

Result: The Select Attribute dialog box appears.

3 Select the attribute from which you want to remove the data
item link(s), then click on OK.

Result: The Unlink Attribute From Property dialog box appears.

4 Select the database design that contains the property(s) from
which you want to unlink the attribute. The list contains all design
views added to the encyclopedia.

5 Select the property(s) from which you want to unlink the
attribute, then click on OK. The list includes all properties within
the design views selected above.

2 Note  To highlight multiple consecutive list items, hold down
the SHIFT key and click on the first item you want to highlight,
and then click on the last item you want to highlight. To highlight
multiple non-consecutive items, hold down the CTRL key and
click on each item you want to highlight.
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å To remove a link between an attribute and one or more properties
while working in the Data Dictionary window:

1 Highlight the name of the attribute in the Attributes field for
which you want to remove property link(s).

2 Choose Unlink From Property...  from the Attribute menu.

Result: The Unlink Attribute From Property dialog box appears.

3 Select the design view that contains the property(s) from
which you want to unlink the attribute. The list contains all  design
views added to the encyclopedia.

4 Select the property(s) from which you want to unlink the
attribute, then click on OK. The list includes all properties within
the design views selected above.

2 Note  To highlight multiple consecutive list items, hold down
the SHIFT key and click on the first item you want to highlight,
and then click on the last item you want to highlight. To highlight
multiple non-consecutive items, hold down the CTRL key and
click on each item you want to highlight.
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UNLINK ATTRIBUTE
 FROM STATEMENT

Unlinking Attributes from
Statements

Description The Unlink Attribute From Statement command, available from the
Data Dictionary window, allows you to unlink an attribute from planning
statement(s).

Procedure åTo unlink an attribute from  planning statement(s):

1 In the Attributes field, highlight the attribute from which you
want to unlink a planning statement.

2 Choose Unlink From Statement... from the Attribute menu.

Result: The Unlink Statement dialog box appears.

3 Select the statement(s) from which you want to unlink the
attribute, then click on OK.

2 Note  To highlight multiple consecutive list items, hold down
the SHIFT key and click on the first item you want to highlight,
and then click on the last item you want to highlight. To highlight
multiple non-consecutive items, hold down the CTRL key and
click on each item you want to highlight.



694

UNLINK DESIGN OBJECT
 FROM ENTITY

Unlinking Design Objects from Entities

Description The Unlink Design Object From Entity command, available from the
Design Dictionary and Design Map windows, allows you to remove defined
links between the current design object and one or more entities in the data
model.

Procedure å To unlink a design object from one or more entities to which it
is linked in a Design Dictionary window:

1 In the Model Link field in the Design Dictionary window,
highlight the link you want to remove.

2 Choose Unlink…  from the Design Object menu.

Result:  The link is removed.

å To unlink a design object from one or more entities to which it is
lined in a Design Map window:

1 Select the design object to unlink.

2 Choose Unlink... from the Design Object menu.

Result: The Unlink Design Object dialog box appears.

3 All of the entities to which the design object has been linked
are listed in the Entities list box.

Highlight the entity or entities from which you want to unlink the
design object, then click on OK.

2 Note  To highlight multiple consecutive entities, hold down the
SHIFT key and click on the first entities you want to highlight, and
then click on the last entities you want to highlight. To highlight
multiple non-consecutive entities, hold down the CTRL key and
click on each entity you want to highlight.
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UNLINK ENTITY FROM
 DESIGN OBJECT

Unlinking Entities from
Design Objects

Description The Unlink Entity from Design Object command, available from both
the Data Map and Data Dictionary windows, allows you to remove a link
between an entity and one or more design objects within a database design.

Procedure å To remove a link between an entity and design object(s) in the
Data Map window:

1 Select the entity you wish to unlink.

2 Choose Unlink from Design Object…  from the Entity menu.

Result: The Unlink Entity From Design Object dialog box appears.

3 Select the database design that contains the design object
from which you want to unlink the entity. The list contains all
database designs added to the encyclopedia.

4 Select the design object(s) from which you want to unlink the
entity, then click on OK. The list includes all design objects within
the database design selected above.

2 Note  To highlight multiple consecutive design objects, hold
down the SHIFT key and click on the first design object you want
to highlight, then click on the last design object you want to
highlight. To highlight multiple non-consecutive design objects,
hold down the CTRL key and click on each design object you want
to highlight.

å To remove a link between an entity and design object(s) in the
Data Dictionary window:

1 In the Model Link field in the Data Dictionary window,
highlight the link you want to remove.
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2 Select Unlink from the Entity menu.

Result:  The entity is unlinked.
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UNLINK ENTITY FROM
 STATEMENT

Unlinking Entities from Statements

Description The Unlink Entity From Statement command, available from the Data
Dictionary window, allows you to unlink the current entity from a planning
statement.

Procedure å To unlink the current entity from a planning statement:

1 In the Model Links field, highlight the planning statement
link you want to remove.

2 Choose Unlink from the Entity menu.
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UNLINK PROPERTY
 FROM ATTRIBUTE

Unlinking Properties from
Attributes

Description The Unlink Property From Attribute command, available from the
Design Dictionary and Design Map windows, allows you to remove a
defined link between a property and an attribute in the data model.

Procedure å To unlink a property from one or more attributes  in the Design
Dictionary window:

1 In the  Properties field, highlight the property you want to
unlink from an attribute or attributes.

2 Choose Unlink From Attribute... from the Property menu.

Result: The Unlink Property dialog box appears.

3 All of the attributes to which the property has been linked
are listed in the Attributes list box.

Highlight the attribute(s) from which you want to unlink the
property, then click on OK.

2 Note  To highlight multiple consecutive attributes, hold down
the SHIFT key and click on the first attribute you want to
highlight, and then click on the last attribute you want to highlight.
To highlight multiple non-consecutive attributes, hold down the
CTRL key and click on each attribute you want to highlight.

 å  To unlink a property from one or more attributes in the Design
Map window:

1 Highlight the design object from which you want to unlink a
property.

2 Choose Unlink From Attribute…  from the Property menu.
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Result:  The Select Design Object Property dialog box
appears.

3 Select the property, then click on OK.

Result:  The Unlink Property dialog box appears.

4 All of the attributes to which the property has been linked are
listed in the Attributes list box.

Highlight the attribute(s) from which you want to unlink the
property, then click on OK.

2  Note  To highlight multiple consecutive attributes,
hold down the SHIFT key and click on the first attribute
you want to highlight, and then click on the last attribute you
want to highlight.  To highlight multiple non-consecutive
attributes, hold down the CTRL key and click on each
attribute you want to highlight.
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UNLINK STATEMENT
 FROM OBJECT

Unlinking Statements from Objects

Description The Unlink command, available from both the Planning Outline and
Planning Dictionary windows, allows you to remove a link between the
current or selected statement(s) and an entity, attribute, association, or
design object.

Procedure å To unlink selected statement(s) from one or more data modeling
objects while you are working in the Planning Outline window:

1 Choose Unlink... from the Link menu.

Result: The Unlink Dictionary Object dialog box appears.

2 Select the object(s) from which you want to unlink the
statement, then click on OK.

2 Note To select multiple items, hold down the CTRL key and
click on each item you want to select.

å To unlink the current statement from a data modeling object while
you are working in the Planning Dictionary window:

1 In the Model Links field, highlight the link you want to
remove.

2 Choose Unlink from the Link menu.

Result:  Statement is unlinked.
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UNMOUNT

Creating a Stand-Alone Encyclopedia

Description The Unmount command, available from the Visible Advantage Admin
Utility, allows the system administrator to create a stand-alone
encyclopedia by copying aclient/server edition encyclopedia.

Usage Tips This command is available in client/server versions only, and can only
be used on encyclopedias created on or imported into Version 7 of
Visible Advantage.

Procedure å  To create a stand-alone copy of an encyclopedia:

1 Start the Visible Advantage Admin program from
Windows.

2 If you have not set up automatic Raima server login, supply
the server name, user name, and password to log on to the Raima
database server.

3 Pull down the Encyclopedia menu, and click on Open.

4 Select the encyclopedia you want to convert to stand-alone and
click on OK.

5 Provide your ID and password,  and click on OK.

6 Pull down the Encyclopedia menu and click on Unmount.
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USER GROUP REPORT

Printing a User Group Report

Description The User Group Report command, available from the Visible
Advantage Admin Utility, allows a system administrator to print
a report that lists the names, logons, privileges, and status of each
authorized user group of the current encyclopedia.

Procedure å  To print a user group report:

1 Choose the Visible Advantage Admin Utility icon from the
Program Manager window.

2 Choose Group User Report  from the Group menu.

Result:  The Group User Report Dialog box appears.

3 Complete the dialog box, then click on OK.

Result:  The Report Destination dialog box appears.

4 Select a report destination (Printer, File or Screen),
then click on OK.
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User Group Report Dialog Box

Dialog Box
Illustration

                                 

         User Group Report Dialog Box

Dialog Box Use the information below to complete the User Group Report
Components dialog box.

Component         Description                                                                 
Users Prints the individual users assigned to the user

group.

Read/Write Prints the user group access levels for views.
Views

Controlled Prints if user group has control assignment by
Statements view or by object ownership.

Controlled Prints if user group has control assignment by
Entities control by view or by object ownership.

Controlled Prints all attributes assigned to user group.
Attributes
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Controlled Prints (by view or by object ownership).
Processes

Controlled Prints all design objects assigned (by design
Design view or by object ownership) to user group.
Object

Controlled Prints all sessions assigned (by ownership) to
Sessions user group.

Controlled Prints all functions assigned (by ownership) to
Functions user group.

Time Stamps Prints the date and time each user group was
added to the encyclopedia, along with the date
and time each user group was modified.

New Page Select this checkbox if you want each user group
to start on a new page.
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USER REPORT

Printing User Reports

Description The User Report command, available from the Visible Advantage
Admin Utility, allows a system administrator to print a report that lists the
name, logon, privilege, and status of each authorized user of the
current encyclopedia.

Procedure å To print a user report:

1 Choose User Report... from the User  command.

Result: The User  Report dialog box appears.

2 Complete the dialog box, then click on OK.

Result: The Report Destination dialog box appears.

3 Select a report destination (Printer, File, or Screen), then
click on OK.
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User Account Report Dialog Box

Dialog Box
Illustration

                    

           User Account Report Dialog Box

Dialog Box Use the information below to complete the User Account Report dialog
Components box.

Component         Description                                                                 
Passwords Prints the password for each account.

Notes Prints the notes attached to each reported user.

Note Texts Prints the text of each reported note.

Time Stamps Prints the date and time each user account was added
to the encyclopedia, along with the date and time each
user account was modified.

New Page Select this checkbox if you want each user account to
start on a new page.
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VARIABLES

Defining Attribute Variables

Description The Variables command, available from the Process Map window,
allows you to define a variable for each attribute used in the process model.
Variables are used to differentiate between multiple occurrences of the same
attribute, either between different or the same entities.

Usage Tips Variables are defined globally, for the entire process model, rather
than for the current process only. Once a variable is defined, you can select
it when adding or editing attribute lists for applicable process steps.

Procedure å To add a variable for an attribute used by the process model:

1 Choose Variables... from the Process menu.

Result: The Variables dialog box appears.

2 From the Attribute drop-down list, select the attribute for
which you want to define a variable.

3 Type the variable name into the Variable box, then click on
Add.

Result: The variable and attribute appear in the large list box.

åTo change a variable defined for an attribute:

1 Choose Variables... from the Process menu.

Result: The Variables dialog box appears.

2 In the large list box, click on the variable and attribute
combination you want to change, make changes to the Variable or
Attribute field, then click on Change.

If the Show Unused Variables Only checkbox is selected, only
those variables that have not been used by any process steps are
listed in the large list box. You may change both used and unused
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variables. If you change a used variable, the change will be
reflected in all process steps that use the variable.

å To delete a variable for an attribute:

1 Choose Variables... from the Process menu.

Result: The Variables dialog box appears.

2 In the large list box, click on the variable and attribute
combination you want to delete, then click on Delete.

If the Show Unused Variables Only checkbox is selected, only
those variables that have not been used by a process are listed in
the list box. You may delete only unused variables.
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Variables Dialog Box

Dialog Box
Illustration

                   Variables Dialog Box

Dialog Box Use the information below to complete the Variables dialog box.
Components

Component         Description                                                                 
Variable Type into this box the variable name for the attribute

you selected from the Attribute list.

Attribute Select from this drop-down list the attribute that the
variable represents.

Show Unused Select this checkbox if you want to display only
Variables Only unused variables in the variable list box.

You may delete only unused variables; however, if you
change a variable used in the process model, the change
will be reflected in each use of the variable.

Add Use this button to add the variable and attribute
combination shown in the Variable and Attribute
fields.
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Change Use this button to change a variable. Highlight the
variable-attribute combination you want to change,
make the changes to the Variable and/or Attribute
field(s), then click on this button.

Delete Use this button to delete a variable. Highlight the
able-attribute combination you want to delete, then
click on this button.
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VIEW TYPES

Defining Model View Types

Description The View Types command, available from the Visible Advantage
Admin Utility, allows you to define view types  in the current
encyclopedia.

Usage Tips The view types you define with this command are for the current
encyclopedia only. If you want to define view types for all future
encyclopedias, use the Encyclopedia Initializer command before you use the
View Types command.

Procedure åTo add a view type for the current encyclopedia or
Encyclopedia Initializer.

1 Choose Table main Visible Advantage Admin Utility
window, then choose View Types... from the cascading
menu that follows.

Result: The Edit View Type Table dialog box appears.

2 Type the name of the new type into the Entry field. If you
highlighted an entry in the type list box, you will have to
clear its entry from the field before typing the entry for the
new type. You may type 1-31 alphabetic characters.

3 Type an abbreviation for the model view into the
Abbreviation field. This abbreviation appears in the lower right-
hand corner of each model view rectangle in the Model View
Hierarchy window and printed diagram.

If you highlighted an entry in the type list box before you typed
your entry, you will have to clear the entry in the Abbreviation
field before typing the abbreviation for the new type.

4 To add the new entry to the end of the type list, click on
Append.

5 Repeat the procedure for each entry you want to add to the
type table.
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6 Click on OK.

åTo edit an existing view type for the current encyclopedia or
Encyclopedia Initializer:

1 Choose View Types... from the Table menu.

Result: The Edit View Type Table dialog box appears.

2 Highlight the entry in the large list box that you want to edit.

Result: The view type and its abbreviation appear in the Entry and
Abbreviation fields.

3 Edit the information in these fields, then click on Change.

2 Note  A message appears telling you that the type cannot be
changed if the entry is a system-defined model view type (root
view, functional area) protected from editing by Visible
Advantage.

åTo delete a view type for the current encyclopedia or Encyclopedia
Initializer:

1 Choose View Types... from the Table menu.

Result: The Edit View Type Table dialog box appears.

2 Highlight the entry in the large list box that you want to
delete.

Result: The view type and its abbreviation appear in the Entry and
Abbreviation fields.

3 Click on Delete.

Result: The entry will be deleted.

2 Note  A message appears telling you that the type cannot be
deleted if the entry is a system-defined model view type (root
view, functional area) protected from deletion by Visible
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Advantage, or if it is referenced by any model view in the
encyclopedia.
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Edit View Type Table Dialog Box

Dialog Box 
Illustration

        Edit View Type Table Dialog Box

Dialog Box Use the information below to complete the Edit View Type Table
Components dialog box.

Component         Description                                                                 
Entry The name of the model view type that is highlighted

in the model view type list box, or that you enter when
you are adding a new type.

Abbreviation The abbreviation for the model view type that is
highlighted in the model view type list box, or that you
enter when you are adding a new type.

The model view type abbreviation appears in the lower
right-hand corner of each model view rectangle in the
model view hierarchy diagram.

Has Business Select this checkbox if you want to be able to define
Levels a business level (strategic, tactical, operational)

when you add a model view.
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Model Views Select this checkbox if you want the entry to be used
for model views.

Design Views Select this checkbox if you want the entry to be used
for design views.

Append Use this button to add a new model view type to the
end of the model view type list.

Change Use this button to edit a model view type in the
table. To do this , highlight the model view type in
the list, edit the Entry and/or Abbreviation fields,
then click on this button.

A view type cannot be changed if it is a system-defined
type (root view, functional area) protected from editing by
Visible Advantage.

Delete Use this button to delete a model view type from the
table. To do this, highlight the model view type in the list,
then click on this button.

A view type cannot be deleted if it is a system-defined
type (root view, functional area) protected from deletion
by Visible Advantage, or if it is referenced by any model
view in the encyclopedia.
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VIEWS

Opening a View Hierarchy Window

Description The Views command allows you to open a View Hierarchy window.
This window provides a graphical representation of the model views
defined for the encyclopedia and the hierarchical relationships between
them. This command is available from all windows.

Procedure å  To open a View Hierarchy window:

Choose Views... from the Encyclopedia menu on the main Visible
Advantage window.
or
Choose Views from the main menu Encyclopedia Management sub-menu
on any other menu bar.
or
Click on the Views icon on the main Visible Advantage window
workspace.

Result: The View Hierarchy window and menu bar appear.

Related Use the table below to find information on topics related to the
Topics Views command.

For More Information On...          See...                                                
how to use each command in  the entry in this manual for the
the View Hierarchy individual command.  For
window example, to learn how to use the

Add command on the View menu,
see Add View.

how to use the View the Encyclopedia Management
Hierarchy window's special section in the User's Guide.
features, such as the tool
panel, mouse commands,
and keyboard shortcuts
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WINDOW

Scaling Graphic Information
to a Window

Description The Window command resizes the model view hierarchy or data map
diagram to fit inside the window. This command is available from the
following windows: View Hierarchy, Design Map, and Data Map.

Usage Tips After you use this command, you may use the Normal command on
the Display menu to return the diagram to the default scale. You can
also use the Larger and Smaller commands on the Display menu to further
refine the size of the diagram.

Procedure å  To scale a diagram to fit inside the active window:

Choose Window from the Display menu.
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WRITE MATRIX

Writing Matrix Changes to
the Database

Description The Write Matrix command saves any matrix changes to the current
encyclopedia's database. This command is available from all matrix
windows except the Process-Entity Matrix, which is not an active matrix.

Usage Tips If you are running the active matrix window in immediate mode, your
changes are written to the database as you make them, and you do not need
to use this command to make your changes effective in the encyclopedia.

If you are not running in immediate mode, your matrix changes are not
written to the encyclopedia database until you choose this command.

Procedure å  To write your matrix changes to the encyclopedia database:

Choose Write Matrix from the Matrix menu.
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ZOOM

Zooming the Model View Hierarchy

Description The Zoom command, available from the View Hierarchy window,
displays only the selected view and those beneath it in the View Hierarchy
window.

Using This This command is useful when you want to view only a focused group
Command of model views. The Zoom command is not available when more than

one view is selected.

Procedure å  To zoom in on a view subset:

1 Select the view you want to zoom in on.

2 Choose Zoom from the Hierarchy menu.

Result: The subset will display and a checkmark will appear next
to the Zoom command. This lets you know that only a subset of the
view is displayed.



720

ZOOM SELECTION

Zooming in on Selections

Description The Zoom Selection command, available from the Design Map and
Data Map windows, enlarges one or more selected objects . This
command is useful when you want a close-up view of a group  in the
window.

Procedure å  To zoom in on selected objects:

Choose Zoom Selection from the Display menu.
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APPENDICES

In This Unit The Appendices unit contains the following appendices.

Appendix                                                      
Functions and Expressions Guide
Model Analysis Checklist
IDEF1X Data Map Notation
VSC File Formats
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FUNCTIONS AND
 EXPRESSIONS GUIDE

Overview

Introduction This section provides useful information on using expressions and
functions in your Visible Advantage data and process models.

An expression is a rigorous depiction of logic. Each expression is a specific
instance of a function, which is a generic pattern of logic. When you
evaluate an expression for specific instances of values, it returns results
fitting a predefined pattern. Expressions define calculations and decision
logic based on variable data represented in the data model.

Related to expressions and functions, a variable can represent an entity
attribute to clarify the different uses of the same attribute.

In This This appendix contains the following sections.
Appendix
. Section                                                                                      

Using Functions
Using Variables
Applying Expressions
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Using Functions

Introduction A Function is a generic pattern of logic that returns a value of a known
domain. Functions include Algorithmic Functions and Unary and
Binary Functions.

Algorithmic An Algorithmic Function is the function type that accomplishes
Functions a predefined algorithm on a variable set of arguments.  The

data type of the value returned by the function is indicated in parentheses to
the left of the colon. Following the colon is the predefined algorithm and
then the type of argument the algorithm will be performed on.
o   (Numerical): Abs(Numerical)
o   (Numerical): Acos(Numerical)
o   (Numerical): Asin(Numerical)
o   (Numerical): Atan(Numerical)
o   (Numerical): Average(Numerical)
o   (Numerical): Cos(Numerical)
o   (Numerical): Count(ENTITY)
o   (Numerical): Exponent(Numerical)
o   (Numerical): Log(Numerical)
o   (Numerical): Max(Numerical)
o   (Numerical): Min(Numerical)
o   (Numerical): Remainder(Numerical)
o   (Numerical): Sin(Numerical)
o   (Numerical): Sqrt(Numerical)
o   (Numerical): Tan(Numerical)

Unary A Unary Operator is the function type that always has one and only
Operators one argument. Essentially, Unary Operators accomplish signing

functions. The plus and minus signs in the examples below are operators
and in parentheses is the type of argument.
o    +(Numerical)
o  -(Numerical)

Binary A Binary Operator is the function type that always has two
Operators and only two arguments. There are many Binary Operators

included in Visible Advantage.

The values returned by Binary Operators can be:
o   Boolean (true or false, yes or no, on or off, etc.)
o   Numerical
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o   Character
o   Date

The pattern is:
(data type of return value): (argument) operator (argument)

Binary Boolean Binary Operators compare two arguments of the same type
Operators and can be:
That Return o   Numerical
a Boolean o   Character

o   Date
o   Time

The table below explains each logical operator used to compare two
arguments.

Description                                     Symbol
Not equal to !=
Equal to =
Greater than >
Less than <
Greater than or equal to >=
Less than or equal to <=
Or |
And &

The arguments and logical operators can be combined to make many
expressions. The table below provides some examples:

Binary Operator                                          Description                       
(Boolean): (Numerical) != (Numerical) If one numerical value (a

fixed number, attribute, or
variable) is not equal to
another numerical value,
then "True" is returned;
otherwise, the expression is
"False."
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(Boolean): (Date) <= (Date)  If the first date is less
than or equal to the 
second date, then "True"
is returned, otherwise the
expression is "False.”

(Boolean): (Boolean) | (Boolean) If either the first or second
Boolean is "True," then
"True" is returned.  If both
are "False," the whole
expression is "False."

Binary Other Binary Operators have the same pattern and return either a
Operators numerical, character or date value; the arguments don’t  necessarily
That Return have to be the same type, and the arithmetic operators available are:
Values Other o   Addition: +
Than Boolean o   Subtraction: -

o   Multiplication: *
o   Division: /
o   Exponentiation: **

+  Examples
(Numerical): (Numerical) * (Numerical).  Two numerical values are
multiplied together returning a numerical value.

(Date): (Date) - (Numerical). A date minus a number returns a date.

(Character): (Character) + (Character). A character is concatenated with
another character returning a character.

Using When you use a function you do not write it exactly as shown above.
Functions You do not write the data type of the value returned, parenthesis or

colon.  For example, if you want to use the function,
(Numerical): (Numerical) * (Numerical), you simply write, 2 * 5 or
substitute the numerical values with attributes.

Creating You can create additional functions, if required. To read about adding
Functions functions, see Functions in this manual.
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Using Variables

Definition A variable is an alias for an attribute of an entity. Variables are used in
Process Modeling primarily to clarify the different uses of the same
attribute.

Where You You can use variables:
Can Use a o   In any attribute list of both business process and data access
Variable       process steps

o   In the modified attribute expression of Initiation lists
o   In the qualifying expression of a Do Read and Do Update process
      step
o   In an Evaluate process step expression
o   As the object of an Examine step

2   Note  You cannot use variables in derivation formulas.

Examples Suppose you have the following structure entity:

               

PERSON STRUCTURE

person id #
person id#

You can assign a variable such as teacher to one person id and student
to the other to differentiate which person id is being referenced.

2 Note You may assign more than one variable to any attribute.
Variables are encyclopedia-wide and may be used by any process.

Below is an example of a variable in a qualifying expression of a Do
Read process step.

             

Do Read PERSON STRUCTURE

Q: PERSON STRUCTURE.person
id = teacher(person id)
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Applying Expressions

Introduction Currently, you can use expressions in Data Modeling and Process
Modeling:
o   In the derivation formula for attributes (note that you cannot use
      variables for derivation formulas)
o   In the qualifying expression
o   In a conditional step that evaluates to a continuous domain
o   In the Evaluate process step expression
o   In the modified attribute expression of Initiation lists

Derivation The derivation formula is an expression used to determine
Formula the values for a derived attribute. You may not use variables in a

derivation formula.

Derived attributes use an algorithm or calculation involving other attributes
and/or fixed numbers to determine its values. Usually, derived attributes use
mathematical logic yielding a numerical result. Date and time computations
are also possible.

+  Examples  Below are two examples of derivation formulas for attributes.

Derived Attribute: total vacant jobs
Purpose: The number of job openings.
Derivation Formula: total number of jobs - total jobs filled
This derivation formula is using the binary operator
             (Numerical): (Numerical) - (Numerical)

Derived Attribute: head count
Purpose: The total number of employees.
Derivation Formula: Count(EMPLOYEE)
This derivation formula is using the algorithmic function
            Count(ENTITY)

Qualifying A qualifying expression identifies which occurrence(s)
Expressions of an entity or entity-attribute in an expression. A qualifying

expression can be used in:
o   Do Read process step
o   Do Update process step
o   To qualify which entity occurrences a process step acts on

+  Examples  Below are examples of qualifying expressions.
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Derived Attribute: total jobs filled
Purpose: The number of positions currently filled for a specific job.
Derivation Formula: count(EMPLOYEE JOB [where EMPLOYEE.job code
= JOB.job code])
This derivation formula is using the algorithmic function Count(ENTITY).

2 Note  If a qualifying expression is part of a larger expression, the
matching brackets are required but "where" is optional. If an attribute exists
in more than one entity, the entity name followed by a period must precede
the attribute name so it won't be ambiguous.

Process step: Do Read PERSON
Purpose: This process step invokes the data access process Read PERSON
and the occurrence(s) read should be limited to the name provided by the
user in the previous Accept step.

ACCEPT

A:first name

last name

Do Read PERSON

Q:last name &
:first name = first
name

The Do Read PERSON process step should be read as "Read PERSON
where PERSON.last name equals the last name provided by the user and
PERSON.first name equals the first name provided by the user."

2 Note  Since the expression is a qualifying expression and not part of a
larger expression, the matching brackets and "where" are not allowed. The
entity name PERSON is not required because the attribute's last name and
first name do not exist anywhere else.

The colon is required before the attributes (or variables) that are being read
to differentiate it from the attributes that are being provided by the user (that
is, a colon identifies an attribute as a value coming from or within the data
model). It does not matter which order you put the attributes in; i.e., "last
name = :last name & first name = :first name" is also allowed.
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Condition If the object attribute of a process step with the condition is static,
Expressions then the condition for selecting from alternative actions must be the set

of static values for that attribute. However, if the object attribute is
dynamic, then the condition must be a mutually exclusive set of values or
expression.

An example of a condition expression in an Examine step is illustrated
below.

Examine
order date

<30
= 30 or
<= 60

>60

2 Note You may include the object attribute name as part of the condition
expression but this is not required. In other words, the condition expression,
job code 100, is legal. However, if the object attribute exists in more than
one entity, then you must specify the entity name to avoid ambiguity.

Evaluate Step An Evaluate step is the category of decision control step that
Expression uses an expression as the basis for selecting from alternative actions.

The object of an Evaluate step must be a logical expression and the control
flow conditions are "true" and "false," "found" and "not found," or "ok" and
"blocked."

For example, the process step below evaluates to an expression and using
the binary operator (Boolean): (numerical) = (numerical).

Evaluate
total order
>=5000 

true false

Modified In an Initiation list, you can include an expression to modify an
Attribute attribute. For example, if you want to update all employees salaries
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Expressions by 20 percent, the initiation list for a Do Update process step would
look like the illustration below.

Do Update EMPLOYEE

I: salary *1.2

ok blocked



731

MODEL ANALYSIS
 CHECKLIST

Overview

Introduction This appendix documents each item checked during the Model
Analysis operation, available through the Reports/Model Analysis
command.

In This This appendix contains the following sections.
Appendix

Section                                                                                      
Planning Analysis
Data Modeling Analysis
Process Modeling Analysis
Database Design Analysis
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Planning Analysis

Introduction An encyclopedia's planning items are analyzed if Planning is selected
in the Phase area of the Model Analysis Report dialog box.

Analysis Items The following items are analyzed during model analysis:
o   Link planning statements to objects
o   Link planning statements to supporting statement(s)
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Data Modeling Analysis

Introduction An encyclopedia's data modeling items are analyzed if Data Modeling
is selected in the Phase area of the Model Analysis Report dialog box.

You may further refine the data modeling analysis by selecting a modeling
level (strategic, tactical, or operational) in the Data Modeling area.

Entity The table below explains each data modeling item analyzed during
Analysis model analysis pertaining to entities, along with the requirement
Items for each item at each modeling level:

Item Strategic Tactical Operational
Define entity
model view
authority

Should be
defined for all
entities in
strategic model

Should be
defined for all
entities in
tactical model

Mandatory

Identify type
entity control of
secondary
entity

Not necessary Not necessary Mandatory

Identify
secondary
entities for all
entities
associated with
type entities

Identify where
appropriate

Should identify
where
appropriate

Mandatory

Identify
primary key for
all entities

Should be
defined prior to
cluster analysis

Mandatory Mandatory

Identify
complete
primary keys
for each
intersecting
entity

Should be
defined prior to
cluster analysis

Mandatory Mandatory

Define entity
purpose

Should be
defined for
clarification

Mandatory Mandatory

Create reason
entities

Not necessary Not necessary Create where
appropriate
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Create structure
entities

Not necessary Not necessary Create where
appropriate

Create role
entities

Not necessary Not necessary Create where
appropriate

Identify entity
category

Mandatory Mandatory Mandatory

Identify control
of rule entities

Not necessary Not necessary Create where
appropriate

Identify non-
key attributes
for all entities

Identify where
appropriate

Identify where
appropriate

Mandatory

Populate/
validate static
table

Identify where
appropriate

Mandatory
where
necessary

Mandatory

Define entity
nature (dynamic
or static)

Not necessary Mandatory Mandatory

Verify many-to-
one association
for all role
entities

Identify where
appropriate

Identify where
appropriate

Mandatory

Child model
view authority
must be valid
for parent
model view

Not necessary Verify where
appropriate

Mandatory

Entity in child
model view
must exist in
parent model
view (subset
view only)

Verify for
correctness

Verify where
appropriate

Mandatory

Limit sole
create/read/upd
ate/delete
authority to one
model view

Recommended Recommended Recommended

Identify model
view purpose

Identify where
appropriate

Identify where
appropriate

Mandatory

Designate
cluster end
points

Designate
where
appropriate

Designate
where
necessary

Designate
where
necessary

Assign clusters Assign clusters Assign clusters Cluster
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to functional
areas

to functional
business areas
(not necessarily
formal business
units)

to operational
areas

analysis
should be
completed
before the
operational
phase

Name each
cluster

Assign names
to functional
(tactical) areas
and clusters

Assign names
to operational
areas and
clusters

Cluster
analysis
should be
completed
before the
operational
phase

Attribute The table below explains each data modeling item analyzed during
Analysis model analysis pertaining to attributes.
Items

Item Strategic Tactical Operational
Define attribute
model view
authority

Should be
defined

Should be
defined

Mandatory

Define attribute
data type and
length/precision

Not necessary Identify where
appropriate

Data types
mandatory;
add precision
where
necessary

Define attribute
purpose

Identify to
clarify

Mandatory Mandatory

Develop
formulas for
derived
attributes

Identify where
appropriate

Identify where
appropriate

Mandatory
where
appropriate

Normalize
repeating
attributes

Not necessary Normalize
tactical model

Mandatory

Normalize
optional
attributes

Normalize
where
appropriate

Normalize
where
appropriate

Mandatory

Define attribute
edit rule

Not necessary Define where
appropriate

Mandatory

Define foreign
key alias if

Not necessary Identify where
appropriate

Identify where
appropriate
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attribute
appears in the
entity more than
once
Identify foreign
keys as
mandatory or
optional; define
uniqueness and
edit rule
characteristics

Should be
defined before
cluster analysis

Mandatory Mandatory

Association The table below explains each data modeling item analyzed during
Analysis model analysis pertaining to associations.
Items

Item Strategic Tactical Operational
Create
association for
all entities

Mandatory Mandatory Mandatory

Define correct
degree and
nature of
associations

Define before
cluster analysis

Mandatory Mandatory

Ensure that all
associations are
supported by
keys

Not necessary Support all
associations
within tactical
area

Mandatory

Define
association
purposes

Define where
appropriate to
clarify

Define where
appropriate to
clarify

Define where
appropriate to
clarify
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Process Modeling Analysis

Introduction An encyclopedia’s process modeling items are analyzed if Process
Modeling is selected in the Phase area of the Model Analysis Report
dialog box.

Business The following item is analyzed during model analysis pertaining to
Event business events:
Analysis q    Each business event must have at least one business process.

Process The following items are analyzed during model analysis pertaining
Analysis to business and data access processes.

q  A data access process must access one entity directly, but only
when invoked by a business process or another data access
process.

q  All add now attributes must be listed on the target list for the Do
Create, add later attributes.

q  A business process must be initiated by a business event or another
business process.

q  Within a model view, a business process may only use attributes and
Do data access processes consistent with the model view authority for
the attributes and entities.

q  A business process that does not respond directly to a business event
should be invoked by more than one business process.  If it is only
invoked by one process, this is indicative of an unnecessary layer in the
process model.

q  Attributes that are input from the user must be on the attribute list for
the data access process called by the process or at a lower level, or be
used in an Examine step.

q  A business process that invoked the same data access process(es) as
another business process may be redundant, or nearly redundant and
should be flagged with a warning message.

q  All attributes that are returned from a Read data access process must be
output to the user, used in the attribute list for invoking another data
access process or used as the basis for a decision.

q  Every entity must have a data access process consistent with its model
view authority.

q  Every data access process must be invoked directly by a process.
q  Every business process must directly or indirectly invoke a data access

process.
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Process Step The following items are analyzed during model analysis pertaining to
Analysis process steps:

q  Each step, except Start or Stop mechanisms, must have at least one
incoming flow and one outgoing flow.

q  Multiple conditions must account for all of the values of the attribute or
both values of the state.

q  A Next step is always a looping step.
q  All Stop mechanisms must have a completion state.

Condition When a step’s parent step is a condition, the step must have a condition
Analysis state.
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Database Design Analysis

Introduction An encyclopedia's database design items are analyzed if Database
Design is selected in the Phase area of the Model Analysis Report dialog
box.

Database The following items are analyzed during model analysis
Design pertaining to database design objects:
Analysis o    Data structure and data item names cannot be longer than the

       maximum number of characters specified for the applicable data
       structure manager through Visible Advantage Admin Utility Table
       Maintenance/Data Structure Managers command.
o    There cannot be more data items per data structure than the
       maximum specified for the database design through the Data
       Structure Managers command.
o    Number of data structures per database design cannot be more than
       the maximum specified for the database design through the Data
       Structure Managers command.
o    Each data structure must have at least one data item.
o    Each data structure must have at least one access mechanism.
o    Each data structure must have at least one relationship.
o    A data type must be defined for each data item.
o    Each data structure, data item, and data structure relationship must
       have a purpose.
o    Data model links must be defined for data structures.
o    Static data structure tables must be populated.
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IDEF1X DATA MAP NOTATION

Overview

Background Visible Advantage has the ability to display and print data maps in
both Information Engineering (IE) and IDEF1X formats. This
appendix documents the differences between the IE and
IDEF1X notation.

In This This appendix contains the following sections.
Appendix

Section                                                                                      
IDEF1X Entity Notation
IDEF1X Attribute Notation
IDEF1X Association Notation
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IDEF1X Entity Notation

Introduction This section shows the way entities are depicted in data maps
displayed or printed in IDEF1X format.

Independent In IDEF1X format, a square-cornered rectangle is used when
Entities all of an entity's primary keys originate in the entity. In addition, the

name of the entity appears above the entity rectangle:

ENTITY NAME

Dependent In IDEF1X format, a round-cornered rectangle indicates that at
Entities least one primary key originates in another entity:

ENTITY NAME

Visible advantage will automatically round the corners of the entity
when a primary key is cascaded from another entity through an identifying
association.

Type/ In IDEF1X format, secondary entities are indicated by a hollow circle
Secondary above one or two parallel lines:
Entities
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One line indicates a complete discriminator.

ENTITY NAME

ENTITY NAME

ENTITY NAME

Two lines indicate an incomplete discriminator.

   

ENTITY NAME

ENTITY NAME

ENTITY NAME

Visible Advantage will group together category entities based on a
common controlling entity or attribute.  This means that all categorizing
entities for a given generic entity are grouped below a common
discriminator based on the fact that they are all controlled by the same
entity or the same attribute.

The discriminator will automatically show as complete or incomplete
based on the following rules:

If the category entities are controlled by a type entity, the complete versus
incomplete designation is derived by counting the number of static values
for the controlling entity (essentially all possible categories) and counting
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the number of category entities actually shown in the view.  If they are
equal, then all categories are shown and the discriminator is shown as
complete (i.e., one line).  IF there are more static values than there are
category entities, then all categories are not shown and the discriminator is
shown as incomplete (i.e., two lines).

Similarly, if the category entities are controlled by an attribute, the complete
versus incomplete designation is derived by counting the number of domain
values populated in the domain for the controlling attribute (essentially all
possible categories) and counting the number of category entities actually
shown in the view.  If they are equal, then all categories are shown and the
discriminator is shown as complete (i.e., one line).  if there are more static
values than there are category entities, then all categories are not shown and
the discriminator is shown as incomplete (i.e., two lines).

In this manner, the category discriminator is always shown correctly as
complete or incomplete in all views that the category entities are shown in.
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IDEF1X Attribute Notation

Introduction This section shows the way attributes are depicted in data maps
displayed or printed in IDEF1X format.

Placement All attributes above the entity's horizontal line make up the primary
key. If an attribute is cascaded from another entity, `(FK)' appears after the
key name, regardless of whether it is a primary or foreign key in the
dependent entity. Non-keys and foreign keys appear below the horizontal
line.

Attribute placement within entity rectangles is shown below:

ENTITY NAME

primary key 1
primary key 2 (FK)

foreign key (FK)
non-key

Aliases/ If an attribute has an alias— or attribute role name— it is indicated
Attribute before the attribute name, separated by a period:
Role Names alias.attribute name (FK).

Unique A unique attribute— or alternate key— is indicated by the alternate
Attributes/ number in parentheses after the attribute name:
Alternate Keys  attribute (AKn), where n is the number of the alternate key.

Group Group attributes are indicated by the group attribute name followed
Attributes by the attribute members in parentheses:

group attribute name
(member attribute 1
member attribute 2,
member attribute 3)
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IDEF1X Association Notation

Introduction This section compares the way associations are represented in data
maps displayed in IE and IDEF1X formats.

Graphic The table below compares the symbolism of IE and IDEF1X
Depiction associations in data maps.

2 Note  There are no allowances in IDEF1X for optional-
becoming-mandatory associations. Therefore, the optional association
notation is used in the IE-IDEF1X association notation table below.

IE Format                                       IDEF1X Format
Association with key 
cascading as primary 
key

                                                                                
Association with key
cascading as foreign key

                 p

        (p=positive)       p

   z

           (z=zero)    z
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   The diamond represents
    optional on the owning
    entity end of the association.

    (p=positive)                p

Association with a 
maximum number of 
occurrences (min = 1)

   (m=maximum)           m

Association with a 
maximum number of 
occurrences (min > 1)

   (n=min n-m
   m=maximum)

   (z=zero)   z

         (p=positive)              p

    p                    p
            (p=positive)
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VSC FILE FORMATS

Overview

Background The Visible Advantage Import/Export functions enable you to build
custom interfaces between Visible Advantage and both commercially
available and internally developed tools.

Two functions, import and export, are provided to move meta data between
the Visible Advantage encyclopedia database and VSC file and Access
interface platforms.

The platform consists of the following files:

Import: VSC import.ad
Access imp-exp.mdb

Export: VSC export.ad
Access imp-exp.mdb

In This This appendix contains the following sections.
Appendix

Section                                                                                      
General Rules
VSC File Specifications
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General Rules

Overview Several general rules govern how files are imported to or
exported from Visible Advantage. These rules are documented below.

Visible Advantage requires that all IDs be unique across the whole
encyclopedia. Valid IDs must also be positive numbers greater than 2.

Model Views Visible Advantage links all model views into a view tree with a single
root model view. The root model view will always be assigned the ID value
of 2. All other model views must be linked through the view tree to the root
view to be accessible by the tool.

Tables The export function exports all static tables referenced by other
objects contained in the interface platform. The import function will only
import the following tables:
o   Attribute Data Type Table
o   Statement Type Table
o   Model View Type Table
o   Person Type Table

All other tables in the file will be ignored. In addition, entry number 0 in the
Model View Type Table will be ignored. This entry is reserved for the root
model view type.
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Import/Export VSC Format

Overview When you select import from VSC or export to VSC, Advantage puts
the encyclopedia data in an ASCII file named import.ad or export.ad.  The
format of this file is shown below.  All fields except those that describe the
number of description, notes, location, etc., field records are enclosed in
quotation marks.

The import/export file is a variable record length file divided into three
sections.  The first section is the header, a single record containing basic
information about the file contents.  The next section defines user attributes
and objects.  The third section is defined as the Object Block and contains
the Object Header followed by zero or more Field Blocks and an Object
Footer.  The order of the Field Blocks in not important; however, the
KEYS, CHECK, and TRIGGER fields must be present after the
COMPOSITION or CLASS COMPOSITION Field Block.

2 Note  A number of fields contain multiple pieces of information
separated by hex 01 characters (they appear on your screen as a “smiley
face” when using DOS utilities); <crlf> indicates a carriage return line
field sequence.

File Format The following format is not used for importing or exporting data flow
diagrams.  It is used only for importing or exporting database designs.

Record 1 – Header
Record

“project root”, “File creation date”, File creation time”[,User
Attribute Count [ ,User Entry Type Count}}<crlf>

User Attribute
Information:

“user defined name”, type, length, description<crlf>

Note:  The number of records is indicated by the User
Defined Count in the header record

User Entry Type
Information

“user entry type name”, Link Support, “LinkToType”,
LinkToCardinality,” “LinkDisplayName”, “CompSupport”,
“CompType”, “CompDisplayName”<crlf>
LinkSupport=digit 0 – no support, 1 – supported
LinkToType=VRE standard or aggregate type
LinkToCardinality=digit 0 – 1:1, 1 – 1:m, 2 – m:1, 3 – m:m
LinkDisplayName=Text name for the define dialog box
CompSupport=digit 0 – no support, 1 – supported
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CompType = VRE standard or aggregate type
CompDisplayName=Text name for the define dialog box

Note:  The number of records is indicated by the User Entry
Type Count in the header record

Subsequent Records
Object Header Item ID
record

ENTRY “Entry Key”, “Entry Type | User Defined Name”,
“additional Information”[, ” [ Time Stamp ] “ ]<crlf>

Entry Key [ Class Name :: ] Entry Name [::: [ Parameter Key ]]

This is the ‘ENTRY LABEL’ in the encyclopedia.  Class
Name is the name of the class that owns the object.  This is
an optional field.  Entry Name is the key field that is used in
the Define dialog box as the primary name.  Both Class
Name and Entry Name are ASCII fields up to 40 characters
in length.  Parameter Key is used for Module types to define
the argument types that uniquely identify an instance of a
function.  Each argument type is an object in the repository
of type Class, Data Element, or Data Structure, and is
followed by either an ampersand (&) if the parameter is
passed by value or reference, or an asterisk (*) if it is passed
by address.  There is no limit to the number of parameters a
function may contain.  The colons are required even if there
are no parameters.

Note:  It is possible for there to be duplicate keys (this can
happen if there are files and data flows with the same name).

Entry Type This is a number that indicates the type of entry as follows:
0=Data Element
1=Process
2=File, Data Store
3=Source/Sink, External Entity
4=Data Flow
5=Miscellaneous
6=Alias
7=Data Structure
9=Domain
14=Function
15=Module
16=Library Module
17=Macro
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18=Library Macro
19=Data Only Module
20=Inf Cluster
21=Data Couple
22=Control Couple
23=Generic Couple
24=Data Interface Table Row
25=Control Interface Table Row
26=Generic Interface Table Row
28=Program
34=Entity
35=Associative Entity
36=Attributive Entity
37=Relationship Name
38=Cluster
40=Relationship Line
43=Member Name
45=Class
46=State
47=Event
48=Tablespace

SubType If entry type is greater than 65535, then the low order word
contains the entry type as described above, and the high
order word contains the subtype.  This optional field applies
only to module types and classes and is used to denote the
following special cases.

Module Subtypes
0=Standard
1=Stored Procedure
2=Check Constraint
3=Trigger

Class Subtypes
0=Standard
5=Structure
6=Union
7=Element
8=Entity
9=Associative Entity
10=Attributive Entity
This is the name of the user-defined entry types and it



752

replaces the Entry Type.

Additional
Information

For aliases, this field will contain the owner entry key and
the owner entry type separated by hex 01 characters.

For relationship name and relationship line entries, this field
will contain the From Entity name, To Entity name, From-
To Relationship name  and To-From Relationship name,
separated by hex 01 characters.

For structure chart items appearing on a virtual diagram:
For Invocation Lines, special compound type of all
information necessary to create a virtual diagram location, as
follows:
   Type, bounding box, source module, destination module
(separated by hex 01 characters).
       type=Invocation_Normal[0x01],
       Invocation_Data[0x02],
       Invocation_Lex[0x03]
   bounding box = 1sx, 1sy, 1ex, 1ey

Note:  The modules referenced in this record must also be
included in the same import file.

In all other cases, this field will be empty.

Time Stamp

Object Footer

This optional field holds the Create and Modify dates for the
object.  It is used for import only.  The format is Create Date
followed by Modify Date, separated by hex 01 characters, as
follows:
yyyy-mm-dd, yyyy-mm-dd (separated by hex 01 characters).

END ENTRY <crlf>

Object Fields FIELD “Field Type Name”, Number of Records <crlf>

The basic format for all object fields is a header that
specifies the name of the field and the number of lines in the
body of the field.  Many types use ‘plain text’ that is defined
as a list of lines each with a single quoted string with a
maximum line length of 254  characters after processing.
Standard Advantage Text means that the field uses the same
format per line as the Advantage define screen field bearing
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the same name.  Entry names can be up to 40 characters in
length.  Names in fields use Entry Key format unless the
entry key information is redundant; i.e., Member names
listed in a class composition must be part of that class.

ADM DATA Type, min, max, average <crlf>

Type is the ASCII number for K (key), M (multiple), or G
(group).

ALIAS “Standard Advantage Text” <crlf>

There may be up to 10 aliases per entry.

ASSOCIATOR “Standard Advantage Text” <crlf>

A relationship can have one associator and can be up to 40
characters in length.

ATTR: “Standard Advantage Text” <crlf>

User-defined attribute entries.  The actual Field Type is
“ATTR:User Attribute Name”.  There is one of these for
each user attribute used on the object.

CHECK “Column Name”, “Check Constraint Name” <crlf>

CLASS
COMPOSITION

“Member Name”, “Type Name”, Array Limit, Flags <crlf>

The Type Name is an object in the repository of type Class,
Data Element, or Data Structure.  Both Member Name and
Type Name can be up to 40 characters in length.

Three pieces of information are in the flags field.  One item
from each of the following categories is ORed together.

Reference
   Address                  [0x80]
   Reference               [0x100]
   Value                      [0x00]
Visibility
   Implementation      [0x18]
   Private                    [0x00]
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   Protected                [0x08]
   Public                     [0x00]
Qualification
   Constant                 [0x400]
   None                       [0x000]
   Static                      [0x800]
   Volatile                   [0x200]

CLASS DATA Cardinality, “Cardinality Text”, Flags <crlf>

Cardinality can be one of the following values:
   One                         [0x01]
   One or Many           [0x02]
   Many                       [0x03]
   Zero or One             [0x04]
   Zero or Many          [0x05]

Cardinality text can be up to 20 characters in length.

Three pieces of information are stored in the flags field.  One
item from each of the following categories is ORed together
(Persistent and Abstract are optional):

Currency
   Active                      [0x60]
   Guarded                   [0x20]
   Sequential                [0x00]
   Synchronous            [0x40]
   Persistent                 [0x4000]
   Abstract                   [0x8000]

COMPOSITION “Standard Advantage Text” <crlf>

This field can be used with any object that supports a
composition, such as data structures, entities, and data stores.

DATA ONLY
MODULE

“Standard Advantage Text” <crlf>

This field is used with an information cluster entry, and can
be up to 40 characters in length.

DBFILES Database Type, “File Name”, Size, Reuse <crlf>
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This field is used with a tablespace entry to specify either the
data files that comprise the tablespace or the logical device
name.  Database Type is 1 for Oracle and 2 for SQL Server.

DBPHYSINFO “Tablespace name”, Database Type, Sequence, Index Type,
Additional Information <crlf>

This field is used with either an entity or a tablespace entry
to specify physical storage information.  There can be one
DBPHYSINFO object for each entity, unique key, and
performance index defined.

Tablespace Name should be blank (“”) if the current entry is
a tablespace.

Database Type is 1 for Oracle and 2 for SQL Server.

Sequence is 0 to define physical information for the table,
100 + key number for unique keys, and 200 + index number
for performance indexes.  (Key number for the primary key
is zero.)

Index type can be one of the following values.
   Sorted                         [0x00]
   Hashed Ordered         [0x10]
   Hashed Scattered       [0x20]

Additional Information for Oracle:
No Sort, PCTFREE, PCTUsed, INITrans, MAXTrans,
InitialExtent, NextExtent, PCTIncrease, MINExtents,
MAXExtents, FreeLists, FreeListGroups, Offline

Additional Information for SQL Server indexes:
SortedData, FillFactor, IgnoreDupKey, DupRow

DESCRIPTION “Standard Advantage Text” <crlf>

This is a short description for the entry.  Up to two lines of
information can be specified.

FRIEND “Friend Name” <crlf>
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This field is used with classes to specify either classes or
functions that are friends of the current object.  See the
description for Entry Key for the format.

FUNCTION
DESCRIPTION
KEYS

“Standard Advantage Text” <crlf>

Key Type, Key Number, “Key Name”, Column Count
<ccrlf>

“Column Name”, Order <crlf>

Key Type is either 21 for unique keys or 22 for performance
indexes.

Key Number is either zero for the primary key or non-zero
for alternate keys and performance indexes.

Column Count indicates the number of columns in the key.

Order indicates the sort order of the column and is either
zero for ascending or one for descending.

LINK: “Standard Advantage Text” <crlf>

User-defined object link references.  The actual Field Type is
“LINK:User Object”.  There is one of these for each user
object referenced by the object.

LOCATION Diagram Type, “Diagram Name”, Upper Left X, Upper Left
Y, Lower Right X, Lower Right Y, Associated Line Count
<crlf>

“Associated Line Name | Parent Flow Name”, Start X, Start
Y, End X, End Y, Direction <crlf>

This field is a list of all diagram locations for the object.
Each diagram location consists of a header line followed
optionally by either a parent flow name record for data flows
or list of associated lines for other objects.

Diagram Type can be one of the following values:
   Data Flow                    1
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   Structure Chart            2
   Entity Relationship      3
   Unstructured                4
   Decomposition             5
   Class                             6
   State Transition            7

Diagram Name can be up to 40 characters in length.  Each
diagram within a diagram type must have a unique name.  If
the name is prefixed by hex 9B, the diagram is a Virtual
diagram imported from Application Browser.

Associated Line Count is the number of lines attached to the
object on the indicated diagram.

Associated Line Name is the name of the attached line,
which can be up to 40 characters in length.

Direction can be one of the following values:
   Input                             49
   Output                           48
   or
   Couple Down                48
   Couple Up                     49
   Couple Bidirectional     50

MODULE
DESCRIPTION

“Standard Advantage Text” <crlf>

MODULES
CONTAINED

“Standard Advantage Text” <crlf>

This field is used with an information cluster entry.  There
can be up to seven modules each up to 40 characters in
length.

NOTES “Standard Advantage Text” <crlf>

PARAMETER “Name”, “Type Name”, Array Limit, Flags

The Type Name is an object in the encyclopedia of type
Class, Data Element, or Data Structure.  Both Name and
Type Name can be up to 40 characters in length.
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Two pieces of information are stored in the flags field.  One
item from each of the following categories is ORed together.

Pass By
   Address             [0x80]
   Reference          [0x100]
   Value                 [0x00]
Qualification
   Constant            [0x400]
   None                  [0x000]
   Volatile             [0x200]

PHYSINFO Data Type, Length, Decimal, “Default Value”, “Picture”,
“Owner”, Allow Null <crlf>
or
Data Type, “Domain Name”, “Owner”, Allow Null <crlf>

This field is used with data elements or classes with an
elemental subtype.  The first version is used if the entry does
NOT reference a domain.

Default Value can be up to 20 characters in length.

Picture can be up to 18 characters in length.

Owner can be up to 8 characters in length.

Allow Null is either ASCII 89 (Y) or 78 (N).

PROCESS
DESCRIPTION

“Standard Advantage Text” <crlf>

PROCESS NUMBER “Standard Advantage Text” <crlf>

RELATED TO “Standard Advantage Text” <crlf>

This field is used with structure chart items to create an
association with data flow diagram items.  For modules,
there can be up to 10 processes listed, for couples there can
be one data element listed, and for data only modules there
can be one data store, data structure, data element, or data
flow listed.  Each related to item can be up to 40 characters
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in length.

RELATIONSHIP Header
Controlling Key, Flags, From-To Cardinality, To-From
Cardinality, On Delete, On Update, “From-To Cardinality
Text”, “To-From Cardinality Text”, “From Role Name”, “To
Role Name”, From Qualifier Name”, “To Qualifier Name”
<crlf>
or
Controlling Key, Flags, from-To cardinality, To-From
Cardinality, On Delete, On Update, “From-To Cardinality
Text”, “To-From Cardinality Text”, “Discriminator Name”
<crlf>

Group/Prefix

Group Number, “Prefix 1”, “Prefix 1”,… <crlf>

Foreign keys “Foreign Key Column Name”, <crlf>

This field is used with a relationship line entry to supply
information used during SQL Generation.  A relationship
field consists of one header, one group/prefix line, and one
line for each column of the foreign key.  The second form of
the header is used with supertype/subtype and inheritance
relationships, while the first form is used with all other
relationship types.

Controlling key is zero to indicate the primary key is used in
the owner entity, while any other number indicates an
alternate key number.

Four pieces of information are stored in the flags field.  One
item from each of the following categories is ORed together.

Relationship Type
   Normal                                   [0x0]
   Inheritance                              [0x01]
   Aggregation                            [0x03]

Denormalization Option
   None                                        [0x0]
   Collapse Child                         [0x80000]



760

   Duplicate Parent                      [0x10000]
Duplicate Parent and Retain    [0x180000]

Identifying                                  [0x2000]

Use suffix                                   [0x200000]

Cardinality can be one of the following values.
   One                     [0x01]
   One or Many       [0x02]
   Many                   [0x03]
   Zero or One         [0x04]
   Zero or Many      [0x05]

On Delete and On Update can be one of the following.
   Cascade               [0x01]
   Restrict                [0x00]
   Set Default          [0x03]
   Set Null               [0x02]

Cardinality text can be up to 20 characters in length.

Discriminator, Roles, and Qualifier names can be up to 40
characters in length.

Group Number is used with supertype / subtype relationships
to indicate how relationships are grouped together.
Relationships drawn with the same start point on the
supertype should have identical group numbers.

TRIGGER “Trigger Name”, Operations, Fire time, Scope, # of
associated columns <crlf>

The values to use are:

Operation – Note that some dialects allow you to specify
more than one operation.
   Update                    [0x01]
   Insert                       [0x02]
   Delete                      [0x04]
Fire Time
   Before                     [0x00]
   After                        [0x08]
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Scope
   Table                       [0x10]
   Row                         [0x10]

For TRIGGER field records, the above structure is used.  For
each associated column there is one associated column
record, as follows:
“Column Name” <crlf>

VALUES AND
MEANINGS

“Standard Advantage Text” <crlf>

2 Note  Bounding boxes for structure chart types refer to “virtual
diagram” positions.  The virtual diagram is a temporary object created
by import so that invocation lines can exist in the encyclopedia without
an associated diagram.  Virtual locations disappear when the associated
objects are added to real diagrams.  Virtual locations are not visible
when editing repository items.
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INDEX

a
about the data dictionary window, 276
about the data map window, 282
about the entity-view matrix window, 405
accept list dialog box, 136
accept step, 94
access mechanism components dialog box, 11
access methods dialog box, 292
add accept step dialog box, 115
add access mechanism, 3, 4
add access mechanism dialog box, 4
add association, 13
add association dialog box, 14
add attribute, 19
add attribute dialog box, 26
add business event, 47
add business event dialog box, 48
add calls relationship dialog box, 68
add choose step dialog box, 116
add cluster access mechanism dialog box, 155
add condition end, 50
add contains relationship dialog box, 69
add control flow, 51
add control flow dialog box, 53
add create step dialog box, 118
add data access process dialog box, 90
add data dependency relationship dialog box,

71
add data item, 57
add data item dialog box, 58
add data structure, 63
add data structure dialog box, 64
add data structure manager, 66
add data structure manager dialog box, 286
add data structure relationship, 67
add database view access mechanism dialog

box, 157
add delete step dialog box, 119
add design object, 76
add design object dialog box, 77
add do create step dialog box, 122

add do delete step dialog box, 124
add do read step dialog box, 126
add do step dialog box, 120
add do update step dialog box, 128
add document dialog box, 355
add domain set dialog box, 363
add entity, 78
add entity dialog box, 79
add evaluate step dialog box, 130
add examine step dialog box, 131
add foreign key attribute dialog box, 31
add foreign key constraint access mechanism

dialog box, 7
add foreign key group attribute dialog box, 41
add function dialog box, 433
add index access mechanism dialog box, 9
add is superclass of relationship dialog box, 75
add next step dialog box, 132
add non-key attribute dialog box, 35
add non-key group attribute dialog box, 43
add note, 82
add note dialog box, 83, 510
add parallel control, 85
add planning statement dialog box, 149
add present step dialog box, 133
add primary key attribute dialog box, 28
add primary key constraint access mechanism

dialog box, 5
add primary key group attribute dialog box, 39
add process, 86
add process step, 92
add process step dialog box, 114
add read step dialog box, 134
add session, 145
add session dialog box, 146, 501
add statement, 148
add stop, 151
add stop control dialog box, 152
add storage access mechanism, 154
add system controlled access mechanism

dialog box, 159
add update  step dialog box, 135
add user, 161
add user dialog box, 162
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add user group, 165
add user group dialog box, 166
add valid word dialog box, 168
add view, 171
add view dialog box, 171
add view dialog box, 172
adding foreign key groups, 24
adding foreign keys, 21
adding new sessions, 500
adding non-key group, 25
adding non-keys, 22
adding notes to the encyclopedia, 504
adding primary key groups, 23
adding primary keys, 20
appendices, 721
applying expressions, 727
arrange icons, 174
assemble attribute group dialog box, 45
assigning titles to statements, 673
association keys dialog box, 17
attibute report dialog box, 597
attribute mode, 175
attribute-model view matrix dialog box, 177
attribute-view matrix, 176

b
bold, 178

c
cascade, 179
cascading open windows, 179
change attribute, 180
change password, 182
change to design view, 183
change to model view, 184
change to process, 187
changing a window's display font, 421
changing the font for a report, 583
changing the font in an editor window, 400
changing to another design view, 183
changing to another model view, 184
changing to another process, 187
check-in/merge encyclopedia, 191
checking-in/merging copied encyclopedias,

191
checking-out and copying encyclopedias, 198

check-out/copy, 198
choose step, 95
clear check-out, 688
close all, 205
close session, 206
close window, 208
closing all windows, 205
closing the active window, 208
cluster report dialog box, 600
color dialog box, 539
combine design object, 209
combine design objects dialog box, 210
combine domain sets dialog box, 370
combining two design objects, 209
compare encyclopedia, 212
compare encyclopedias dialog box, 214
completion table, 202, 215
completion values dialog box, 203, 216
control entity, 218
control entity dialog box, 219
control flow condition states dialog box, 55
converting IE: Advantage 6.1 encyclopedias,

220
copy access mechanism from design view, 222
copy access mechanism to design view, 223
copy attribute from database design dialog

box, 225
copy attribute from model view, 227
copy attribute from model view dialog box,

228
copy attribute to design, 229
copy attribute to design dialog box, 251
copy attribute to design object dialog box, 230
copy attributefrom design, 224
copy data item to entity dialog box, 254
copy design object from data model, 231
copy design object from design view, 235
copy design object to data model, 236
copy design object to data model dialog box,

240
copy design object to design view, 238
copy design objects to data model dialog box,

237
copy encyclopedia dialog box, 688
copy entity from design, 239
copy entity from model view, 242
copy entity from model view dialog box, 243
copy entity to design, 244
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copy entity to design dialog box, 232
copy entity to model view, 247
copy entity to model view dialog box, 248
copy property from  design view, 256
copy property from data model, 250
copy property from design object, 255
copy property to data model, 253
copy property to design object, 257
copy property to design view, 258
copy statement from model view, 260
copy statement to model view, 262
copy statement to model view dialog box, 263
copy text, 265
copy view, 266
copy/check-out encyclopedia dialog box, 200
copying attributes to design, 229
copying design objects, 235
copying entities to another model view, 247
copying model views, 266
copying text in a text editor window, 265
create step, 97
creating a completion table, 202, 215
creating a stand-alone encyclopedia, 701
creating new encyclopedias, 497
custom field dialog box, 269
custom fields, 267
cut text, 271
cutting text in a text editor window, 271

d
data access generation dialog box, 438
data access methods, 272
data dictionary, 276
data dictionary display options dialog box, 532
data item display characteristics dialog box, 61
data item mode, 278
data item report dialog box, 613
data item types, 279
data map, 282
data map display options dialog box, 529
data modeling analysis, 733
data structure managers, 284
data structure types, 298
data structure types dialog box, 290
data types, 301
data types dialog box, 288
database design analysis, 739

default path, 305
defining association keys, 449
defining attribute domains, 358
defining attribute variables, 707
defining custom fields, 267
defining data access methods, 272
defining data item types, 279
defining data structure managers, 284
defining data structure types, 298
defining data types, 301
defining entity control links, 218
defining functions, 427
defining general preferences, 435
defining model view types, 711
defining naming preferences, 493
defining session types, 657
defining statement types, 674
delete access mechanism, 307
delete access mechanism dialog box, 308
delete association, 309
delete association dialog box, 311
delete attribute, 312
delete business event, 316
delete control flow, 317
delete data item, 318
delete design object, 319
delete design object relationship, 320
delete design view, 321
delete encyclopedia, 322
delete entity, 323
delete key attribute dialog box, 314
delete model view, 324
delete non-key attribute dialog box, 315
delete planning statement, 327
delete planning statement dialog box, 328
delete process, 329
delete process control, 330
delete process step, 331
delete step, 99
delete storage access mechanism, 332
delete user group, 333
delete view dialog box, 326
deleting attributes, 312
deselect all, 334
design abbreviation dialog box, 170
design dictionary, 335
design dictionary display preferences dialog

box, 535
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design map, 337
design map display options dialog box, 536
design object mode, 339
design object report dialog box, 609
design reference, 340
design reference in data item mode, 278
design reference in design object mode, 339
design reference in entity mode, 404
designate attribute authority, 341
designate attribute authority dialog box, 342
designate entity authority, 344
designate entity authority dialog box, 345
designated cluster end point, 348
designating an entity's authority, 344
displaying and hiding the input list, 447
displaying and hiding the invocation list, 448
displaying and hiding the output list, 541
displaying and hiding the result list, 627
displaying and hiding the tool bar, 683
do create step, 102
do delete step, 104
do read step, 105
do step, 100
do update step, 106
documents, 350
documents dialog box, 353
domain map dialog box, 294
domain ranges dialog box, 366
domain report dialog box, 603
domain sets dialog box, 361
domain values dialog box, 368
domains, 358

e
edit access mechanism, 371
edit association, 373
edit attribute, 375
edit business event, 377
edit control, 378
edit control flow, 379
edit data access method table dialog box, 274
edit data item, 380
edit data item type table dialog box, 281
edit data structure, 381
edit data structure manager, 382
edit data structure relationship, 383
edit data structure type table dialog box, 300

edit data type table dialog box, 303
edit entity, 384
edit model view, 385
edit process, 387
edit process step, 389
edit session, 390
edit session type table dialog box, 659
edit statement, 391
edit statement type table dialog box, 676
edit storage access mechanism, 392
edit user, 394
edit user group, 395
edit valid word, 396
edit view, 397
edit view dialog box, 398
edit view type table dialog box, 714
editing design views, 397
editing user accounts, 394
editor font, 400
encyclopedia initializer, 402
encyclopedia menu, 688
encyclopedias list box, 688
enlarging graphical objects in a window, 450
entity mode, 404
entity report dialog box, 593
entity-view matrix, 405
error message, 688
evaluate step, 108
event-process matrix, 407
examine step, 109
exit, 408
expand all, 409
expand one branch, 410
expand one level, 411
expanding all hierarchy/outline levels, 409
expanding one hierarchy/outline branch, 410
expanding one hierarchy/outline level, 411
export.ad, 747
exporting encyclopedias, 412
expressions and functions overview, 722
extract database location information dialog

box, 630

f
find, 416
find dialog box, 417
find next, 419
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find previous, 420
finding next text occurrences, 419
finding previous text occurrences, 420
finding text, 416
font, 421
font dialog box, 401, 423
freeze all, 424
freeze all objects, 424
freezing and unfreezing concepts, 426
functions, 427
functions and functions guide, 722
functions dialog box, 430

g
general preferences, 435
generate data access processes, 436
generate SQL schema, 440
generate SQL schema dialog box, 442

h
history log report dialog box, 623

i
IDEF1X association notation, 745
IDEF1X attribute notation, 744
IDEF1X data map notation, 740
IDEF1X entity notation, 741
immediate mode, 444
immediate mode command, 444
imp-exp.mdb, 747
import, 445
import.ad, 747
import/export general rules, 748
import/export VSC format, 749
initiation list dialog box, 139
input list, 447
invocation list, 448

k
keys, 449

l
larger, 450
line wrap, 451
link association to statement, 452
link attribute to property, 453
link attribute to property dialog box, 454
link attribute to statement, 456
link design object to entity, 457
link design object to entity dialog box, 458
link entity to design object, 460
link entity to design object dialog box, 461
link entity to statement, 465
link property to attribute, 466
link property to attribute dialog box, 468
link statement to association, 469
link statement to attribute, 471
link statement to design object, 472
link statement to design object dialog box, 473
link statement to entity, 474
locate attribute, 475
locate design object, 476
locate entity, 477
locate model view, 478
locate next statement, 479
locate property, 480
locate statement, 481
locating planning statements, 481
logon, 688
logon dialog box, 688

m
maintaining tables, 680
making text bold in a text editor window, 178
manual positioning, 482
manually positioning data map entities, 482
merge encyclopedias dialog box, 196
model analysis checklist, 731
model analysis report dialog box, 616
model view dialog box, 415
modified attribute dialog box, 144
mount, 484
move attribute, 486
move property from design object, 488
move property to design object, 489
move view, 491
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n
name cluster end point, 492
naming preferences, 493
naming preferences dialog box, 494
navigate association, 496
navigating through associations, 496
new encyclopedia, 497
new encyclopedia dialog box, 498
new session, 500
next step, 110
normal, 502
normal text, 503
notes, 504
notes dialog box, 508
notes on check-in/merge types, 194
notes report dialog box, 619

o
open encyclopedia, 512
open encyclopedia dialog box, 688
open encyclopedia dialog box, 514
open statement, 515
opening a planning dictionary window, 544
opening a planning outline window, 546
opening a process hierarchy window, 564
opening a process map window, 566
opening a process-attribute matrix window,

562
opening a process-entity matrix window, 563
opening a process-process matrix window, 568
opening a statement editor window, 670
opening a statement-data matrix window, 669
opening a statement-statement matrix window,

672
opening a statement-view matrix window, 677
opening a view hierarchy window, 716
opening an event-process matrix window, 407
opening the design dictionary window, 335
opening the design map window, 337
opening the design reference window, 340
options, 516
outline display options dialog box, 526

p
parameters, 542

password, 688
paste, 543
pasting text in a text editor window, 543
path list box, 688
planning analysis, 732
planning dictionary, 544
planning dictionary display options dialog box,

527
planning outline, 546
planning statement report dialog box, 589
populate, 548
populate dialog box, 549
populating tables, 548
present list dialog box (choose steps), 141
present list dialog box (present steps), 142
present step, 111
print data map, 550
print data map dialog box, 551
print design map, 553
print design map dialog box, 554
print process map, 556
print process map dialog box, 557
print view tree, 569
print view tree dialog box, 570
printer setup, 572
printing a user group report, 702
printing reports, 585
printing user reports, 705
process hierarchy, 564
process hierarchy report dialog box, 607
process map, 566
process map display options dialog box, 534
process modeling analysis, 737
process report dialog box, 604
process-attribute matrix, 562
process-entity matrix, 563
process-process matrix, 568
publishing encyclopedia documents, 350
purge cluster, 573
purge cluster run, 573
purge history log, 574
purge history log dialog box, 575

r
read step, 112
redisplay, 576
redisplaying the active window, 576
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reference manual overview, 1
relationship keys dialog box, 73
remove statement from parent, 577
removing entity control links, 684
removing formatting from editor text, 503
rename encyclopedia, 578
reopen session, 579
replace, 580
replace dialog box, 581
replacing text in a text editor window, 580
report font, 583
reports, 584
reports overview, 584
result list, 627
return list dialog box (create, read, update

steps), 143
returning graphic objects to normal scale, 502
reverse engineering, 628
reversing your last editing action, 687
running matrix windows in immediate mode,

444

s
save as statement, 634
save statement, 635
saving statements and sessions, 635
saving text as another statement, 634
scale, 636
scale matrix dialog box, 637
scaling graphic information to a window, 717
scaling matrix windows, 636
schema generation scripts dialog box, 296
scrub, 638
scrubbing the encyclopedia, 638
select all, 639
select cluster, 640
select current, 641
select data source dialog box, 632
select design object types dialog box, 645
select design objects, 642
select design objects dialog box, 643
select entities, 647
select entities dialog box, 648
select model view dialog box, 185
select neighborhood, 651
select process dialog box, 189
select processes dialog box, 560

select properties dialog box, 463
select session, 652
select statements, 653
select statements dialog box, 654
select sub-tree, 656
selecting all objects in a window, 639
selecting an entity neighborhood, 651
selecting model view sub-trees, 656
session report dialog box, 621
session types, 657
set default path dialog box, 306
setting a default path, 305
setting data dictionary options, 521
setting data map options, 520
setting design dictionary options, 523
setting design map options, 524
setting matrix window parameters, 542
setting planning dictionary options, 519
setting process map options, 522
setting statement priorities, 671
setting up printers, 572
setting view hierarchy options, 517
shrinking graphical objects in a window, 660
smaller, 660
sort children dialog box, 662
sort statement children, 661
sort top level, 663
sort top level dialog box, 664
sorting outline children, 661
sorting the top outline level, 663
spell check, 665
spell-checking in a text editor window, 665
split design object, 666
split design object dialog box, 667
statement editor, 670
statement priority, 671
statement title and type, 673
statement types, 674
statement-data matrix, 669
statement-statement matrix, 672
statement-view matrix, 677
subdomains dialog box, 369
synchronize, 679
synchronizing visible advantage windows, 679

t
table, 680
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tile, 682
tiling open windows on the workspace, 682
tool bar, 683
transfer entities to design dialog box, 245

u
uncontrol entity, 684
underline, 686
underlining text in an editor window, 686
undo, 687
unfreezing/clearing a checked-out

encyclopedia, 688
unlink association from statement, 690
unlink attribute from property, 691
unlink attribute from statement, 693
unlink design object from entity, 694
unlink entity from design object, 695
unlink entity from statement, 697
unlink property from attribute, 698
unlink statement from object, 700
unmount, 701
update step, 113
user account report dialog box, 706
user group report, 702
user group report dialog box, 703
user report, 705
using functions, 723
using the encyclopedia initializer, 402

using this manual, 2
using variables, 726

v
valid words, 167
valid words dictionary report dialog box, 625
variables, 707
variables dialog box, 709
view display options dialog box, 525
view report dialog box, 586
view types, 711
views, 716
VSC file formats, 747

w
window, 717
wrapping text to the next line, 451
write matrix, 718
writing matrix changes to the database, 718

z
zoom, 719
zoom, 719
zoom selection, 720
zooming the model view hierarchy, 719


